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| Before You Use Your Label Maker
» Definitions of Notes
» General Precautions
» Trademarks and Licenses

* Important Note
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#& Home > Before You Use Your Label Maker > Definitions of Notes
| Definitions of Notes

We use the following symbols and conventions throughout this User's Guide:

DANGER indicates an imminently hazardous situation which, if not avoided, will
A DANGER result in death or serious injuries.
WARNING indicates a potentially hazardous situation which, if not avoided, could
A WARNING result in death or serious injuries.
CAUTION indicates a potentially hazardous situation which, if not avoided, may
A CAUTION result in minor or moderate injuries.
IMPORTANT IMPORTANT indicates a potentially hazardous situation which, if not avoided, may
result in damage to property or loss of product functionality.
NOTE NOTE specifies the operating environment, conditions for installation, or special
conditions of use.
% The tips icon indicates helpful hints and supplementary information.
Bold Bold style identifies buttons on the machine's control panel or computer screen.
Italics Italicized style emphasizes an important point or refers you to a related topic.
Courier New Courier New font identifies messages shown on the machine's LCD.

m Related Information

» Before You Use Your Label Maker
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& Home > Before You Use Your Label Maker > General Precautions
| General Precautions

+ Depending on the area, material, and environmental conditions, the label may unpeel or become
permanently affixed, and the color of the label may change or be transferred to other objects. Before affixing
the label, check the environmental conditions and the material. Test the label by affixing a small piece of it to
an inconspicuous area of the intended surface.

« DO NOT use the machine, components, or supplies in any way or for any purpose not described in this
guide. Doing so may result in accidents or damage.
* Use only Brother TZe tapes with the Label Maker. DO NOT use tapes that do not have the TZo0 mark.

+ Use a soft wipe to clean the Print Head; never touch the Print Head.
+ DO NOT try to print if the cassette is empty; it will damage the Print Head.
+ DO NOT pull the tape while printing or feeding; it will damage the tape and the Label Maker.

* Any data stored in memory will be lost due to failure, or repair of the printer, or if the batteries discharge
completely.

» Printed characters may look different than previewed, as your device's or computer’s screen may have a
higher resolution than the printer.

+ The displayed label length may differ from the actual length of the printed label.

+ When power is disconnected for two minutes, all text, format settings, and any text files stored in the memory
will be cleared.

» Be sure to read the instructions provided with the Fabric Iron-On Tapes, Extra Strength Adhesive Tapes, or
other special tapes and observe all precautions noted in the instructions.

'u_, Related Information

» Before You Use Your Label Maker
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#& Home > Before You Use Your Label Maker > Trademarks and Licenses
| Trademarks and Licenses

* Android is a trademark of Google LLC.
* Google Play and the Google Play logo are trademarks of Google LLC.

+  The Bluetooth® word mark and logos are registered trademark owned by Bluetooth SIG, Inc. and any use of
such marks by Brother Industries, Ltd. is under license. Other trademarks and trade names are those of their
respective owners.

* QR Code is a registered trademark of DENSO WAVE INCORPORATED.

* Mac, iPad, iPhone, and iPod touch are trademarks of Apple Inc.

* QR Code Generating Program Copyright © 2008 DENSO WAVE INCORPORATED.

+ Portions of this software are copyright © 2014 The FreeType Project (www.freetype.org). All rights reserved.

Any trade names and product names of companies appearing on Brother products, related documents
and any other materials are all trademarks or registered trademarks of those respective companies.

'u_j Related Information

» Before You Use Your Label Maker
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# Home > Before You Use Your Label Maker > Important Note
| Important Note

» The contents of this document and the specifications of this Label Maker are subject to change without
notice.

+ Brother reserves the right to make changes without notice in the specifications and materials contained
herein and shall not be responsible for any damages (including consequential) caused by the reliance on the
materials presented, including, but not limited to, typographical and other errors relating to the publications.

* This Label Maker does not support wireless connection.

» Screen images in this document may differ depending on your computer's operating system, your product
model, and software version.

+ Before using the Label Maker, make sure you read all the documents included with the Label Maker for
information about safety and operation.

* The Label Maker shown in the illustrations may be different from your Label Maker.
+ The available supplies may vary depending on your country or region.
+ We recommend using the latest version of P-touch Editor.

» To keep your Label Maker's performance up to date, visit support.brother.com to check for the latest firmware
updates. Otherwise, some of your Label Maker's functions may not be available.

*  When replacing or disposing of your Label Maker, Brother strongly recommends resetting it to its factory
settings to remove all personal information.

L;u Related Information

» Before You Use Your Label Maker

[ H-10159

PAGE 9 OF 464 1-800-295-5510 1023 IH-10159VND



#& Home > Set Up Your Label Maker
| Set Up Your Label Maker

» Parts Description

* LCD Overview

» Keyboard Overview

» Connect the AC Adapter

* Install Batteries

* Insert Tape Cassette

* Turn the Label Maker On/Off
» Set Language

* Set Measurement Units

» Set Auto Power-Off Time

» Enable or Disable Bluetooth
* Turn Tape Color Detection On/Off
* Feed Tape

* Adjust Display Brightness

+ Set Input Mode
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# Home > Set Up Your Label Maker > Parts Description

| Parts Description
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Tape Viewer
Liquid Crystal Display (LCD)
Tape Cassette Compartment Cover

Tape Cassette Compartment
Release Lever

Print Head

Tape Cutter

© N AWM~

Keyboard

9. Tape Exit Slot

10. Battery Compartment Cover
11. Battery Compartment

12. USB Port

13. AC Adapter Jack

a3 .
m Related Information
» Set Up Your Label Maker
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#& Home > Set Up Your Label Maker > LCD Overview
| LCD Overview

Print Preview Mode

10 =
I‘D ﬂ 23456

2 3456 8
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Label View Mode

10.

1.
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. Caps mode

Indicates if the caps lock mode is enabled.
Current font

Indicates the current font.
Character size

Indicates the current character size.
Character style

Indicates the current character style.
Frame

Indicates if a frame is set.

Width

Indicates the character width.

Align

Indicates the text alignment.

Tape width x Label length

The label length displayed on the LCD may slightly differ from the actual label length when printed.

Block number

Indicates the block number.

Line number

Indicates line numbers within the label layout.
Cursor

New characters appear to the left of the cursor.

[ H-10159
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Indicates the current data entry position.
12. Return mark

Indicates the end of a line of text.
13. Scale/Zoom

Changes the magnification of the preview.

Eﬁ Related Information

» Set Up Your Label Maker
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#& Home > Set Up Your Label Maker > Keyboard Overview

| Keyboard Overview
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Press to turn on or off the Label Maker.
Home/Bluetooth

11

Press to return to the Home Screen. To turn Bluetooth on or off, press Home/Bluetooth and the Shift key

simultaneously.

Clear

Press to clear all text and print settings.
Escape

Press to cancel the current operation.
Cursor

Press to move the cursor in the direction of the arrow.
OK

Press to select the displayed option.
Function

Press to select a function menu.

To display the attributes, press Function and the Shift key simultaneously.

Preview/Feed &Cut
Press to view an image of the label before printing.

[ H-10159
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To feed the Tape, press Preview/Feed & Cut and the Shift key simultaneously.
9. Print/Print Options

Press to print.

To set Print Options, press Print/Print Options and the Shift key simultaneously.
10. Backspace

Press to delete any character to the left of the cursor.
11. Shift

Press and hold when pressing a letter or number key to type an uppercase letter or the symbol marked on
the number key.

To move the cursor to the beginning of the previous or next block, press Shift and the A or ¥ key
simultaneously.

To move the cursor to the beginning or end of the current line, press Shift and the € or » key simultaneously.
12. Enter

Press to confirm your selection.
13. Accent

Press to select and insert an accented character.
14. Space

Press to insert a blank space.

Press to return to the default value.
15. Symbol

Press to select and insert a symbol from the symbols menus.
16. Scale/Zoom

Press to change the magnification of the preview.
17. Shift

Press and hold when pressing a letter or number key to type an uppercase letter or the symbol marked on
the number key.

To move the cursor to the beginning of the previous or next block, press Shift and the A or ¥ key
simultaneously.

To move the cursor to the beginning or end of the current line, press Shift and the € or » key simultaneously.
18. Caps

Press to use only uppercase letters (ALL CAPS mode).

When Caps mode is on, all letters entered are typed in uppercase.
19. Tab

Press to insert a tab.

'u_, Related Information

» Set Up Your Label Maker
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# Home > Set Up Your Label Maker > Connect the AC Adapter
| Connect the AC Adapter

If connecting a power adapter, use only the AC Adapter, part number AD-E001A, specifically designed for this
Label Maker.

1. Insert the AC Adapter cord into the AC Adapter Jack on the side of the Label Maker.
2. Insert the plug into the nearest standard electrical outlet.

DCIN12V

M Related Information

» Set Up Your Label Maker

[ H-10159
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# Home > Set Up Your Label Maker > Install Batteries
| Install Batteries

To ensure memory backup, we recommend using six new AA alkaline batteries (LR6) along with the AC Adapter.

NOTE

+ To safeguard and back up the Label Maker’s memory, when the AC Adapter is unplugged, we
recommend having AA alkaline batteries installed in the Label Maker.

*  When power is disconnected for more than two minutes, all text and format settings will be cleared. Any
text files saved in the memory will also be cleared.

* Remove the batteries if you do not intend to use the Label Maker for an extended period of time.

» Dispose of the batteries at an appropriate collection point, not in the general waste stream. In addition, be
sure to observe all applicable federal, state, and local regulations.

*  When storing or discarding the batteries, wrap them (for example, with cellophane tape, as illustrated), to
prevent them from short-circuiting.

54

1. Cellophane tape
2. Alkaline battery

1. Open the Battery Compartment Cover.

2. Install six new AA alkaline batteries (LR®6).
Make sure they are installed in the correct direction.
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3. Close the Battery Compartment Cover.

To remove the batteries, reverse the installation procedure.

Ea Related Information
» Set Up Your Label Maker
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# Home > Set Up Your Label Maker > Insert Tape Cassette
| Insert Tape Cassette

1. Open the Tape Cassette Compartment Cover.

2. Insert the Tape Cassette as illustrated.

NOTE

When inserting the Tape Cassette, make sure the tape does not catch on the Print Head.

3. Close the Tape Cassette Compartment Cover.

ﬁ If you cannot close the Tape Cassette Compartment Cover, make sure the Release Lever is in the 'up'
position. If not, lift the Release Lever, and then close the cover.

M Related Information

» Set Up Your Label Maker
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# Home > Set Up Your Label Maker > Turn the Label Maker On/Off
| Turn the Label Maker On/Off

1. To turn on the Label Maker, press [}

2. To turn off the Label Maker, press and hold j‘j

To save power and turn off the Label Maker automatically after a specific amount of time, use the Auto Power-Off
function.

M Related Information
« Set Up Your Label Maker

Related Topics:
» Set Auto Power-Off Time

* Specifications

(ULINE JERES
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#& Home > Set Up Your Label Maker > Set Language

| Set Language

When you turn on the Label Maker for the first time, the language selection screen appears. Select the language
by pressing € or », and then pressing OK.

1. Press .

Press < or » to display [Settings], and then press OK.
Press A or ¥ to display [Language], and then press OK.

A oDN

Press A or V¥ to select your language, and then press OK.

u Related Information

» Set Up Your Label Maker

[ H-10159
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#& Home > Set Up Your Label Maker > Set Measurement Units
| Set Measurement Units

1. Press .

Press < or » to display [Settings], and then press OK.
Press A or ¥ to display [Unit], and then press OK.

oDN

Press A or Y to display [inch] or [mm], and then press OK.

u Related Information

» Set Up Your Label Maker

(ULINE JERES
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# Home > Set Up Your Label Maker > Set Auto Power-Off Time
| Set Auto Power-Off Time

Your Label Maker has a powersaving function that automatically turns it off if no key is pressed within a certain

time, under certain operating conditions. Regardless of whether you use the AC Adapter or the batteries, you can
change the automatic powering-off time.

1. Press .

2. Press dor» todisplay [Settings], and then press OK.
3. Press A or Ytodisplay [Auto Power Off], and then press OK.
4. Press A or Ytodisplay [AC Adapter] or [Battery], and then press OK.
5. Press A or V¥ to select one of the following options:
Option Description
AC Adapter Off
lhr.
2hr.
4hr.
8hr.
Battery S5min.
10min.
30min.

6. Press OK.

M Related Information

» Set Up Your Label Maker
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# Home > Set Up Your Label Maker > Enable or Disable Bluetooth
| Enable or Disable Bluetooth

1. Press .

Press 4 or » to display [Settings], and then press OK.
Press 4 or » to display [Bluetooth], and then press OK.
Press A or Y to display [Bluetooth (On/0Off) ], and then press OK.

o~ 0D

Press A or Y to select [On] or [0ff], and then press OK.
When you select [On], the Bluetooth icon appears on the LCD.

'ﬁ * You can also enable or disable Bluetooth by pressing and simultaneously when the Home

Screen is displayed.

+ Set the Automatic Reconnection mode for Bluetooth to On or Off when you connect the Label Maker to
your mobile device.

£ .
Lg;j Related Information
» Set Up Your Label Maker
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# Home > Set Up Your Label Maker > Turn Tape Color Detection On/Off
| Turn Tape Color Detection On/Off

When using Label View mode as your Input mode, if tape color detection is set to [On], the Label Maker detects

the color of the tape and displays the label image in color on the LCD, providing a more accurate preview of the
label that you are creating.

The default setting is [On].

1. Press .

2. Press dor» todisplay [Settings], and then press OK.

3. Press AorVtodisplay [Tape Color], and then press OK.

4. Press Aor VYtoselect [On] or [0ff], and then press OK.
NOTE

The Label Maker cannot detect colors in certain Tape Cassettes. In this case, the LCD label image will
appear as black text on a white background.

u Related Information

» Set Up Your Label Maker

Related Topics:
» Set Input Mode

[ H-10159

PAGE 25 OF 464 1-800-295-5510 1023 IH-10159VND



# Home > Set Up Your Label Maker > Feed Tape
| Feed Tape

1. To feed the tape, press and .

2. Press A or ¥ to select one of the following options:

Option Description

Feed & Cut Selectto feed and cut the tape automatically.

Feed Only Select to feed, but not cut, the tape.
Recommended when using Fabric Iron-On Tapes, which should be cut using scissors.

3. Press OK.

u Related Information

» Set Up Your Label Maker

[ H-10159
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# Home > Set Up Your Label Maker > Adjust Display Brightness
| Adjust Display Brightness

1. Press .

Press < or » to display [Settings], and then press OK.
Press A or ¥ to display [Adjustment], and then press OK.
Press A or Y to display [Display Brightness], and then press OK.

o k> DN

Press A or ¥ to select your preference, [-2 - +2], and then press OK.

M Related Information
» Set Up Your Label Maker

[ H-10159
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# Home > Set Up Your Label Maker > Set Input Mode
| Set Input Mode

Label View Mode

:

ABC Company
Sales Dept.

Print Preview Mode

ABC Companyd
Sales Dept.

1. Press .

2. Press dor» todisplay [Settings], and then press OK.
3. Press AorVtodisplay [Input Mode], and then press OK.
4. Press A or ¥V to select one of the following options:
Option Description
Label View Displays the character attributes and frames you set when creating a label.
Press to change the LCD magnification.
Print Preview Selectif you do not want to view the attributes on the LCD.
5. Press OK.

L‘j Related Information

» Set Up Your Label Maker

Related Topics:
* Preview Labels

[ H-10159
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#& Home > Install Software

| Install Software
* Install the Printer Driver and Software on a Computer (Windows)

* Connect the Label Maker to a Computer

[ H-10159
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#& Home > Install Software > Install the Printer Driver and Software on a Computer (Windows)
| Install the Printer Driver and Software on a Computer (Windows)

To print from your Windows compulter, install the printer driver and the Brother P-touch Editor software on your
computer.

1. Open your preferred web browser and type install.brother in the address bar.

http://install.brother

L ] AL "\
£ = —
e Y e Y | | | i | i\ i\ i\ Wi i

L

2. Click the Download button to download the Software/Documentation Installer.

3. Navigate to your computer's Downloads folder, double-click the downloaded installer file, and follow the on-
screen instructions.

NOTE

*  When you connect the Label Maker to your computer using Bluetooth, make sure you set the
Bluetooth data transfer setting in your operating system to bi-directional.

* Press the required button on the Label Maker for pairing when you confirm the passcode.

m Related Information

* Install Software

+ Available Applications

[ H-10159
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# Home > Install Software > Install the Printer Driver and Software on a Computer (Windows) > Available

Applications

| Available Applications

Windows

Application

Features

P-touch Editor !

Allows you to design and print custom labels using built-in drawing tools to create various font
and text styles, import images, and insert barcodes.

P-touch Transfer
Manager 2

Allows you to transfer templates and other data to the Label Maker and save backups of your
data on the computer.

This application is installed with P-touch Editor.

P-touch Library

Manages and prints P-touch Editor templates.
You can use P-touch Library to print templates.
This application is installed with P-touch Editor.

P-touch Transfer
Express 2

Allows you to transfer documents to the Label Maker.

P-touch Update
Software 2

Updates software and firmware to the latest version.

1 The template transfer function is currently available with P-touch Editor 5.4 only. P-touch Editor 6.0 will support this function from a future

update.

2 Available with the USB connection only.

Mac

Application

Features

P-touch Editor

Allows you to design and print custom labels using built-in drawing tools to create various font
and text styles, import images, and insert barcodes.

Transfer Express '

Updates firmware to the latest version.

1 Available with the USB connection only.

m Related Information

* Install the Printer Driver and Software on a Computer (Windows)
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#& Home > Install Software > Connect the Label Maker to a Computer

| Connect the Label Maker to a Computer

* Connect the Label Maker to a Computer Using a USB Cable

[ H-10159
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# Home > Install Software > Connect the Label Maker to a Computer > Connect the Label Maker to a
Computer Using a USB Cable

| Connect the Label Maker to a Computer Using a USB Cable

1. Make sure the Label Maker is turned off before connecting the USB cable.
2. Connect the USB cable to the USB port on the Label Maker, and then to your computer.

3. Turn on the Label Maker.

u Related Information

» Connect the Label Maker to a Computer

[ H-10159
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#& Home > Edit a Label
| Edit a Label

Add Text to Your Label

Add a New Line of Text to Your Label
Add a New Block of Text to Your Label
Delete Text

Insert a Tab

Use Text Reminder to Autocomplete Common Words
Enter Symbols

Enter Accented Characters

Set Character Attributes

Set Label Length

Use Auto Format Layouts

Use Block Layouts

Create Tables

Create a Barcode Label

Use the Time and Date Function

[ H-10159
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#& Home > Edit a Label > Add Text to Your Label
| Add Text to Your Label

1. Press .

2. Press dorp todisplay [Create Label], and then press OK.

3. Type the text or symbols you want (up to 280 alphanumeric characters, including spaces and punctuation
marks).

u Related Information
» Edit a Label

[ H-10159
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& Home > Edit a Label > Add a New Line of Text to Your Label

| Add a New Line of Text to Your Label

You can add up to seven lines to your labels, depending on the tape you are using. For more information, see

Related Topics.

1. Move the cursor to the end of the current line.

2. pross (B )

Line 1

1 ABC

Line 2

0| ABCJ
3 DEF

Printed Label Result

ABC
DEF

.ﬁ The maximum number of lines you can add depends on the tape width.

Max Lines Tape Width

7 lines 0.94" (24 mm)

5lines 0.70" (18 mm)

3 lines 0.47" (12 mm)

2 lines 0.35" (9 mm)
0.23" (6 mm)

1 line 0.13" (3.5 mm)

u Related Information

« Edit a Label

Related Topics:
» Specifications
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& Home > Edit a Label > Add a New Block of Text to Your Label
| Add a New Block of Text to Your Label

To print labels with multiple, but separate, sections of text, you can insert up to five different text blocks within the
same label.

ABC DEF: GHI A JKL M

To add a new block of either text or blank lines to the right of your current text, press and hold , and then

press I| simultaneously.

The cursor moves to the start of the new block.

ABC

ﬁ - To change the character attributes for a block of text, follow the steps for changing character attributes
for a line of text.

- There is a maximum of five blocks per label.

w Related Information

« Edit a Label

[ H-10159
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& Home > Edit a Label > Delete Text

| Delete Text

>> To delete one character at a time:

>> To delete text but not format settings:

>> To delete all characters in a specific line:

>> To delete all characters and all format settings:

To delete one character at a time:

Press .

To delete text but not format settings:

1. Press .

2. Press A or Vtodisplay [Text Only], and then press OK.

To delete all characters in a specific line:

1. Press A or Y to move to the line you want to delete.

2. Press and (clear| simultaneously.

To delete all characters and all format settings:

1. Press .

2. Press A or Vtodisplay [Text & Format], and then press OK.

| .
M Related Information
« Edit a Label

[ H-10159
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& Home > Edit a Label > Insert a Tab

| Inserta Tab
To insert a tab, place the cursor to the left of the text, and press .

The tab symbol () appears on the LCD.

.ﬁ To delete a tab from a label:
Position the cursor to the right of the tab symbol on the text entry screen, and then press .

Eﬁ Related Information

» Edit a Label
» Change the Tab Length

[ H-10159
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# Home > Edit a Label > Insert a Tab > Change the Tab Length
| Change the Tab Length

1. Enter the text you want.

Press .

2
3. Press AorVYtodisplay [Tab Length], and then press OK.
4. Do one of the following:

* Press A or ¥ to display 0.0"-4.0" (O - 100 mm), and then press OK.

+ Enter the tab length you want using the number keys. When finished, press OK.

5. Press to return to the text entry screen.

m Related Information

¢ Inserta Tab

(ULINE JERES
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#& Home > Edit a Label > Use Text Reminder to Autocomplete Common Words
| Use Text Reminder to Autocomplete Common Words

You can save frequently used text or phrases in your Label Maker for quick retrieval and use in your labels. By
default, the Text Reminder feature is setto [On].

ﬁot hier

B

1. Type a character (for example: "B").
2. Press OK.
The Label Maker displays a list of words printed beginning with the letter “B”, such as “Brother”.
3. Press A or ¥ to select the word you want.
4. Press » to display the entire word if necessary.
Press «to return to the list of words.
5. Press OK.

To close the list of words and return to the text entry screen, press .

£ .
Lg;j Related Information
» Edit a Label

» Clear Text Reminder Memory
* Enable or Disable Text Reminder

[ H-10159
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# Home > Edit a Label > Use Text Reminder to Autocomplete Common Words > Clear Text Reminder
Memory

| Clear Text Reminder Memory

1. Press .

2. Press dor» todisplay [Settings], and then press OK.
3. Press A or Ytodisplay [Text Reminder], and then press OK.
4. Press AorVYitodisplay [Clear Memory], and then press OK.
The message [Clear all Text Reminder memory?] appears.
5. Press OK.

u Related Information

» Use Text Reminder to Autocomplete Common Words

[ H-10159
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# Home > Edit a Label > Use Text Reminder to Autocomplete Common Words > Enable or Disable Text
Reminder

| Enable or Disable Text Reminder

1. Press .

Press € or » to display [Settings], and then press OK.
Press A or Y to display [Text Reminder], and then press OK.
Press A or Y to select [on/0ff], and then press OK.

o b~ DN

Press A or Y to select [On] or [0ff], and then press OK.

u Related Information

» Use Text Reminder to Autocomplete Common Words

[ H-10159
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#& Home > Edit a Label > Enter Symbols

| Enter Symbols
* Enter Symbols Using the Symbol Function
» Set Symbol History

* Symbol Options

[ H-10159

PAGE 44 OF 464 1-800-295-5510 1023 IH-10159VND



# Home > Edit a Label > Enter Symbols > Enter Symbols Using the Symbol Function

| Enter Symbols Using the Symbol Function
1. Press .

2. Press A or ¥V to select a category, and then press OK.
3. Press A, V, € or » to select a symbol, and then press OK.

u Related Information

» Enter Symbols

[ H-10159
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#& Home > Edit a Label > Enter Symbols > Set Symbol History

| Set Symbol History

The Symbol History can store up to 30 recently used symbols. By default, the Symbol History feature is set to
[On].

1. Press .

Press €4 or » to display [Settings], and then press OK.
Press A or Y to display [Symbol History], and then press OK.

»ooDd

Press A or Y to select [On] or [0ff], and then press OK.

u Related Information

* Enter Symbols

(ULINE JERES
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#& Home > Edit a Label > Enter Symbols > Symbol Options

| Symbol Options

Category Symbols

Punctuation . s 2 1 4 - & \
| x @ #

BracketArrow ( ) [ ] < = « ' [ ] * « f ‘ “’ ‘“
2 EPILo2C U N IR2 T e §

Mathematics + - x + + =2 £ =# aBvouaqQ
o > sos 2 % e s I INIVVY
VI VIEVIE X X

CurrencyUnit % $ ¢ € £ ¥ ° ft.inmmecee £ ozlb
F O

(Number) D - @

[Number] ] - [o9]

o QO@EEAQELHS LSRR T & o
S 1 OO@WA®E (¢ 2 &
QOB L &

Hectrones DO dE@c @bl Jzxedi@ ™ % &
B/ 00 Emasl=Q T L0 ca
TIFaslaPmBaagsorr r «
|4 |4«

pusiess VIO IXBRASRDIIAP =™
SBEHEGYWLIOM,roT & A
BRYDENDaQSFXasMmn oo
B INNARMaAa-HR@THEG®
HELOS A D A @2 TS
e HNEMBELE ee™

realineare MaeSswiddB dads350® 20D
P BYLAl PHRTH
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Category

Symbols

Electrical

~=44=80Q 00| @00 ([4A

Tools

REBDBBID WAL SLALITIASE
m

Garden

CRES A SORT T ETHRELOR
BERY L SENE

Craft/Baby

OQEMIAL,ETESH

Music

P AR LT VS

Animal

PTOORDOODBUOBYON
HY LW madlmy T €L O B &
LI g &

Foods

GEEIORFY L OO @l
B OBCHTLERPLPLES S (T
BEOCPES®S@eHI¥Y L,/ dNBOSOD

WOl I eoMmidl &S

Nature/Earth

RGHPOZPRCZOIRANLE

Event

RO L2400 PTYeEdRTORRN
!*GQ@@mﬁﬁﬁﬁﬁ@@ﬁw

Vehicle

’*"%"E@&@%@lié@w—

Wardobe

TORBITRORees@IX
SRR Dsoeorellh A

Sports

RO PRSFEROL XCYP
ZHALLE S TPROLL

Family

GRS & Eo ity
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Category Symbols

=l POEOEEELOOINLVEOYWBE
OO nwra g B

Pictograph . NON NElY WAN AVAE ad BANR AVE IK¢
o T2 FEDR1GGeYNEAHILBED
A B

Astrology T X AMOMAUS M

'm: Related Information

» Enter Symbols

[ H-10159
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# Home > Edit a Label > Enter Accented Characters
| Enter Accented Characters

1. Enter the character you want.

2. Press .

3. Press A or V to select the accented character, and then press OK.

u Related Information

« Edit a Label

» Accented Character Options

[ H-10159
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#& Home > Edit a Label > Enter Accented Characters > Accented Character Options
| Accented Character Options

The accented characters displayed on the LCD depend on your language.

Character Accented Characters
a daaddexagdaa
A AAAAAAAAAA
° cCe
© CCC
d dod
0 DD
° éeéecgeee
" EEEEEEEE
: off¢
¢ GG
! (RRREAN
| FITTLT
“ k
K K
! il P
: LLLLD
n ANNAN
§ NNNN
’ 000000 Es
° I O00YOOEO
r rrr
* |RRF
s §8§sshB
° SSSSB
t tib
T TTh
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Character Accented Characters

u rd ~ ~ =n =]

y yy

Y YY
z 2727
z 2727

u Related Information

* Enter Accented Characters
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& Home > Edit a Label > Set Character Attributes

| Set Character Attributes

You can set character attributes by label or per line.
* Apply Character Attributes to a Character
* Apply Character Attributes to a Line of Text
» Attribute Setting Options

» Set Auto Fit Style

[ H-10159
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# Home > Edit a Label > Set Character Attributes > Apply Character Attributes to a Character
| Apply Character Attributes to a Character

When formatting your text, you can preview your character attribute selections on the LCD.

1. Type the text you want.

Press .

2

3. Press A or ¥ to select an attribute, and then press OK.

4. Press A or ¥V to set a value for that attribute, and then press OK.
5

Press to return to the text entry screen.

u Related Information

¢ Set Character Attributes

Related Topics:
* Attribute Setting Options

[ H-10159
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# Home > Edit a Label > Set Character Attributes > Apply Character Attributes to a Line of Text

| Apply Character Attributes to a Line of Text

If you add multiple lines in your label, you can format each line of text to look different.

1. Type the lines of characters or text you want on your label.
2. Press A or Y to move the cursor to the line whose character attributes you want to change.

3. Press' ssnitt | and (@) to display the available formatting attributes.

Three black lines (1) on the left side of the character attribute indicate that you are now applying the attribute
to that specific line only.
1

[ﬁFunt AA

B ABC Compal Sz= 1A
d Sales Dep/ wan A

. Press A or ¥ to select an attribute, and then press OK.
5. Press A or ¥ to set a value for that attribute, and then press OK.

6. Press to return to the text entry screen.

.ﬁ When different attribute values are set for each line, each lines values appear as three black lines (1), also

called a 'hamburger menu', when you press .

Font IE,_
ABC Compan Sz Elnn

Sales Dept wian [=

Lﬁ Related Information

» Set Character Attributes

Related Topics:
* Attribute Setting Options

[ H-10159
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#& Home > Edit a Label > Set Character Attributes > Attribute Setting Options
| Attribute Setting Options

Font

Value LCD Message Result

Helsinki HEL A1
Dortmund DTM A1
Brussels BRU A 1
Cooperstown COP A.I
Atlanta ATL A1
us Us Al

Los Angeles LA Al
San Diego 560 Al
Florida FLO Al
Calgary caL a7
Belgium BEL Al
Adams ADM A1

Brunei BRN A 1
Sofia SOF A ]

Germany GER AI
Letter Gothic LGO A’I
Istanbul IST A 1
Font Size

Available Sizes:
Auto, 6 pt, 9 pt, 12 pt, 18 pt, 24 pt, 36 pt, 42 pt, 48 pt

.ﬁ When Auto is selected, the text is automatically adjusted to print in the largest size available in the font
settings for each tape width.

Width

Value Result
x1 A

x 3/2 A
2 A

[ H-10159
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Value Result
x 1/2 A
x 2/3 A
Font Style
Value LCD Message Result
Normal Normal A
Bold BLD A
Underline UND A
Underline Bold UND+BLD A
Strikeout STR #
Outline ouT A
Shadow SHD A
Solid SLD A
Italic ITA A
Italic Bold I+BLD A
Underline + Italic UND+ITA A
Underline + Bold + Italic UND+BLD+ITA A
Italic Outline I+0UT A
Italic Shadow I+SHD A
Italic Solid I+SLD A
Vertical VERT <
Vertical Bold VERT+BLD <
Alignment
Value Result

Left AB C

Center AB C

Right AB C
Justify A B C

L_“ Related Information

« Set Character Attributes

[ H-10159
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# Home > Edit a Label > Set Character Attributes > Set Auto Fit Style
| Set Auto Fit Style

You can reduce the text size to fit within the length of your label.

1. Press .

Press 4 or » to display [Settings], and then press OK.
Press A or Y to display [Auto Fit Stylel], and then press OK.

el

Press A or ¥ to select one of following options:

Option Description

Text Size  The total text size is reduced to fit within the label.

Text Width The text width is reduced to the size of the x 1/2 or x 2/3 setting to fit within the label.
For the expected output, see Related Topics.

5. Press OK.

u Related Information

¢ Set Character Attributes

Related Topics:
* Attribute Setting Options

[ H-10159
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# Home > Edit a Label > Set Label Length
| Set Label Length

Labels can be between 1.2" (30 mm) and 12.0" (300 mm) in length. When you select [Auto], the label length is
automatically adjusted based on the amount of text entered.

1. Press .
2

Press A or Y to display [Length], and then press OK.

Do one of the following:

* Press A or ¥ to set a value, and then press OK.

« Set the label length by typing in the length you want using the number keys. When finished, press OK.

4. Press to return to the text entry screen.

m Related Information

» Edit a Label

« Set Frames

Related Topics:
» Change the Tab Length
» Select a Cut Option

(ULINE JERES
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# Home > Edit a Label > Set Label Length > Set Frames

| Set Frames

1. Press .

Press A or ¥ to display [Frame], and then press OK.
Press A or V¥ to select a category, and then press OK.

o N

Press A, V, 4, or » to select a frame, and then press OK.

.ﬁ You can also select a frame by entering its number. For more information, see Related Information.

M Related Information
» Set Label Length

» Frame Options

(ULINE JERES
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# Home > Edit a Label > Set Label Length > Set Frames > Frame Options

| Frame Options

Category Frames

et | | | | | | )
( ) { N
{ > «r 43 $ 4 )
F | 4§ | | [ |
g i L ] E : L Al ]
¢ 3 =2, R

Simple 2 [ e I ) I o N — ] S—
— [ : | O 1 M)
| i H g 3 ¢ 7 ¥ f

Decorative %: : i %

D ¥ < Cr X, X
V& 2.3 4% } 5 i

el W A LI bée F+w@ =
= Kok g JEyT Wy ¥
B A LT P by b
3 YA (Mg a3® =R ol
Yo onle

Business 1\ o) &1 & g ]
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Category

Frames

Business 2

W W@ B = @D
= GEERECTR)] =GR 8] -

B am B W S

| B #) S © H S

0
aS
'4
&

& = s | [ |
%] | | = | (2 | [ |

'u_j Related Information

» Set Frames
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& Home > Edit a Label > Use Auto Format Layouts

| Use Auto Format Layouts
* Use Templates

» Template Options

[ H-10159
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#& Home > Edit a Label > Use Auto Format Layouts > Use Templates
| Use Templates

Select a layout from the preloaded templates included with your Label Maker, enter your text, and then apply any
formatting you want. For preloaded templates, see Related Topics:Template Options.

.‘ﬁ If the width of the current Tape Cassette does not match the set width for the selected template, an error
message appears when you try to print the label. Press or any other key to clear the error message,
and then insert the correct Tape Cassette or choose a different template.

Example - To customize and print the preloaded template named Asset Tag 1:
XXX COMPANY

XXX department
| AT O IR OO R T )
*0001492%

—_

Press .

Press «or » to display [Auto Format], and then press OK.

Press A or ¥ to display [Templates], and then press OK.

Press A or ¥ to display [Asset Management], and then press OK.
Press A or Y to display [Asset Tag 1], and then press OK.

Enter the text you want, and then press OK.

Enter the text for the next field, and then press OK.

Press A, ¥, 4, or » to select a barcode attribute, and then press OK.

© © N o gk~ DN

Enter the barcode data, and then press OK. For more information, see Related Topics: Create a Barcode
Label.

. Do one of the following:

-
o

» Select [Print], and then press OK.

* Press A or V¥ to select one of the following options:
. ==
Print

Edit 2

Save ﬁ

Option Description
Edit Change the text.
Save Save the label.

For more information, see Related Topics: Use the File Memory.

Menu Change the Font or Style settings.

Preview Preview the label before printing.

Press to change the LCD magnification.

Print Options Select print options.

For more information, see Related Topics: Print Labels.

11. Press A or ¥ to select the number of labels you want to print, and then press w or OK.

[ H-10159
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Related Information

* Use Auto Format Layouts
Related Topics:

* Create a Barcode Label

* Use the File Memory

* Print Labels

» Template Options

[T H-10159
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#& Home > Edit a Label > Use Auto Format Layouts > Template Options

| Template Options

Category Value

Details

Asset Management | Asset Tag 1

(0.94" x 2.8" [24 mm x 70 mm])

Asset Tag 2

e

(0.70" x 2.8" [18 mm x 70 mm])

Asset Tag 3

ABC Company, Inc.
{0 0D U
*00001%

(0.94" x 2.8" [24 mm x 70 mm])

Asset Tag 4

ABC Company, Inc.
(YN R AT AN
*00001%

(0.70" x 2.8" [18 mm x 70 mm])

Asset Tag 5

Property of:
ABC Company, Inc.

00001

(0.94" x 2.8" [24 mm x 70 mm])

Asset Tag 6

Property of:
ABC Company, Inc.
00001

(0.70" x 2.8" [18 mm x 70 mm])

Asset Tag 7

ABC Company, Inc.

[N A O
(0.47" x 2.8" [12 mm x 70 mm])

Bin Box

(0.94" x 3.0" [24 mm x 76 mm])

Equipment Label

ABC Company, Inc.

123456789

(0.94" x 2.3" [24 mm x 58 mm])

Cabinet Cabinet Label 1

Office Supplies
Sales Dept.

(0.94" x 5.0" [24 mm x 126 mm])

Cabinet Label 2

@ Office Supplies
Sales Dept.

(0.70" x 4.4" [18 mm x 111 mm])

Cabinet Label 3

@ Office Supplies
Sales Dept.

(0.94" x 5.0" [24 mm x 126 mm])

Cabinet Label 4

‘ @ Office Supplies @

(0.94" x 6.3" [24 mm x 160 mm])

File Binder Spine 1

‘m<4mm <O00DZ+®

(0.94" x 8.6" [24 mm x 219 mm])

Binder Spine 2

‘w<4mm <OOO0ODZ+W

(0.70" x 8.6" [18 mm x 219 mm])
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Category Value Details
Binder Spine 3 .
-—
& Design Data Jan-Mar 2022
(0.94" x 8.6" [24 mm x 219 mm])
Binder Spine 4 ‘ S Design Data Jan-Mar 2022
(0.47" x 8.6" [12 mm x 219 mm])
File Folder Tab PAYABLES
(0.47" x 3.2" [12 mm x 82 mm])
Divider Tab AUGUST
(0.47" x 1.6" [12 mm x 42 mm])
Document index s
(0.94" x 1.4" [24 mm x 36 mm])
Address/ID Address Label 1
(0.94" x 2.8" [24 mm x 72 mm])
Address Label 2
Robert Becker
T ephame R R
(0.94" x 2.8" [24 mm x 72 mm])
Name Badge 1 Ro‘k:irtr Esgiifer
(0.94" x 2.8" [24 mm x 72 mm])
Name Badge 2
" Robert Becker
Sales Manager
(0.94" x 2.8" [24 mm x 72 mm])
Name Badge 3 Rﬂn;bean B;ecll:er
(0.70" x 2.8" [18 mm x 72 mm])
Name Badge 4
Robert Becker
ABC Company, Inc.
(0.94" x 2.8" [24 mm x 72 mm])
Media SD Card Label aphotoss
(0.47" x 1.0" [12 mm x 25 mm])
USB Flash Memory
(0.35" x 1.0" [9 mm x 25 mm])
DVD Case Spine SERVICE MANUAL (PDF)
(0.35" x 7.0" [9 mm x 178 mm])
CD Case Spine \ ]
(0.23" x 4.4" [6 mm x 113 mm])
Cable Labeling Flag 1 ABC | ABC
(0.47" x 3.5" [12 mm x 90 mm])
Flag 2 e 5
(0.47" x 3.5" [12 mm x 90 mm])

[ H-10159

1-800-295-5510

1023 IH-10159VND



Category

Value

Details

Cable Wrap 1

Cable Wrap 2

(0.70" x 1.5" [18 mm x 39 mm])

Faceplate (VRT)

(0.47" x 2.8" [12 mm x 70 mm])

Signage

Signage 1

HOT!

(0.94" x 2.6" [24 mm x 66 mm])

Signage 2

-
L

(0.94" x 2.0" [24 mm x 50 mm])

CAUTION
THIS IS SIDE
upP

u Related Information

¢ Use Auto Format Layouts
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#& Home > Edit a Label > Use Block Layouts
| Use Block Layouts
You can choose different Block Layouts, based on the tape size, to arrange text lines on your label. Select one of

the Block Layout options, enter your text, and then apply text formatting if needed. To see what options are
available for the tape you are using, see Related Information: Block Layout Options.

Press .

Press «or » to display [Auto Format], and then press OK.

—_

Press A or Y to display [Block Layouts], and then press OK.
Press A or V¥ to select the tape width you want, and then press OK.
Press A or Y to select the block layout you want, and then press OK.
Enter the text you want, and then press OK.

Repeat these steps for each text field, and then press OK.

Press OK to display the print menu.

© © N o g br w0 DN

Do one of the following:
* Select [Print], and then press OK.
* Press A or ¥ to select one of the following options:

Print

Edit

R

Save ﬁ

Option Description
Edit Change the text.
Save Save the label.

For more information, see Related Topics: Use the File Memory.

Menu Change the Font, Align, or Frame settings.

Preview Preview the label before printing.

Press to change the magnification of the LCD.

Print Options Select print options.

For more information, see Related Topics: Print Labels.

10. Press A or V to select the number of labels you want to print, and then press

.ﬁ If the width of the current Tape Cassette does not match the set width for the selected layout, an error
message appears when you try to print the label. Press or any other key to clear the error message,
and then insert the correct Tape Cassette.

L.u Related Information

+ Edit a Label
» Block Layout Options

[ H-10159
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Related Topics:
* Use the File Memory
* Print Labels

[T H-10159
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#& Home > Edit a Label > Use Block Layouts > Block Layout Options

| Block Layout Options
0.94"/24 mm Tape

Value Details
1Line(Inversion)
2LineA
2LineB
3LineA
3LineB
3LineC
1+1LineA
24 pt-.
1+1LineB
] = |:.-|:... 2
1+1LineC !
d2pt.-| 2
1+2LineA
: 2 pt
qSpt--| & w2 pt

[ H-10159
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Value Details
1+2LineB
43 pt--
1+2LineC
43 pt--
1+3LineA
45 pt-| &
1+3LineB
43 pt.-
1+3LineC
43 pt--
1+4LineA
24pt--
1+4LineB
43 pt--
1+5Line
24pt.-
0.70"/18 mm Tape
Value Details
2LineA
2LineB
3LineA
3LineB

[ H-10159
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Value Details
1+1LineB
] = I:.-I:...
1+1LineC
42 pt-| &
1+2LineA
42 pt-.
1+2LineB
42 pt..
1+2LineC
42 pt--
1+2LineD
3z pt-| 2
1+3Line
32 pt--
1+4Line
24 pt--
1+5Line
24 pt--
0.47"/12 mm Tape
Value Details
2LineA | Mo 'E| I:It
“12pt
2LineB . 1 E I:lt
...... 9 pt
3LineA e Ept
= I:lt
12pt
3LineB Az2pt
o Bpt
Ept
1+1LineA
1+1LineB
1+1LineC
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Value Details
1+2Li
ine 29 pt.--- :}%EE
0.35"/9 mm Tape
Value Details
2LineA [T ITTTTTTTTTTTTT T T T e El pt
2LineB . -I E Flt
...... El I:'t
1+2Line
12pt-- L
0.23"/6 mm Tape
Value Details
1+2Line '|E|:I'|Z---

Lﬁ Related Information

» Use Block Layouts
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& Home > Edit a Label > Create Tables

| Create Tables

Create a table by setting the number of rows and columns you want. You can save the file as a template to reuse
in other labels.

.ﬁ There is a maximum number of rows, depending on the tape width.

Max Lines Tape Width

7 lines 0.94" (24 mm)

5 lines 0.70" (18 mm)

3 lines 0.47" (12 mm)

2 lines 0.35" (9 mm)
0.23" (6 mm)

1. Press .
2

Press 4 or » to display [Auto Format], and then press OK.

w

Press A or Y to display [Table Format], and then press OK.

Use the A, V, 4, and P keys to create your table.

Press A or ¥ to select the tape width you want, and then press OK.
Press A or ¥ to select [Rows].

Press < or » to set the number of rows you want.

Press A or ¥ to select [Columns].

Press < or » to set the number of columns you want, and then press OK.
Enter the text you want, and then press OK.

223 © % No ok

0. Repeat these steps for each text field, and then press OK.
1. Do one of the following:
* Select [Print], and then press OK.

* Press A or ¥ to select one of the following options:

Print
Edit &
Save ﬁ

Option Description
Edit Change the text.
Save Save the label.
For more information, see Related Topics: Use the File Memory.
Menu Change the Font or Style settings.
Preview Preview the label before printing.

Press to change the LCD magnification.

Print Options

Select print options.

For more information, see Related Topics: Print Labels.

[ H-10159

1-800-295-5510

PAGE 75 OF 464 1023 IH-10159VND



12. Press A or ¥ to select the number of labels you want to print, and then press or OK.

ﬁ + 0.13" (3.5 mm) tape cannot be used to create tables.
+ If the width of the current Tape Cassette does not match the set width for the selected layout, an error

message appears when you try to print the label. Press or any other key to clear the error
message, and then insert the correct Tape Cassette.

m Related Information

» Edit a Label
Related Topics:

* Use the File Memory
* Print Labels

» Block Layout Options

[ H-10159
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#& Home > Edit a Label > Create a Barcode Label

| Create a Barcode Label
* Create and Print Barcodes

» Edit or Delete a Barcode and Barcode Data

[ H-10159
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#& Home > Edit a Label > Create a Barcode Label > Create and Print Barcodes
| Create and Print Barcodes

The Label Maker is not designed exclusively for creating barcode labels. Always check that barcode labels can
be read by the barcode reader.

For best results, print barcode labels in black ink on white tape. Some barcode readers may not be able to read
barcode labels created using colored tape or ink.

Up to five barcodes can be printed on a label.

NOTE

* Usethe [Large] setting for [Width] whenever possible. Some barcode readers may not be able to
read barcode labels created using the [Small] setting.

» Continuously printing a large number of labels with barcodes can overheat the Print Head, which may
affect the print quality.

* Symbols are available only for the CODE39, CODE128, CODABAR, or GS1-128 protocols.
+ The "C.Digit" (Check Digit) attribute is available only for the CODE39, |-2/5, and CODABAR protocols.

1. Press .

2. Press A or ¥V to display [Barcode], and then press OK.
3. Press A, V, 4 or » to select an attribute, and then press OK.
4. Enter the barcode data. For more information, see Related Topics.
5. Press | Symbol | or ()
. Press A or ¥ to select a character, and then press OK.
7. Press OK.

u Related Information

¢ Create a Barcode Label

» Barcode Options

[ H-10159
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& Home > Edit a Label > Create a Barcode Label > Create and Print Barcodes > Barcode Options

| Barcode Options

Attribute Value
Protocol CODE39, CODE128, EAN-8, EAN-13, GS1-128 (UCC/
EAN-128), UPC-A, UPC-E, I-2/5 (ITF), CODABAR
Width Small
Large
Under# On
(Characters printed below the barcode)
Off
C.Digit Off
(Check Digit)
On

(Available only for the CODE39, I-2/5, and CODABAR

protocols)

Special Character Options

CODE39
Special Character
(SPACE)

$

/

+

4
CODABAR

Special Character

[ H-10159
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Special Character

+

CODE128, GS1-128 (UCC / EAN-128)

Special Character
(SPACE) l ' #
$ 7 & '
( ) X +
r — = !
. ’ < =
? al C
\ ] A _
NUL SOH STX
ETX EOT ENQ ACK
BEL BS HT LF
\a) FF CR SO
Sl DLE DC1 DC2
DC3 DC4 NAK SYN
ETB CAN EM SUB
ESC { FS
GS } RS o
us DEL FNC3 FNC2
FNC4 FNC1

EE Related Information

¢ Create and Print Barcodes
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#& Home > Edit a Label > Create a Barcode Label > Edit or Delete a Barcode and Barcode Data
| Edit or Delete a Barcode and Barcode Data

>> Delete a barcode from a label
>> Edit Barcode Data

Delete a barcode from a label

1. Position the cursor to the right of the barcode on the data entry screen.

2. Press .
Edit Barcode Data
PT-D610BT

1. To edit barcode attributes and barcode data, position the cursor to the left of the barcode on the data entry
screen.

2. Press to open the Barcode Setup screen.

3. Press A or Y to display [Barcode], and then press OK.

M Related Information

» Create a Barcode Label

[ H-10159
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& Home > Edit a Label > Use the Time and Date Function
| Use the Time and Date Function

You can add time and date to your label.
+ Set the Time and Date
+ Set the Time and Date Format
» Set the Time Stamp and Add the Time and Date to a Label

* Change or Delete the Time and Date Settings

[ H-10159
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#& Home > Edit a Label > Use the Time and Date Function > Set the Time and Date

| Set the Time and Date

Set the time and date in the Clock setting. After setting the time and date, you can add this information to your
label using the Time and Date function.

1. Press .

2. Press dor» todisplay [Settings], and then press OK.
3. Press A or Ytodisplay [Set Clock], and then press OK.
4. Press A or ¥ to set the year.
5. Press < or » to move to the next field.
6. Press A or ¥ to update the field.
7. Press OK.

NOTE

* You can also use the device's number keys to type the time and date.
* The time and the date are active as soon as you press OK.

» To back up the time and date settings even when your device is not plugged into a power source, install
two AA alkaline batteries (LR6).

u Related Information

¢ Use the Time and Date Function

[ H-10159
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#& Home > Edit a Label > Use the Time and Date Function > Set the Time and Date Format
| Set the Time and Date Format

This Label Maker offers various time and date formats to add to your label. Choose either the analog or digital
style.

1. Press .

2. Press dor» todisplay [Settings], and then press OK.

3. Press AorVYtodisplay [Time & Date Format], and then press OK.
4. Press A or Ytodisplay [Date] or [Time].

5. Press < or » to set the format.

6. Press OK.

m Related Information

¢ Use the Time and Date Function

» Time and Date Format Options

(ULINE JERES
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& Home > Edit a Label > Use the Time and Date Function > Set the Time and Date Format > Time and Date

Format Options

| Time and Date Format Options

Available time and date format options are listed in the table. You can set the time and date from the device's
[Settings] > [Time & Date Format] menu.

Attribute Format Options Attribute Format Options
Date 12/31/2099 Date 2099-12-31
12.31.2099 31/12/2099
12-31-2099 31.12.2099
December 31, 2099 31-12-2099
Dec. 31, 2099 31. December 2099
2099/12/31 31. Dec. 2099
Time 11:59 PM Time 23:59

The default settings are shown in Bold.

NOTE

The values for the date and time are used to display a sample setting. When a format is selected, the time
and date you set in the Clock setting will appear in the selected format option.

u Related Information

» Set the Time and Date Format
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#& Home > Edit a Label > Use the Time and Date Function > Set the Time Stamp and Add the Time and Date
to a Label

| Set the Time Stamp and Add the Time and Date to a Label

Press .

Press < or » to display [Settings], and then press OK.

1.

Eall

Press A or Yto display [Time Stamp Setting], and then press OK.

Press A or ¥ to select one of the following options:

[Timing]

Use the [Time Stamp] to add the date and the time to any label.

a. Press AorVtodisplay [Timing].

b. Press < or» to display [Auto] O

r [Fixed], and then press OK.

Option

Description

Auto

» Position the cursor where you want the time and date to appear.
Press , press A or Y to select Time Stamp, and then press
OK. The current date and time (or a future or past date and time,
if you previously set them using the Forward option) and a clock
icon appear on the LCD.

*  When you press [m only, the latest date and time will print on
the label. The clock icon does not print.

Fixed

» Position the cursor where you want the time and date to appear.

Press , press A or Y to select Time Stamp, and then press

OK. The current date and time appear on the LCD.

, the date and time will print on your label.

*  When you press

ﬁ Check and confirm the time and date settings by positioning the cursor to the left of the clock icon, pressing
, pressing A or Y to select [Time Stamp], and then pressing OK.

PAGE 86 OF 464

[Format]

Select what time and date format you want to use.

a. Press A or Vtoselect [Format].

b. Press < or » to select the format option you want.

Option Description
Date Prints only the date on the label.
D&T Prints the date and time on the label.
Time Prints only the time on the label.
T&D Prints the time and date on the label.
c. Press OK.
[Forward]

Set a future or past date and time.

a. Press A or Vto select [Forward].
b. Press < or» to select [On] and specify the date and time values you want to use, and then press OK.

Option

Description

On

Allows you to increase or decrease the time and date values.

[ H-10159
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Option Description

Off Prints the current time and date.

c. Press «or » to select the year, month, week, date, hour or minute.
d. Press A or ¥ to change the current date and time as needed.

ﬁ You can also set the date and time by entering the numbers using the keyboard.

e. Press OK.

u Related Information

* Use the Time and Date Function
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#& Home > Edit a Label > Use the Time and Date Function > Change or Delete the Time and Date Settings
| Change or Delete the Time and Date Settings

>> Change Time and Date Settings
>> Delete the Time and Date from a Label

Change Time and Date Settings

1. Position the cursor to the left of the clock icon on the text entry screen.

2. Press to open the time stamp setting screen.

3. Update the settings you want and press OK when finished.

Delete the Time and Date from a Label

1. Position the cursor to the right of the clock icon on the text entry screen.

2. Press .

u Related Information

» Use the Time and Date Function

[ H-10159
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& Home > Print Labels

| Print Labels
* Preview Labels
* Print Labels
» Select a Cut Option
* Adjust the Label Length

* Print Transferred Templates

(ULINE JERES
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# Home > Print Labels > Preview Labels
| Preview Labels
You can preview labels before printing to make sure they are correct.

1. Press .

2. Do one of the following:
* Press 4, P, A, or ¥ to scroll the preview left, right, up, or down.

* Press and 4, », A, or V¥ to scroll directly to the left, right, top, or bottom border.

* Press to change the preview magnification.

M Related Information

¢ Print Labels

[ H-10159
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& Home > Print Labels > Print Labels

| Print Labels

NOTE

* Do not pull the label when the Label Maker is ejecting it from the Tape Exit Slot. Doing so will cause the
ink ribbon to be discharged with the tape, making the tape unusable.

* Do not block the Tape Exit Slot during printing. Doing so will cause the tape to jam.

1. After creating your label, press .

2. Press A or ¥ to change the number of copies, and then press

ﬁ * You can also specify the number of copies using the number keys.

+ If you need only one copy of the label, press without selecting the number of copies.

u Related Information

¢ Print Labels

» Sequential Printing
» Mirror Printing

[ H-10159
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# Home > Print Labels > Print Labels > Sequential Printing
| Sequential Printing

Use this function to create labels with sequentially arranged numbers or letters, from a single label format.
1
AA| AB T
1
0123[ 0124 912

1. Press ({}Shiﬂ j) and ( Print ]

Press A or ¥ to display [Number], and then press OK.
Press € or » to select the start point, and then press OK.
Press < or » to select the end point, and then press OK.

Press A or ¥ to select the number of labels you want to print, and then press or OK.

o Moo DN

M Related Information

* Print Labels

[ H-10159
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& Home > Print Labels > Print Labels > Mirror Printing
! Mirror Printing

Use clear tape in [Mirror], so the labels can be read correctly from the opposite side when attached to glass,
windows, or other transparent surfaces.

= T2WNILH

1. Press (Gsmﬂ) and ( Print )

2. Press A or Vtoselect [Mirror], and then press OK.

3. Press or OK.

'u.: Related Information

* Print Labels

[ H-10159
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# Home > Print Labels > Select a Cut Option
| Select a Cut Option

Choose from several built-in options to determine how the Label Maker cuts your labels.

1. Press .
2

Press A or Y to display [Cut Option], and then press OK.

. Press AorVYtoselect [Small Margin], [Large Margin], [Chain], [No Cut], or [Special Tape],
and then press OK.

u Related Information

¢ Print Labels

» Tape Cutting Options

(ULINE JERES
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#& Home > Print Labels > Select a Cut Option > Tape Cutting Options

| Tape Cutting Options

In the Options table, these visual patterns represent parts of your label, as illustrated in the Example column.

Print area
ABC
Margin
% Laminate margin
Setting Description Example
Small Automatically cuts a piece of blank tape before * When the label length is approximately 0.9" (23
Margin printing the first label and then cuts the tape after mm) or more
each label is printed, leaving a 0.08" (2 mm) 2 2 2
margin at both ends of each label. FL FL FL
V// ABC || ABC
7
T
1 2
1. Approximately 0.9" (23 mm)
2. 0.08" (2 mm)
* When the label length is approximately 0.9" (23
mm) or less
2
1
AllA
T 71
1 2 1
1. Approximately 0.9" (23 mm)
2. 0.08" (2 mm)
Large Automatically cuts the tape after each label is 2 2 2 2
Margin printed, leaving a margin of 0.98" (25 mm) on L 1 1 1
each end.
ABC ABC
1 1 1 1
1. Approximately 0.9" (23 mm)
2. 0.08" (2 mm)
Chain » Automatically cuts a piece of blank tape 2 2
before printing the first label and then cuts the 1 1 3
tape after each label is printed, leaving a 7
0.08" (2 mm) margin at both ends of each / ABC ABC
label. %
* When the last label is printed, the tape is T ;
neither fed nor cut. Press and
simultaneously to feed and cut the tape. 1. Approximately 0.9" (23 mm)
2. 0.08" (2 mm)
3. Cut Position
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Setting

Description

Example

No Cut

+ Select this setting when printing multiple
copies of a label or when using Fabric Iron-On
Tapes or other special tapes that cannot be
cut by the Tape Cutter of the Label Maker.

*  When the last label is printed, the tape is not
fed and cut.

- Press and simultaneously to

feed and cut the tape.

- When using the special tapes that cannot
be cut by the Tape Cutter of the Label
Maker, remove the Tape Cassette from the
Label Maker and use scissors to cut the
tape.

2 2
. .

ABC ABC

T T
1 2
1. 0.9" (23 mm)
2. 0.08" (2 mm)

Special
Tape

Select this setting when using special tape.

2 2
L L

2
L

ABC ABC

T T
1 2

1. Approximately 0.9" (23 mm)
2. 0.08" (2 mm)

m Related Information

» Select a Cut Option
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& Home > Print Labels > Adjust the Label Length
| Adjust the Label Length

When the Tape Cassette is almost empty, the printed label length may be less accurate. In this case, adjust the
label length manually.

.ﬁ Approximately 1% of the total label length is adjusted by one level.

1. Press .

Press 4 or » to display [Settings], and then press OK.

Press A or ¥ to display [Adjustment], and then press OK.
Press A or Y to display [Label Length], and then press OK.

ok~ 0N

Press 4 or » to display [-3 - +3], and then press OK.

m Related Information

e Print Labels

(ULINE JERES
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#& Home > Print Labels > Print Transferred Templates
| Print Transferred Templates

You can transfer templates created in P-touch Editor to your Label Maker, customize your text, and then print the
updated labels.

1. Press .

Press 4 or » to display [Transferred Templates], and then press OK.
Press A or ¥ to select the template you want to print, and then press OK.
Press A or Y to display [Print], and then press OK.

o DN

.ﬁ If you have not yet transferred templates from P-touch Editor, [Transferred Templates] will not
appear in the list of options.

For more information, see Related Topics.

u Related Information

* Print Labels

» Edit and Print Transferred Templates
* Print Transferred Templates from the Database
* Delete a Transferred Template

Related Topics:

» Transfer Templates to the Printer (P-touch Transfer Manager) (Windows)
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# Home > Print Labels > Print Transferred Templates > Edit and Print Transferred Templates

| Edit and Print Transferred Templates

1. Press .

Press 4 or » to display [Transferred Templates], and then press OK.
Press A or V¥ to select the template you want to edit, and then press OK.
Press A or Yto display [Edit Label without Saving], and then press OK.

o M DN

Edit the template.

ﬁ You cannot add or delete a line break when editing a transferred template.

6. Press A or ¥ to select the edited template, and then press OK.
7. Press AorYtodisplay [Print], and then press OK.

ﬁ You cannot save your changes to a transferred template.

M Related Information

* Print Transferred Templates
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# Home > Print Labels > Print Transferred Templates > Print Transferred Templates from the Database

| Print Transferred Templates from the Database

1. Press .

Press 4 or » to display [Transferred Templates], and then press OK.
Press A or V¥ to select the template you want to print, and then press OK.
Press A or Yto display [Print from Database], and then press OK.

Press 4, P, A, or V¥ to select the first record in the range you want to print.

o ok~ w N

Press 4, P, A, or V¥ to select the last record in the range you want to print.
The records in the selected range are highlighted on the LCD.
7. Press A orVYtodisplay [Print], and then press OK.

.ﬁ The maximum number of characters that can be printed for one transferred template is 1500 characters.
Line breaks and text blocks reduce the maximum number.

L‘j Related Information

* Print Transferred Templates

* Find a Template in the Database
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#& Home > Print Labels > Print Transferred Templates > Print Transferred Templates from the Database > Find
a Template in the Database

| Find a Template in the Database

1. Press .
2

Press 4 or » to display [Transferred Templates], and then press OK.
Press A or ¥ to select the template you want to print, and then press OK.
The first record of the selected database is displayed.
4. Type the data or name you want to find.
For example, type 'B' to find any character strings containing 'B'. Type 'BR' to find any character strings
containing '‘BR'.
Type as many letters or numbers as needed.

.ﬁ « If a string contains the character you typed, the cursor on the LCD moves to that content and highlights
it. If the content doesn't exist, the cursor remains in its current position.

» If the character you searched for is contained in multiple fields in the database, press and

I| simultaneously to move to the next field containing the character. The character is
highlighted in the field.

* Press to delete the last character in your search data. The cursor moves to the next field
containing the remaining search characters.

lu.; Related Information

 Print Transferred Templates from the Database
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# Home > Print Labels > Print Transferred Templates > Delete a Transferred Template
| Delete a Transferred Template

When you delete a transferred template, it is deleted only from your Label Maker.

1. Press .

Press 4 or » to display [Transferred Templates], and then press OK.
Press A or ¥ to select the template you want to delete, and then press OK.

o DN

Press A or ¥ to display [Delete], and then press OK.
The [Delete?] message appears.
5. Press OK.

u Related Information

* Print Transferred Templates
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& Home > Use the File Memory

| Use the File Memory
» Save Label Files

» Print, Open, Delete, or Mark a Saved Label
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# Home > Use the File Memory > Save Label Files

| Save Label Files

You can save up to 99 labels and recall them for printing at a later date. A maximum of 280 characters can be
saved per file. You can also edit and overwrite saved labels.

1. Enter the text and format your label.

Press .

2
3. Press A or Ytodisplay [Save], and then press OK.
4. Press A or ¥V to select a file, and then press OK.

m Related Information

* Use the File Memory
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#& Home > Use the File Memory > Print, Open, Delete, or Mark a Saved Label
! Print, Open, Delete, or Mark a Saved Label

1. Press .

Press 4 or » to display [File], and then press OK.
Press A or ¥ to select a file, and then press OK.

HwN

Do one of the following:

Option Description
Print a. Press A or ¥V to display Print, and then press OK.

b. Press A or ¥ to change the number of copies, and then press

Open Press A or V¥ to display Open, and then press OK.

Delete a. Press A or V¥ to display Delete, and then press OK.
Press OK.
The Delete? message appears.
c. Press OK.
To delete a saved label from the file selection screen, select the label using A or ¥, and then

press .

Marking Saved files can be organized into eight different color-coded categories. The color choices
appear on the left side of the file name in the file selection screen.

a. Press A or ¥ to display Marking, and then press OK.
b. Press A or V¥ to select a color, and then press OK.

Lj Related Information

* Use the File Memory
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#& Home > Create and Print Labels Using Your Computer

| Create and Print Labels Using Your Computer
* Create Labels Using P-touch Editor (Windows)
* Create Labels and Print Using P-touch Editor (Mac)

* Print Labels Using the Printer Driver (Windows)
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# Home > Create and Print Labels Using Your Computer > Create Labels Using P-touch Editor (Windows)

| Create Labels Using P-touch Editor (Windows)

The transfer function can only be used with P-touch Editor 5.4.

To use your Label Maker with your Windows computer, install P-touch Editor and the printer driver on your
computer.

For the latest drivers and software, go to your model's Downloads page on the Brother support website at
support.brother.com.

1. Start P-touch Editor @.
*  Windows 11:
Click Start > Brother P-touch > P-touch Editor, or double-click the P-touch Editor icon on the desktop.
*Depending on your computer's operating system, the Brother P-touch folder may or may not be created.
*  Windows 10:
Click Start > Brother P-touch > P-touch Editor, or double-click the P-touch Editor icon on the desktop.
*  Windows 8.1:

Click the P-touch Editor icon on the Apps screen, or double-click the P-touch Editor icon on the
desktop.

2. Do one of the following:
» P-touch Editor 5.4
- To open an existing layout, click Open (1).
- To connect a preset layout to a database, select the checkbox next to Connect Database (2).

- To create a new layout, double-click the New Layout pane (3), or click the New Layout pane (3) and
then click —.

- To create a new layout using a preset layout, double-click a category button (4), or select a category
button (4), and then click —.

@ P-touch Editor - [Layout1] = =] X

£

3@1&3@!

* P-touch Editor 6.0
- To open an existing layout, click Open (4).
- To create a new layout, click the New Label tab and the New Label button (1).

- To create a new layout using a preset layout, click the New Label tab and click a category button (2),
select a template, and then click Create (3).
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Related Information

» Create and Print Labels Using Your Computer
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#& Home > Create and Print Labels Using Your Computer > Create Labels and Print Using P-touch Editor

(Mac)
| Create Labels and Print Using P-touch Editor (Mac)

Download and install P-touch Editor from the App Store on your Mac.

To use your Label Maker with your Mac computer, install P-touch Editor.

1. Double-click Macintosh HD > Applications, and then double-click the Brother P-touch Editor icon.

2. When P-touch Editor starts, click New to select a template, create a new layout, or open an existing layout.

[ ] [ ] Select a Template

Asset management

Greeting Identification Kitchen Media

Sign Store Thermal Paper(AV)

3. Select the print settings.
4. Click the Print icon.

Related Information

Cable&Panel

» Create and Print Labels Using Your Computer
* Main Window of P-touch Editor (Mac)
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# Home > Create and Print Labels Using Your Computer > Create Labels and Print Using P-touch Editor
(Mac) > Main Window of P-touch Editor (Mac)

! Main Window of P-touch Editor (Mac)

@@ Untied l'ﬁ~ - 100%  + [} T O @ © B ® = m &
1 Edited \vw, Zoom Print TextBox Frame Image Symbol ClipArt Shape Table BarCode Database
Tred = 5
o o 2 @ o o 100 120 140 160 180 w0 20
None Selected
Printer (
)
Print Media
T 12mm e
2 — Check Media = No Object Selected
Length
Set Length
Margin 2mm
Direction
© Landscape 2 -
Buy labels [ Drag & drop database file here ]

Object Inspector
Database Connection Area
Label Inspector

o~ 0 DN~

Layout Window

u Related Information

» Create Labels and Print Using P-touch Editor (Mac)
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# Home > Create and Print Labels Using Your Computer > Print Labels Using the Printer Driver (Windows)

| Print Labels Using the Printer Driver (Windows)

Make sure you have installed the printer driver.

For the latest drivers and software, go to your model's Downloads page on the Brother support website at
support.brother.com.

Connect the Label Maker to a computer.
Open the document you want to print.
Select the print command in your application.

o nN =

Select your Label Maker, and then click the printer's properties or preferences button.
The printer driver window appears.

o

Change the printer driver settings, if needed.
6. Click OK.
7. Complete your print operation.

u Related Information

» Create and Print Labels Using Your Computer

Related Topics:

* Connect the Label Maker to a Computer Using a USB Cable
» Enable or Disable Bluetooth

« Install the Printer Driver and Software on a Computer (Windows)
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& Home > Print Labels Using Mobile Devices

| Print Labels Using Mobile Devices
* Install the Brother iPrint&Label App

» Create Labels and Print Using Mobile Devices
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# Home > Print Labels Using Mobile Devices > Install the Brother iPrint&Label App
| Install the Brother iPrint&Label App

Use Brother's iPrint&Label app to print directly from your iPhone, iPad, iPod touch, and Android™ mobile
devices.

App Features

Brother iPrint&Label Create labels for business use, including barcodes, office equipment labels, and
labels for folder tabs.

For more information about the mobile apps available for your printer, visit https://support.brother.com/g/d/f5f9.

M Related Information

* Print Labels Using Mobile Devices
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#& Home > Print Labels Using Mobile Devices > Create Labels and Print Using Mobile Devices

| Create Labels and Print Using Mobile Devices

1. Start the label printing app on your mobile device.
2. Select a label template or design.

ﬁ You can also select a previously designed label or image and print it.

3. Select the print menu in the label printing app.

u Related Information

* Print Labels Using Mobile Devices
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#& Home > Transfer Templates to the Printer (P-touch Transfer Manager) (Windows)

| Transfer Templates to the Printer (P-touch Transfer Manager) (Windows)
» Transfer Templates to the Printer Using P-touch Transfer Manager (Windows)

» Distribute Templates to be Transferred to Users Without Using P-touch Transfer Manager
(Windows)
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# Home > Transfer Templates to the Printer (P-touch Transfer Manager) (Windows) > Transfer Templates to
the Printer Using P-touch Transfer Manager (Windows)

Transfer Templates to the Printer Using P-touch Transfer Manager
(Windows)

* Notes on Using P-touch Transfer Manager (Windows)

» About Transferring Templates from the Computer to the Printer (Windows)
* Back up Templates or Other Data Saved in the Printer (Windows)

* Delete Printer Data (Windows)

* Create Transfer Files and Transfer Package Files (Windows)
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#& Home > Transfer Templates to the Printer (P-touch Transfer Manager) (Windows) > Transfer Templates to
the Printer Using P-touch Transfer Manager (Windows) > Notes on Using P-touch Transfer Manager
(Windows)

| Notes on Using P-touch Transfer Manager (Windows)

Some P-touch Editor functions are not available with the printer, so keep the following points in mind when using
P-touch Editor to create templates.

You can preview created templates before they are transferred to the printer.

Creating Templates

+ Some of the text in the templates transferred to the printer may be printed using similar fonts and character
sizes loaded in the printer. As a result, the printed label may differ from the image of the template created in
P-touch Editor.

+ Depending on the text object setting, the character size may be automatically reduced or some of the text
may not be printed. If this occurs, change the Text Object setting.

« Although character styles can be applied to individual characters in P-touch Editor, styles can be applied to a
block of text only from the printer. In addition, some character styles are not available on the printer.

« Backgrounds specified in P-touch Editor are not compatible with the printer.

+ The P-touch Editor layout using the split printing function (enlarging the label and printing it on two or more
labels) cannot be transferred.

* Only the portion of the label within the printable area is printed.

Transferring Templates

» The printed label may differ from the image appearing in the preview area of P-touch Transfer Manager.

« If a two-dimensional barcode other than a QR code not loaded on the printer is transferred to the printer, the
barcode is converted into an image. The image of the converted barcode cannot be edited.

« All transferred objects that cannot be edited by the printer are converted into images.
» Grouped objects are converted into a single bitmap.
+ If objects overlap, only the bottom object is printed.

Transferring Data Other Than Templates

If the number or order of fields in a database is changed and only the database (CSV file) is transferred to
update it, the database may not link correctly with the template. In addition, the first line of data in the transferred
file must be recognized by the printer as "field names."

w Related Information

» Transfer Templates to the Printer Using P-touch Transfer Manager (Windows)
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#& Home > Transfer Templates to the Printer (P-touch Transfer Manager) (Windows) > Transfer Templates to

the Printer Using P-touch Transfer Manager (Windows) > About Transferring Templates from the Computer to
the Printer (Windows)

About Transferring Templates from the Computer to the Printer
(Windows)

You can transfer templates and other data to the printer and save backups of your data on the computer.

To use P-touch Transfer Manager, you must first transfer templates created in P-touch Editor to P-touch Transfer
Manager.

u Related Information

» Transfer Templates to the Printer Using P-touch Transfer Manager (Windows)
» Transfer a Template to P-touch Transfer Manager (Windows)
* Main Window of P-touch Transfer Manager (Windows)

» Transfer Templates or Other Data from the Computer to the Printer (Windows)
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#& Home > Transfer Templates to the Printer (P-touch Transfer Manager) (Windows) > Transfer Templates to
the Printer Using P-touch Transfer Manager (Windows) > About Transferring Templates from the Computer to
the Printer (Windows) > Transfer a Template to P-touch Transfer Manager (Windows)

| Transfer a Template to P-touch Transfer Manager (Windows)

1. Start P-touch Editor @.
*  Windows 11:

Click Start > Brother P-touch > P-touch Editor, or double-click the P-touch Editor icon on the desktop.

*Depending on your computer's operating system, the Brother P-touch folder may or may not be created.
*  Windows 10:

Click Start > Brother P-touch > P-touch Editor, or double-click the P-touch Editor icon on the desktop.
*+  Windows 8.1:

Click the P-touch Editor icon on the Apps screen, or double-click the P-touch Editor icon on the
desktop.

Open the template you want or create a layout.
3. Click File > Transfer Template > Transfer.

The P-touch Transfer Manager window appears. The template is transferred to the Configurations folder.

PC (Brother X{-30000 MConfigurations - P-touch Transfer Manager — O >
g 9
File Edit View Tool Help

— e g ] I Printer:
Search Display Style

All Printers e

=] P-touch Library
5 [E5 All Contents
? Filter

[ Recycle Bin

..}, Search Results

Transfer Name Size Type Date Key Assign MName
@:name 1KB  Layout 24/10/2018 11:22:3... - name.lbx

:_i Transfer Manager
18] PC (Brother XXX )
%5 Configurations
Y] Backups
i PC (Brother XX-XXXX)
I #2) Brother Xx-xxxx

<

No contents are selected. s

For Help, press F1 NUM

m Related Information

» About Transferring Templates from the Computer to the Printer (Windows)
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#& Home > Transfer Templates to the Printer (P-touch Transfer Manager) (Windows) > Transfer Templates to
the Printer Using P-touch Transfer Manager (Windows) > About Transferring Templates from the Computer to
the Printer (Windows) > Main Window of P-touch Transfer Manager (Windows)

| Main Window of P-touch Transfer Manager (Windows)

All Contents - P-touch Transfer Manager - O X
1 —\Ele Edit View ool Help
= ) = Printer
— = =] B @ El - |
6 ( - s All Printers v 2
Search Display Sty

72 P-touch Library Y | Hame Size Date Location

PRE] Al Contents ( ~N
w7 Filter

(@ Recycle Bin

1.3@ Search Results
[3 Transfer Manager
=] PC (Brother XX-X000 )

;=% Configurations 3
: (231 New Folder
%) Backups
=8 PC (Brother XX-3000K)
%1 Configurations
5 — %7 Backups = <
Ko contents are selected. )

For Help, press F1 CAP_NUM

1. Menu Bar

Provides access to various commands grouped under each menu title (the File, Edit, View, Tool, and Help
menus) according to their functions.

2. Printer Selector

Allows you to select a printer to transfer the data to. When you select a printer, only the data that can be sent
to the selected printer appears in the data list.

3. Template List

Displays a list of templates in the selected folder.
4. Preview

Displays a preview of the templates in the templates list.
5. Folder List

Displays a list of folders and printers. When you select a folder, the templates in the selected folder appear in
the template list. If you select a printer, the current templates and other data stored in the printer appear.

6. Toolbar
Provides access to frequently used commands.

Toolbar Icons

Icon Button name Function
+-) Transfer Click to transfer templates and other data from the computer to
. the printer.
Save Transfer File Click to change the file type of the data to be transferred to
(When not connected to a other applications.
printer) The available interfaces may differ depending on your model.
"SJ_J Backup Click to retrieve the templates and other data saved in the
printer and saves it on the computer.
==t Open Click to open the selected template.
L
Search Click to search for templates or other data registered to P-
%

touch Library.
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Icon

Button name

Function

Display Style

Click to change the file display style.

. Related Information

» About Transferring Templates from the Computer to the Printer (Windows)
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#& Home > Transfer Templates to the Printer (P-touch Transfer Manager) (Windows) > Transfer Templates to
the Printer Using P-touch Transfer Manager (Windows) > About Transferring Templates from the Computer to
the Printer (Windows) > Transfer Templates or Other Data from the Computer to the Printer (Windows)

Transfer Templates or Other Data from the Computer to the Printer
(Windows)

ﬁ To transfer templates from a mobile device to the printer, see Related Information.

1. Connect the printer to the computer using a USB cable, and then turn on the printer.
The printer model name appears next to a printer icon in the folder view.
If you select the printer in the folder view, the current templates and other data stored in the printer appear.

ﬁ If a printer is disconnected or offline, it does not appear in the folder view.

2. Select the printer you want to transfer the template or other data to.

PC (Brother 343X TwConfigurations - P-touch Transfer Manager — O *
9 9
Hle Edit View Tool Help

et g = Printer:

All Printers ~

All Printers

Search Display Style

=] P-touch Library Transfer Name TRl rother JOCXOOC Key Assign Name
(B3 All Contents MBrother HR-KIKK
s @ name 1KB Lay® T 2018 11:22:32 AM - name.lbx
+--- :'ter o @ CD KB Layout 24/10/2018 3:13:35 PM - CDMlbx
-5 Se:y(;eR in d @ address 1KB  Layout 24/10/2018 3:13:15 PM - address.Ibx
“€), Search Results
;_,i Transfer Manager
-8 PC (Brother Xx-xxxx )
: “j Configurations
| Backups
(BrotherXX-X000 )
—F21 Brother 36000
% >

No contents are selected.

For Help, press F1 MUK
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3. Right-click the Configurations folder, select New, and then create a new folder.

& PC (Brother XX-XXXX  J\Configurations - P-touch Transfer Manager - O ®
File Edit View Tool Help
: o g » = Printer:
- P.ﬂ A\ e s rinter:
All Printers ~
Search Display Style
= P-touch Library Transfer Name Size Type Date Key Assign MName
-5 All Contents @ name KB Layout 24/10/2018 11:22:32 AM namelbx
- :"te'l - l@co KB Layout 24/10/2018 31335 PM CDJbx
= @ address KB Layout 24/10/2018 3:15:15 PM address.lbx
-, Search Results
L_fi Transfer Manager
(=-m PC (Brother }x-Xx0 b
4 Contuationd
%)) Backups Mew
PC (Brother XX Mew Message...
i...f2l Brother XX-XXXX
Properties...
< >
No contents are selected. N
v
Creates a new folder MUM

4. Do one of the following:

Drag the template or other data you want to transfer and place it in the new folder.
To transfer multiple templates or other data, drag the files you want to transfer, and then place them in the

new folder. Each file is assigned a Key Assign number (memory location in the printer) when it is placed
in the new folder.

& PC (Brother XX-000¢ \Cenfigurations\New Folder - P-touch Transfer Manager - m] X
File Edit View Tool Help
1 = 1;' _."_i, = - Printer:
=) o D J All Printers v
Search Display Style
FE] P-touch Library Transfer Name size Type Date Key Assign Name
“A”[“"tE”tS @ name KB Layout 24/10/2018 11:22:32 AM 1 namelbx
s :‘te'l - @co KB Layout 24/10/2018 3:12:35 PM 2 CDbx
Ak vkl @ address KB Layout 24/10/2018 3:15:15 PM 3 addresslbx
-&), Search Results
|3 Transfer Manager
=8| PC (Brother XXX 3
%2 Configurations
'] Backups
1[5 PC (Brother XX-000K)
F7) Brother 3-xxd
< >
Mo contents are selected. =
o
For Help, press F1 NUM
Data type Maximum number of Restriction details
transferable items
Template 20 » Each template can contain a maximum of 20 objects.
+ Each object can contain a maximum of seven lines.
Database 20 + Only CSV files can be transferred.
» Each CSV file can contain a maximum of 255 fields
and 65000 records.
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ﬁ * You can confirm the available space in the transfer file memory by printing the configuration report.
* You can view the templates and other data by selecting:
- The folder in the Configurations folder
- All Contents
- One of the categories under Filter, such as Layouts

5. To change the Key Assign number assigned to an item, right-click the item, select the Key Assign menu, and
then select the Key Assign number you want.

@ OC (Brother
File Edit View Tool Help
_8 _D_I I E}\? O% o Printer:
Sai ; All Printers ~
Transfer ckup Open Search Display Style
FE] P-touch Library Transfer Name Size Type Date Key Assign Name
i"l' Contents [@ name KB Layout 24/10/2018 11:22:32 AM 1 name.lbx
R‘ e : D KB Layout 24/10/2018 3:13:35 PM 2 CD.Ibx
ecycle Bin = 7
}@, Search Results ﬂaddress 1KB  Layout 24/10/2018 3:1 Key Assign x address.lbx
Q Transfer Manager
-8 PC [Brother }XxX-20000 } 2 e
] 'E Configurations ~
w21 New Folder 3 El
Eﬂ Backups g
.M PC (Brotherxx-»0x ) [
----- 721 Brother X300 ;
L
< 0 >
11
12 2
13
14
15
16
17
13
19
20 W
21
For Help, press F1 27 NUM

ﬁ + Except for the data in databases, all data transferred to the printer is assigned a key number.

+ If the template or other data transferred to the printer has the same key number as another template
already saved in the printer, the new template overwrites the old one. You can confirm the assigned
template numbers saved in the printer by backing up the templates or other data.

+ If the printer memory is full, remove one or more templates from the printer's memory.

6. To change the template names or other data you want to transfer, click the item you want, and then type the
new name.

The number of characters used for the template names may be limited depending on the printer model.

(ULINE JER[E
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Select the folder containing the templates or other data you want to transfer, and then click Transfer.

@ PC (Brother 30¢-)000K J\Configurations\New Folder - P-touch Transfer Manager — [m| X
File Edit View Tool Help
w = @ F O
s ] . All Printers b
Transfer Open Search Display Style
[ P-touch Library Transfer Name Size Type Date Key Assign Name
""" ':_'I' Contents @ name KB Layout 24/10/2018 11:22:32 AM 1 namelbx
e R' te'l B [@co KB Layout 06/11/2018 9:50:25 AM 2 CD.Jbx
S =4 @ address KB Layout 24/10/2018 3:15:15 PM 3 address.bx
..... ) Search Results
Q Transfer Manager
S| PC (Brother {3000 1
Configurations
Mew Folder:
‘) Backups
I PC (Brotherxx-000 )
..... £2) Brother 30¢-300xX
< >
~
v
For Help, press F1 NUM

A confirmation message appears.

ﬁ * You can also transfer individual items to the printer without adding them to a folder. Select the template

or other data you want to transfer, and then click Transfer.

+ Multiple items and folders can be selected and transferred in one operation.

8. Click OK.

The selected items are transferred to the printer.

u Related Information

» About Transferring Templates from the Computer to the Printer (Windows)
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#& Home > Transfer Templates to the Printer (P-touch Transfer Manager) (Windows) > Transfer Templates to
the Printer Using P-touch Transfer Manager (Windows) > Back up Templates or Other Data Saved in the

Printer (Windows)

| Back up Templates or Other Data Saved in the Printer (Windows)

ﬁ « Backed up templates or other data cannot be edited on the computer.

» Depending on the printer model, backed up templates or data may not be transferable between different

models.

1. Connect your computer to the Label Maker and turn on the Label Maker.

The printer model name appears next to a printer icon in the folder view. If you select the printer in the folder

view, the current templates and other data stored in the printer appear.

2. Select the printer to back up from, and then click Backup.

For Help, press F1

& Brother XX-X000 - P-touch Transfer Manager - [m] *
Fle Edit View Tool Help
Vo] *g[_] % \) = Printer:
All Printers V2
Backup Search Display Style
[ P-touch Library Transfer Name Size Type Date Key Assign Connected Database Na
""" @E Al fonient: name KB Template 10/24/18 15:34 1
*"' :"te' . Bico 1KB Template 10/24/18 15:34 2
----- ecycle bin = ;
_____ @, Search Results address 1KBE Template 10/24/1813:34 3
__; Transfer Manager
—__-,J PC (Brother XX-X00( )
%) Configurations
-[273 Mew Folder
[ Backups
] PC (Brotherxx-3000 )
----- Se3) Brother XxX-XX00K
< >
Multiple contents are selected. it
v
NUM

A confirmation message appears.

3. Click OK.

A new folder is created under the printer in the folder view. The folder name is based on the date and time of
the backup. All of the printer's templates and other data are transferred to the new folder and saved on the

computer.

u Related Information

» Transfer Templates to the Printer Using P-touch Transfer Manager (Windows)
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#& Home > Transfer Templates to the Printer (P-touch Transfer Manager) (Windows) > Transfer Templates to

the Printer Using P-touch Transfer Manager (Windows) > Delete Printer Data (Windows)
| Delete Printer Data (Windows)

To delete all templates and other data saved on the printer, do the following:
1. Connect the computer to the Label Maker and turn on the Label Maker.

The printer model name appears next to a printer icon in the folder view.
2. Right-click the printer, and then select the Delete All menu.

@ Brother 0030000 - P-touch Transfer Manager
File Edit View Tool Help

..... -\, Search Results
g Transfer Manager
- B PC (Brother X}-2000¢ }
=451 Configurations
. 1.[23 New Folder
%y Backups
C (Brother }x-XXKX)
Brother 040000

..... &l
Delete All

Printer Settings... |

= — et () =l Printer:
K T 7 & i
v - & O -
= — h All Printers %
Backup Search Display Style
[E] P-touch Library Transfer Name Size Type Date Key Assign Connected Database Ma
..... ,:III Contents name KB Template 10/24/18 15:34 1
- R. ter e D 1KB Template 10/24/18 15:34 2
R Bl sddress 1KE Template 10/24/18 15:24 3

ntents are selected.

Properties...

NUM

A confirmation message appears.

P-touch Transfer Manager >

| All data will be deleted from the printer,
OK to continue?

Cancel

3. Click OK.
All templates and other data saved on the printer are deleted.

u Related Information

+ Transfer Templates to the Printer Using P-touch Transfer Manager (Windows)
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#& Home > Transfer Templates to the Printer (P-touch Transfer Manager) (Windows) > Transfer Templates to
the Printer Using P-touch Transfer Manager (Windows) > Create Transfer Files and Transfer Package Files
(Windows)

| Create Transfer Files and Transfer Package Files (Windows)

Computer 1

P-touch Editor

Create template

Transfer template

P-touch Transfer Manager P-touch Transfer
Express

Create template package file E:'|>

xxx.blf XXX.pdz

xxx.pdz ]
Mass storage Email attachment
(BLF) P-touch Transfer

Express (PDZ)
N\
Printer Computer 2

P-touch Transfer
Express

¢ ]
P-touch Transfer (
Express (PDZ)

Template Transfer Method File Format

From a computer P-touch Transfer Express PDZ

1. Create the template using P-touch Editor, and then transfer it to P-touch Transfer Manager.

ﬁ » For more information, see Related Information.

* When transferring a new template, make sure you specify a Key Assign number (in P-touch Transfer
Manager) that is not currently used. If the specified Key Assign number is already being used, the
existing template will be overwritten with the new one.

2. Without connecting the Label Maker to the computer, select the Configurations folder in the P-touch
Transfer Manager window, and then select the template to save.

.ﬁ You can select multiple templates at the same time.

3. Click File > Save Transfer File.

NOTE

The Save Transfer File button appears when the Label Maker is disconnected from the computer or
offline.

[ H-10159
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ﬁ + If you click the Save Transfer File button after selecting Configurations, all templates in the folder are
saved as the Transfer file (BLF) or Transfer Package file (PDZ).

* You can combine multiple templates into a single Transfer file (BLF) or Transfer Package file (PDZ).

4. Inthe Save as type field, select the template format you want, and then type in the name and save the
template.

u Related Information

» Transfer Templates to the Printer Using P-touch Transfer Manager (Windows)
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#& Home > Transfer Templates to the Printer (P-touch Transfer Manager) (Windows) > Distribute Templates to
be Transferred to Users Without Using P-touch Transfer Manager (Windows)

Distribute Templates to be Transferred to Users Without Using P-touch
Transfer Manager (Windows)

Transfer templates to the printer using P-touch Transfer Express.

To download the latest version of P-touch Transfer Express, go to your model's Downloads page on the Brother
support website at support.brother.com.

.ﬁ *  When transferring a new template, make sure you specify a Key Assign number (in P-touch Transfer
Manager) that is not currently used. If the specified Key Assign number is already being used, the
existing template will be overwritten with the new one.

« This function requires a USB connection.

Administrator

Brother support website =
1. support.brother.com e
P-touch P-touch P-touch
Editor Transfer Manager Transfer Express
™ 2 [ 1
D V; D => D D‘Hudu PtT%x’ime PtTE:\m |;J> f—J
) A
xxx.lbx xxx.lbx  xxx.pdz TRDJM %dﬂ Dp;
l I | l
I 2 . I I 3 . I I 4 .

>> Administrator Tasks
>> User Tasks

Administrator Tasks

>> Preparing P-touch Transfer Express

>> Transfer a Template to P-touch Transfer Manager

>> Save the Template as a Transfer Package File (PDZ)

>> Distribute the Transfer Package File (PDZ) and P-touch Transfer Express to Others

Preparing P-touch Transfer Express

The printer driver must be installed before using P-touch Transfer Express.

.ﬁ P-touch Transfer Express is available only in English.

1. Download P-touch Transfer Express to any location on the computer.
2. Decompress the downloaded file (ZIP).

Transfer a Template to P-touch Transfer Manager

ﬁ To use the template transfer function, use P-touch Editor 5.4. P-touch Editor 6.0 will be updated in the
future.

1. Start P-touch Editor @.
*  Windows 11:
Click Start > Brother P-touch > P-touch Editor, or double-click the P-touch Editor icon on the desktop.

[ H-10159
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*Depending on your computer's operating system, the Brother P-touch folder may or may not be created.
*  Windows 10:

Click Start > Brother P-touch > P-touch Editor, or double-click the P-touch Editor icon on the desktop.
*+  Windows 8.1:

Click the P-touch Editor icon on the Apps screen, or double-click the P-touch Editor icon on the
desktop.

2. Open the template you want.
3. Click File > Transfer Template > Transfer.

@ P-touch Editor - [Layout3] - =) x
@ File| Edit View Inset Format Tools Layout Window Help - ax
% New... Ctrl+N " ﬁ —a8
E |

- Open... Ctrlv0 ‘

Close Ctldew A
P Save Ctrl+5 B Buylabels
Al Save As... e -:‘
o
Save to Web...
i Export...
M T
Database
Printer/Page Setup...
— Print Preview
= Print.. CrlP
Layout Properties... Ctrl+L
= Exit
B =
= @ Horizontal =
O vertical =
1 Purpose =
Normal Format MlE
=
=
S; v
> E 1
% Snap Express Professional © 10% v @

The template is transferred to P-touch Transfer Manager. P-touch Transfer Manager starts.

Save the Template as a Transfer Package File (PDZ)

To create a file in a format that can be used by P-touch Transfer Express, save the template as a Transfer
Package file (PDZ).

1. Select the Configurations folder in the P-touch Transfer Manager window.
2. Select the templates you want to distribute.
3. Click File > Save Transfer File.

ﬁ + The Save Transfer File option appears only if the printer is disconnected from the computer or offline.

« If you click the Save Transfer File option after selecting the Configurations folder or a created folder,
all templates in the folder are saved as the Transfer Package file (PDZ).

* You can combine multiple templates into a single Transfer Package file (PDZ).

(ULINE JER[E
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4. Type the name, and then click Save.

& Save As >

i «~ 4 s ThisPC » Desktop » w | () Search Desktop 2
Organise » Mew folder =5 e
B Thic PC A Mame Date modified Type £

= Local Disk (C:)
PerfLogs
Program Files

Program Files (x86)

temp
Users
Windows
ﬂ' Metwork o
N | >
File name: | Layout] i
Save as type: | Transfer Package File (*.pdz) w

» Hide Folders Cancel

The template is saved as a Transfer Package file (PDZ).

Distribute the Transfer Package File (PDZ) and P-touch Transfer Express to Others

ﬁ If you already downloaded P-touch Transfer Express, it is not necessary for the administrator to send the
Transfer Express folder. In this case, you can simply move the distributed Transfer Package file to the
downloaded folder, and then double-click the PtTrExp.exe file.

1. Move the Transfer Package file (PDZ) to the downloads folder.

I + | Tranfer Express - [} x
Home Share View o

2> v 4 » Tranfer Express v O Search Tra... @

ptfilot.dll PtTrExp REadMaEn ReadMelpn TRDRV.dll un2|p3?_ dil Layouﬂ pd

Titems  1item selected 970 bytes

Layoutl.pdz

2. Distribute all the files in the downloads folder to others.
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User Tasks

Transfer the Transfer Package File (PDZ) to Your Printer

.ﬁ Do not turn off the power when transferring templates.

Turn on the Label Maker.
Connect the printer to the computer using a USB cable.
Double-click the PtTrExp.exe file received from the administrator.

Ao bd-~

Do one of the following:

« To transfer a single Transfer Package file (PDZ) within the folder containing the PtTrExp.exe file, click
Transfer.

« To transfer multiple Transfer Package files (PDZ) within the folder containing the PtTrExp.exe file, do the
following:

a. Click Browse.

@ P-touch Transfer Express *

= Select the Transfer Package file to be transferred to the printer.
Then, click the Transfer button to begin transferring.

Transfer Package File:

| | Browse...

%3] Transfer Exit

b. Select the Transfer Package file you want to transfer, and then click Open.
c. Click Transfer.
d. Click Yes.

5. When completed, click OK.

u Related Information

» Transfer Templates to the Printer (P-touch Transfer Manager) (Windows)
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#& Home > Store and Manage Templates (P-touch Library)

| Store and Manage Templates (P-touch Library)
» Edit Templates Using P-touch Library (Windows)
* Print Templates Using P-touch Library (Windows)

» Search Templates Using P-touch Library (Windows)
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Start the P-touch Library.
*  Windows 11:

| Edit Templates Using P-touch Library (Windows)

Click Start > Brother P-touch > P-touch Library.
*Depending on your computer's operating system, the Brother P-touch folder may or may not be created.

«  Windows 10:

Click Start > Brother P-touch > P-touch Library.

«  Windows 8.1:

Click the P-touch Library icon on the Apps screen.

The main window appears.

# Home > Store and Manage Templates (P-touch Library) > Edit Templates Using P-touch Library (Windows)

@ All Contents - P-touch Library
File Edit View Tool Help

7 B QA

For Help, press F1

Open Print Search Display Style
[ P-touch Library MName Size Date Location
""" ﬂABC.Ib}( KB 31/10/2018 3:20:42  ChUsers\WM138_WIN10\AppData\Roaming\Brother\P-touch Librany\Librany\ABC.Ibx
""" o Sec—"'cheR " . @) Brother.lbx KB 31/10/2018 33305 CAUsers\VM138_WIN10\AppData\Roaming\Brother\P-touch Library\Library\Brother.Ibx
""" S @ P-touch.lbx KB 31/10/20183:33:20  Ci\Users\VM133_WIN10\AppData\Roaming\Brother\P-touch Library\Library\P-touch.lb:

NUM

Overview of the Toolbar Icons

Icon Button name Function
E_i} Open Click to open the selected template.
EZJ Print Click to print the selected template.
) Search Click to search for templates registered to P-touch Library.
%
j Display Style Click to change the file display style.

Select the template you want to edit, and then click Open.

You can now edit the template.

u Related Information

» Store and Manage Templates (P-touch Library)
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# Home > Store and Manage Templates (P-touch Library) > Print Templates Using P-touch Library (Windows)
| Print Templates Using P-touch Library (Windows)

1. Start the P-touch Library.
*  Windows 11:
Click Start > Brother P-touch > P-touch Library.
*Depending on your computer's operating system, the Brother P-touch folder may or may not be created.
*  Windows 10:
Click Start > Brother P-touch > P-touch Library.
*+  Windows 8.1:
Click the P-touch Library icon on the Apps screen.
The main window appears.

&8 All Contents - P-touch Library — O X
File Edit View Tool Help
ER () =
S d [ 2 =
Open Print Search Display Style
[ P-touch Library MName Size Date Location
""" ﬂABC.Ib}( KB 31/10/2018 3:20:42  ChUsers\WM138_WIN10\AppData\Roaming\Brother\P-touch Librany\Librany\ABC.Ibx
""" o Sec—"'cheR " . @) Brother.lbx KB 31/10/2018 33305 CAUsers\VM138_WIN10\AppData\Roaming\Brother\P-touch Library\Library\Brother.Ibx
""" S @ P-touch.lbx KB 31/10/20183:33:20  Ci\Users\VM133_WIN10\AppData\Roaming\Brother\P-touch Library\Library\P-touch.lb:
< >
For Help, press F1 NUM

2. Select the template you want to print, and then click Print.
The connected Label Maker prints the template.

u Related Information

» Store and Manage Templates (P-touch Library)
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#& Home > Store and Manage Templates (P-touch Library) > Search Templates Using P-touch Library
(Windows)

| Search Templates Using P-touch Library (Windows)

1.

& All Contents - P-touch Library - m] *
File Edit View Tool Help
= Fe
(o 7 A
Open Print Search Display Style
:] P-touch Library Mame Size Date Location
@ABC‘be 1KB  31/10/2018 3:20:42  C\Users\VM138_WIN10\AppData\Roaming\Brother\P-touch Library\Libran A ABC.Ibx
® :“"‘:R 2 . @) Brother.Ibx TKE 31/10/2018 33305 C:AUsers\WM138 WIN10\AppData\Roaming\Brother\P-touch Library\Library\Brother.lbx
Sl T @) P-touch.lbx KB 31/10/20183:3329  C:\Users\WM138_WIN10\AppData\Roaming\Brother\P-touch Library\Library\P-touch.lb
< >
For Help, press Fi NUM
2. Click Search.
The Search dialog box appears.
a8
File Edit View Tool Help
-4
5 2 Q
Open Print Search Display Style
:I P-touch Library MName Size Date Location
& ':” C"‘”t;f“s [@ ABC.Ibx KB 31/10/2018 3:20:42  C\Users\WM138_WIN10WAppDatatRoaming\Brother\P-touch Libran/\Library\ABC.lbx
sEthER i ! @ Brother.lbx KB 31/10/20183:3205  CA\Users\WM138_WIN10\AppData\Roaming\Brother\P-touch Library\Library\Brother.lbx
FEAR T, @ P-touch.lbx KB 31/10/20123:33:29  C:AUsers\VM133 WIN10\AppData\Roaming\Brothen\P-touch Library\Librar\P-touch.Ibs
Search X
Multiple Parameters @ anD Cor
[ IName [ CONTAINS v
[Type Layout (bx;lbl;lbp;mbi) ~  CONTAINS ~
[ size From lU = B
< e >
To |0 =l 8
[Joste Fom  [3y/10/2018 [~ |
To 3yw/2018 [H |
Close
NUM
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Start the P-touch Library.
*  Windows 11:
Click Start > Brother P-touch > P-touch Library.

*Depending on your computer's operating system, the Brother P-touch folder may or may not be created.

*  Windows 10:

Click Start > Brother P-touch > P-touch Library.
*  Windows 8.1:

Click the P-touch Library icon on the Apps screen.
The main window appears.

For Help, press F1

3. Specify the search criteria.
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The following search criteria are available:

Settings Details

Multiple Parameters Determines how the program searches when multiple
criteria are specified. If you select AND, the program
searches for files meeting all of the criteria. If you select
OR, the program searches for files meeting any of the

criteria.
Name Search for a template by specifying the file name.
Type Search for a template by specifying the file type.
Size Search for a template by specifying the file size.
Date Search for a template by specifying the file date.

4. Click Begin Search.
The search begins and the search results are displayed.
5. Close the Search dialog box.
To confirm the search results, click Search Results in the folder view.

ﬁ You can register templates to P-touch Library by dragging and dropping them into the All Contents folder
or to the folder list.

m Related Information

» Store and Manage Templates (P-touch Library)
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& Home > Routine Maintenance

| Routine Maintenance

* Maintenance

[ H-10159
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& Home > Routine Maintenance > Maintenance

| Maintenance

Always remove the batteries and disconnect the AC Adapter before cleaning the Label Maker.

>> Clean the Unit
>> Clean the Print Head
>> Clean the Tape Cutter

Clean the Unit

1. Wipe any dust and marks from the Label Maker using a soft, dry cloth.
2. Use a slightly dampened cloth on difficult to remove marks.

ﬁ Do not use paint thinner, benzene, alcohol or any other organic solvent. These may deform or damage the
case of your Label Maker.

Clean the Print Head

Streaks or poor quality characters on printed labels generally indicate that the Print Head is dirty.
Clean the Print Head using a cotton swab or the optional Print Head Cleaning Cassette (TZeCL5).

N

ﬁ - Do not touch the Print Head directly with your bare hands.
- Read and follow the instructions provided with the Print Head Cleaning Cassette.

Clean the Tape Cutter

Tape adhesive can build up on the cutter blade after repeated use, taking the edge off the blade, which may
result in the tape jamming in the cutter.

[ H-10159
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About once a year, wipe the cutter blade using a cotton swab moistened with Isopropyl alcohol (rubbing alcohol).

ﬁ - Do not touch the cutter blade directly with your bare hands.
- Use isopropyl alcohol according to the manufacturer's guidelines.

Eﬁ Related Information

« Routine Maintenance

(ULINE JERES
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& Home > Troubleshooting

| Troubleshooting
* If You Are Having Difficulty with Your Label Maker
* Error and Maintenance Messages
» Check the Version Information

* Reset the Label Maker

[ H-10159
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& Home > Troubleshooting > If You Are Having Difficulty with Your Label Maker
| If You Are Having Difficulty with Your Label Maker

This chapter explains how to resolve typical problems you may encounter when using the Label Maker.

If you still have problems, see Related Information. If after reading the topics you are unable to resolve the
problem, visit the Brother support website at support.brother.com.

Problem Solution

The Label Maker does not |+ Check that the Tape Cassette is inserted correctly.

print. + If the Tape Cassette is empty, replace it. To order supplies and accessories, visit
www.brother-usa.com.

* Check that the Tape Cassette Compartment Cover is securely closed.
* Check that the Label Maker is on.
* Check that the computer’s or mobile device’s Bluetooth setting is on.

+ Check that the Label Maker is connected to the computer or your mobile device via
Bluetooth.

* Check that the Label Maker is selected in the Brother iPrint&Label app.
» Check that the Label Maker is not paired with another device.

* Make sure the Label Maker and your mobile device or computer are close enough
to communicate.

* Check that the automatic Bluetooth reconnection setting of another computer or
mobile device is not enabled.

* Make sure no devices that emit radio waves (for example, a microwave oven) are
located nearby.

» Check that the correct printer driver is installed when printing from a computer.

+ Connect the Label Maker to your computer using the USB Cable (included) when
printing from a computer.

« If the Print Head is dirty, clean it with a cotton swab or optional Print Head Cleaning
Cassette (TZeCL5).

* The tape does not feed |+ If the tape is bent, cut off the bent section.

correctly. «+ If the tape is jammed, remove the Tape Cassette, remove the jammed tape, and
* The tape gets stuck then cut off any damaged tape.

inside the Label Maker. |.  check that the end of the tape exits through the Tape Guide.
* Confirm that the tape is pointed at the Tape Exit Slot.
* Remove the Tape Cassette and insert it again.

An error occurred when Go to your mobile application’s settings menu and select Support > FAQs &

using a mobile app. Troubleshooting.

The screen has locked. * Reset the internal memory to the factory settings. For more information, see Related
Topics.

» Disconnect the AC Adapter and remove the batteries for at least 10 minutes.

The LCD remains blank Check that the batteries are correctly installed or that the AC Adapter included with your
after turning on the power. | Label Maker is correctly connected.

The LCD messages are Set the LCD language you want. For more information, see Related Topics.

displayed in a foreign

language.

The Label Maker stops * Replace the Tape Cassette if striped tape is visible, as this indicates that you have
while printing a label. reached the end of the tape.

* Replace all batteries or connect the AC Adapter directly to the Label Maker.

Previously saved label files | All files saved in the internal memory are deleted when the batteries are weak or the

are not available. AC Adapter is disconnected.
* | cannot install the If you cannot use your Label Maker even though you have installed the Printer Driver:
Printer Driver even if | |1 Download the Printer Driver Uninstaller from your model’s page at

support.brother.com.
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Problem

Solution

follow the correct
procedure. (Windows)

| cannot see my printer
listed in P-touch Editor
even though | have
installed the Printer
Driver. (Windows)

2. Use the Printer Driver Uninstaller to remove the printer information.

3. Run the Printer Driver Installer again and follow the on-screen instructions to
proceed with the installation.

The ink ribbon is separated
from the ink roller.

If the ink ribbon is damaged, replace the Tape Cassette. If it is not, leave the tape uncut
and carefully remove the Tape Cassette, and then wind the loose ink ribbon back onto
the spool.

Printed barcodes or QR
codes cannot be read.

Change the tape. (Recommended: Black on white tape)

Enlarge the barcodes or QR codes using your barcode application, if possible.

| do not know the version
number of the firmware for
the Label Maker.

You can confirm the firmware version number and other information on the LCD. For
more information, see Related Topics.

When the label is printed,
there is too much margin
(space) on both sides of the
text.

Select Small Margin, Chain, or No Cut options for smaller margins.
For more information, see Related Topics.

After the last label prints, press and simultaneously to feed the tape,
and then eject and cut the last label. Note that the Label Maker will feed
approximately 0.9" (23 mm) of tape before the next new label when you use this
method.

The font size cannot be
increased.

The font is already the maximum size for the width of the label, or the label length has
been set, so there is a limit on the font size to prevent exceeding the set length.

When multiple labels are
printed, the last label is cut
incorrectly.

When Chain is enabled, feed the tape to eject the last printed label.

| cannot update the printer’s
firmware using the P-touch
Update Software, Transfer
Express, or Mac Update
Tool.

Restart the printer and then try to update the firmware again. Do not press any buttons
during the firmware update until the Home Screen is displayed automatically.

The Label Maker does not
operate normally.

Reset the internal memory to the factory settings. For more information, see Related
Topics.

Disconnect the AC Adapter and remove the batteries for at least 10 minutes.

Lﬁ Related Information

» Troubleshooting

Related Topics:
* Reset the Label Maker
» Set Language

» Check the Version Information

* Tape Cutting Options
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#& Home > Troubleshooting > Error and Maintenance Messages

| Error and Maintenance Messages

Message

Cause/Remedy

Barcode error
Record: XXXXX
Field: XXXXX

There was an attempt to print barcode labels from a database.

The Label Maker displays this message when the selected range of the database
includes invalid characters or numbers not supported by the barcode protocol.

Check no.
entered

of digits

The number of digits entered in the barcode data does not match the number of digits
set in the barcode parameters. Enter the correct number of digits.

Cutter malfunction

If the tape is jammed in the Cutter unit, remove the tape. Turn the Label Maker off and
then on again before continuing.

Label too long

The printed label length using the text entered is longer than 39.37" (999 mm). Edit the
text so that the label length is less than 39.37" (999 mm).

System error XX

Contact Brother Customer Service.

Text too long

The printed label length using the text entered is longer than the length setting. Edit the
text to fit within the set length or change the length setting.

m Related Information

» Troubleshooting
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# Home > Troubleshooting > Check the Version Information
| Check the Version Information

You can confirm the firmware version number and other information on the LCD. You may need this information if
you call Brother regarding a question or a warranty.

1. Press .

2. Press dor» todisplay [Settings], and then press OK.

3. Press AorVYtodisplay [Version Information], and then press OK.

m Related Information

* Troubleshooting

(ULINE JERES
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#& Home > Troubleshooting > Reset the Label Maker
| Reset the Label Maker

Reset the internal memory of your Label Maker to clear all saved label files or if the Label Maker is not operating
correctly.

* Reset Using the LCD

(ULINE JERES
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# Home > Troubleshooting > Reset the Label Maker > Reset Using the LCD
| Reset Using the LCD

1. Press .

Press < or » to display [Settings], and then press OK.
Press A or ¥ to display [Reset], and then press OK.

oDN

Press A or V¥ to display the reset method, and then press OK.
A message appears asking you to confirm your reset option.
5. Press OK.

ﬁ If using the [Reset All Settings] or [Factory Settings] reset options, you will need to set your
preferred default language again after the reset.

Reset Options Details

Reset All Settings File memory is NOT cleared.
Settings data is cleared and all settings are reset to the factory settings.

Erase All Content File memory is cleared.
Settings data is NOT cleared and settings remain as currently configured.

Factory Settings File memory, labels, and customized settings are reset to the factory settings.

u Related Information
* Reset the Label Maker
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| Specifications

>> Printing

>> Size

>> Interface

>> Environment

>> Power Supply

>> Media

>> Memory

>> Compatible Operating Systems

Printing

Print Speed Approximately 1.18" (30 mm) /sec.
(Depending on the media used)

Maximum Print Height 0.71" (18.0 mm) (when using 0.94"/24 mm tape) '

1 The actual character size may be smaller than the maximum print height.

Size
Weight Approximately 2.2 Ib. (Approximately 990 g) (without batteries and Tape Cassette)
Dimensions | Approximately 7.95" (W) x 3.42" (H) x 7.83" (D) (Approximately 202 mm (W) x 87 mm (H) x 199 mm (D))
LCD 320 dpi x 120 dpi

Interface
uUsB USB Ver.2.0 (Full Speed) (Micro B)
Bluetooth Bluetooth Ver.5.0

SPP: iAP2

Environment
Operating Temperature Between 50°F and 95°F (Between 10°C and 35°C)
Operating Humidity Between 20% and 80%

Maximum wet bulb temperature: 80.6°F (27°C)

Power Supply
Battery Six AA alkaline batteries (LR6)
AC Adapter (AD-E001A)
Media

Tape Width Standard TZe Tape Cassette:
0.13" (3.5 mm), 0.23" (6 mm), 0.35" (9 mm), 0.47" (12 mm), 0.70" (18 mm), 0.94" (24 mm)

No. of Lines [0.94" (24 mm) tape: 1 - 7 lines
0.70" (18 mm) tape: 1 - 5 lines
0.47" (12 mm) tape: 1 - 3 lines
0.35" (9 mm) tape: 1 - 2 lines
0.23" (6 mm) tape: 1 - 2 lines
0.13" (3.5 mm) tape: 1 line

[ H-10159
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Memory

Text Buffer Maximum 280 characters

File Storage Maximum 99 files

Compatible Operating Systems

For the latest list of compatible software, visit support.brother.com.

m Related Information

* Appendix
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| Brother Help and Customer Support

For technical help, you must call the country where you bought the machine. Calls must be made from
within that country.

>> FAQs (Frequently Asked Questions)
>> For Customer Service
>> Ordering Accessories and Supplies

FAQs (Frequently Asked Questions)

For more information on your Brother machine, visit the Brother support website at support.brother.com. For
additional help and tips, go to your model's FAQs & Troubleshooting page; for the latest drivers and software,
go to your model's Downloads page.

For Customer Service

In USA:
www.brother-usa.com/support (Self-Service/Email/Chat)
1-877-BROTHER (1-877-276-8437)

In Canada:
www.brother.ca/support

(Self-Service Videos, Email, Chat, Facebook and Twitter Help)

Service Center Locator (USA only)

For the location of a Brother authorized service center, call 1-877-BROTHER (1-877-276-8437) or visit
www.brother-usa.com/support.

Service Center Locations (Canada only)

For the location of a Brother authorized service center, visit www.brother.ca/support.

Ordering Accessories and Supplies

For best quality results use only genuine Brother supplies, which are available at most Brother retailers. If you
cannot find the supplies you need and have a Visa, MasterCard, Discover, American Express credit card, or
PayPal account, you can order directly from Brother. Visit us online for a complete selection of the Brother
accessories and supplies that are available for purchase.

NOTE

In Canada, only Visa and MasterCard are accepted.

In USA:
1-877-BROTHER (1-877-276-8437)

www.brother-usa.com/support

In Canada:

www.brother.ca
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# Inicio > Antes de usar la rotuladora > Definiciones de notas
| Definiciones de notas

En esta Guia del usuario se utilizan los siguientes simbolos y convenciones:

PELIGRO indica una situacion de peligro inminente que, si no se evita, puede
A PELIGRO provocar la muerte o lesiones graves.

ADVERTENCIA indica una situacion potencialmente peligrosa que, de no evitarse,
A ADVERTENCIA puede provocar la muerte o lesiones graves.

A AVISO AVISO indica una situacion potencialmente peligrosa que, de no evitarse, puede
provocar lesiones leves o moderadas.
IMPORTANTE IMPORTANTE indica una situacion potencialmente peligrosa que, de no evitarse,
puede producir dafios materiales o pérdida de la funcionalidad del producto.
NOTA NOTA especifica el entorno operativo, las condiciones de instalacién o las
condiciones especiales de uso.
% El icono de consejos brinda indicaciones utiles e informacién adicional.
Negrita Las letras en negrita identifican botones en el panel de control del equipo o en la
pantalla de la computadora.
Cursiva El estilo en cursiva tiene por objeto destacar un punto importante o derivarle a un
tema afin.
Courier New El tipo Courier New identifica los mensajes que aparecen en la pantalla LCD del
equipo.

u Informacion relacionada

¢ Antes de usar la rotuladora
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| Precauciones generales

» Segun el area, el material y las condiciones ambientales, la etiqueta puede desprenderse o adherirse de
forma permanente y el color puede cambiar o transferirse a otros objetos. Antes de adherir la etiqueta,
verifique las condiciones ambientales y el material. Para verificar la etiqueta, adhiera una pequefia porcion
de esta a un area poco visible de la superficie donde se la desea colocar.

+ NO utilice la maquina, los componentes o accesorios para fines diferentes de los que se describen en esta
guia. De lo contrario, podrian ocurrir accidentes o producirse algun tipo de dafio.
+ Utilice solo cintas Brother TZe con la rotuladora electrénica. NO utilice cintas que no tengan la marca.

« Utilice un pano suave para limpiar el cabezal de impresién; nunca toque el cabezal de impresion.
* NO intente imprimir si el casete esta vacio, ya que puede dafar el cabezal de impresion.
* NO tire de la cinta mientras imprime o la alimenta; de hacerlo, dafiara la cinta y la rotuladora.

* Cualquier informacion guardada en la memoria se puede perder por un fallo o reparacion en la impresora o
si las pilas se descargan completamente.

» Los caracteres impresos pueden ser un poco diferentes a los de la vista previa porque la pantalla de su
dispositivo o computadora puede tener una resolucion mas alta que la de la impresora.

» Lalongitud de la etiqueta impresa puede diferir de la longitud de la etiqueta mostrada.
+ Sise apaga el equipo durante dos minutos, se perdera todo el texto y los ajustes de formato.

» Asegurese de leer las instrucciones que encontrara junto a las cintas de tela termoadhesiva, las cintas
adhesivas extrafuertes y otras cintas especiales y verifique todas las precauciones que encontrara en las
instrucciones.

... Informacién relacionada

* Antes de usar la rotuladora
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| Marcas comerciales y licencias

» Android es una marca comercial de Google LLC.
+ Google Play y el logotipo de Google Play son marcas comerciales registradas de Google LLC.

+ La marca denominativa y los logotipos de Bluetooth® son marcas comerciales registradas propiedad de
Bluetooth SIG, Inc. y el uso de estos por parte de Brother Industries Ltd. esta sujeto a licencia. Las demas
marcas y nombres comerciales son propiedad de sus respectivos titulares.

* QR Code es una marca comercial registrada de DENSO WAVE INCORPORATED.
* Mac, iPad, iPhone y iPod touch son marcas comerciales registradas de Apple Inc.
* QR Code Generating Program Copyright © 2008 DENSO WAVE INCORPORATED.

« Algunas partes de este software estan sujetas a copyright © 2014 The FreeType Project (www.freetype.org).
All rights reserved.

Los nombres comerciales y los nombres de los productos de las compaiias que aparecen en los
productos de Brother, documentos relacionados y otros materiales son marcas comerciales o marcas
comerciales registradas de esas respectivas compaiias.

... Informacion relacionada

* Antes de usar la rotuladora
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| Nota importante

» El contenido de este documento y las especificaciones de esta impresora de etiquetas estan sujetos a
modificaciones sin previo aviso.

+ Brother se reserva el derecho de modificar sin previo aviso las especificaciones y materiales aqui
contenidos, y no asumira responsabilidad alguna por dafos de cualquier indole (incluidos los dafios
derivados) producidos por basarse en el material presentado en las publicaciones, incluidos, entre otros,
errores tipograficos y de otra naturaleza.

+ Esta impresora de etiquetas no admite conexion inalambrica.

+ Las imagenes de pantalla en este documento pueden diferir segun el sistema operativo de su computadora,
el modelo del producto y la version de software.

+ Antes de usar la impresora de etiquetas, asegurese de leer todos los documentos incluidos en la impresora
de etiquetas para obtener informacion sobre la seguridad y el funcionamiento.

+ Laimpresora de etiquetas que aparece en las ilustraciones puede ser distinta a la suya.
* Los suministros disponibles pueden diferir en funcion del pais o la region.
* Recomendamos usar la ultima versiéon de P-touch Editor.

+ Afin de que el rendimiento de la impresora de etiquetas se mantenga actualizado, consulte
support.brother.com para verificar las actualizaciones de firmware mas recientes. En caso contrario, es
posible que algunas funciones de su impresora de etiquetas no estén disponibles.

* Antes de darle su rotuladora electronica a otra persona, reemplazarla o deshacerse de ella, se recomienda
restablecerla a la configuracion de fabrica para eliminar toda la informacion personal.

../ Informacién relacionada

¢ Antes de usar la rotuladora
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| Configurar la rotuladora

Descripcién de piezas

Descripcidn general de la pantalla LCD
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Conectar el adaptador de CA

Instalar pilas

Insertar un casete de cinta
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& |nicio > Configurar la rotuladora > Descripcién de piezas

| Descripcién de piezas
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Visor de la cinta
Pantalla de cristal liquido (LCD)
Cubierta del compartimiento de casete de cinta

Compartimiento de casete de cinta
Palanca de liberacion

Cabezal de impresion

Cortador de cinta

© N R WDN~

Teclado

©

Ranura de salida de la cinta

10. Cubierta del compartimento de la bateria
11. Compartimento de la bateria

12. Puerto USB

13. Enchufe adaptador de CA

73 ‘. .
L{J Informacion relacionada
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| Descripcion general de la pantalla LCD

Modo de vista previa de la impresion

2 34567 8

WI_I N

—[ |1_2345E5.J§—

11 12

Modo de visualizacion de la etiqueta

1 13 8

123456

|
11

1. Modo mayusculas
Indica si el modo de bloqueo de mayusculas esta activado.
2. Fuente actual
Indica la fuente actual.
3. Tamaio del caracter
Indica el tamario actual del caracter.
4. Estilo del caracter
Indica el estilo actual del caracter.
5. Marco
Indica qué marco se ha configurado.
6. Ancho
Indica el ancho del caracter.
7. Alineacion
Indica la alineacion del texto.
8. Ancho de la cinta x Longitud de la etiqueta

La longitud de la etiqueta que se muestra en la pantalla LCD puede ser diferente a la longitud de la etiqueta
actual cuando se imprime.

9. Numero de bloque
Indica el numero de bloque.
10. Namero de linea
Indica el numero de lineas en el disefio de la etiqueta.

[ H-10159
8
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11. Cursor
Aparecen nuevos caracteres a la izquierda del cursor.
Indica la informacién actual en la posicion de entrada.
12. Marca de regreso
Indica el final de una linea de texto.
13. Scale/Zoom (Escala/Zoom)
Cambiar la ampliacién de la vista previa.

u Informacion relacionada

» Configurar la rotuladora
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# Inicio > Configurar la rotuladora > Vista general del teclado

| Vista general del teclado
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1. Power (Alimentacion)
Pulse para encender o apagar la rotuladora electronica.
2. Home (Hogar)/Bluetooth

Pulse para regresar a la pantalla Inicio. Para encender o apagar el Bluetooth, pulse Home (Hogar)/
Bluetooth y la tecla Shift (Mayus) simultaneamente.

3. Clear (Borrar)

Pulse para borrar todo el texto y la configuracion de impresion.
4. Escape (Esc)

Pulse para cancelar la operacién actual.
5. Cursor

Pulse para desplazar el cursor a la direccion que marca la flecha.
6. OK

Pulse para seleccionar la opcién que aparece.
7. Function (Funcion)

Pulse para seleccionar un menu de funciones.

Para mostrar los atributos, pulse Function (Funcion) y la tecla Shift (Mayus) simultdneamente.
8. Preview (Vista previa)/Feed &Cut (Alimentacion y corte)

Pulse para mostrar una imagen de la etiqueta antes de imprimirla.
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Para proporcionar cinta, pulse Preview (Vista previa)/Feed &Cut (Alimentacién y corte) y la tecla Shift
(Mayus) simultaneamente.

9. Print (Imprimir)/Print Options (Opciones de impresion)
Pulse para imprimir.

Para establecer opciones de impresion, pulse Print (Imprimir)/Print Options (Opciones de impresion) y la
tecla Shift (Mayus) simultdneamente.

10. Backspace (Retroceso)
Pulse para eliminar cualquier caracter que se encuentre a la izquierda del cursor.
11. Shift (Mayus)

Mantenga pulsado la tecla de una letra o nUmero cuando quiera escribir una letra mayuscula o el simbolo
que aparece en la tecla del numero.

Para desplazar el cursor al inicio del siguiente bloque o del anterior, pulse Shift (Mayus) ylateclaAoV
simultaneamente.

Para desplazar el cursor al inicio o final de la linea actual, pulse Shift (Mayus) y la tecla 4o »
simultaneamente.

12. Enter (Intro)

Pulse para confirmar su seleccion.
13. Accent (Acento)

Pulse para seleccionar e insertar el caracter acentuado.
14. Space (Espacio)

Pulse para insertar un espacio en blanco.

Pulse para regresar a los valores predeterminados.
15. Symbol (Simbolo)

Pulse para seleccionar e insertar un simbolo del menu de simbolos.
16. Scale/Zoom (Escala/Zoom)

Pulse para cambiar la ampliacion de la vista previa.
17. Shift (Mayus)

Mantenga pulsado la tecla de una letra o nUmero cuando quiera escribir una letra mayuscula o el simbolo
que aparece en la tecla del numero.

Para desplazar el cursor al inicio del siguiente bloque o del anterior, pulse Shift (Mayus) ylateclaAoV
simultaneamente.

Para desplazar el cursor al inicio o final de la linea actual, pulse Shift (Mayus) y la tecla <o »
simultaneamente.

18. Caps (Bloqueo)

Pulse para usar solo letras mayusculas (modo todo en mayusculas).

Cuando el modo mayusculas esta activado, todas las letras se escriben en mayusculas.
19. Tab (Tabulado)

Pulse para insertar una pestana.

... Informacién relacionada

» Configurar la rotuladora
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# Inicio > Configurar la rotuladora > Conectar el adaptador de CA

| Conectar el adaptador de CA

Si conecta un adaptador de corriente, utilice solo el adaptador de CA con numero AD-E001A, disefiado
especificamente para esta impresora de etiquetas.

1. Inserte el cable del adaptador de CA en el enchufe adaptador de CA en un lado de la rotuladora electronica.
2. Inserte el enchufe en el tomacorriente eléctrico mas cercano.

DCIN12V

______ 3

u Informacion relacionada

» Configurar la rotuladora
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# Inicio > Configurar la rotuladora > Instalar pilas
| Instalar pilas

Para asegurar una memoria de repuesto, recomendamos usar seis pilas alcalinas AA (LR6) nuevas junto con el
adaptador de CA.

NOTA

+ Para guardar y hacer una copia de seguridad de la memoria de la impresora de etiquetas, cuando el
adaptador de CA esté desconectado, recomendamos poner seis pilas alcalinas AA en la impresora de
etiquetas.

» Silafuente de energia esta desconectada durante mas de dos minutos, se borrara todo el texto y la
configuracién del formato. También se borrara cualquier archivo de texto guardado en la memoria.

« Extraiga las pilas si no tiene intencién de usar la impresora de etiquetas durante un periodo de tiempo
prolongado.

+ Deshagase de las baterias en un punto de recoleccién adecuado, no las tire a la basura comun.
Ademas, asegurese de respetar todas las reglamentaciones federales, estatales y locales aplicables.

+ Cuando almacene o deseche las pilas, Unalas (por ejemplo, con cinta adhesiva, tal y como se ve en la
ilustracion) para prevenir que causen un cortocircuito.

£

v,

<

MY

1. Cinta adhesiva
2. Pila alcalina

1. Abra la cubierta del compartimento de las pilas.

2. Coloque seis pilas alcalinas AA (LR6) nuevas.
Asegurese de que estan colocadas en la posicion correcta.
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3. Cierre la cubierta del compartimento de las pilas.

Para extraer las pilas, realice el procedimiento inverso al de instalacion.

ﬁ Informacion relacionada

» Configurar la rotuladora
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# Inicio > Configurar la rotuladora > Insertar un casete de cinta
| Insertar un casete de cinta

1. Abra la cubierta del compartimiento de casete de cinta.

2. Inserte un casete de cinta como se muestra en el ejemplo.

NOTA

Cuando inserte el casete de cinta, asegurese de que la cinta no se pegue en el cabezal de impresion.

3. Cierre la cubierta del compartimiento de casete de cinta.

ﬁ Si no puede cerrar la cubierta del compartimiento de casete de cinta, asegurese de que la palanca de
liberacién esté en la posicidén superior. En caso contrario, suba la palanca de liberacién y, a continuacién,
cierre la cubierta.

u Informacion relacionada

» Configurar la rotuladora
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& Inicio > Configurar la rotuladora > Encienda/apague la impresora de etiquetas

| Encienda/apague la impresora de etiquetas

Para ahorrar energia y apagar la rotuladora electronica automaticamente después de un tiempo determinado,
utilice la funcion de apagado automatico.

u Informacion relacionada

» Configurar la rotuladora

Informacion adicional:

» Configurar un tiempo de apagado automatico
» Especificaciones
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# Inicio > Configurar la rotuladora > Configurar el idioma
| Configurar el idioma

Cuando encienda la impresora de etiquetas por primera vez, aparecera la pantalla de seleccion de idioma.
Seleccione el idioma pulsando € o » y, a continuacién, pulse OK.

1. Pulse .

Pulse €4 0 » para mostrar [Configur.] Yy, a continuacion, pulse OK.

Pulse A 0 Y para mostrar [Idioma] Y, a continuacion, pulse OK.

A oDN

Pulse A o ¥ para seleccionar su idioma y, a continuacion, pulse OK.

u Informacion relacionada

» Configurar la rotuladora
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# Inicio > Configurar la rotuladora > Configurar las unidades de medida
| Configurar las unidades de medida

1. Pulse .

Pulse €0 » para mostrar [Configur.] Y, a continuacién, pulse OK.
Pulse A o Y para mostrar [Unidad] Y, a continuacién, pulse OK.

oDN

Pulse A o Y para mostrar [pulgadas] o [mm], Y luego pulse OK.

m Informacion relacionada

» Configurar la rotuladora
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# Inicio > Configurar la rotuladora > Configurar un tiempo de apagado automatico
| Configurar un tiempo de apagado automatico

La impresora de etiquetas tiene una funcion de ahorro de energia que apaga el dispositivo automaticamente si
no se toca ninguna tecla durante un periodo de tiempo y unas condiciones determinadas. No importa si utiliza
un adaptador de CA o baterias, puede cambiar el tiempo que debe pasar para que se apague automaticamente.

1. Pulse .

Pulse € 0 » para mostrar [Configur.] Yy, a continuacién, pulse OK.
Pulse A 0 Y para mostrar [Apagado automatico] y, a continuacion, pulse OK.
Pulse A 0 Y para mostrar [Adaptador CA] 0 [Baterial],y luego pulse OK.

o~ 0D

Pulse A o ¥ para seleccionar una de las siguientes opciones:

Opcién Descripcion

Adaptador CA Desactivado
1 h

o=

2
4
8

oy

Bateria 5 min
10 min

30 min

6. Pulse OK.

71 ‘2 .
L{J Informacion relacionada

» Configurar la rotuladora
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# Inicio > Configurar la rotuladora > Activar o desactivar el Bluetooth

| Activar o desactivar el Bluetooth

1. Pulse .

Pulse € 0 » para mostrar [Configur.] Yy, a continuacién, pulse OK.
Pulse € 0 » para mostrar [Bluetooth] Yy, a continuacién, pulse OK.
Pulse A 0 Y para mostrar [Bluetooth (Activado/Desactivado)] Y, a continuacion, pulse OK.

o~ 0D

Pulse A o ¥ para seleccionar [Activado] 0 [Desactivado] Yy, a continuacion, pulse OK.

Cuando selecciona [Activado], el icono de Bluetooth aparece en la pantalla LCD.

'ﬁ + También puede activar o desactivar el Bluetooth pulsando y de manera simultanea

cuando se muestre la pantalla de inicio.

+ Configure el modo de reconexiéon automatica para Bluetooth para encender o apagar la rotuladora
electrénica cuando la conecta a su dispositivo movil.

73 ‘s .
Lg;j Informacion relacionada

» Configurar la rotuladora
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# Inicio > Configurar la rotuladora > Active o desactive la deteccion del color de la cinta
| Active o desactive la deteccion del color de la cinta

Cuando utiliza el modo de visualizacién de la etiqueta como su modo de entrada, si la deteccion del color de la
cinta esta establecida en [Activado], la rotuladora electrénica detecta el color de la cinta y muestra la imagen
de la etiqueta en color en la pantalla LCD, de modo que se dispone de una vista previa precisa de la etiqueta
que esta disefiando.

El ajuste predeterminado es [Activado].

1. Pulse .

Pulse €0 » para mostrar [Configur.] Y, a continuacién, pulse OK.

Pulse A 0 Y para mostrar [Color de cinta] Y, a continuacién, pulse OK.

poN

Pulse A o ¥ para seleccionar [Activado] 0 [Desactivado] Y, a continuacion, pulse OK.

NOTA

La rotuladora electrénica no puede detectar algunos colores en algunos casetes de cinta. En ese caso, la
imagen de la etiqueta LCD aparecera como texto en negro en un fondo blanco.

u Informacion relacionada

» Configurar la rotuladora

Informacién adicional:
» Configure el modo de entrada
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# Inicio > Configurar la rotuladora > Introducir cinta

| Introducir cinta

1. Para proporcionar cinta, pulse y ]]

2. Pulse A o ¥ para seleccionar una de las siguientes opciones:

Opcién Descripcion

Alimentac y corte Seleccione para introduciry cortar la cinta de manera automatica.

S6lo alimentacién Seleccione para introducir la cinta, pero no cortarla.

Esta opcién se recomienda cuando se usan cintas de tela termoadhesiva, ya que
deben cortarse con tijeras.

3. Pulse OK.

m Informacion relacionada

» Configurar la rotuladora
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# Inicio > Configurar la rotuladora > Ajuste el brillo de la pantalla

| Ajuste el brillo de la pantalla

1. Pulse .

Pulse €40 » para mostrar [Configur.] Y, a continuacién, pulse OK.
Pulse A o Y para mostrar [Ajustar] Y, a continuacion, pulse OK.
Pulse A 0 Y para mostrar [Brillo de la pantalla] y, a continuacion, pulse OK.

ok~ DN

Pulse A o ¥ para seleccionar su preferencia [-2 - +2] y, a continuacion, pulse OK.

u Informacion relacionada

» Configurar la rotuladora
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# Inicio > Configurar la rotuladora > Configure el modo de entrada
| Configure el modo de entrada

Modo de visualizacion de la etiqueta

u

ABC Company
Sales Dept.

Modo de vista previa de la impresion

ABC Companyd
Sales Dept.

1. Pulse .

2. Pulse 40P para mostrar [Configur.] Y, a continuacion, pulse OK.
3. Pulse A 0 ¥ para mostrar [Modo de carga] Y, a continuacion, pulse OK.
4. Pulse A o ¥ para seleccionar una de las siguientes opciones:
Opcidn Descripcion
Vista de etiqueta Muestra los atributos de caracter y los marcos que ha establecido al crear una
etiqueta.
Pulse para cambiar la ampliacion de la pantalla LCD.
Vista previa de Seleccione esto si no desea ver los atributos en la pantalla LCD.
impresién
5. Pulse OK.

£ . .
'uu Informacion relacionada

» Configurar la rotuladora

Informacion adicional:
» Vista previa de las etiquetas

[ H-10159

PAGE 182 OF 464 1-800-295-5510 1023 IH-10159VND



# Inicio > Instalar software

| Instalar software
* Instalar el controlador de la impresora y el software en una computadora (Windows)

» Conecte la rotuladora electronica a una computadora
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& |nicio > Instalar software > Instalar el controlador de la impresora y el software en una computadora
(Windows)
Instalar el controlador de la impresora y el software en una
computadora (Windows)

Para imprimir desde su computadora Windows, instale el controlador de la impresora y el software Brother P-
touch Editor en la computadora.

1. Abra el explorador web que prefiera y escriba install.brother en la barra de direcciones.

http://install.brother

LT e | -\ v NN
£ ] [ s [ —
e Y s s Y | i [ | i\ i { i\ i\ i

L

2. Haga clic en el boton Descargar para descargar el software/instalador de documentacion.

3. Vaya a la carpeta Descargas de su computadora, haga doble clic en el archivo del instalador descargado y
siga las instrucciones que aparecen en la pantalla.

NOTA

« Cuando conecte la impresora de etiquetas a la computadora a través del Bluetooth, asegurese de
tener configurado como bidireccional el botén de transferencia de datos por Bluetooth en su sistema

operativo.
» Pulse el botdn requerido en la impresora de etiquetas para emparejar después de confirmar la
contrasenfia.

71 ‘. .
Lg;j Informacion relacionada

* |nstalar software

» Aplicaciones disponibles
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# Inicio > Instalar software > Instalar el controlador de la impresora y el software en una computadora
(Windows) > Aplicaciones disponibles

| Aplicaciones disponibles

Windows

Aplicacion

Caracteristicas

P-touch Editor !

Le permite disefiar e imprimir etiquetas personalizadas con herramientas de dibujo integradas
para crear distintas fuentes y estilos de texto, importar imagenes e insertar cédigos de barras.

P-touch Transfer
Manager 2

Le permite transferir plantillas y otros datos a la rotuladora electrénica y guardar copias de
seguridad de los datos en la computadora.

Esta aplicacion se instala con P-touch Editor.

P-touch Library

Administra e imprime las plantillas de P-touch Editor.
Puede usar P-touch Library para imprimir plantillas.
Esta aplicacion se instala con P-touch Editor.

P-touch Transfer
Express 2

Le permite transferir documentos a la rotuladora electronica.

P-touch Update
Software 2

Actualiza el software y el firmware a la versién mas reciente.

1

La funciéon de transferencia de plantillas actualmente solo esta disponible con la version 5.4 de P-touch Editor. La version 6.0 de P-touch
Editor sera compatible con esa funcién cuando se lleve a cabo una futura actualizacion.

2 Disponible solo con conexion USB.

Mac

Aplicacion

Caracteristicas

P-touch Editor

Le permite disefar e imprimir etiquetas personalizadas con herramientas de dibujo integradas
para crear distintas fuentes y estilos de texto, importar imagenes e insertar cédigos de barras.

Transfer Express

Actualiza el firmware a la versidon mas reciente.

1

Disponible solo con conexién USB.

M Informacion relacionada

* Instalar el controlador de la impresora y el software en una computadora (Windows)
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& |nicio > Instalar software > Conecte la rotuladora electrénica a una computadora

| Conecte la rotuladora electrénica a una computadora

» Conectar la rotuladora electronica a una computadora mediante un cable USB

[ H-10159
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# Inicio > Instalar software > Conecte la rotuladora electrénica a una computadora > Conectar la rotuladora
electronica a una computadora mediante un cable USB

Conectar la rotuladora electrénica a una computadora mediante un
cable USB

1. Asegurese de que la rotuladora electronica esté apagada antes de conectar el cable USB.
2. Conecte el cable USB al puerto USB de la rotuladora electrénica y luego a su computadora.

3. Encienda la rotuladora electrénica.

u Informacion relacionada

» Conecte la rotuladora electrénica a una computadora
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# Inicio > Editar una etiqueta

| Editar una etiqueta

Anada texto a su etiqueta

Anadir una linea de texto nueva a la etiqueta
Anadir un bloque de texto nuevo a la etiqueta
Borrar texto

Insertar una pestafna

Utilice el recordatorio de texto para autocompletar palabras comunes
Introducir simbolos

Introducir caracteres acentuados

Configurar los atributos de caracter
Configure la longitud de la etiqueta

Utilice los disefios de formato automaticos
Utilice formatos predisefiados

Crear tablas

Crear una etiqueta de codigo de barras

Utilice la funcion de Fecha y hora

[ H-10159

PAGE 188 OF 464 1-800-295-5510

1023 IH-10159VND



# |nicio > Editar una etiqueta > Ahada texto a su etiqueta
| Afada texto a su etiqueta

1. Pulse .
2

Pulse €40 » para mostrar [Crear etiqueta] Yy, a continuacién, pulse OK.

Escriba el texto o los simbolos que quiera (hasta 280 caracteres alfanuméricos, espacios y simbolos de
puntuacion incluidos).

u Informacion relacionada

» Editar una etiqueta
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# Inicio > Editar una etiqueta > Afadir una linea de texto nueva a la etiqueta

| Aadir una linea de texto nueva a la etiqueta

Puede afadir hasta siete lineas a las etiquetas, dependiendo de la cinta que esté usando. Mas informacion »»

Informacién adicional

1. Desplace el cursor hasta el final de la linea.

2. Pulse .

Linea 1

1 ABG

Linea 2

0| ABCJ
3 DEF

Resultado de la etiqueta impresa

ABC
DEF

ﬁ El nimero maximo de lineas que puede afnadir depende del ancho de la cinta.

Maximo de lineas Ancho de la cinta
7 lineas 24 mm (0,94")
5 lineas 18 mm (0,70")
3 lineas 12 mm (0,47")
2 lineas 9 mm (0,35")
6 mm (0,23")
1 linea 3,5 mm (0,13")

u Informacion relacionada

» Editar una etiqueta

Informacion adicional:
» Especificaciones
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# Inicio > Editar una etiqueta > Afadir un bloque de texto nuevo a la etiqueta
| Anadir un bloque de texto nuevo a la etiqueta

Para imprimir etiquetas con varias secciones de texto separadas, puede insertar hasta cinco bloques de texto
dentro de la misma etiqueta.

ABC DEF: GHI A JKL M

Para afiadir un nuevo bloque tanto de texto o con lineas en blanco a la derecha del texto actual, mantenga

pulsado y, a continuacion, pulse | simultaneamente.

El cursor se desplaza hasta el inicio del nuevo bloque.

ABC

.ﬁ - Para cambiar los atributos de caracter de un bloque de texto, siga los pasos para cambiar atributos de
caracter de una linea de texto.

- Hay un maximo de cinco bloques por etiqueta.

... Informacion relacionada

» Editar una etiqueta

(ULINE JERES
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# |nicio > Editar una etiqueta > Borrar texto

| Borrar texto
>> Para borrar un caracter de golpe:
>> Para borrar texto, pero no configuraciones de formato:
>> Para borrar todos los caracteres de una linea especifica:

>> Para borrar todas las configuraciones de caracteres y formato:

Para borrar un caracter de golpe:

Pulse .

Para borrar texto, pero no configuraciones de formato:

1. Pulse .

2. Pulse A o Y para mostrar [S61o texto] Y, a continuacién, pulse OK.

Para borrar todos los caracteres de una linea especifica:

1. Pulse A o ¥ para ir a la linea que desea eliminar.
2. Pulse y simultdneamente.

Para borrar todas las configuraciones de caracteres y formato:

1. Pulse @

2. Pulse A 0 Y para mostrar [Textosformato] y, a continuacion, pulse OK.

L‘g Informacion relacionada

« Editar una etiqueta
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# |nicio > Editar una etiqueta > Insertar una pestafa

| Insertar una pestana

Para insertar una pestaina, coloque el cursor a la izquierda del texto y pulse .

El simbolo de pestafia () aparece en la pantalla LCD.

.ﬁ Para eliminar una pestafia de una etiqueta:
Posicione el cursor a la derecha del simbolo de pestafia en la pantalla donde se introduce el texto y pulse

@

m Informacion relacionada

» Editar una etiqueta

» Cambiar la longitud de la pestana
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# Inicio > Editar una etiqueta > Insertar una pestafia > Cambiar la longitud de la pestafa
| Cambiar la longitud de la pestaina

1. Introduzca el texto que desee.

Pulse .

2
3. Pulse A 0 Y para mostrar [Longitud tab]ly, a continuacion, pulse OK.
4. Realice una de las siguientes acciones:

* Pulse A 0 Y para mostrar 0-100 mm (0,0"-4,0")y, a continuacion, pulse OK.

* Introduzca la longitud de la pestafia que quiera con el teclado numérico. Cuando finalice, pulse OK.

5. Pulse para regresar a la pantalla donde se introduce el texto.

m Informacion relacionada

* Insertar una pestafia
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# Inicio > Editar una etiqueta > Ultilice el recordatorio de texto para autocompletar palabras comunes
| Utilice el recordatorio de texto para autocompletar palabras comunes

En la rotuladora electrénica, se pueden guardar textos o frases de uso habitual para poderlas recuperar y usar
rapidamente en las etiquetas. Por defecto, la funcion de recordatorio de texto esta configurada como
[Activado].

ﬁot her

Escriba un caracter (por ejemplo: “B”).
2. Pulse OK.

La rotuladora electrénica muestra una lista de palabras impresas que empiezan con la letra “B”, por ejemplo,
“Brother”.

3. Pulse A o ¥ para seleccionar la palabra que desee.

—_

Pulse » para mostrar |la palabra entera en caso de ser necesario.
Pulse < para volver a la lista de palabras.
5. Pulse OK.

Para cerrar la lista de palabras y regresar a la pantalla de entrada de texto, pulse .

73 ‘s .
L{J Informacion relacionada

» Editar una etiqueta

* Borre la memoria de los textos recordatorios
¢ Active o desactive el texto recordatorio
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# |nicio > Editar una etiqueta > Utilice el recordatorio de texto para autocompletar palabras comunes > Borre
la memoria de los textos recordatorios

| Borre la memoria de los textos recordatorios

1. Pulse .

Pulse €4 0 » para mostrar [Configur.] Y, a continuacion, pulse OK.
Pulse A 0 Y para mostrar [Aviso texto] Y, a continuacion, pulse OK.

P on

Pulse A 0 Y para mostrar [Borrar memoria] Y, a continuacion, pulse OK.
Aparece [Borrar todos avisos texto?] el mensaje.
5. Pulse OK.

u Informacion relacionada

» Utilice el recordatorio de texto para autocompletar palabras comunes
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# |nicio > Editar una etiqueta > Utilice el recordatorio de texto para autocompletar palabras comunes > Active
o desactive el texto recordatorio

| Active o desactive el texto recordatorio

1. Pulse .

Pulse €4 0 » para mostrar [Configur.] Y, a continuacion, pulse OK.
Pulse A 0 Y para mostrar [Aviso texto] Y, a continuacion, pulse OK.
Pulse A o ¥ para seleccionar [Activado/Desactivado] y, a continuacion, pulse OK.

o~ D

Pulse A o ¥ para seleccionar [Activado] 0 [Desactivado] y, a continuacion, pulse OK.

u Informacion relacionada

» Utilice el recordatorio de texto para autocompletar palabras comunes
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# Inicio > Editar una etiqueta > Introducir simbolos

| Introducir simbolos
* Introducir simbolos con la funcion de simbolos
» Configure el historial de simbolos

* Opciones de simbolos
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# Inicio > Editar una etiqueta > Introducir simbolos > Introducir simbolos con la funcién de simbolos

| Introducir simbolos con la funcién de simbolos

1. Pulse Symbol |.

2. Pulse A o ¥ para seleccionar una categoria y, a continuacién, pulse OK.
3. Pulse A, ¥, 40 » para seleccionar un simbolo y, a continuacion, pulse OK.

u Informacion relacionada

¢ Introducir simbolos
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# Inicio > Editar una etiqueta > Introducir simbolos > Configure el historial de simbolos
| Configure el historial de simbolos

El historial de simbolos puede almacenar hasta 30 simbolos usados recientemente. Por defecto, el historial de
simbolos esta configurado con [Activado].

1. Pulse .

Pulse €4 0 » para mostrar [Configur.] Yy, a continuacién, pulse OK.
Pulse A 0 Y para mostrar [Historial simbolo] Y, a continuacion, pulse OK.

ral

Pulse A o ¥ para seleccionar [Activado] 0 [Desactivado] y, a continuacion, pulse OK.

u Informacion relacionada

¢ [ntroducir simbolos

(ULINE JERES
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# Inicio > Editar una etiqueta > Introducir simbolos > Opciones de simbolos

| Opciones de simbolos

Categoria Simbolos
Puntuacién ) : . : L &i_&_ \
[ = @ #
Paréntesis Flecha ( ) [ ] < > o« » [ ] * « 1_ ‘ “’ ‘“
2§ TPTI2¢C NN 2§
Matematicas + - x =+ =222 aBvdun
o > 2 2, St o wm | MNIVV
VI VIEVIIE X X
Unidadmonetaria | o5 § ¢ € £ ¥ & ° ft in mmm cc £ oz b
F °C
(NUmero) 1) - @
[Numero] I| - E
Sedal PR . s . .
e OSQEAQD UGS LSP®GEM T 4 of

CEZVENPORWAREO (Y2 8
COEHEeL &2
eones A @dEsBE Jzoodi™ % &

B/ 200 Ema2l @Y 0 ca
TIFAarslaPmBaoagsHsorr r 4

|4 44

regect VHAOA I <XNASRDIARN @™
B¢ YWL IO, T AHA
DT REIMIaQEXEaamn0a
R INISAMATHNRASTSTETE®
GELOSHMIN DHEBEEHESEL TS
L@ HBMPMREE @ o™

e FASNCEBB s0% dh
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T
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[ H-10159

1-800-295-5510 1023 IH-10159VND

PAGE 201 OF 464



Categoria

Simbolos

Eléctrico

N=—|F,J7E|E®(.I)O | EBCD@E(I&
L

Herramientas

REEDBB IS YL ARITASE

i

Jardineria @f_@ ﬁ@ @0 ‘{ @lé @ﬂ? % % “? 1.!:1 ﬁj}@
BEBRY SN

ses T OQQEMIYN LSS D

. DELSIBS 7 B

Amaes QPO ORROODBYD BTN
HALWEDOmMrAYTE L H B
BRI % d

comes YF¥LBIORFV @b I0aax
®HIOBCToe®LLES 51 0
BOCEOR@IYLLINITOSES
FOl T eomidflE S

Naturaleza/La
Tierra

REBXPORIRZIRALE

Eventos

XOLZ BB ST EERTIORDR
Qh@ﬁ@@%&é%ﬂﬁ@@ﬁw

Vehiculos

*%@@&@&%L%@

Vestuario

TOARBETROHeEBIX
AR B soeopa il 4

Deportes

OPVBR-@FERAA XY P
2P R FE 3 TERBLL

Familia

TSNS
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Categoria Simbolos

Emoticonos @OEOEEEEOOHOLEL®
OO nrad B

Pictografia .O.D‘ﬂvv*'ﬁ?Q@,@’o
oD T2 FEDR1MLGGeVNETEAHILBED
A B

Astrologia T XS AMOMA MMy

| ., .
'uu Informacion relacionada

¢ Introducir simbolos
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# |nicio > Editar una etiqueta > Introducir caracteres acentuados
| Introducir caracteres acentuados

1. Introduzca el caracter que desee.

2. Pulse .

3. Pulse A o ¥ para seleccionar el caracter acentuado y, a continuacion, pulse OK.

m Informacion relacionada

» Editar una etiqueta

» Opciones de caracteres acentuados

[ H-10159
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& |nicio > Editar una etiqueta > Introducir caracteres acentuados > Opciones de caracteres acentuados
| Opciones de caracteres acentuados

Los caracteres acentuados que aparecen en la pantalla LCD dependen de su idioma.

Caracter Caracteres acentuados
a dadamxagaaa
A AAAAAAAAAA
c ¢cC¢
¢ CCC
d dod
0 DD
° éeéeeccee
" EEEEEEEE
0 e
¢ GG
' PiTipn
! NERERN
“ K
K K
! i r
) LLLL
" NNAN
" NNNN

C)
C}
O
Q
O:
@]
-
L
O

r Frr

*  |RRR

S §§ssh3

° SSSSAB
t tth
TOTTP
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Caracter Caracteres acentuados

lyy
T vy
‘ 2227

u Informacion relacionada

 Introducir caracteres acentuados
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# Inicio > Editar una etiqueta > Configurar los atributos de caracter
| Configurar los atributos de caracter

Puede configurar los atributos de caracter por etiqueta o por linea.
» Aplique atributos de caracter al caracter
» Aplicar atributos de caracter a una linea de texto
* Opciones de configuracion de atributos

» Configure el estilo de ajuste automatico
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# Inicio > Editar una etiqueta > Configurar los atributos de caracter > Aplique atributos de caracter al caracter
| Aplique atributos de caracter al caracter

Cuando diserie el formato de su texto, puede previsualizar las selecciones de atributos de caracter en la pantalla
LCD.

1. Escriba el texto que desee.

Pulse ({ZB).

Pulse A o ¥ para seleccionar un atributo y, a continuacién, pulse OK.
Pulse A o ¥ para establecer un valor para ese atributo y, a continuacion, pulse OK.

Pulse para regresar a la pantalla donde se introduce el texto.

o e N

u Informacion relacionada

» Configurar los atributos de caracter

Informacion adicional:
» Opciones de configuracién de atributos
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# Inicio > Editar una etiqueta > Configurar los atributos de caracter > Aplicar atributos de caracter a una linea
de texto

| Aplicar atributos de caracter a una linea de texto

Si afiade varias lineas en su etiqueta, puede formatear cada linea de texto para que tenga una apariencia
diferente.

Escriba las lineas de caracteres o de texto que desee en la etiqueta.
2. Pulse A o Y para mover el cursor a la linea cuyos atributos de caracter quiera cambiar.

3. Pulse y para mostrar los atributos de formato disponibles.

Tres lineas negras (1) a la izquierda del atributo de caracter indica que solo se esta aplicando el atributo a
esa linea en concreto.

1

[ﬁmente AA

B ABC Compal Tomam LA
A Sales Depl anche A

4. Pulse A o ¥ para seleccionar un atributo y, a continuacion, pulse OK.
5. Pulse A 0 ¥ para establecer un valor para ese atributo y, a continuacién, pulse OK.

6. Pulse para regresar a la pantalla donde se introduce el texto.

.ﬁ Cuando se establecen valores de atributo distintos en cada linea, cada valor de linea aparece como tres
lineas negras (1), lo que también se conoce como “menu hamburguesa”, cuando pulsa .

Fuente E,—

ABC Company| Temaio [= 1
Sales Dept ancno [=|

L‘g Informacion relacionada

» Configurar los atributos de caracter

Informacion adicional:
» Opciones de configuracién de atributos
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# Inicio > Editar una etiqueta > Configurar los atributos de caracter > Opciones de configuracién de atributos

| Opciones de configuracion de atributos

Fuente

Valor Mensaje en la pantalla LCD Resultado

Helsinki HEL A1
Dortmund DTM Al
Bruselas BRU Al
Cooperstown cop Al
Atlanta ATL AT
us Us Al
Los Angeles LA Al
San Diego GO A 1
Florida FLO Al
Calgary CAL a1
Bélgica BEL A
Adams ADM A1
Brunéi BRN A1

Sofia SOF A ]
Alemania GER CAI

Letra gotica LGO A1

Estambul IST A]

Tamano de la fuente

Tamanos disponibles:
Auto, 6 pt, 9 pt, 12 pt, 18 pt, 24 pt, 36 pt, 42 pt, 48 pt

ﬁ Cuando se selecciona Auto, el texto se ajusta automaticamente al tamario de impresién mas grande que
haya disponible en la configuracion de fuente para cada ancho de cinta.

Ancho

Valor Resultado
x1 A

x 3/2 A

- A

[ H-10159
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Valor Resultado

x 1/2 A
x 2/3 A

Estilo de fuente

Subrayado + negrita + cursiva Sbryar+Ngr+C

Valor Mensaje en la pantalla LCD Resultado
Normal Normal A
Negrita Negrita A
Subrayado Subrayar A
Negrita subrayada Sbryar+Ngrta A
Tachado Tachar #
Contorno Contr A
Sombra Sombra A
Solida S6lido A
Cursiva Cursiva A
Negrita en cursiva Cursiva+Negr A
Subrayado + cursiva Sbryar+C A

A
Contorno en cursiva C+Con A
Sombra en cursiva Cursiva+Somb A
Cursiva solida Cursiva+Sol A
Vertical Vertical

<C

Negrita vertical Vrtcal+Ngrta <

Alineacion

Valor Resultado

lzquierda AB C
Centro AB C

Derecha ABC
Justificado A B C

/. Informacién relacionada

 Configurar los atributos de caracter
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# Inicio > Editar una etiqueta > Configurar los atributos de caracter > Configure el estilo de ajuste automatico
| Configure el estilo de ajuste automatico

Puede reducir el tamafo del texto para que encaje en la longitud de la etiqueta.

1. Pulse .

2. Pulse 40 » para mostrar [Configur.] Y, a continuacion, pulse OK.

3. Pulse A 0 Y paramostrar [Estilo de autoajuste] Y, a continuacion, pulse OK.

4. Pulse A o ¥ para seleccionar una de las siguientes opciones:
Opcién Descripcion
Tamafio del Se ha reducido el tamafio total del texto para que quede ajustado a la etiqueta.
texto
Ancho del Se ha reducido el ancho del textoa x 1/2 0 x 2/3 para que quede ajustado a la
texto etiqueta. Para la produccion esperada »» Informacién adicional

5. Pulse OK.

M Informacion relacionada

» Configurar los atributos de caracter
Informacién adicional:
» Opciones de configuracién de atributos
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# Inicio > Editar una etiqueta > Configure la longitud de la etiqueta
| Configure la longitud de la etiqueta

Las etiquetas pueden tener una longitud entre 30 mm (1,2") y 300 mm (12,0"). Cuando selecciona [Auto. ], se
ajusta automaticamente la longitud de la etiqueta segun la cantidad de texto introducido.

1. Pulse .
2

Pulse A o Y para mostrar [Longitud] Y, a continuacion, pulse OK.
Realice una de las siguientes acciones:
* Pulse A 0 ¥ para establecer un valor y, a continuacion, pulse OK.

+ Configure la longitud de la etiqueta escribiendo la longitud que desee con las teclas numéricas. Cuando
finalice, pulse OK.

4. Pulse para regresar a la pantalla donde se introduce el texto.

73 ‘. .
Lg;j Informacion relacionada

» Editar una etiqueta
» Configurar marcos

Informacién adicional:
+ Cambiar la longitud de la pestafia
» Seleccione una opcion de corte
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# Inicio > Editar una etiqueta > Configure la longitud de la etiqueta > Configurar marcos

| Configurar marcos

1. Pulse .

Pulse A o Y para mostrar [Marco] Yy, a continuacion, pulse OK.
Pulse A o ¥ para seleccionar una categoria y, a continuacion, pulse OK.

pwn

Pulse A, ¥, 4 0 » para seleccionar un marco y, a continuacion, pulse OK.

ﬁ También puede seleccionar un marco introduciendo su nimero. Mas informacién »» Informacién
relacionada

m Informacion relacionada

» Configure la longitud de la etiqueta

* Opciones de marcos
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# Inicio > Editar una etiqueta > Configure la longitud de la etiqueta > Configurar marcos > Opciones de

marcos

| Opciones de marcos

PAGE 215 OF 464
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Categoria

Negocio 2

Marcos

W W @ » & 02 Ei O
B, & E N o <
A o A W S ¥
| N #® w0 H Q &
Q] i=] | & =] | |8 |
[#] | S | |Ed | &3 | |5 |

72 . .
... Informacién relacionada

» Configurar marcos
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# Inicio > Editar una etiqueta > Utilice los disefios de formato automaticos

| Utilice los disefios de formato autométicos
» Utilice plantillas

* Opciones de plantilla

[ H-10159
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# Inicio > Editar una etiqueta > Utilice los disefios de formato automaticos > Utilice plantillas
| Utilice plantillas

Seleccione un disefio de las plantillas precargadas incluidas en la rotuladora electrénica, introduzca el texto y
aplique el formato que desee. Para plantillas precargadas »» Informacion adicional:Opciones de plantilla.

.ﬁ Si el ancho del casete de cinta no corresponde al ancho establecido para la plantilla seleccionada, aparece
un mensaje de error cuando se intenta imprimir una etiqueta. Pulse | Esc || o cualquier otra tecla para
eliminar el mensaje de error y, a continuacion, introduzca el casete de cinta adecuado o elija otra plantilla.

Ejemplo: Para personalizar e imprimir una plantilla precargada con el nombre Etiqueta de inventario 1:
XXX COMPANY

XXX department
| IS S O 0
*0001492%

—

Pulse .

2. Pulse 40 » para mostrar [Formato automético] Y, a continuacion, pulse OK.

3. Pulse A o Y para mostrar [Plantillas] Y, a continuacion, pulse OK.

4. Pulse A 0 Y para mostrar [Admin. Invntario] y, a continuacion, pulse OK.

5. Pulse A 0 Y para mostrar [Etiqueta de inventario 1] Y, a continuacion, pulse OK.

6. Introduzca el texto que desee y, a continuacion, pulse OK.

7. Introduzca el texto en el siguiente campo y, a continuacion, pulse OK.

8. Pulse A, ¥, 40 » para seleccionar un atributo de cédigo de barras y, a continuacion, pulse OK.

9. Escriba la informacion del cédigo de barras y, a continuacion, pulse OK. Mas informacién »» Informacion
adicional: Crear una etiqueta de codigo de barras.

10. Realice una de las siguientes acciones:

+ Seleccione [Imprimir] Y, a continuacion, pulse OK.

* Pulse A o ¥ para seleccionar una de las siguientes opciones:

Imprimir

Editar &

Guardar i
Opcién Descripcion
Editar Cambie el texto.
Guardar Guarde la etiqueta.

Mas informacion »» Informacién adicional: Usar la memoria de archivos.

Ment Cambie la configuracién de estilo o fuente.

Vista previa Vea una vista previa de la etiqueta antes de imprimirla.

Pulse para cambiar la ampliacién de la pantalla LCD.

Opciones de impresién Seleccione las opciones de impresion.

Mas informacién »» Informacién adicional: Imprimir etiquetas.

11. Pulse A o Y para seleccionar el numero de etiquetas que desea imprimir y a continuacion, pulse o]
OK.

[ H-10159
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Informacion relacionada

« Utilice los disefios de formato automaticos
Informacién adicional:

» Crear una etiqueta de cédigo de barras

» Usar la memoria de archivos

* Imprimir etiquetas

* Opciones de plantilla

(ULINE JER[E
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# Inicio > Editar una etiqueta > Utilice los disefios de formato automaticos > Opciones de plantilla

| Opciones de plantilla

Categoria

Valor

Detalles

Gestion de inventario

Etiqueta de inventario
1

Etiqueta de inventario
2

(18 mm x 70 mm [0,70" x 2,8"])

Etiqueta de inventario
3

ABC Company, Inc.
{0 O 0 0
*00001%

(24 mm x 70 mm [0,94" x 2,8"])

Etiqueta de inventario
4

ABC Company, Inc.
(1O O R
*00001%

(18 mm x 70 mm [0,70" x 2,8"])

Etiqueta de inventario
5

Property of:
ABC Company, Inc.

00001

(24 mm x 70 mm [0,94" x 2,8"])

Etiqueta de inventario
6

Property of:
ABC Company, Inc.
00001

(18 mm x 70 mm [0,70" x 2,8")

Etiqueta de inventario
7

ABC Company. Inc.

LT
(12 mm x 70 mm [0,47" x 2,8"])

Bandeja

(24 mm x 76 mm [0,94" x 3,0"])

Etiqueta de equipo

ABC Company, Inc.

123456789

(24 mm x 58 mm [0,94" x 2,3"])

Armario

Etiqueta de armario 1

PAGE 220 OF 464

Office Supplies
Sales Dept.
(24 mm x 126 mm [0,94" x 5,0"])
Etiqueta de armario 2 ‘ @ ogg:%f%%;;l{gs
(18 mm x 111 mm [0,70" x 4,4"])
Etiqueta de armario 3 ‘ @ Office Supplies
Sales Dept.
(24 mm x 126 mm [0,94" x 5,0"])
Etiqueta de armario 4 ‘ @ Office Supplies @
(24 mm x 160 mm [0,94" x 6,3"])
Archivo Lomo de carpeta 1

‘m<4mm <OO0DZHW

(24 mm x 219 mm [0,94" x 8,6")

Lomo de carpeta 2

’m<4mm <O00DZ+Ww

(18 mm x 219 mm [0,70" x 8,6"])

[ H-10159
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Categoria

Valor

Detalles

Lomo de carpeta 3

o Design Data

Jan-Mar 2022

(24 mm x 219 mm [0,94" x 8,6"])

Lomo de carpeta 4 ‘ S Design Data Jan-Mar 2022
(12 mm x 219 mm [0,47" x 8,6"])

Pestafia de carpeta de [ PAYABLES

archivos (12 mm x 82 mm [0,47" x 3,2")

Pestana separadora [AUGUST |

(12 mm x 42 mm [0,47" x 1,6"])

indice de documentos

2zcoz
Y38W3030
DECEMBER

2022

(24 mm x 36 mm [0,94" x 1,4"])

Direccién/
identificacion

Etiqueta de direccion 1

(24 mm x 72 mm [0,94" x 2,8"])

Etiqueta de direccion 2

Robert Becker
ABC CORPORATION

1234 Main street
Telephone (XXX) XXX-XXXX

(24 mm x 72 mm [0,94" x 2,8"])

Placa con nombre 1

Robert Becker
Sales Manager

ABC Company, Inc.

(24 mm x 72 mm [0,94" x 2,8"])

Placa con nombre 2

OO0

&

(24 mm x 72 mm [0,94" x 2,8"])

Robert Becker
Sales Manager

Placa con nombre 3

Robert Becker
AABC Company., Inc.

(18 mm x 72 mm [0,70" x 2,8"])

Placa con nombre 4

Robert Becker

ABC Company, Inc.

(24 mm x 72 mm [0,94" x 2,8"])

Material informatico

Etiqueta de tarjeta SD

#Photos ¥
April'22
Trip

(12 mm x 25 mm [0,47" x 1,0"])

Memoria flash USB

(9 mm x 25 mm [0,35" x 1,0"])

Lomo de caja de DVD

SERVICE MANUAL (PDF)

(9 mm x 178 mm [0,35" x 7,0"])

Lomo de caja de CD

[ Ny Favorte Musc |

(6 mm x 113 mm [0,23" x 4,4"])

Etiquetado de cables
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Marca 1

ABC

(12 mm x 90 mm [0,47" x 3,5"])

ABC

Marca 2

ABC
DEF

(12 mm x 90 mm [0,47" x 3,5"])

ABC
DeF
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Categoria

Valor

Detalles

Organizador de cables
1

Organizador de cables
2

Placa frontal (VRT)

(12 mm x 70 mm [0,47" x 2,8")

Letrero

Letrero 1

HOT!

(24 mm x 66 mm [0,94" x 2,6"])

Letrero 2

<
o

(24 mm x 50 mm [0,94" x 2,0"])

CAUTION
THIS IS SIDE
UpP

u Informacion relacionada

« Utilice los disefos de formato automaticos
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# Inicio > Editar una etiqueta > Utilice formatos predisefiados
| Utilice formatos predisefiados

Puede elegir entre varios formatos predisefiados segun el tamafio de la cinta, para poder ajustar las lineas de
texto en la etiqueta. Seleccione una de las opciones de formatos predisefiados, introduzca el texto y aplique
formato al texto en caso de ser necesario. Para mostrar qué opciones disponibles hay para la cinta que esta
utilizando, »>» Informacién relacionada: Opciones de formato predisefiado.

Pulse .

Pulse €4 0 » para mostrar [Formato automatico] Y, a continuacion, pulse OK.

N

Pulse A 0 ¥ para mostrar [Disefios de bloque] Y, a continuacion, pulse OK.

Pulse A o ¥ para seleccionar el ancho de la cinta deseado y, a continuacion, pulse OK.
Pulse A o ¥ para seleccionar el formato predisefiado y, a continuacion, pulse OK.
Introduzca el texto que desee y, a continuacion, pulse OK.

Repita esos pasos para cada campo de texto y, a continuacion, pulse OK.

Pulse OK para mostrar el menu de la impresora.

© ©®O N~ DN

Realice una de las siguientes acciones:
» Seleccione [Imprimir] y, a continuacion, pulse OK.

» Pulse A 0 ¥ para seleccionar una de las siguientes opciones:

Imprimir

Editar W 4

Guardar j.
Opcién Descripcion
Editar Cambie el texto.
Guardar Guarde la etiqueta.

Mas informacion »» Informacién adicional: Usar la memoria de archivos.

Menu Cambie la configuracién de fuente, alineacion o marcos.

Vista previa Vea una vista previa de la etiqueta antes de imprimirla.

Pulse para cambiar la ampliacion de la pantalla LCD.

Opciones de impresién Seleccione las opciones de impresion.

Mas informacién »» Informacién adicional: Imprimir etiquetas.

10. Pulse A o ¥ para seleccionar el numero de etiquetas que desea imprimir y a continuacion, pulse (
OK.

.ﬁ Si el ancho del casete de cinta no corresponde al ancho establecido para el disefio seleccionado, aparece

un mensaje de error cuando se intenta imprimir una etiqueta. Pulse o cualquier otra tecla para

eliminar el mensaje de error y, a continuacion, introduzca el casete de cinta adecuado.

... Informacién relacionada

» Editar una etiqueta
» Opciones de formato predisefiado

Informacién adicional:
* Usar la memoria de archivos

[ H-10159
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* Imprimir etiquetas

(ULINE JER[E
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& |nicio > Editar una etiqueta > Utilice formatos predisefiados > Opciones de formato predisefado

| Opciones de formato predisefado

Cinta de 24 mm/0,94"

Valor Detalles
1Linea(inversion)
2LineaA
2LineaB
3LineaA
3LineaB
3LineaC
1+1LineaA
24pt-- 48 pt
1+1LineaB
26 pt-| & - 18pt
1+1LineaC
2qpt
1+2LineaA . Eq. |:|'|:
24 pt
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Valor Detalles
1+2LineaB
45 pt-| &
1+2LineaC
45 pt--
1+3LineaA
43 pt--
1+3LineaB
43 pt.-
1+3LineaC
43 pt--
1+4LineaA
24pt..
1+4LineaB
45 pt--
1+5Linea
24pt..
Cinta de 18 mm/0,70"
Valor Detalles
2LineaA
2LineaB
3LineaA
3LineaB

(ULINE JERES
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Valor Detalles
1+1LineaB
1= I:'t"'
1+1LineaC I
42 pk-
1+2LineaA
42 pt--
1+2LineaB
42 pk--
1+2LineaC
42 pt--
1+2LineaD e
42 pk--
1+3Linea
42 pt.-
1+4Linea
24 pt.--
1+5Linea
20 pt-
Cinta de 12 mm/0,47"
Valor Detalles
2LineaA | P Y L q I:'t
12 pt
2LineaB . 1 E I:lt
...... 9 pt
sLinesA | m— &pt
E I:'t
12pt
3LineaB -12pt
o Bpt
E&pt
1+1LineaA
1+1LineaB
1+1LineaC
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Valor Detalles
1+2Linea n - 12pt
Cinta de 9 mm/0,35"
Valor Detalles
2LineaA [T ITTTTTTTTTTTTT T T T e E.pt
"12pt
2LineaB zpt
...... Ell:lt
1+2Linea
18pt .- L
Cinta de 6 mm/0,23"
Valor Detalles
1+2Linea 1E|:It---

173 . .
Lg;j Informacion relacionada

 Utilice formatos predisefiados
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& |nicio > Editar una etiqueta > Crear tablas

| Crear tablas

Cree una tabla estableciendo el niumero de filas y columnas que desee. También puede guardar el archivo como
una plantilla para volver a usarlo en otras etiquetas.

ﬁ Dependiendo del ancho de la cinta, hay un nimero maximo de filas.

w

a8 9 e N ok

12.

PAGE 229 OF 464

Maximo de lineas Ancho de la cinta
7 lineas 24 mm (0,94")
5 lineas 18 mm (0,70")
3 lineas 12 mm (0,47")
2 lineas 9 mm (0,35")
6 mm (0,23")

Pulse .

Pulse €4 0 » para mostrar [Formato automético] Y, a continuacion, pulse OK.
Pulse A 0 Y para mostrar [Formato de tabla] y, a continuacion, pulse OK.

Utilice la tecla A, ¥, 4y » para crear una tabla.

Pulse A o ¥ para seleccionar el ancho de la cinta deseado y, a continuacion, pulse OK.
Pulse A 0 ¥ para seleccionar [Filas].

Pulse €4 o » para establecer el nimero de filas que desea.

Pulse A o ¥ para seleccionar [Columnas].

Pulse € o » para establecer el numero de columnas que desea y luego pulse OK.
Introduzca el texto que desee y, a continuacion, pulse OK.

. Repita esos pasos para cada campo de texto y, a continuacién, pulse OK.
. Realice una de las siguientes acciones:

* Seleccione [Imprimir] y, a continuacion, pulse OK.
* Pulse A 0 ¥ para seleccionar una de las siguientes opciones:

Imprimir

Guardar j'
Opcidn Descripcion
Editar Cambie el texto.
Guardar Guarde la etiqueta.

Mas informacién »» Informacién adicional: Usar la memoria de archivos.

Ment Cambie la configuracion de estilo o fuente.

Vista previa Vea una vista previa de la etiqueta antes de imprimirla.

Pulse para cambiar la ampliacién de la pantalla LCD.

Opciones de impresién Seleccione las opciones de impresion.
Mas informacion »» Informacién adicional: Imprimir etiquetas.

Pulse A o ¥ para seleccionar el nimero de etiquetas que desea imprimir y a continuacion, pulse o]

o [ H-10159
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ﬁ + Lacinta de 3,5 mm (0,13") no se puede usar para crear tablas.
« Si el ancho del casete de cinta no corresponde al ancho establecido para el disefo seleccionado,
aparece un mensaje de error cuando se intenta imprimir una etiqueta. Pulse o cualquier otra tecla

para eliminar el mensaje de error y, a continuacion, introduzca el casete de cinta adecuado.

m Informacion relacionada

» Editar una etiqueta

Informacién adicional:

» Usar la memoria de archivos

e Imprimir etiquetas

» Opciones de formato predisefiado

[ H-10159
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& |nicio > Editar una etiqueta > Crear una etiqueta de codigo de barras

| Crear una etiqueta de cédigo de barras
* Crear e imprimir cédigos de barras

» Editar o borrar un cédigo de barras o informacién de un cédigo de barras

[ H-10159
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# Inicio > Editar una etiqueta > Crear una etiqueta de cédigo de barras > Crear e imprimir codigos de barras
| Crear e imprimir cédigos de barras

Esta rotuladora electronica no esta disefiada exclusivamente para crear etiquetas de codigos de barras.
Siempre verifique que el lector de cddigo de barras pueda leer las etiquetas de codigo de barras.

Para conseguir mejores resultados, imprima etiquetas de codigo de barras con tinta negra en cinta blanca. Es
posible que algunos lectores de codigos de barras no puedan leer etiquetas de cédigos de barras creadas con
cinta o tinta de colores.

En una etiqueta se pueden imprimir hasta cinco cédigos de barras.

NOTA

« Utilice la configuracion [Grande] para [Ancho] siempre que sea posible. Es posible que algunos
lectores de cédigos de barras no puedan leer etiquetas de cédigos de barras creadas con la
configuracion [Pequefio].

* Imprimir continuamente una gran cantidad de etiquetas con cédigos de barras puede sobrecalentar el
cabezal de impresion, cosa que puede afectar a la calidad de la impresion.

* Los simbolos solo estan disponibles en los protocolos CODE39, CODE128, CODABAR o GS1-128.

+ El atributo“C.Digit” (Comprobar digito) solo esta disponible en los protocolos CODE39, I-2/5, y
CODABAR.

1. Pulse .

2. Pulse A o Y para mostrar [C barra]y, a continuacion, pulse OK.
3. Pulse A, ¥, 40 » para seleccionar un atributo y, a continuacion, pulse OK.
4. Escriba la informacién del cédigo de barras. Mas informacion »>» Informacién adicional
5. Pulse | symbol | o ({2
Pulse A o ¥ para seleccionar un caracter y, a continuacion, pulse OK.
7. Pulse OK.

73 ‘. .
L{J Informacion relacionada

» Crear una etiqueta de cédigo de barras

» Opciones de cédigo de barras
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# |nicio > Editar una etiqueta > Crear una etiqueta de cédigo de barras > Crear e imprimir codigos de
barras > Opciones de cddigo de barras

| Opciones de coédigo de barras

Atributo Valor
Protocolo CODE39, CODE128, EAN-8, EAN-13, GS1-128 (UCC/
EAN-128), UPC-A, UPC-E, 1-2/5 (ITF), CODABAR
Ancho Pequefio
Grande
Numero menor Activado

(Caracteres impresos debajo del cédigo de barras)

Desactivado
C.Digit Desactivado
(Comprobar digito)
Activado
(Disponible solo para los protocolos CODE39, I-2/5 y
CODABAR)

Opciones de caracteres especiales

CODE39
Caracteres especiales
(ESPACIO)

$

/

+

4
CODABAR

Caracteres especiales

[ H-10159
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Caracteres especiales

+

CODE128, GS1-128 (UCC / EAN-128)

Caracteres especiales
(ESPACIO) | 3] #
$ 4 & '
( ) X +
r — = !
. ’ < =
? al C
\ ] A -
NUL SOH STX
ETX EOT ENQ ACK
BEL BS HT LF
VT FF CR SO
Sl DLE DCA1 DC2
DC3 DC4 NAK SYN
ETB CAN EM SUB
ESC { FS
GS } RS ~
us DEL FNC3 FNC2
FNC4 FNC1

Eﬁ Informacion relacionada

* Crear e imprimir codigos de barras
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# Inicio > Editar una etiqueta > Crear una etiqueta de cédigo de barras > Editar o borrar un cédigo de barras
o informacién de un cédigo de barras

I Editar o borrar un cédigo de barras o informacioén de un cédigo de
barras

>> Eliminar un cddigo de barras de una etiqueta
>> Editar informacién de un cddigo de barras

Eliminar un cédigo de barras de una etiqueta
1. Coloque el cursor a la derecha del codigo de barras en la pantalla de entrada de datos.

2. Pulse .

Editar informacién de un cédigo de barras

PT-D610BT

1. Para editar los atributos y la informacion del codigo de barras, coloque el cursor a la izquierda del cédigo de
barras en la pantalla de entrada de datos.

2. Pulse para abrir la pantalla de configuracién de cddigo de barras.

3. Pulse A 0 Y para mostrar [C barraly, a continuacion, pulse OK.

£ . .
'uu Informacion relacionada

» Crear una etiqueta de codigo de barras

[ H-10159
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# Inicio > Editar una etiqueta > Utilice la funcién de Fecha y hora
| Utilice la funcién de Fecha y hora

Puede afadir la fecha y la hora a su etiqueta.
» Configure la fecha y la hora

» Configurar el formato de la fecha y la hora

Configure la Marca de hora y anada la fecha y la hora a una etiqueta

» Cambiar o eliminar la configuracion de fecha y hora

[ H-10159
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# Inicio > Editar una etiqueta > Utilice la funcién de Fecha y hora > Configure la fecha y la hora

| Configure la fecha y la hora

Configure la fecha y la hora en la configuracion del reloj. Después de configurar la fecha y la hora, puede afiadir
esta informacion a la etiqueta con la funcion de fecha y hora.

1. Pulse .

Pulse € 0 » para mostrar [Configur.] Yy, a continuacién, pulse OK.
Pulse A 0 Y para mostrar [Ajustar reloj] Y, a continuacion, pulse OK.
Pulse A o ¥ para establecer el afio.

Pulse €0 » para ir al siguiente campo.

Pulse A o ¥ para actualizar el campo.

Pulse OK.

N ook oD

NOTA

+ También puede usar el teclado numérico del dispositivo para escribir la fecha y la hora.

+ Lafechay la hora estan activas justo después de que pulse OK.

+ Para confirmar la configuracion de fecha y hora, incluso si el dispositivo no esta conectado un una fuente
de energia, coloque dos pilas alcalinas AA (LR6).

m Informacion relacionada

« Utilice la funcion de Fecha y hora

[ H-10159
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# Inicio > Editar una etiqueta > Utilice la funcién de Fecha y hora > Configurar el formato de la fecha y la hora
| Configurar el formato de la fecha y la hora

Esta impresora de etiquetas ofrece varios formatos de fecha y hora que puede anadir a las etiquetas. Elija o el
estilo analdgico o digital.

1. Pulse .

Pulse €0 » para mostrar [Configur.] Yy, a continuacién, pulse OK.
Pulse A 0 Y para mostrar [Formato de hora y fecha]l y, a continuacion, pulse OK.
Pulse A 0 Y para mostrar [Fecha] 0 [Hora].

Pulse €0 » para establecer el formato.
Pulse OK.

o oA w N

u Informacion relacionada

« Utilice la funcién de Fecha y hora

» Opciones de formato de fecha y hora

(ULINE JERES
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& |nicio > Editar una etiqueta > Utilice la funcion de Fecha y hora > Configurar el formato de la fecha y la
hora > Opciones de formato de fecha y hora

| Opciones de formato de fecha y hora

Las opciones de formato de fecha y hora disponibles se encuentran en la tabla. Puede configurar la fecha y hora
en el menu del [Configur.] > [Formato de hora y fecha] dispositivo.

Atributo Opciones de formato Atributo Opciones de formato
Fecha 31/12/2099 Fecha 31-12-2099
31.12.2099 31/12/2099
31-12-2099 31.12.2099
31 de diciembre de 2099 31-12-2099
31 dic. 2099 31 de diciembre de 2099
31/12/2099 31 dic. 2099
Hora 23:59 Hora 23:59

La configuracion por defecto se muestra en negrita.

NOTA

Los valores de fecha y hora se utilizan para mostrar una configuracion de muestra. Cuando se selecciona un
formato, la fecha y hora que establezca en la configuracion del reloj apareceran en la opcion de formato
seleccionada.

u Informacion relacionada

» Configurar el formato de la fecha y la hora

[ H-10159
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# [nicio > Editar una etiqueta > Utilice la funcién de Fecha y hora > Configure la Marca de hora y afada la
fecha y la hora a una etiqueta

| Configure la Marca de hora y afiada la fecha y la hora a una etiqueta

1. Pulse .

Pulse €0 » para mostrar [Configur.] Y, a continuacion, pulse OK.

Pulse A 0 ¥ para mostrar [Ajustar marca de hora] Y, a continuacion, pulse OK.

oD

Pulse A o ¥ para seleccionar una de las siguientes opciones:

* [Tiempo]
Utilice la [Marca de hora] para afadir la fecha y hora a cualquier etiqueta.
a. Pulse A 0 Y para mostrar [Tiempo].

b. Pulse €40 » para mostrar [Automat] o [Fijo], Yy luego pulse OK.

Opcion Descripcion

Automat * Coloque el cursor donde quiera que aparezca la fecha y la hora.

Pulse , pulse A o0 ¥ para seleccionar Marca de horay, a

continuacion, pulse OK. La fecha y hora actuales (o una fecha y
hora del pasado o del futuro si ha configurado previamente la
opcidn Adelante)y el icono del reloj aparecen en la pantalla
LCD.

* Cuando pulsa ' | solo, se imprimira la ultima fecha y hora en

la etiqueta. No se imprime el icono del reloj.

Fijo » Coloque el cursor donde quiera que aparezca la fecha y la hora.
Pulse , pulse A o ¥ para seleccionar Marca de horay, a

continuacion, pulse OK. La fecha y hora actuales aparecen en la
pantalla LCD.

+ Cuando pulsa [m

, se imprimira la fecha y hora en la etiqueta.

ﬁ Verifique y confirme la configuracién de fecha y hora colocando el cursor a la izquierda del icono del reloj,
pulsando , pulsando A o ¥ para seleccionar [Marca de hora], y pulsando OK.

* [Formato]
Seleccione el formato de fecha y hora que desea utilizar.
a. Pulse A o ¥ para seleccionar [Formato].

b. Pulse €0 » para seleccionar la opcion de formato que desee.

Opcion Descripcion

Fecha Imprime solo la fecha en la etiqueta.

Fech/hora Imprime la fecha y la hora en la etiqueta.

Hora Imprime solo la hora en la etiqueta.

Hora/fech Imprime la hora y la fecha en la etiqueta.
c. Pulse OK.

* [Adelante]
Configure una fecha y hora del futuro o del pasado.
a. Pulse A 0 ¥ para seleccionar [Adelante].
b. Pulse €0 » para seleccionar [Activado] y especificar los valores de fecha y hora que desea utilizar

y, a continuacion, pulse OK.
[ H-10159
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Opcidn Descripcion

Activado Le permite aumentar o disminuir los valores de fecha y hora.

Desactiv Imprime la fecha y hora actuales.

c. Pulse €40 » para seleccionar el afo, el mes, la semana, la fecha, la hora o el minuto.
d. Pulse A o ¥ para cambiar la fecha y hora actual segun sea necesario.

.ﬁ También puede configurar la fecha y hora introduciendo los nimeros con el teclado.

e. Pulse OK.

u Informacion relacionada

« Utilice la funcién de Fecha y hora

(ULINE JERES
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# Inicio > Editar una etiqueta > Utilice la funcién de Fecha y hora > Cambiar o eliminar la configuracion de
fecha y hora

| Cambiar o eliminar la configuracién de fecha y hora

>> Cambiar la configuracion de fecha y hora
>> Eliminar la fecha y hora de una etiqueta

Cambiar la configuracién de fecha y hora

1. Coloque el cursor a la izquierda del icono del reloj en la pantalla de entrada de texto.

2. Pulse para abrir la pantalla de configuraciéon de marca de la hora.

3. Actualice la configuracion que desee y pulse OK cuando haya terminado.

Eliminar la fecha y hora de una etiqueta

1. Coloque el cursor a la derecha del icono del reloj en la pantalla de entrada de texto.

2. Pulse .

£33 .. .
Lg;j Informacion relacionada

« Utilice la funcion de Fecha y hora
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é |nicio > Imprimir etiquetas

| Imprimir etiquetas
» Vista previa de las etiquetas
* Imprimir etiquetas

» Seleccione una opcion de corte

Ajustar la longitud de la etiqueta

» Imprimir plantillas transferidas

[ H-10159
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é |nicio > Imprimir etiquetas > Vista previa de las etiquetas
| Vista previa de las etiquetas
Puede ver una vista previa de las etiquetas antes de imprimirlas para asegurarse de que son correctas.

1. Pulse .

2. Realice una de las siguientes acciones:
+ Pulse 4, », A 0 Y para desplazar la vista previa a la izquierda, a la derecha, hacia arriba o hacia abajo.

+  Pulse y 4, >, A 0 Y para desplazarse directamente hasta el borde izquierdo, derecho, superior o
inferior.

*  Pulse para cambiar la ampliacion de la vista previa.

u Informacion relacionada

e Imprimir etiquetas

[ H-10159
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# |nicio > Imprimir etiquetas > Imprimir etiquetas

| Imprimir etiquetas

NOTA

* No tire de la etiqueta cuando la impresora de etiquetas esté expulsandola de la ranura de salida de la
cinta. Eso podria causar que la cinta de tinta se descargue en la cinta, haciendo que no se pueda
aprovechar.

* No bloquee la ranura de salida de la cinta durante la impresion. Si lo hace, puede ocasionar un atasco de
cinta.

.ﬁ » Puede especificar el nimero de copias con el teclado numérico.

+ Sinecesita solo una copia de la etiqueta, pulse [] sin seleccionar el niumero de copias.

u Informacion relacionada

* Imprimir etiquetas
» Impresion secuencial
* Impresion reflejada
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# Inicio > Imprimir etiquetas > Imprimir etiquetas > Impresion secuencial
| Impresi6n secuencial

Utilice esta funcién para crear etiquetas con nimeros o letras ordenados secuencialmente en un Unico formato
de etiqueta.

AA [ AB [ AC
0123] 0124[ 0125

1. Pulse (Gsmft ]) y ( Print ]

Pulse A o Y para mostrar [Numero] Y, a continuacién, pulse OK.

Pulse € o » para seleccionar el punto de inicio y, a continuacion, pulse OK.
Pulse €0 » para seleccionar el punto final y, a continuacién, pulse OK.

o Mo

Pulse A o ¥ para seleccionar el numero de etiquetas que desea imprimir y a continuacion, pulse m 0
OK.

L‘g Informacion relacionada

e Imprimir etiquetas
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# Inicio > Imprimir etiquetas > Imprimir etiquetas > Impresion reflejada
| Impresién reflejada

Utilice papel claro en [Espejo]l, para que la parte posterior de las etiquetas se puedan leer correctamente
cuando se peguen en un cristal, ventana u otra superficie transparente.

= T2NILH

1. Pulse (Gsmn) y ( Print ]

2. Pulse A 0 ¥ para seleccionar [Espejo] Y, a continuacion, pulse OK.

3. Pulse @] o OK.

[ ‘4 e H
... Informacién relacionada

e Imprimir etiquetas
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# Inicio > Imprimir etiquetas > Seleccione una opcion de corte
| Seleccione una opcién de corte

Elija entre varias opciones integradas para determinar como quiere que la impresora de etiquetas corte las
etiquetas.

1. Pulse .
2

Pulse A 0 Y para mostrar [Opcién corte] Yy, a continuacion, pulse OK.

Pulse A o ¥ para seleccionar [Mrgen pquefio], [Margn grande], [Cadena], [Sin corte] O [Cint
espciall] y, a continuacion, pulse OK.

m Informacion relacionada

* Imprimir etiquetas

» Opciones de corte de la cinta
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# Inicio > Imprimir etiquetas > Seleccione una opcion de corte > Opciones de corte de la cinta

| Opciones de corte de la cinta

En la tabla de opciones, esos patrones visuales representan partes de la etiqueta, tal y como se ilustra en la
columna de ejemplo.

ABC

Area de impresion

Margen

Z

Margen laminado

Configuracion

Descripcion

Ejemplo

Mrgen pguefio

Corta automaticamente un trozo de cinta
blanca antes de imprimir la primera etiqueta y,
a continuacion, corta la cinta después de que
se imprima cada etiqueta, dejando un margen
de 2 mm (0,08") a ambos lados de cada
etiqueta.

» Cuando la longitud de una etiqueta es
aproximadamente de 23 mm (0,9") o mas

2 2 2
L L L

%
_ || nsc]|| ABC
T T
1 2
1. Aproximadamente 0,9" (23 mm)
2. 2mm (0,08")

» Cuando la longitud de una etiqueta es
aproximadamente de 23 mm (0,9") o menos

1. Aproximadamente 23 mm (0,9")
2. 2mm (0,08")

Margn grande

Corta automaticamente un trozo de cinta
después de que se imprima cada etiqueta,
dejando un margen de 25 mm (0,98") en
ambos lados.

2 2
L L

ABC

2 2
L L

ABC

T T T T
1 1 1 1

1. Aproximadamente 23 mm (0,9")
2. 2mm (0,08")

Cadena

» Corta automaticamente un trozo de cinta
blanca antes de imprimir la primera etiqueta
y, a continuacion, corta la cinta después de
que se imprima cada etiqueta, dejando un
margen de 2 mm (0,08") a ambos lados de
cada etiqueta.

* Cuando se ha impreso la tltima etiqueta,

. . — )
no se coloca ni corta la cinta. Pulse

y simultaneamente para colocar y
cortar la cinta.

2 2
L L

7
4

T T
1 2

. Aproximadamente 23 mm (0,9")
2. 2mm (0,08")
3. Posicion de corte

ABC || AB(

)

-
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Configuracion

Descripcion

Ejemplo

Sin corte

» Seleccione esta configuraciéon cuando
imprima varias copias de una etiqueta o
cuando utilice cinta de tela termoadhesiva u
otras cintas especiales que no puedan
cortarse con el cortador de cinta de la
impresora de etiquetas.

* Cuando se ha impreso la ultima etiqueta,
no se coloca ni corta la cinta.

- Pulse y simultaneamente

para colocar y cortar la cinta.

- Cuando utilice cintas especiales que no
pueden cortarse con el cortador de cinta
de la impresora de etiquetas, extraiga el
casete de cinta de la impresora de
etiquetas y utilice tijeras para cortar la
cinta.

2 2
. .

ABC ABC

T T
1 2

1. 23 mm (0,9")
2. 2mm (0,08")

Cint espcial

Seleccione esta configuracion cuando utilice
una cinta especial.

2 2 2
L L L
ABC ABC

T Ji
1 2

1. Aproximadamente 23 mm (0,9")

7

2. 2mm (0,08")

u Informacion relacionada

» Seleccione una opcion de corte
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é |nicio > Imprimir etiquetas > Ajustar la longitud de la etiqueta
| Ajustar la longitud de la etiqueta

Cuando el casete de cinta esta casi vacio, la longitud de la etiqueta impresa puede ser menos precisa. En ese
caso, ajuste manualmente la longitud de la etiqueta.

.ﬁ Aproximadamente el 1% de la longitud total de la etiqueta se ajusta a un nivel.

1. Pulse .

Pulse €0 » para mostrar [Configur.] Yy, a continuacién, pulse OK.

Pulse A 0 Y para mostrar [Ajustar] Y, a continuacion, pulse OK.

Pulse A 0 Y para mostrar [Longitud de etiqueta] y, a continuacion, pulse OK.

ok~ DN

Pulse €40 » para mostrar [-3 - +3] y, a continuacion, pulse OK.

M Informacion relacionada

* Imprimir etiquetas
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PAGE 251 OF 464 1-800-295-5510 1023 IH-10159VND



# Inicio > Imprimir etiquetas > Imprimir plantillas transferidas
| Imprimir plantillas transferidas

Puede transferir a la impresora de etiquetas plantillas creadas con P-touch Editor, personalizar el texto e
imprimir las etiquetas actualizadas.

1. Pulse .

Pulse €40 » para mostrar [Plantillas transferidas] y, a continuacion, pulse OK.
Pulse A o ¥ para seleccionar la plantilla que desea imprimir y, a continuacion, pulse OK.

wnN

Pulse A 0 Y para mostrar [Imprimir] Yy, a continuacion, pulse OK.

.ﬁ Si todavia no ha transferido plantillas desde P-touch Editor, [Plantillas transferidas] no
aparecera en la lista de opciones.

Mas informacion »» Informacién adicional

m Informacion relacionada

* Imprimir etiquetas
« Editar e imprimir plantillas transferidas
 Imprimir plantillas transferidas desde una base de datos
+ Eliminar una plantilla transferida
Informacién adicional:
» Transferir plantillas a la impresora (P-touch Transfer Manager) (Windows)

[ H-10159
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# Inicio > Imprimir etiquetas > Imprimir plantillas transferidas > Editar e imprimir plantillas transferidas
| Editar e imprimir plantillas transferidas

1. Pulse .

Pulse 4 0 » para mostrar [Plantillas transferidas] Y, a continuacién, pulse OK.
Pulse A o ¥ para seleccionar la plantilla que desea editar y, a continuacién, pulse OK.
Pulse A 0 Y para mostrar [Editar etig. (sin guard.)] Y, a continuacion, pulse OK.

o DN

Edite la plantilla.

.ﬁ No puede anadir o eliminar un salto de linea cuando esta editando una plantilla transferida.

6. Pulse A o ¥ para seleccionar la plantilla editada y, a continuacion, pulse OK.
7. Pulse A 0 Y para mostrar [Imprimir] Yy, a continuacién, pulse OK.

.ﬁ No puede guardar los cambios en una plantilla transferida.

£33 . .
Lg;j Informacion relacionada

* Imprimir plantillas transferidas
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# Inicio > Imprimir etiquetas > Imprimir plantillas transferidas > Imprimir plantillas transferidas desde una base
de datos

| Imprimir plantillas transferidas desde una base de datos

1. Pulse .

Pulse €40 » para mostrar [Plantillas transferidas] y, a continuacion, pulse OK.
Pulse A o ¥ para seleccionar la plantilla que desea imprimir y, a continuacion, pulse OK.
Pulse A 0 Y para mostrar [Impr. desde base datos] Y, a continuacion, pulse OK.

Pulse «, », A 0 ¥ para seleccionar el primer documento en el rango que desea imprimir.

2 e

Pulse 4, », A 0 ¥ para seleccionar el ultimo documento en el rango que desea imprimir.
Los documentos en el rango seleccionado aparecen destacados en la pantalla LCD.
7. Pulse A 0 Y para mostrar [Imprimir] Yy, a continuacion, pulse OK.

ﬁ El numero maximo de caracteres que se pueden imprimir en una plantilla transferida es 1500. Los saltos
de linea y los bloques de texto reducen el nimero maximo.

73 ‘. .
L{J Informacion relacionada

* Imprimir plantillas transferidas

* Encontrar una plantilla en la base de datos
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# Inicio > Imprimir etiquetas > Imprimir plantillas transferidas > Imprimir plantillas transferidas desde una base
de datos > Encontrar una plantilla en la base de datos

| Encontrar una plantilla en la base de datos

1. Pulse .
2

Pulse €40 » para mostrar [Plantillas transferidas] y, a continuacion, pulse OK.
Pulse A o ¥ para seleccionar la plantilla que desea imprimir y, a continuacion, pulse OK.
Se muestra el primer registro de la base de datos seleccionada.

4. Escriba la informacién o el nombre de lo que desee encontrar.

Por ejemplo, escriba “B” para encontrar cualquier linea de caracter que contenga “B”. Escriba “BR” para
encontrar cualquier linea de caracter que contenga “BR”.

Escriba tantas letras o nUmeros como sea necesario.

ﬁ + Siunalinea contiene el caracter que ha escrito, el cursor se desplaza hasta ese contenido en la
pantalla LCD vy lo resalta. Si el contenido no existe, el cursor permanece en la misma posicion.

» Si el caracter que ha buscado aparece en varios campos de la base de datos, pulse y

I| simultdneamente para desplazarse al siguiente campo que contenga el caracter. Se resalta

el caracter en el campo.

+  Pulse para eliminar el ultimo caracter de la busqueda de datos. El cursor se desplaza hasta el
siguiente campo que contenga el caracter restante de la busqueda.

73 ‘. .
luz,j Informacion relacionada

* Imprimir plantillas transferidas desde una base de datos
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# Inicio > Imprimir etiquetas > Imprimir plantillas transferidas > Eliminar una plantilla transferida
| Eliminar una plantilla transferida

Cuando elimina una plantilla transferida, solo se borra de la rotuladora electrénica.

1. Pulse .

2. Pulse 40P paramostrar [Plantillas transferidas] Y, a continuacién, pulse OK.
3. Pulse A o ¥ para seleccionar la plantilla que desea eliminar y, a continuacion, pulse OK.
4. Pulse A o Y para mostrar [Eliminar] Y, a continuacion, pulse OK.

Aparece el mensaje [¢Eliminar?].
5. Pulse OK.

u Informacion relacionada

* Imprimir plantillas transferidas
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# Inicio > Usar la memoria de archivos

| Usar la memoria de archivos
* Guarde archivos de etiquetas

* Imprimir, abrir y borrar una etiqueta guardada
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# |nicio > Usar la memoria de archivos > Guarde archivos de etiquetas
| Guarde archivos de etiquetas

Puede guardar hasta 99 etiquetas y volver a imprimirlas mas tarde. Se puede guardar un maximo de 280
caracteres por archivo. También puede editar o sobrescribir etiquetas guardadas.

1. Introduzca el texto y el formato de la etiqueta.

Pulse (ZB).

2
3. Pulse A 0 Y para mostrar [Guardar] Y, a continuacién, pulse OK.
4. Pulse A o Y para seleccionar un archivo y, a continuacion, pulse OK.

m Informacion relacionada

¢ Usar la memoria de archivos
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# Inicio > Usar la memoria de archivos > Imprimir, abrir y borrar una etiqueta guardada

| Imprimir, abrir y borrar una etiqueta guardada

1. Pulse .

Pulse €0 » para mostrar [Archivo] Y, a continuacion, pulse OK.
Pulse A o ¥ para seleccionar un archivo y, a continuacion, pulse OK.

»wN

Realice una de las siguientes acciones:

Opcién Descripcion
Imprimir a. Pulse A o Y para mostrar Imprimir y, a continuacion, pulse OK.

b. Pulse A o Y para cambiar el numero de copias y, a continuacion, pulse o OK.

Abrir Pulse A o Y para mostrar Abrir y, a continuacion, pulse OK.
Eliminar a. Pulse A o Y para mostrar E1iminar y, a continuacion, pulse OK.
Pulse OK.
Aparece ;Eliminar? el mensaje.
c. Pulse OK.

Para eliminar una etiqueta guardada en la pantalla de seleccion de archivos, seleccione la
etiqueta con A o V y, a continuacion, pulse .

Creacion de Los archivos guardados se pueden organizar en ocho categorias diferentes marcadas con
marcas colores distintos. La eleccion del color aparece en el lado izquierdo del nombre del archivo
en la pantalla de seleccioén de archivos.

a. Pulse A 0 Y para mostrar Marcado y, a continuacion, pulse OK.

b. Pulse A o ¥ para seleccionar un color y, a continuacion, pulse OK.

£ . .
'uu Informacion relacionada

¢ Usar la memoria de archivos
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# |nicio > Crear e imprimir etiquetas usando la computadora

| Crear e imprimir etiquetas usando la computadora
» Crear etiquetas con P-touch Editor (Windows)
» Crear etiquetas e imprimir con P-touch Editor (Mac)

» Imprimir etiquetas con el controlador de la impresora (Windows)

[ H-10159
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# Inicio > Crear e imprimir etiquetas usando la computadora > Crear etiquetas con P-touch Editor (Windows)

| Crear etiquetas con P-touch Editor (Windows)

La funcién de transferencia solo se puede utilizar con P-touch Editor 5.4.

Para usar la rotuladora con una computadora Windows, instale P-touch Editor y el controlador de la impresora
en la computadora.

Para obtener los ultimos controladores y software, vaya a la pagina Descargas del modelo en la pagina web de
soporte de Brother en support.brother.com.

1. Inicie el P-touch Editor @.

*  Windows 11:

Haga clic en Inicio > Brother P-touch > P-touch Editor o haga doble clic en el icono P-touch Editor en
el escritorio.

*Dependiendo del sistema operativo de su computadora, la carpeta Brother P-touch puede que se cree o
no.

«  Windows 10:

Haga clic en Inicio > Brother P-touch > P-touch Editor o haga doble clic en el icono P-touch Editor en
el escritorio.

*«  Windows 8.1:

Haga clic en el icono P-touch Editor en la pantalla Aplicacioneso haga doble clic en el icono P-touch
Editor en el escritorio.

2. Realice una de las siguientes acciones:
» P-touch Editor 5.4
- Para abrir un disefio existente, haga clic en Abrir (1).

- Para conectar un disefio predisefiado a una base de datos, seleccione la casilla de verificacion junto
a Conectar base de datos (2).

- Para crear un disefio nuevo, haga doble clic en el panel Nuevo disefo (3) o haga clic en el panel
Nuevo disefo (3) y luego haga clic en —.

- Para crear un disefio utilizando uno preestablecido, haga doble clic en un botdn de categoria (4) o
seleccione un botdn de categoria (4) y luego haga clic en —.

@ P-touch Editor - [Diseno1] - 0o X
Nuevo
1 2
S
3
prra—
i 4
§ ]
| .,.
IS i

* P-touch Editor 6.0
- Para abrir un disefio existente, haga clic en Abrir (4).
- Para crear un disefio, haga clic en la pestafia Etiqueta nueva y el botdn Etiqueta nueva (1).

- Para crear un disefio usando uno preestablecido, haga clic en la pestafia Etiqueta nueva y, a
continuacién, en un botén de categoria (2). Seleccione una plantilla y luego haga clic en Crear (3).

[ H-10159
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Medios de comunicacion
Cable

Direccién y envio

Insignia con nombre
Gestion de inventario
Aviso
Sefalizacion
Atencion sanitaria

Tiendas

Abrir...

RS

@ nicio
Brother 7 Etiqueta nueva Etiquetas creadas

Superior

p o -

| ‘ AFZ
Gestion de inventario |
/ i
Organizacion de documentos 5
© <
Organizacién Etiqueta nueva Organizacion de Medios de
documentos comunicacion

=

T
T

——
T ——

== it 1, 8

Insignia con nombre

P

Organizacion Cable

Gestion de inventario

- 18 mm

)

Atencién sanitaria
W3

Sefalizacion Tiendas

iy o il
i i i

Crear Cancelar

4

Informacion relacionada

» Crear e imprimir etiquetas usando la computadora
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# Inicio > Crear e imprimir etiquetas usando la computadora > Crear etiquetas e imprimir con P-touch Editor
(Mac)

| Crear etiquetas e imprimir con P-touch Editor (Mac)

Descargue e instale P-touch Editor desde la App Store de su Mac.

Para utilizar la rotuladora electrénica con su computadora Mac, instale P-touch Editor.
1. Haga doble clic en Macintosh HD > Aplicaciones y luego haga doble clic en el icono Brother P-touch

Editor.
2. Cuando P-touch Editor se inicie, haga clic en Nuevo para seleccionar una plantilla, crear un nuevo disefio o

abrir uno existente.

® [ ) Seleccionar una plantilla

Nuevo Comercio

( .
Gestion Activos Identificacion Medios Oficina Redes
o [ N, [ &
// L) .’, ‘ -
pAuTIO - "
SERVICE : ]
Sefializacion A Administracion de docu... Tiendas y minoristas Organizacidén de Oficina
R " .
| |
& ; Rl
— N im = ' ]
' ! s ¢ b L

3. Seleccione la configuracion de impresion.
4. Haga clic en el icono Imprimir.

Informacion relacionada

» Crear e imprimir etiquetas usando la computadora

» Ventana principal de P-touch Editor (Mac)

(ULINE JER[E

PAGE 263 OF 464

1-800-295-5510 1023 IH-10159VND



& |nicio > Crear e imprimir etiquetas usando la computadora > Crear etiquetas e imprimir con P-touch Editor

(Mac) > Ventana principal de P-touch Editor (Mac)

| Ventana principal de P-touch Editor (Mac)

ece Sintitulo
O = - 100%  + il 0O @ e} @ @ B8 =l
1 Imprimir Zoom Cuadro de texto Imag Simbolo  Imagen predisefiada  Form: Tabla Cédigo de barras Base de dat
L
o o 2 a0 60 80 100 120 140 160 80 200 20 | 240 - -
Ninguno seleccionado
Impresora

Medio de impresién

T 12mm e
Comprobar medio g

Longitud

Longitud establecidz

120

Mérgenes  2mm $

Direccién

O Texto horizontal

160

Texto vertical

Comprar etiquetas [ Arrastrar y soltar archivo de base de datos aqui

Ningun objeto seleccionado

|
3

Barra de herramientas

Inspector de objetos

Area de conexién con la base de datos
Inspector de etiqueta

ok~ 0Ddp =

Ventana de disefio

m Informacion relacionada

» Crear etiquetas e imprimir con P-touch Editor (Mac)

[ H-10159

PAGE 264 OF 464 1-800-295-5510

1023 IH-10159VND



# Inicio > Crear e imprimir etiquetas usando la computadora > Imprimir etiquetas con el controlador de la
impresora (Windows)

| Imprimir etiquetas con el controlador de la impresora (Windows)

Asegurese de haber instalado el controlador de impresora.

Para mostrar los controladores y el software mas recientes, vaya a la pagina Descargas de su modelo en la
pagina web de soporte de Brother en support.brother.com.

Conecte la impresora de etiquetas a una computadora.
Abra el documento que desea imprimir.
Seleccione el comando de impresién en su aplicacion.

down =

Seleccione su impresora de etiquetas y luego haga clic en las propiedades de impresion o en el botén de
preferencias.

Aparecera la ventana del controlador de impresora.
5. Cambie la configuracion del controlador de la impresora, si es necesario.
6. Haga clic en Aceptar.
7. Termine la operacién de impresion.

M Informacion relacionada

» Crear e imprimir etiquetas usando la computadora

Informacién adicional:

» Conectar la rotuladora electrénica a una computadora mediante un cable USB
» Activar o desactivar el Bluetooth

* Instalar el controlador de la impresora y el software en una computadora (Windows)
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# Inicio > Imprimir etiquetas usando dispositivos moviles

| Imprimir etiquetas usando dispositivos moéviles
* Instale la aplicacion iPrint&Label de Brother

» Crear etiquetas e imprimir con dispositivos méviles
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# Inicio > Imprimir etiquetas usando dispositivos moviles > Instale la aplicacion iPrint&Label de Brother
| Instale la aplicacion iPrint&Label de Brother

Utilice la aplicacion iPrint&Label de Brother para imprimir directamente desde su iPhone, iPod touch y
dispositivos méviles Android ™.

Aplicacion Caracteristicas

Brother iPrint&Label Cree etiquetas para fines comerciales, como cddigos de barras, etiquetas para
equipos de oficina y etiquetas para fichas de carpetas.

Para mas informacién sobre las aplicaciones méviles disponibles para su impresora, visite https://
support.brother.com/g/d/f5f9

u Informacion relacionada

* Imprimir etiquetas usando dispositivos moviles

[ H-10159

PAGE 267 OF 464 1-800-295-5510 1023 IH-10159VND



# Inicio > Imprimir etiquetas usando dispositivos moviles > Crear etiquetas e imprimir con dispositivos
méviles

| Crear etiquetas e imprimir con dispositivos moéviles

1. Inicie la aplicacion de imprimir etiquetas en su dispositivo mévil.
2. Seleccione una plantilla o disefio de etiqueta.

ﬁ También puede seleccionar una etiqueta o imagen disefiada anteriormente e imprimirla.

3. Seleccione el menu de impresion en la aplicacion de imprimir etiquetas.

u Informacion relacionada

* Imprimir etiquetas usando dispositivos moviles
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& |nicio > Transferir plantillas a la impresora (P-touch Transfer Manager) (Windows)

Transferir plantillas a la impresora (P-touch Transfer Manager)
(Windows)

» Transferir plantillas a la impresora con P-touch Transfer Manager (Windows)

+ Distribuir plantillas para transferirlas a los usuarios sin usar P-touch Transfer Manager
(Windows)

[ H-10159
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# Inicio > Transferir plantillas a la impresora (P-touch Transfer Manager) (Windows) > Transferir plantillas a la
impresora con P-touch Transfer Manager (Windows)

Transferir plantillas a la impresora con P-touch Transfer Manager
(Windows)

* Notas sobre el uso de P-touch Transfer Manager (Windows)

* Informacién sobre la transferencia de plantillas de la computadora a la impresora
(Windows)

» Copia de seguridad de plantillas u otros datos guardados en la impresora (Windows)
» Eliminacién de datos de la impresora (Windows)

» Crear archivos de transferencia y archivos de paquete de transferencia (Windows)

[ H-10159
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# Inicio > Transferir plantillas a la impresora (P-touch Transfer Manager) (Windows) > Transferir plantillas a la
impresora con P-touch Transfer Manager (Windows) > Notas sobre el uso de P-touch Transfer Manager
(Windows)

| Notas sobre el uso de P-touch Transfer Manager (Windows)

Dado que algunas funciones de P-touch Editor no estan disponibles con la impresora, tenga en cuenta los
siguientes aspectos al utilizar P-touch Editor para crear plantillas.

Puede obtener una vista previa de las plantillas creadas antes de transferirlas a la impresora.

Creacion de plantillas

Puede que parte del texto de las plantillas transferidas a la impresora se imprima con tamafios de caracteres
y fuentes similares que estan cargados en la impresora. Por consiguiente, es posible que la etiqueta impresa
difiera de la imagen de la plantilla creada en P-touch Editor.

En funcién de la configuracién del objeto de texto, el tamano del caracter se puede reducir automaticamente
0 es posible que no se imprima parte del texto. En caso de que esto ocurra, cambie la configuracion del
objeto de texto.

Aunque se pueden aplicar estilos de caracteres a caracteres individuales en P-touch Editor, los estilos se
pueden aplicar a un bloque de texto solo desde la impresora. Ademas, algunos estilos de caracteres no
estan disponibles en la impresora.

Los fondos especificados en P-touch Editor no son compatibles con la impresora.

No se puede transferir el disefio de P-touch Editor usando la funcion de impresion dividida (se agranda la
etiqueta y se imprime en dos 0 mas etiquetas).

Solo se imprime la porcién de la etiqueta con el area imprimible.

Transferencia de plantillas

La etiqueta impresa puede diferir de la imagen que aparece en el area de vista previa de P-touch Transfer
Manager.

Si un coédigo de barras bidimensional que no sea un cédigo QR no cargado en la impresora se transfiere a la
impresora, se convertira en una imagen. La imagen del cédigo de barras convertido no se puede editar.

Todos los objetos transferidos que la impresora no puede editar se convierten en imagenes.
Los objetos agrupados se convierten en un solo mapa de bits.
Si los objetos se solapan, solo se imprime el objeto de la parte inferior.

Transferencia de datos que no son plantillas

Si se cambia el numero o el orden de los campos en una base de datos y solo se transfiere la base de datos
(archivo CSV) para actualizarla, la base de datos no puede vincularse correctamente con la plantilla. Ademas, la
impresora debe reconocer la primera linea de datos en el archivo transferido como "nombres de campo”.

... Informacién relacionada

» Transferir plantillas a la impresora con P-touch Transfer Manager (Windows)

[ H-10159

PAGE 271 OF 464 1-800-295-5510 1023 IH-10159VND



# Inicio > Transferir plantillas a la impresora (P-touch Transfer Manager) (Windows) > Transferir plantillas a la
impresora con P-touch Transfer Manager (Windows) > Informacion sobre la transferencia de plantillas de la
computadora a la impresora (Windows)

Informacion sobre la transferencia de plantillas de la computadora a la
impresora (Windows)

Puede transferir plantillas y otros datos a la impresora y guardar copias de seguridad de los datos en la
computadora.

Para utilizar P-touch Transfer Manager, debera primero transferir plantillas creadas en P-touch Editor a
P-touch Transfer Manager.

u Informacion relacionada

» Transferir plantillas a la impresora con P-touch Transfer Manager (Windows)
» Transferir una plantilla a P-touch Transfer Manager (Windows)
* Ventana principal de P-touch Transfer Manager (Windows)

» Transferencia de plantillas u otros datos de la computadora a la impresora (Windows)
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# Inicio > Transferir plantillas a la impresora (P-touch Transfer Manager) (Windows) > Transferir plantillas a la
impresora con P-touch Transfer Manager (Windows) > Informacion sobre la transferencia de plantillas de la
computadora a la impresora (Windows) > Transferir una plantilla a P-touch Transfer Manager (Windows)

| Transferir una plantilla a P-touch Transfer Manager (Windows)

1. Inicie el P-touch Editor @.
*  Windows 11:

Haga clic en Inicio > Brother P-touch > P-touch Editor o haga doble clic en el icono P-touch Editor en

el escritorio.

*Dependiendo del sistema operativo de su computadora, la carpeta Brother P-touch puede que se cree o

no.
«  Windows 10:

Haga clic en Inicio > Brother P-touch > P-touch Editor o haga doble clic en el icono P-touch Editor en

el escritorio.
*  Windows 8.1:

Haga clic en el icono P-touch Editor en la pantalla Aplicacioneso haga doble clic en el icono P-touch

Editor en el escritorio.
2. Abra la plantilla que desee o cree un disefio.
3. Haga clic en Archivo > Transferir plantilla > Transferir.

Aparece la ventana de P-touch Transfer Manager. Se transfiere la plantilla a la carpeta Configuraciones.

&5 PC (Brother XXHO0M

MCenfiguraciones - P-touch Transfer Manager

Archive Edicion  Ver Herramientas Ayuda

By
= —i ot Impresora:

-

Buscar

Todas las impresoras =~ ~

Vistas

O X

:] P-touch Library Mombre de transferencia Tamafic Tipo Fecha Asignacion de clave

MNombre

----- G5 Todos los elementos
. ? Filtro
Elernentos eliminados

@iname 2KB Disefio 07/01/2019 7:58:34

A2, Resultados de la blsqueda
ansfer Manager

PC (Brother X*-XX00K }
51 Configuraciones

1)) Copias de seguridad

PC (Brother XX-xXXX )
i..fal) Brother XX-00CK

<

name.lbx

No se ha seleccionado ningun elemento,

Para obtener ayuda, pulse F1

MNUM

M Informacion relacionada

* Informacion sobre la transferencia de plantillas de la computadora a la impresora (Windows)
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# Inicio > Transferir plantillas a la impresora (P-touch Transfer Manager) (Windows) > Transferir plantillas a la
impresora con P-touch Transfer Manager (Windows) > Informacion sobre la transferencia de plantillas de la
computadora a la impresora (Windows) > Ventana principal de P-touch Transfer Manager (Windows)

| Ventana principal de P-touch Transfer Manager (Windows)

& Todos los elementos - P-touch Transfer Manager — O X
1 _‘(Ar:hwu Edicion Ver Herramientas Ayuda )

=2 = et o) == Impresora:
6 i =] I ?g rug EE = P
- Todas las impresoras
Buscar Vistas

[ P-touch Library ) Mombre Tamafio  Fecha Localizacién
- ~N
&7 Filtro
-8 Elementos eliminados
- Resultados de la biisqueda
B Transfer Manager — 3

-] PC (Brother XX-XXXX )
L.%5) Configuraciones
.| Copias de seguridad
-H]] PC (Brother Xx%-X000¢ )
5— i.-%51 Configuraciones

*. )] Copias de seguridad
-3 Brother Xx-X00(X

N -/

No se ha seleccionado ningln elemento.

Nlara obtener ayuda, pulse F1 AL NUM =

Barra de menu

Ofrece acceso a varios comandos agrupados debajo de cada titulo de menu (los menus Archivo, Edicién,
Ver, Herramientas y Ayuda) segun sus funciones.

Selector de impresora

Le permite seleccionar una impresora adonde transferir los datos. Cuando seleccione una impresora,
apareceran en la lista de datos unicamente los datos que puedan enviarse a la impresora seleccionada.

Lista de plantillas

Muestra la lista de plantillas de la carpeta seleccionada.

Vista previa

Muestra una vista previa de las plantillas de la lista de plantillas.
Lista de carpetas

Muestra una lista de carpetas e impresoras. Cuando selecciona una carpeta, las plantillas de la carpeta
seleccionada aparecen en la lista de plantillas. Si selecciona una impresora, aparecen las plantillas actuales
y otros datos almacenados en la impresora.

Barra de herramientas
Permite acceder a los comandos mas frecuentes.

Iconos de la barra de herramientas

Icono Nombre del botén Funcion
-I,;J Transferir Haga clic para transferir plantillas y otros datos de la

computadora a la impresora.

Almacenar archivo de
transferencia

Haga clic para cambiar el tipo de archivo de los datos que se
van a transferir a otras aplicaciones.

(Cuando no esta conectado a
una impresora)

Las interfaces disponibles pueden diferir en funcién del
modelo de su equipo.

"EU Copia de seguridad Haga clic para recuperar las plantillas y otros datos guardados
en la impresora y guardarlos en la computadora.
ii} Abrir Haga clic para abrir la plantilla seleccionada.
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Icono Nombre del botén Funcién
) Buscar Haga clic para buscar plantillas u otros datos registrados en P-
A touch Library.
Vistas Haga clic para cambiar el estilo de visualizacion de archivos.

Ea Informacion relacionada

* Informacion sobre la transferencia de plantillas de la computadora a la impresora (Windows)
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# Inicio > Transferir plantillas a la impresora (P-touch Transfer Manager) (Windows) > Transferir plantillas a la
impresora con P-touch Transfer Manager (Windows) > Informacion sobre la transferencia de plantillas de la
computadora a la impresora (Windows) > Transferencia de plantillas u otros datos de la computadora a la

impresora (Windows)

Transferencia de plantillas u otros datos de la computadora a la
impresora (Windows)

ﬁ Para transferir plantillas desde un dispositivo mévil a la impresora, »» Informacién relacionada

1. Conecte la impresora a la computadora mediante un cable USB, y luego encienda la impresora.
El nombre de modelo de la impresora aparecera junto a un icono de impresora en la vista carpeta.
Si selecciona la impresora en la vista carpeta, apareceran las plantillas actuales y otros datos almacenados

en la impresora.

.ﬁ Si una impresora esta desconectada o se encuentra sin conexion, no aparecera en la vista de carpetas.

2. Seleccione la impresora a la que desea transferir la plantilla u otros datos.

& PC (Brother XX-XXO0X

Archive Edicion Mer Herramientas Ayuda

[FZ] P-touch Library

----- [E§ Todos los elementos
-5 Filtro

Elementos eliminados

24 Resultados de |z bisqueda
;_i Transfer Manager
—.[H] PC (Brother XX000C )
%) Configuraciones
[| Copias de seguridad
| PC (Brother 300 b
1 Brother J)O(-X000(

Para obtener ayuda, pulse F1

NConfiguracienes - P-touch Transfer Manager - O X
B, s ;
=7 4 ‘o) % Impresora:
> Todas las impresoras ~
Buscar Vistas -
Todas las impresoras
Mombre de transferencia Tamafio Tipo fesds Asignacidon de clave  Nombre
Brother RJ-4230B
@ name 2KB Disend OTTOTTZ0TY 7:58:34 name.lbx
@| CD 1KB Disefic 07/01/2019 8:00:25 CDulbx
@| address 2KB Disefio 07/01/2019 8:00:54 address.lbx
< >
No se ha seleccionado ningun elemento. el
v
NUM
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continuacion, cree una carpeta nueva.

Haga clic con el botdn derecho del raton en la carpeta Configuraciones, seleccione Nuevay, a

@ PC (Brother X000 J\Configuraciones - P-touch Transfer Manager

- [m] X
Archive Edicion  Ver Herramientas  Ayuda
5 =
o & Impresora:
. b : Todas las impresoras At
Buscar Vistas
:] P-touch Library Moembre de transferencia Tamafio Tipo Fecha Asignacion de clave  Mombre
:_‘I’d“"” slementos @ name KB Disciio 07/01/20197:58:34 - name.lbx
E: i Wy @ co KB Disefio 07/01/2019 8:00:25 1 CDbx
= TR . i @| address 2KB Disefio 07/01/2019 8:00:34 2 address./bx
"\, Resultados de la bisqueda ?
[3 Transfer Manager
|.[m[| PC (Brother XX-X000K )
- B
[| Copias de sequr Nueva
=[] PC (Brother JX-CH Nuevo mensaje...
i..f2) Brother XX-XXxx
Propiedades...
< >
Na se ha seleccionado ningln elemento. e
v
Crea una nueva carpeta NUM

4. Realice una de las siguientes acciones:

» Arrastre la plantilla o los otros datos que desea transferir y coléquelos en la nueva carpeta.

» Para transferir varias plantillas u otros datos, arrastre todos los archivos que desee transferir y coléquelos
en la nueva carpeta. A cada archivo se le asigna un nimero de asignacion de clave (ubicacion de
memoria de la impresora) cuando se coloca en la nueva carpeta.

& PC (Brother XX-XXXX J\Configuraciones\Mueva carpeta - P-touch Transfer Manager - O X
Archive Edicidn Ver Herramientas Ayuda
= ? :.:;‘ fe) Impresora:
- i Todas las impresoras ~
Buscar Vistas
[E] P-touch Library MNombre de transferencia Tamafie Tipo Fecha Asignacion de clave  Nombre
{5 Todos los elementos @) name KB Disefio 07/01/2019 7:58:34 1 name.lbx
E:'t"’ = @ D 1KB Disefio 07/01/2019 8:00:25 2 CObx
ementoselmmal 5 @| address 2KB Disefic 07/01/2019 8:00:54 3 address.lbx
“, Resultados de la bisqueda
;_% Transfer Manager
: PC (Brother XX-X0CK )
Configuraciones
O —
-] Copias de seguridad
PC (Brother X-X000K )
Brother xXX-X0<X
€ >
No se ha seleccionado ningln elemento. A
v
Para obtener ayuda, pulse F1 NUM
Tipo de datos NUmero maximo de Detalles sobre restricciones
elementos transferibles
Plantilla 20 » Cada plantilla puede contener un maximo de 20
objetos.
» Cada plantilla puede contener un maximo de siete
lineas.

Base de datos 20 » Solo se pueden transferir archivos CSV.

» Cada archivo CSV puede contener un maximo de
255 campos y 65.000 registros.
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de configuracion.

+ Puede buscar plantillas u otros datos seleccionando:

- La carpeta en la carpeta Configuraciones

- Todos los elementos

- Una de las categorias debajo de Filtro, como Disenos

Puede confirmar el espacio disponible en la memoria de archivos de transferencia al imprimir el informe

5. Para cambiar el nimero de asignacién de clave asignado a un elemento, haga clic con el botén derecho del
raton en el elemento, seleccione el menlu Asignacion de clave y después seleccione el nimero de

asignacion de clave que desee.

Archive Edicion Ver Herramientas Ayuda
v W &
Transferir Abrir

&

Buscar

Impresora:

Todas las impresoras v

Vistas

P-touch Library
Todos los elementos

?3" name
& Filtro cn
Elementos eliminados =

ﬂaddress

@, Resultados de la bisqueda
G Transfer Manager

[ | PC (Brother X000 )
Configuraciones

[0 Mueva carpeta

&) Copias de seguridad

8[| PC (Brother XX-200(X }
#2) Brother XX-3000K

Nombre de transferencia

Tamafic Tipo
2KB Disefic
1KB Disefic
2KB Disefio

Fecha

07/01/2019 7:58:34 1
07/01/2019 8:00:25 2

07

Asignacion de clave

Asignacidn de clave

Para obtener ayuda, pulse F1

Jar

MNombre

name.lbx
CDulbx
address.Ibx

MUM

un namero de clave.

Salvo por los datos de las bases de datos, todos los datos transferidos a la impresora tienen asignado

» Sila plantilla o los otros datos transferidos a la impresora tienen el mismo nimero de clave que otra
plantilla ya guardada en la impresora, la nueva plantilla sobrescribira la anterior. Puede confirmar los
numeros de plantilla asignados que se guardaron en la impresora realizando una copia de seguridad
de las plantillas o de los otros datos.

» Sila memoria de la impresora se encuentra llena, elimine una o mas plantillas de la memoria de la

impresora.

6. Para cambiar los nombres de las plantillas o de otros datos que desea transferir, haga clic en el elemento

que desee y escriba el nuevo nombre.

Es posible que el numero de caracteres usados en los nombres de las plantillas esté limitado por el modelo

de impresora.
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7. Seleccione la carpeta que contiene las plantillas o los otros datos que desea transferir y haga clic en

Transferir.
& PC (Brother XX-XXXX NConfiguraciones\MNueva carpeta - P-touch Transfer Manager - O *
Archive Edicion Mer Herramientas Ayuda
— ot ™ Impresora:
o7 & & Q _
7 y ; Todas las impresoras v
Transferir Abrir Buscar Vistas
FE] P-touch Library Mombre de transferencia Tamafic Tipo Fecha Asignacion de clave  Mombre
;‘l’d"s fos Slementos @ name KB Disefio 07/01/20197:58:24 1 name.lbx
! E: tro G G @ico 1KB Disefio 07/01/20198:00:25 2 CD.Ibx
At @) address KB Disefio 07/01/20198:00:54 3 address.lbx
-, Resultados de la bisqueda
Q Transfer Manager
- 18| PC (Brother XX4-X000¢ )
%5 Configuracicnes
£ e
E-’_.] Copias de seguridad
: & PC (Brother XxX-xx )
L.f2) Brother XX-00CK
€ >
A
v
Para obtener ayuda, pulse F1 NUM

Aparecera un mensaje de confirmacion.

ﬁ + También puede transferir elementos individuales a la impresora sin afiadirlos a una carpeta. Seleccione

la plantilla o los otros datos que desea transferir y haga clic en Transferir.

Se pueden seleccionar varios elementos y carpetas y transferirlos en una sola operacion.

8. Haga clic en Aceptar.

Los elementos seleccionados se transferiran a la impresora.

u Informacion relacionada

* Informacion sobre la transferencia de plantillas de la computadora a la impresora (Windows)
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# Inicio > Transferir plantillas a la impresora (P-touch Transfer Manager) (Windows) > Transferir plantillas a la
impresora con P-touch Transfer Manager (Windows) > Copia de seguridad de plantillas u otros datos
guardados en la impresora (Windows)

Copia de seguridad de plantillas u otros datos guardados en la

impresora (Windows)

ﬁ + Las plantillas u otros datos de la copia de seguridad no se pueden editar en la computadora.

+ Segun el modelo de la impresora, es posible que no se puedan transferir copias de seguridad de
plantillas o datos entre diferentes modelos.

1. Conecte la computadora a la rotuladora electrénica, y encienda la rotuladora electrénica.

El nombre de modelo de la impresora aparecera junto a un icono de impresora en la vista carpeta. Si
selecciona la impresora en la vista de carpeta, apareceran las plantillas actuales y otros datos almacenados
en la impresora.

2. Seleccione la impresora desde la que desea realizar las copias de seguridad y haga clic en Copia de

seguridad.
5 Brother XX-XXXX - P-touch Transfer Manager — O *
Archive Edicién  Ver Herramientas Ayuda
= — | =ty Impresora:
FE *i!j_l . Ny .
. ; i ; Todas las impresoras =~ ~
Copia de seguridad Buscar Vistas
:] P-touch Library Moembre de transferencia ~ Tamafio  Tipe Fecha Asignacién de clave  Nombre de la base de dat
E‘i Z_Td"s fos glementes R KB Plantilla 01/07/19 03:25 1
E; tro B Blco KB Plantilla 01/07/19 03:25 2
ementos eliminades : ;
= -
B, Resiltidos el e address 1KE  Plantilla 01/07/19 03:25 3
_,i Transfer Manager
-] PC (Brother XX-XXXX 3
%5 Configuraciones
) Copias de seguridad
[| PC (Brother Xx-3000% )
[TR Erother X000
£ >
Se ha seleccionado contenido multiple.
Para obtener ayuda, pulse F1 MUM

Aparecera un mensaje de confirmacion.

3. Haga clic en Aceptar.

Se creara una nueva carpeta en la impresora en la vista carpeta. El nombre de la carpeta se basa en la hora
y fecha de la copia de seguridad. Todas las plantillas y los otros datos de la impresora se transfieren a la
nueva carpeta y se guardan en la computadora.

71 ‘. .
Lg;j Informacion relacionada

» Transferir plantillas a la impresora con P-touch Transfer Manager (Windows)
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# Inicio > Transferir plantillas a la impresora (P-touch Transfer Manager) (Windows) > Transferir plantillas a la
impresora con P-touch Transfer Manager (Windows) > Eliminacion de datos de la impresora (Windows)

| Eliminacion de datos de la impresora (Windows)

Para eliminar todas las plantillas y demas datos guardados en la impresora, haga lo siguiente:
1. Conecte la computadora a la rotuladora electrénica, y encienda la rotuladora electronica.

El nombre de modelo de la impresora aparecera junto a un icono de impresora en la vista carpeta.

2. Haga clic con el botén derecho del ratén en la impresora y, a continuacion, seleccione el menu Eliminar

todo.

@ Brother 30030000 - P-touch Transfer Manager

Archive  Edicion  Ver

Copia de seguridad

Herramientas  Ayuda

%A

Buscar

Impresora:

Todas las impresoras v

[FZ] P-touch Library

Todos los elementos e
“# Filtro CD
Elementos eliminados dd
&) address

", Resultados de la busqueda
Transfer Manager

&) PC (Brother }x{-x00( )
*:zj Configuraciones

1)) Copias de seguridad

PC (Brother XX-200
PR Brother X000

3

)

Eliminar tode

Configuracion de impresora..

Propiedades...

MNombre de transferencia

Vistas

Tamafio Tipo Fecha
1KB  Plantilla 01/07/19 03:25
1KB  Plantilla 01/07/19 03:25
1KB  Plantilla 01/07/19 03:25

Asignacion de clave
1
2
3

MNombre de la base de dat

o contenido multiple.

NUM

Aparecera un mensaje de confirmacion.

P-touch Transfer Manager

;Desea continuar?

Se eliminaran todos los datos de la impresora.

Cancelar

3. Haga clic en Aceptar.

Se eliminaran todas las plantillas y los demas datos guardados en la impresora.

u Informacion relacionada

» Transferir plantillas a la impresora con P-touch Transfer Manager (Windows)
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# Inicio > Transferir plantillas a la impresora (P-touch Transfer Manager) (Windows) > Transferir plantillas a la
impresora con P-touch Transfer Manager (Windows) > Crear archivos de transferencia y archivos de paquete
de transferencia (Windows)

Crear archivos de transferencia y archivos de paquete de transferencia
(Windows)

Computadora 1

P-touch Editor

Crear plantilla

Transferir plantilla

P-touch Transfer Manager P-touch Transfer
Express
Crear un archivo de paquete de E:">
plantilla Xxx.pdz
xxx.blf i
xxx.pdz
J
Almacenamiento masivo Adjunto de correo
(BLF) electrénico P-touch
Transfer Express
(PDZ2)
A4
Impresora Computadora 2

P-touch Transfer
Express

¢ ]
P-touch Transfer L
Express (PDZ)

Método de transferencia de plantillas Formato de archivo

Desde una computadora P-touch Transfer Express PDZ

1. Cree la plantilla utilizando P-touch Editor y, seguidamente, transfiérala a P-touch Transfer Manager.

ﬁ * Mas informacién »>» Informacion relacionada

» Al transferir una nueva plantilla, asegurese de especificar un nimero de Asignacion de clave (en P-
touch Transfer Manager) que no se usa actualmente. Si el nUmero de Asignacion de clave especificado
ya esta en uso, la plantilla existente sera reemplazada por la nueva.

2. Sin conectar la rotuladora electrénica a la computadora, seleccione la carpeta Configuraciones en la
ventana de P-touch Transfer Manager y, a continuacion, seleccione la plantilla que desea guardar.

.ﬁ Puede seleccionar varias plantillas a la vez.

3. Haga clic en Archivo > Almacenar archivo de transferencia.

NOTA

El botén Almacenar archivo de transferencia aparece Unicamente si la rotuladora electrénica esta
desconectada de la computadora o sin conexion.

[ H-10159
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ﬁ » Si hace clic en el botdn Almacenar archivo de transferencia después de seleccionar
Configuraciones, todas las plantillas de la carpeta se guardan como archivo de transferencia (BLF) o
archivo del paquete de transferencia (PDZ).

» Se pueden combinar varias plantillas en un solo archivo de transferencia (BLF) o un archivo de paquete
de transferencia (PDZ).

4. En el campo Tipo, seleccione el formato de plantilla que desea y luego escriba el nombre y guarde la
planilla.

u Informacion relacionada

» Transferir plantillas a la impresora con P-touch Transfer Manager (Windows)
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# Inicio > Transferir plantillas a la impresora (P-touch Transfer Manager) (Windows) > Distribuir plantillas para
transferirlas a los usuarios sin usar P-touch Transfer Manager (Windows)

Distribuir plantillas para transferirlas a los usuarios sin usar P-touch
Transfer Manager (Windows)

Transfiera las plantillas a la impresora mediante P-touch Transfer Express.

Para descargar la ultima version de P-touch Transfer Express, vaya a la pagina Descargas de su modelo en la
pagina web de soporte de Brother en support.brother.com.

ﬁ « Al transferir una nueva plantilla, asegurese de especificar un nimero de Asignacion de clave (en P-
touch Transfer Manager) que no se usa actualmente. Si el numero de Asignacion de clave especificado
ya esta en uso, la plantilla existente sera reemplazada por la nueva.

» Esta funcién requiere una conexion USB.

Administrador Usuarios

T Péagina web de asistencia

1 . de Brother I Transfer Express
J_ support.brother.com 1

P-touch P-touch P-touch
Editor Transfer Manager Transfer Express
3 & @
D D |:> D ptfilodl  PiTiExpexe  PrTvExpini
XXX.Ibx xxx.lox  xxx.pdz TRORVAI  wnzpR2dll  xocpdz
l Il | l
[ 2. 11 3. 1 [

>> Tareas del administrador
>> Tareas del usuario

Tareas del administrador

>> Como preparar P-touch Transfer Express

>> Transferir una plantilla a P-touch Transfer Manager

>> Guardar la plantilla como archivo de paquete de transferencia (PDZ)

>> Distribuir el archivo de paquete de transferencia (PDZ) y P-touch Transfer Express a otros

Coémo preparar P-touch Transfer Express

Antes de utilizar P-touch Transfer Express, es necesario instalar el controlador de la impresora.

ﬁ P-touch Transfer Express solo se encuentra disponible en inglés.

1. Descargue P-touch Transfer Express en cualquier ubicacion de su computadora.
2. Descomprima el archivo descargado (ZIP).

Transferir una plantilla a P-touch Transfer Manager

ﬁ Para usar la funcion de transferencia de plantillas, utilice P-touch Editor 5.4. En un futuro, se actualizara P-
touch Editor 6.0.

1. Inicie el P-touch Editor @.
*  Windows 11:

Haga clic en Inicio > Brother P-touch > P-touch Editor o haga doble clic en el icono P-touch Editor en

el escritorio.
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*Dependiendo del sistema operativo de su computadora, la carpeta Brother P-touch puede que se cree o
no.

«  Windows 10:

Haga clic en Inicio > Brother P-touch > P-touch Editor o haga doble clic en el icono P-touch Editor en
el escritorio.

«  Windows 8.1:

Haga clic en el icono P-touch Editor en la pantalla Aplicacioneso haga doble clic en el icono P-touch
Editor en el escritorio.

Abra la plantilla que desea.
3. Haga clic en Archivo > Transferir plantilla > Transferir.

@ P-touch Editor - [Disefio2]

- X
@) Archivo | Edicién Ver Insertar Formato Herramienta Diseio Ventana Ayuda
Nuevo... Ctrl+N m
v
Abrir, -0 |E] I,I
Nue Cerar Culsw  |magen Fa Imprimir | Guardar
Guardar s N v [~ EYl e B 2 Compra
P T T T T T T T T T B e Y Y e T T S AT N ey
Guardar en web
M Transferir plantilla > Vista preliminar
Base de datos Lol
Configurar impresora/pagina
Vista preliminar
y Imprimir... Ctri+P
Propiedades del disefio. Ctrl+L
Archivos usados recientemente
s Salir
[ Tamafio libre =
Dir —
- @Textoh -
A=t © Texto horizontal =
O Texto vertical 2
=
Hoia 1
Srotesaloon Brother - [15%

La plantilla se transfiere a P-touch Transfer Manager. Se inicia P-touch Transfer Manager.
Guardar la plantilla como archivo de paquete de transferencia (PDZ)
Para crear un archivo en un formato que se pueda emplear con P-touch Transfer Express, guarde la plantilla
como archivo de paquete de transferencia (PDZ).
1. Seleccione la carpeta Configuraciones en la ventana de P-touch Transfer Manager.

2. Seleccione la plantilla que desea distribuir.
3. Haga clic en Archivo > Almacenar archivo de transferencia.

;ﬁ * Laopcion Almacenar archivo de transferencia aparece Unicamente si la impresora esta
desconectada de la computadora o sin conexién.

» Sihace clic en la opcién Almacenar archivo de transferencia después de seleccionar la carpeta
Configuraciones o una carpeta creada, se guardaran todas las plantillas de la carpeta como archivo
de paquete de transferencia (PDZ).

» Se pueden combinar varias plantillas en un solo archivo de paquete de transferencia (PDZ).
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4. Escriba el nombre y, a continuacion, haga clic en Guardar.

45 Guardar comao *
& + 4 MM » Esteequipo » Escritorio » v O Buscar en Escritorio 2

Organizar « MNueva carpeta sE T o

3 Acceso rapido

& OneDrive
[ Este equipo
o Red
Mombre: | Layout] i
Tipo: Transferir archive de paquetes (*.pdz) ~

# Ocultar carpetas Guardar Cancelar

La plantilla se guardara como archivo de paquete de transferencia (PDZ).

Distribuir el archivo de paquete de transferencia (PDZ) y P-touch Transfer Express
a otros

.ﬁ Si ya descarg6 P-touch Transfer Express, no sera necesario que el administrador envie la carpeta de
Transfer Express. En este caso, puede simplemente mover el archivo del paquete de transferencia
distribuido a la carpeta descargada vy, luego, hacer doble clic en el archivo PtTrExp.exe.

1. Mueva el archivo del paquete de transferencia (PDZ) a la carpeta de descargas.

[4 [ = | Transfer Express - D X
Inicio Compartir Vista (7]

4 [+ Transfer Express v @ | Buscaren Transfer Express r)

&

pfilot.dil PTrExp ReadMeEng ReadMelpn TRORV.dll unzip32.dil Layoutl.pdz

7elementos 1 elemento seleccionado 989 bytes

Layoutl.pdz

2. Distribuya todos los archivos de la carpeta de descargas a quien corresponda.
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Tareas del usuario

Coémo transferir el archivo de paquete de transferencia (PDZ) a su impresora

ﬁ No desconecte la electricidad mientras transfiere plantillas.

Encienda la rotuladora electronica.
Conecte la impresora a una computadora mediante un cable USB.
Haga doble clic en el archivo PtTrExp.exe que recibié del administrador.

Pon-~

Realice una de las siguientes acciones:

« Para transferir un solo archivo de paquete de transferencia (PDZ) dentro de la carpeta que contiene el
archivo PtTrExp.exe, haga clic en Transfer.

« Para transferir varios archivos de paquete de transferencia (PDZ) dentro de la carpeta que contiene el
archivo PtTrExp.exe, haga lo siguiente:

a. Haga clic en Browse.

@ P-touch Transfer Express it

= Select the Transfer Package file to be transferred to the printer.
@ Then, click the Transfer button to begin transferring.

Transfer Package File:

|| Browse...

_Eowse. |
%21 Transfer Exit

b. Seleccione el archivo de paquete de transferencia que desea transferir y, a continuacion, haga clic en
Abrir.

c. Haga clic en Transfer.

d. Haga clic en Yes.
5. Al finalizar, haga clic en OK.

L‘g Informacion relacionada

» Transferir plantillas a la impresora (P-touch Transfer Manager) (Windows)
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# |nicio > Almacenar y administrar plantillas (P-touch Library)

| Almacenar y administrar plantillas (P-touch Library)
» Editar plantillas con P-touch Library (Windows)
* Imprimir plantillas con P-touch Library (Windows)

* Buscar plantillas con P-touch Library (Windows)
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# [nicio > Almacenar y administrar plantillas (P-touch Library) > Editar plantillas con P-touch Library

(Windows)

| Editar plantillas con P-touch Library (Windows)

1. Inicie P-touch Library.

*  Windows 11:
Haga clic en Inicio > Brother P-touch > P-touch Library.

*Dependiendo del sistema operativo de su computadora, la carpeta Brother P-touch puede que se cree o

no.
*  Windows 10:

Haga clic en Inicio > Brother P-touch > P-touch Library.
*  Windows 8.1:

Haga clic en el icono P-touch Library en la pantalla Aplicaciones.

Aparecera la ventana principal.

% Todos los elementos - P-touch Library

Archive Edicion Ver Herramientas Ayuda

= &

Abrir

Buscar Vistas

=] P-touch Library

5} Todos los elementos

Elementos eliminados
L. Resultades de la bisqueda

Para obtener ayuda, pulse F1

Mombre
@ ABC.Ibx

a Brother.lbx
@ P-touch.lbx

Tamafic Fecha

1KB  21/01/2019 2:02:15
1KB  21/01/2019 2:02:42
2KB  21/01/2019 2:03:03

Localizacién

C\Users\WM138_WIN10\Documents\Mis etiquetas\ ABC.lbx
C:\Users\WIM138_WIN10\Documents'Mis etiquetas\Brother.lbx
C\Usersi\WM138_WIN10\Documents\Mis etiquetas\P-touch.lbx

NUM

Informacién general sobre los iconos de la barra de herramientas

Icono Nombre del boton Funcién
lf}} Abrir Haga clic para abrir la plantilla seleccionada.
b,jj Imprimir Haga clic para imprimir la plantilla seleccionada.
) Buscar Haga clic para buscar plantillas registradas en P-touch
» Library.
Vistas Haga clic para cambiar el estilo de visualizacion de archivos.

2. Seleccione la plantilla que desea editar y luego haga clic en Abrir.

Ahora puede editar la plantilla.

u Informacion relacionada

* Almacenar y administrar plantillas (P-touch Library)
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# |nicio > Almacenar y administrar plantillas (P-touch Library) > Imprimir plantillas con P-touch Library

(Windows)

| Imprimir plantillas con P-touch Library (Windows)

1. Inicie P-touch Library.
*  Windows 11:

Haga clic en Inicio > Brother P-touch > P-touch Library.

*Dependiendo del sistema operativo de su computadora, la carpeta Brother P-touch puede que se cree o

no.
*  Windows 10:

Haga clic en Inicio > Brother P-touch > P-touch Library.
*  Windows 8.1:

Haga clic en el icono P-touch Library en la pantalla Aplicaciones.

Aparecera la ventana principal.

& Todos los elementos - P-touch Library

Archive Edicidn  Ver

Herramientas  Ayuda

o=

F29 A

Abrir Imprimir Buscar Vistas
:] P-touch Library MNoembre Tamarnc Fecha Localizacién
o lo=elementos [@ ABC.Ibx KB 21/01/20192:0215  C:\Users\YM138 WIN10\Documents\Mis etiquetas\ABC.Ibx
9 £ sincuisslycs @) Brother.lbx KB 21/01/20192:02:42  CAUsers\WM133_ WIN10\Documents\Mis etiquetas\Brother.lbx
T R @ P-touch.lbx KB 21/D1/20192:0203  CAUsers\VM138_WINTO\Documents\Mis etiquetas\P-touch.lbx

Para obtener ayuda, pulse F1

NUM

2. Seleccione la plantilla que desea imprimir y luego haga clic en Imprimir.

La rotuladora conectada imprimira la plantilla.

m Informacion relacionada

» Almacenar y administrar plantillas (P-touch Library)
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# Inicio > Almacenar y administrar plantillas (P-touch Library) > Buscar plantillas con P-touch Library

(Windows)

| Buscar plantillas con P-touch Library (Windows)

1. Inicie P-touch Library.
*  Windows 11:

Haga clic en Inicio > Brother P-touch > P-touch Library.

*Dependiendo del sistema operativo de su computadora, la carpeta Brother P-touch puede que se cree o

no.
*  Windows 10:

Haga clic en Inicio > Brother P-touch > P-touch Library.

*  Windows 8.1:

Haga clic en el icono P-touch Library en la pantalla Aplicaciones.

Aparecera la ventana principal.

& Todos los elementos - P-touch Library

Archive Edicién  Ver

& B A

Herramientas  Ayuda

Abrir Imprimir Buscar Vistas
:] P-touch Library MNombre Tamafic Fecha Localizacién
°‘i°5 o= E’“““S [@ ABC.Ibx KB 21/01/20192:02:15  C:\Users\VIM138_WIN10\Documents\Mis etiquetas\ABC.Ibx
: Re"”l‘:”;“ed””l“”s_ e ; @) Brother.lhx 1KB 21/01/20192:02:42  CAUsers\VM138_WIN10\Documents\Mis etiquetas)\Brother.lbx
R PP AR S 5 @) P-touch.lbx KE 21/01/201920303  CAUsers\UM132 WIN10\Documents\Mis etiquetas\P-touch.lbx
£ »

Para obtener ayuda, pulse F1

NUM

2. Haga clic en Buscar.
Aparece el cuadro de dialogo Buscar.
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&
Archivo Edicion Ver Herramientas Ayuda
=E § \1 -
5w QA
Abrir Imprimir Buscar Vistas
] P-touch Library Membre Tamafic Fecha Localizacion
-G ;"d"s la E'Tm?”tzs @ ABC.Ibx KB 21/01/20192:0215  C:\Users\WM138 WIN10\Documents\Mis etiquetas\ABC.Ibx
. tementos ehminados @) Brother.Ibx KB 21/01/2019 20242 C:\Users\VM138_WINT0\Documents\Mis etiquetas\Brother.lbx
- Resultados de la bisqueda 5 T
@) pram—vu SR S S e R R ~145¢ etiquetas\P-touch.Ibx
Buscar =
Pardmetros muiltiples ®y Oo
|
[ IMombre | CONTIENE v |
|
U Tie Disefio (Ibx;lbl;lbp;mbi) | | CONTIENE v
< [ Tamafio Desde 0 = KB > |
Hasta |0 = kB ~ :
[IFecha Desde  |21j01/2019 [E~
Hasta 2012019 [E~
Cerrar |
v

Para obtener ayuda, pulse F1 NUM l
3. Especifique los criterios de busqueda.

Dispone de los siguientes criterios de busqueda:

Configuracion Detalles

Parametros multiples Determina la forma en que el programa busca cuando
se especifican varios criterios. Si se selecciona Y, el
programa busca archivos que reunan todos los
criterios. Si se selecciona O, el programa busca
archivos que reunan cualquiera de los criterios.

Nombre Le permite buscar una plantilla especificando el nombre
del archivo.

Tipo Le permite buscar una plantilla especificando el tipo del
archivo.

Tamaio Le permite buscar una plantilla especificando el tamafo
del archivo.

Fecha Le permite buscar una plantilla especificando la fecha
del archivo.

4. Haga clic en Iniciar busqueda.
La busqueda comienza y se muestran los resultados de busqueda.
5. Cierre el cuadro de dialogo Buscar.

Para confirmar los resultados de la busqueda, haga clic en Resultados de la busqueda en la vista de
carpeta.

.ﬁ Puede registrar plantillas en P-touch Library arrastrando y soltando las plantillas en la carpeta Todos los
elementos o en la lista de carpetas.

u Informacion relacionada

» Almacenar y administrar plantillas (P-touch Library)
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# |nicio > Mantenimiento rutinario

| Mantenimiento rutinario

* Mantenimiento

(ULINE JERES
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#& Inicio > Mantenimiento rutinario > Mantenimiento

! Mantenimiento

Extraiga siempre las baterias y desconecte el adaptador de CA antes de limpiar la impresora de etiquetas.

>> Limpiar la unidad
>> |Limpie el cabezal de impresion
>> Limpieza del cortador de cinta

Limpiar la unidad

1. Limpie el polvo y las marcas de la impresora de etiquetas con un pafio suave y seco.
2. Use un pafo ligeramente humedecido para limpiar las marcas dificiles de quitar.

ﬁ No utilice disolvente para pintura, benceno, alcohol ni otros disolventes organicos, Ya que pueden deformar
o dafar la parte exterior de la impresora de etiquetas.

Limpie el cabezal de impresién

Los caracteres que aparecen con manchas o con poca calidad en las etiquetas impresas indican generalmente
que el cabezal de impresion esta sucio.

Limpie el cabezal de impresion con un bastoncillo de algoddn o con el casete limpiador del cabezal de impresion
opcional (TZe-CL4).

N

ﬁ - No toque directamente el cabezal de impresion con las manos.
- Leay siga las instrucciones que encontrara en el casete limpiador del cabezal de impresion.

Limpieza del cortador de cinta

El adhesivo de la cinta puede acumularse y desgastar la cuchilla del cortador después de varios usos, lo cual
provocara que la cinta se atasque en el cortador.

[ H-10159

PAGE 294 OF 464 1-800-295-5510 1023 IH-10159VND



Una vez al afo, limpie la cuchilla del cortador con un bastoncillo de algodén impregnado con alcohol isopropilico
(alcohol para uso externo).

ﬁ - No toque la cuchilla del cortador con las manos desprotegidas.
- Utilice alcohol isopropilico siguiendo las pautas de seguridad del fabricante, segun corresponda.

u Informacion relacionada

¢ Mantenimiento rutinario

[ H-10159

PAGE 295 OF 464 1-800-295-5510 1023 IH-10159VND



# |nicio > Solucion de problemas

| Solucién de problemas
» Si esta teniendo problemas con la rotuladora electrénica

* Mensajes de error y de mantenimiento

Consultar la informacion de la version

» Restauracion de la impresora de etiquetas
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# Inicio > Solucion de problemas > Si esta teniendo problemas con la rotuladora electronica

| Si esta teniendo problemas con la rotuladora electrénica

En este capitulo, se explica como resolver los problemas tipicos que pueden surgir cuando usa la rotuladora

electronica.

Si los problemas persisten »» Informacién relacionada Si sigue sin poder solucionar el problema después de
leer la informacidn, visite la pagina web de soporte de Brother en support.brother.com.

Problema

Solucion

La rotuladora electrénica no
imprime.

Verifique que el casete de cinta se encuentre correctamente insertado.

» Si el casete de cinta esta vacio, sustituyalo. Para pedir suministros y accesorios,
visite www.brother-usa.com.

» Verifique que la cubierta del compartimiento de casete de cinta esté bien cerrada.
» Verifique que la rotuladora electrénica esté encendida.

» Verifique que la configuraciéon de Bluetooth del dispositivo mévil o de la
computadora esté activada.

» Verifique que la rotuladora electrénica esté conectada a su computadora o
dispositivo movil mediante Bluetooth.

» Verifique que la rotuladora electrénica esté seleccionada en la aplicacién Brother
iPrint&Label.

» Verifique que la rotuladora electrénica no esté emparejada con otro dispositivo.
» Asegurese de que la rotuladora electronica y su dispositivo movil o computadora
estén suficientemente cerca para establecer una comunicacion.

» Verifique que la configuracion de reconexién automatica de Bluetooth de otra
computadora o dispositivo movil no esté habilitada.

» Asegurese de que no haya cerca dispositivos que emitan ondas de radio (por
ejemplo, un microondas).

» Verifique que se haya instalado el controlador correcto de la impresora cuando
imprima desde una computadora.

» Conecte la rotuladora electrénica a su computadora con el cable USB (incluido)
cuando imprima desde una computadora.

» Si el cabezal de impresion esta sucio, limpielo con un bastoncillo de algodén y, de
manera opcional, con un casete limpiador del cabezal de impresion (TZe-CL4).

* Lacinta no circula
correctamente.

» Lacinta se ha quedado
atascada dentro de la
rotuladora electronica.

« Sila cinta esta doblada, corte la seccion doblada.

+ Sila cinta esta atascada, retire el casete de cinta, extraiga la cinta atascada y corte
cualquier parte de la cinta que esté dafada.

» Verifique que el extremo de la cinta sale por fuera de la guia de la cinta.
Confirme que la cinta apunta hacia la ranura de salida de la cinta.
* Quite el casete de cinta e introdizcalo de nuevo.

Se ha producido un error al
utilizar una aplicacion movil.

Vaya al menu de configuracién de aplicaciones méviles y seleccione Support (Ayuda)
> Preguntas frecuentes y Solucién de problemas.

La pantalla esta bloqueada.

* Restaure la memoria interna a la configuracion de fabrica. Mas informacion »»
Informacion adicional

» Desconecte el adaptador de CA y quite las baterias al menos 10 minutos.

La pantalla LCD permanece
en blanco después de
encenderla.

Verifique que las baterias estan bien puestas y que el adaptador de CA incluido con la
rotuladora electronica esta bien conectado.

Los mensajes en la pantalla
LCD se muestran en un
idioma extranjero.

Configure el idioma de la pantalla LCD que desee. Mas informacion »» Informacién
adicional

La rotuladora electronica se
para mientras esta
imprimiendo una etiqueta.

Reemplace el casete de cinta si ve que hay un trozo de cinta rayada, ya que eso
indica que se ha llegado al final de la cinta.

» Reemplace todas las baterias o conecte el adaptador de CA directamente a la
rotuladora electrénica.
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Problema

Solucién

Los archivos de etiquetas
guardados previamente no
estan disponibles.

Todos los archivos que se guardan en la memoria interna se borran cuando queda
poca bateria o cuando se desconecta el adaptador de CA.

» No puedo instalar el
controlador de la
impresora incluso
siguiendo el
procedimiento
adecuado. (Windows)

* No puedo ver mi
impresora en P-touch
Editor incluso habiendo
instalado el controlador
de la impresora.
(Windows)

Si no puede usar la rotuladora electronica incluso habiendo instalado el controlador de
la impresora:

1. Descargue el desinstalador del controlador de la impresora del modelo
correspondiente en la pagina support.brother.com.

2. Utilice el desinstalador del controlador de la impresora para eliminar la informacién
sobre la impresora.

3. Ejecute el instalador del controlador de la impresora de nuevo y siga las
instrucciones que aparecen en la pantalla para realizar la instalacion.

La cinta de tinta esta
separada del rodillo de
tinta.

Si la cinta de tinta esta en mal estado, sustituya el casete de cinta. Si no es asi, no
corte la cinta y quite con cuidado el casete de cinta. A continuacién, enrolle de nuevo
en el carrete la cinta de tinta que se habia separado.

Los cddigos de barras o
codigos QR impresos no
pueden leerse.

» Cambie la cinta. (Recomendado: cinta de texto negro sobre fondo blanco)

* Amplie los codigos de barras o codigos QR con la aplicacion de cédigo de barras, si
es posible.

No conozco el nimero de
version del firmware de la
rotuladora electronica.

Puede confirmar el numero de versién de firmware y otra informacioén en la pantalla
LCD. Mas informacion »» Informacién adicional

Cuando se imprime una
etiqueta, hay mucho
margen (espacio) en ambos
lados del texto.

» Seleccione las opciones Mrgen pquefio, Cadena 0 Sin corte para tener
margenes mas pequefios.
Mas informacion »» Informacién adicional

» Después de imprimir la tltima etiqueta, pulse y de manera simultanea

para poner la cinta y, a continuacion, expulse y corte la ultima etiqueta. Tenga en
cuenta que, al emplear este método, la impresora de etiquetas requiere
aproximadamente de 23 mm (0,9 pulgadas) de cinta en blanco para procesar la
siguiente etiqueta.

El tamafio de la fuente no
se puede aumentar.

La fuente ya esta al tamafio maximo para el ancho de la etiqueta o la longitud de la
etiqueta ya se ha establecido, asi que hay un limite de tamafio de fuente para no
sobrepasar la longitud establecida.

Cuando se imprimen varias
etiquetas, la ultima etiqueta
se corta de manera
incorrecta.

Cuando Cadena se activa, ponga la cinta para expulsar la ultima etiqueta impresa.

No puedo actualizar el
firmware de la impresora
con P-touch Update
Software, Transfer Express,
o la herramienta de
actualizacion de Mac.

Reinicie la impresora e intente de nuevo actualizar el firmware. No pulse ningun botén
durante la actualizacion del firmware hasta que se muestre la pantalla de inicio
automaticamente.

La impresora de etiquetas
no funciona con
normalidad.

* Restaure la memoria interna a la configuracién de fabrica. Mas informacion »>»
Informacion adicional

» Desconecte el adaptador de CA y quite las baterias al menos 10 minutos.
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Informacion relacionada

« Solucién de problemas

Informacién adicional:

» Restauracion de la impresora de etiquetas
» Configurar el idioma

* Consultar la informacion de la version

» Opciones de corte de la cinta

(ULINE JER[E
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# Inicio > Solucion de problemas > Mensajes de error y de mantenimiento

| Mensajes de error y de mantenimiento

Mensaje Causalsolucién

iError c.barras! Se ha intentado imprimir etiquetas de cddigo de barras desde una base de datos.

Reg. n.° :XXXXX La rotuladora electronica muestra un mensaje cuando el rango de la base de datos

Campo n.° :XXXXX seleccionada incluye caracteres no validos o nimeros que no son compatibles con el
protocolo de cédigo de barras.

iError del sistema Contacte al servicio de atencién al cliente de Brother.

XX

iEtig demas. larga! La longitud de la etiqueta impresa con el texto introducido es mas larga de 999 mm

(39,37 pulgadas). Modifique el texto para que la longitud de la etiqueta sea menor de
999 mm (39,37 pulgadas).

iFallo en cortador! Si la cinta esta atascada en la unidad de corte, elimine la cinta. Apague la rotuladora
electronica y, a continuacion, vuelva a encenderla antes de continuar.

Cheqg. n.° dig. El numero de digitos introducidos en el cédigo de barras no coincide con el numero de

intrd. digitos establecido en la configuracion del cédigo de barras. Introduzca el nimero de

digitos correcto.

Txt. demas. largo La longitud de la etiqueta impresa con el texto introducido es mas larga que la
configuracion establecida. Modifique el texto para adaptarlo a la longitud establecida o
cambie los parametros de longitud.

u Informacion relacionada

» Solucién de problemas
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# Inicio > Solucion de problemas > Consultar la informacion de la version
| Consultar la informacién de la version

Puede confirmar el numero de version de firmware y otra informacion en la pantalla LCD. Puede que necesite
esta informacion si llama a Brother con alguna pregunta técnica o sobre la garantia.

1. Pulse .

2. Pulse 40P para mostrar [Configur.] Y, a continuacion, pulse OK.

3. Pulse A 0 Y paramostrar [Informacién de versidn] y, a continuacion, pulse OK.

u Informacion relacionada

» Solucion de problemas
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# |nicio > Solucion de problemas > Restauracion de la impresora de etiquetas
| Restauracion de la impresora de etiquetas

Restablezca la memoria interna de su impresora de etiquetas para borrar todos los archivos de etiqueta
guardados o si la impresora de etiquetas no funciona correctamente.

* Restaurar con la pantalla LCD
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# Inicio > Solucion de problemas > Restauracion de la impresora de etiquetas > Restaurar con la pantalla
LCD

| Restaurar con la pantalla LCD

1. Pulse .

2. Pulse 40 » para mostrar [Configur.] Y, a continuacion, pulse OK.

3. Pulse A 0 Y para mostrar [Restablecer] Y, a continuacion, pulse OK.

4. Pulse A o Y para mostrar cémo restaurar y, a continuacion, pulse OK.
Aparecera un mensaje para que confirme la opcién de restauracion.

5. Pulse OK.

ﬁ Si utiliza las opciones de restaurar [Restablecer configuracién] 0 [Configuracidn
predeterminadal], necesitara configurar de nuevo su idioma predeterminado después de la

restauracion.

Opciones de restauracion Detalles

Restablecer La memoria de archivos NO se borra.

configuracion Los datos de configuracién se borran y se restaura toda la configuracion a la
configuracién de fabrica.

Borrar contenido La memoria de archivos se borra.
Los datos de configuracién NO se borran y la configuracion permanece tal y como
esta establecida.

Configuracidn Se restauran la memoria de archivos, las etiquetas y configuraciones

predeterminada personalizadas a la configuracién de fabrica.

M Informacion relacionada

» Restauracion de la impresora de etiquetas
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# |nicio > Apéndice
| Apéndice
» Especificaciones

* Ayuda de Brother y Atencion al cliente
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# Inicio > Apéndice > Especificaciones

| Especificaciones

>> |mpresion
>> Tamafo
>> |Interfaz
>> Entorno

>> Fuente de alimentacion
>> Material informatico

>> Memoria

>> Sistemas operativos compatibles

Impresién

(dependiendo del dispositivo multimedia utilizado)

Velocidad de impresion Aproximadamente 30 mm (1,18”) /' s

Altura maxima de impresion

18 mm (0,71”) (cuando se utiliza cinta de 24 mm /0,94”) !

1 Es posible que el tamario de caracter actual sea mas pequefio que la altura maxima de impresion.

Tamano

Peso Aproximadamente 990 g (aproximadamente 2,2 Ib) (sin pilas ni casete de cinta)

Dimensiones | Aproximadamente 202 mm (ancho) x 87 mm (alto) x 199 mm (profundidad) (aproximadamente 7,95”
[ancho] x 3,42” [alto] x 7,83 [profundidad])

LCD 320 ppp x 120 ppp
Interfaz
uUsB USB versién 2.0 (velocidad méaxima) (micro B)

Bluetooth

Bluetooth version 5.0
SPP: iAP2

Entorno

Temperatura de funcionamiento Entre 10 °C y 35 °C (entre 50 °F y 95 °F)

Humedad de operacion Entre 20% y 80%

Temperatura maxima en termémetro de bulbo humedo: 27 °C (80,6 °F)

Fuente de alimentacion

Bateria

Seis pilas alcalinas AA (LR6)
Adaptador de CA (AD-E001A)

Material informatico

Ancho de la cinta

Casete de cinta TZe estandar:
3,5 mm (0,13”), 6 mm (0,23"), 9 mm (0,35”), 12 mm (0,47”), 18 mm (0,70”), 24 mm (0,94”")

N.° de lineas

Cinta de 24 mm (0,94”): 1-7 lineas
Cinta de 18 mm (0,70”): 1-5 lineas
Cinta de 12 mm (0,47”): 1-3 lineas
Cinta de 9 mm (0,35”): 1-2 lineas
Cinta de 6 mm (0,23”): 1-2 lineas
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Cinta de 3,5 mm (0,13”): 1 linea

Memoria
Bufer de texto Maximo 280 caracteres
Almacenamiento de archivos Maximo 99 archivos

Sistemas operativos compatibles

Para consultar la lista mas reciente de software admitido, visite support.brother.com.

u Informacion relacionada

* Apéndice
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# Inicio > Apéndice > Ayuda de Brother y Atencion al cliente

| Ayuda de Brother y Atencién al cliente

Para obtener ayuda técnica, debe llamar al pais en el que compré el equipo. Las llamadas se deben realizar
desde dentro de ese pais.

>> Preguntas frecuentes (FAQ)
>> Para el Servicio de atencion al cliente
>> Pedido de accesorios y consumibles

Preguntas frecuentes (FAQ)

Para obtener mas informacién sobre el equipo Brother, visite la pagina web de soporte de Brother en
support.brother.com. Para obtener mas ayuda y sugerencias, vaya a la pagina Preguntas frecuentes y
Solucion de problemas del modelo; para obtener los controladores y software mas recientes, vaya a la pagina
Descargas del modelo.

Para el Servicio de atencion al cliente

En EE. UU.:
www.brother-usa.com/support (autoservicio/correo electronico/chat)
1-877-BROTHER (1-877-276-8437)

En Canada:
www.brother.ca/support

(ayuda con videos de autoservicio, correo electronico, chat, Facebook y Twitter)

Localizador de centros de servicio (EE. UU. Gnicamente)

Si desea conocer la ubicaciéon de un centro de servicio autorizado de Brother, llame al 1-877-BROTHER
(1-877-276-8437) o visite www.brother-usa.com/support.

Ubicaciones de los centros de servicio técnico (solo Canada)

Si desea conocer la ubicacion de un centro de servicio autorizado de Brother, visite www.brother.ca/support.

Pedido de accesorios y consumibles

Para obtener resultados 6ptimos, utilice solo consumibles originales de Brother, disponibles en la mayoria de los
proveedores de Brother. Si no puede encontrar los suministros que necesita y tiene una tarjeta de crédito Visa,
MasterCard, Discover, American Express o una cuenta PayPal, puede pedirlos directamente desde Brother.
Visite nuestro sitio en linea para acceder a la seleccion completa de accesorios y consumibles de Brother
disponibles para su compra.

NOTA

En Canada solo se aceptan las tarjetas Visa y MasterCard.

En EE. UU.:
1-877-BROTHER (1-877-276-8437)

www.brother- m/support
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En Canada:

www.brother.ca

Informacion relacionada

* Apéndice
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| Avant d'utiliser votre étiqueteuse
» Définition des remarques
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# Accueil > Avant d'utiliser votre étiqueteuse > Définition des remarques
| Définition des remarques

Le présent guide de l'utilisateur utilise les symboles et conventions suivants :

A DANGER DANGER signale une situation particulierement dangereuse qui, si elle n'est pas
évitée, provoquera des blessures physiques graves, voire mortelles.

A AVERTISSEMENT signale une situation potentiellement dangereuse susceptible
de provoquer des blessures physiques graves, voire mortelles.

AVERTISSEMENT

ATTENTION indique une situation potentiellement dangereuse qui, si elle n’est pas
A ATTENTION évitée, peut provoquer des blessures mineures ou modérées.

IMPORTANT IMPORTANT indique une situation potentiellement dangereuse qui, si elle n’est
pas évitée, peut provoquer des dommages matériels ou une perte de fonctionnalité
du produit.

REMARQUE REMARQUE précise I'environnement d'exploitation, les conditions d'installation ou
des conditions d'utilisation spéciales.

% L'icone de conseils offre des conseils pratiques et des informations
supplémentaires.
Caractéres gras Les caractéres gras identifient les boutons sur le panneau de commande de
I'appareil ou sur I'écran de I'ordinateur.

Caracteres italiques Les caractéres italiques mettent en valeur un point important ou signalent un sujet
connexe.

Courier New La police Courier New sert a identifier les messages présentés sur I'écran LCD de
I'appareil.

7 .
v Renseignements connexes

* Avant d'utiliser votre étiqueteuse
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# Accueil > Avant d'utiliser votre étiqueteuse > Mesures préventives générales
| Mesures préventives générales

» Selon I'endroit, les matériaux et les conditions environnementales, I'étiquette peut se décoller ou devenir
indécollable; la couleur de I'étiquette peut également changer ou déteindre sur d’autres objets. Avant
d’apposer I'étiquette, vérifiez les conditions environnantes et le matériau. Testez I'étiquette en apposant une
petite partie de celle-ci a un endroit moins visible de la surface désirée.

+ Nutilisez PAS l'appareil, ses composants ou ses fournitures de quelque maniére que ce soit ou a des fins
non indiquées dans ce guide. Cela pourrait entrainer des accidents ou des dommages.

» Nutilisez que les rubans TZe de Brother avec I'étiqueteuse. N'utilisez PAS de rubans ne portant pas la
marque .

« Utilisez un chiffon doux pour nettoyer la téte d'impression; ne touchez jamais la téte d'impression.
+ N’essayez PAS d’imprimer si la cassette est vide; cela endommagerait la téte d’'impression.

* NE PAS tirer sur le ruban pendant I'impression ou I'alimentation; cela endommagerait le ruban et
I'étiqueteuse.

+ Toute donnée stockée en mémoire sera perdue en cas de panne ou de réparation de I'imprimante, ou si les
batteries se déchargent complétement.

» Les caractéres imprimés peuvent avoir un aspect différent de celui de I'apercu, car I'écran de votre appareil
ou de votre ordinateur peut avoir une résolution supérieure a celle de I'imprimante.

» Lalongueur de I'étiquette imprimée peut différer de celle de I'étiquette affichée.
+ Lorsque I'alimentation est coupée pendant deux minutes, le texte et les réglages de format sont perdus.

+ Veillez a lire les instructions fournies avec les rubans pour tissu thermocollants, les rubans adhésifs extra-
forts ou d’autres rubans spéciaux et a respecter toutes les précautions indiquées dans les instructions.

... Renseignements connexes

» Avant d'utiliser votre étiqueteuse
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# Accueil > Avant d'utiliser votre étiqueteuse > Marques de commerce et licences
| Marques de commerce et licences

* Android est une marque de commerce de Google Inc.
+ Google Play et le logo Google Play sont des marques de commerce de Google LLC.

+ Les logos et la marque de mot Bluetooth®MD sont des marques commerciales déposées appartenant &
Bluetooth SIG, Inc. et toute utilisation de ces marques par Brother Industries, Ltd. se fait sous licence. Les
autres marques de commerce et noms de commerce appartiennent a leurs propriétaires respectifs.

*+ QR Code est une marque de commerce déposée de DENSO WAVE INCORPORATED.
* Mac, iPad, iPhone et iPod touch sont des marques de commerce d’Apple Inc.
* QR Code Generating Program Droits d’auteur © 2008 DENSO WAVE INCORPORATED.

+ Certaines parties de ce logiciel sont protégées par copyright © 2014 The FreeType Project
(www.freetype.org). All rights reserved.

Tous les noms de marque et de produit de compagnies apparaissant sur les produits Brother, dans les
documents connexes et la documentation sont tous des marques de commerce ou des marques
déposées de ces compagnies respectives.

... Renseignements connexes

» Avant d'utiliser votre étiqueteuse
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# Accueil > Avant d’utiliser votre étiqueteuse > Remarque importante
| Remarque importante

» Le contenu de ce document et les spécifications de cette étiqueteuse peuvent étre modifiés sans préavis.

+ Brother se réserve le droit d’apporter, a tout moment et sans préavis, des modifications aux spécifications et
renseignements contenus dans ce document. Brother ne saurait étre tenu responsable de tout dommage (y
compris les dommages indirects) causé par la confiance portée aux renseignements présentés, y compris,
mais sans s’y limiter, les erreurs typographiques ou autres liées aux publications.

» Cette étiqueteuse ne prend pas en charge la connexion sans fil.

» Les images d’écran contenues dans ce document peuvent différer selon le systéeme d’exploitation de
I'ordinateur, votre modéle de produit et version logicielle.

+ Avant d'utiliser I'étiqueteuse, assurez-vous de lire tous les documents inclus avec I'étiqueteuse pour obtenir
de plus amples informations sur la sécurité et le fonctionnement.

+ Létiqueteuse présentée dans les illustrations peut différer de votre étiqueteuse.
» Les fournitures disponibles peuvent varier en fonction de votre pays ou de votre région.
+ |l est recommandé d’utiliser la derniére version de P-touch Editor.

» Pour maintenir les performances de votre étiqueteuse a jour, visitez support.brother.com pour vérifier les
derniéres mises a jour du micrologiciel. Sinon, certaines fonctions de votre étiqueteuse ne seront pas
disponibles.

+ Avant de transmettre I'étiqueteuse a un tiers, de la remplacer ou de la mettre au rebut, nous vous
recommandons vivement de rétablir ses paramétres d'usine par défaut afin d’effacer toutes les informations
personnelles qu'elle peut contenir.

... Renseignements connexes

* Avant d'utiliser votre étiqueteuse
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# Accueil > Configurer votre étiqueteuse

| Configurer votre étiqueteuse

Description des pieces

Apercu de I'écran ACL

Apercu du clavier

Brancher I'adaptateur secteur

Installer les piles

Insérer une cassette de ruban

Allumer et éteindre I'étiqueteuse

Définir la langue

Définir les unités de mesure

Définir le délai de mise hors tension automatique
Activer ou désactiver le Bluetooth
Activation/désactivation de la détection de la couleur du ruban
Ruban d’alimentation

Régler la luminosité de I'affichage

Définir le mode d’entrée
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# Accueil > Configurer votre étiqueteuse > Description des piéces

| Description des piéces
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Visualiseur de ruban

Ecran a cristaux liquides (ACL)

Couvercle du compartiment de la cassette de ruban
Compartiment de la cassette de ruban

Levier de déverrouillage

Téte d'impression

Coupe-ruban

© N OAWDN =

Clavier

©

Fente de sortie du ruban

10. Couvercle du compartiment des piles
11. Compartiment des piles

12. Port USB

13. Prise de I'adaptateur secteur

7l .
m Renseignements connexes

» Configurer votre étiqueteuse
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# Accueil > Configurer votre étiqueteuse > Apergu de I'écran ACL
| Apercu de I’écran ACL

Mode Apergu avant impression

1 2 34567 8

Eﬁii_L_ 2| |
—[B |1_234564J§ |

11 12
Mode Vue de I'étiquette

1 13 8

123456

11

1. Mode majuscules
Indique si le mode de verrouillage des majuscules est activé.
2. Police actuelle
Indique la police actuelle.
3. Taille des caractéres
Indique la taille actuelle des caractéres.
4. Style de caractére
Indique le style de caractére actuel.
5. Cadre
Indique si un cadre est défini.
6. Largeur
Indique la largeur de caractére.
7. Aligner
Indique I'alignement du texte.
8. Largeur du ruban x longueur de I’étiquette

La longueur de I'étiquette affichée sur I'écran ACL peut différer Iégérement de la longueur réelle de I'étiquette
lors de I'impression.

9. Numéro de bloc
Indique le numéro de bloc.
10. Numéro de ligne
Indique les numéros de ligne dans la mise en page de I'étiquette.

[ H-10159
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11. Curseur
Les nouveaux caractéres apparaissent a gauche du curseur.
Indique la position actuelle de la saisie de données.
12. Marquage de retour
Indique la fin d’'une ligne de texte.
13. Mise a I’échelle/Zoom
Modifie le grossissement de I'apergu.

u Renseignements connexes

» Configurer votre étiqueteuse
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#& Accueil > Configurer votre étiqueteuse > Apergu du clavier

| Apercu du clavier
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1. Alimentation
Appuyez pour allumer ou éteindre I'étiqueteuse.

2. Accueil/Bluetooth
Appuyez pour revenir a I'écran d’accueil. Pour activer ou désactiver le Bluetooth, appuyez simultanément sur
Accueil/Bluetooth et sur la touche Maj.
3. Effacer
Appuyez sur cette touche pour effacer tous les paramétres de texte et d’impression.
4. Echap
Appuyez pour annuler I'opération actuelle.
5. Curseur

Appuyez pour déplacer le curseur dans la direction de la fleche.
6. OK
Appuyez pour sélectionner I'option affichée.
7. Fonction
Appuyez pour sélectionner un menu de fonctions.
Pour afficher les attributs, appuyez simultanément sur la touche Fonction et sur la touche Maj.

g

Apercu/Alimentation et Coupe
Appuyez pour visualiser une image de I'étiquette avant I'impression.
Pour faire avancer le ruban, appuyez simultanément sur Apergu/Alimentation et Coupe et la touche Maj.
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9. Imprimer/Options d’impression
Appuyez pour imprimer.

Pour définir les options d’impression, appuyez simultanément sur Imprimer/Options d’impression et sur la
touche Maj.

10. Retour arriére
Appuyez pour supprimer tout caractére a gauche du curseur.
11. Accent
Appuyez pour sélectionner et insérer un caractére accentué.
12. Symbole
Appuyez pour sélectionner et insérer un symbole dans les menus de symboles.
13. Entrée
Appuyez pour confirmer votre sélection.
14. Mise a I’échelle/Zoom
Appuyez pour modifier le grossissement de I'apercgu.
15. Espace
Appuyez pour insérer un espace blanc.
Appuyez pour revenir a la valeur par défaut.
16. Verr.Maj
Appuyez pour utiliser uniquement des lettres majuscules (mode TOUT EN MAJUSCULES).
Lorsque le mode Majuscules est activé, toutes les lettres saisies sont en majuscules.
17. Maj

Maintenez cette touche enfoncée en appuyant sur une lettre ou une touche numérique pour saisir une lettre
majuscule ou le symbole marqué sur la touche numérique.

Pour déplacer le curseur au début du bloc précédent ou suivant, appuyez simultanément sur les touches Maj
etAouV.

Pour déplacer le curseur au début ou a la fin de la ligne en cours, appuyez simultanément sur les touches
Maj et < ou ».

... Renseignements connexes

» Configurer votre étiqueteuse
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# Accueil > Configurer votre étiqueteuse > Brancher I'adaptateur secteur

| Brancher I’'adaptateur secteur

Si vous connectez un adaptateur d’alimentation, utilisez uniquement I'adaptateur secteur, référence AD-
EO01A, spécialement congu pour cette étiqueteuse.

1. Insérez la petite fiche du cordon de I'adaptateur secteur dans la prise de I'adaptateur secteur sur le c6té de
I'étiqueteuse.

2. Insérez la fiche dans la prise électrique standard la plus proche.

DCIN12V

...... Fi

u Renseignements connexes

» Configurer votre étiqueteuse
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# Accueil > Configurer votre étiqueteuse > Installer les piles

| Installer les piles

Pour garantir la sauvegarde de la mémoire, nous vous recommandons d’utiliser six nouvelles piles alcalines AA
(LR6) avec I'adaptateur secteur.

REMARQUE

» Pour protéger et sauvegarder la mémoire de I'étiqueteuse, lorsque I'adaptateur secteur est débranché,
nous recommandons d’installer des piles alcalines AA dans I'étiqueteuse.

» Lorsque vous déconnectez I'alimentation électrique pendant plus de deux minutes, tous les paramétres
de texte et de formatage sont effacés. Tous les fichiers texte enregistrés dans la mémoire seront
également effacés.

+ Retirez les piles si vous ne comptez pas vous servir de I'étiqueteuse pendant une longue période.

+ Jetez les piles dans un point de collecte approprié, pas dans le flux général de déchets. Veillez en outre a
vous conformer a toutes les réglementations en vigueur.

» Lorsque vous rangez ou mettez au rebut des piles, enveloppez chacune d’elles (par exemple, avec du
ruban adhésif, comme illustré) pour éviter tout court-circuit.

1. Bande cellophane
2. Pile alcaline

1. Ouvrez le couvercle du compartiment des piles.

2. Installez six nouvelles piles alcalines AA (LR6).
Assurez-vous qu’elles sont installées dans le bon sens.
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3. Fermez le couvercle du compartiment des piles.

Pour retirer les piles, inversez la procédure d’installation.

ﬁ Renseignements connexes

» Configurer votre étiqueteuse

(ULINE JER[E
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# Accueil > Configurer votre étiqueteuse > Insérer une cassette de ruban
| Insérer une cassette de ruban

1. Ouvrez le couvercle du compartiment de la cassette de ruban.

2.

REMARQUE

Lorsque vous insérez la cassette de ruban, assurez-vous que le ruban ne se coince pas dans la téte
d’impression.

3. Fermez le couvercle du compartiment de la cassette de ruban.

ﬁ Si vous ne pouvez pas fermer le couvercle du compartiment de la cassette de ruban, assurez-vous que le
levier de déverrouillage est en position « haute ». Si ce n’est pas le cas, soulevez le levier de
déverrouillage, puis fermez le couvercle.

u Renseignements connexes

» Configurer votre étiqueteuse
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# Accueil > Configurer votre étiqueteuse > Allumer et éteindre I'étiqueteuse

| Allumer et éteindre I'étiqueteuse

1. Pour allumer I'étiqueteuse, appuyez sur [\

2. Pour éteindre I'étiqueteuse, appuyez et maintenez .

Pour économiser de I'énergie et éteindre automatiquement I'étiqueteuse aprés un certain temps, utilisez la
fonction de mise hors tension automatique.

u Renseignements connexes

» Configurer votre étiqueteuse

Sujets connexes :
» Définir le délai de mise hors tension automatique

» Spécifications

[ H-10159
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# Accueil > Configurer votre étiqueteuse > Définir la langue
| Définir la langue

Lorsque vous allumez I'étiqueteuse pour la premiére fois, I'écran de sélection de la langue apparait.
Sélectionnez la langue en appuyant sur €4 ou P, puis sur OK.

1. Appuyez sur .

Appuyez sur €4 ou » pour afficher [Réglages], puis appuyez sur OK.

Appuyez sur A ou ¥ pour afficher [Langue], puis appuyez sur OK.

P onN

Appuyez sur A ou sur ¥ pour sélectionner votre langue, puis appuyez sur OK.

u Renseignements connexes

» Configurer votre étiqueteuse
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# Accueil > Configurer votre étiqueteuse > Définir les unités de mesure
| Définir les unités de mesure

1. Appuyez sur .

Appuyez sur 4 ou » pour afficher [Réglages], puis appuyez sur OK.
Appuyez sur A ou Y pour afficher [Unité], puis appuyez sur OK.

roDN

Appuyez sur A ou sur Y pour afficher [pouce] ou [mm], puis appuyez sur OK.

u Renseignements connexes

» Configurer votre étiqueteuse
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# Accueil > Configurer votre étiqueteuse > Définir le délai de mise hors tension automatique
| Définir le délai de mise hors tension automatique

Votre étiqueteuse est dotée d’'une fonction d’économie d’énergie qui I'éteint automatiquement si aucune touche
n’est pressée pendant un certain temps, dans certaines conditions de fonctionnement. Que vous utilisiez
I'adaptateur secteur ou les piles, vous pouvez modifier le délai d’arrét automatique.

1. Appuyez sur .

2. Appuyez sur €4 ou P pour afficher [Réglages], puis appuyez sur OK.
3. Appuyez sur A ou ¥ pour afficher [Alim auto désactivée], puis appuyez sur OK.
4. Appuyez sur A ou sur Y pour afficher [Adapt secteur] ou [Batterie], puis appuyez sur OK.
5. Appuyez sur A ou sur Y pour sélectionner 'une des options suivantes :
Option Description
Adapt secteur Désactivé
1 h
2 h
4 h
8 h
Batterie 5 min
10 min
30 min

6. Appuyez sur OK.

| .
v Renseignements connexes

» Configurer votre étiqueteuse
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# Accueil > Configurer votre étiqueteuse > Activer ou désactiver le Bluetooth

| Activer ou désactiver le Bluetooth

1. Appuyez sur .

Appuyez sur 4 ou » pour afficher [Réglages], puis appuyez sur OK.
Appuyez sur 4 ou » pour afficher [Bluetooth], puis appuyez sur OK.
Appuyez sur A ou Y pour afficher [Bluetooth (Activé/Désactivé) ], puis appuyez sur OK.

o~ 0D

Appuyez sur A ou sur Y pour sélectionner [Activé] ou [Désactivé], puis appuyez sur OK.

Lorsque vous sélectionnez [Activé], I'icone Bluetooth apparait sur 'écran ACL.

'ﬁ * Vous pouvez également activer ou désactiver Bluetooth en appuyant simultanément sur et
et lorsque I'écran d’accueil est affiché.

* Réglez le mode de reconnexion automatique pour Bluetooth sur Activé ou Désactivé lorsque vous
connectez I'étiqueteuse a votre appareil mobile.

| .
v Renseignements connexes

» Configurer votre étiqueteuse

[ H-10159
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# Accueil > Configurer votre étiqueteuse > Activation/désactivation de la détection de la couleur du ruban
| Activation/désactivation de la détection de la couleur du ruban

Lorsque vous utilisez le mode Affichage des étiquettes comme mode de saisie, si la détection de la couleur du
ruban est réglée sur [Activé], I'étiqueteuse détecte la couleur du ruban et affiche 'image de I'étiquette en
couleur sur I'écran ACL, offrant ainsi un apergu plus précis de I'étiquette que vous créez.

Le paramétre par défaut est [Activé].

1. Appuyez sur .

2. Appuyez sur €4 ou P pour afficher [Réglages], puis appuyez sur OK.

3. Appuyez sur A ou ¥ pour afficher [Couleur de ruban], puis appuyez sur OK.

4. Appuyez sur A ou sur Y pour sélectionner [Activé] ou [Désactivé], puis appuyez sur OK.
REMARQUE

L'étiqueteuse ne peut pas détecter les couleurs de certaines cassettes a ruban. Dans ce cas, I'image de
I'étiquette ACL apparaitra comme un texte noir sur un fond blanc.

m Renseignements connexes

» Configurer votre étiqueteuse

Sujets connexes :
» Définir le mode d’entrée
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# Accueil > Configurer votre étiqueteuse > Ruban d’alimentation

| Ruban d’alimentation

1. Pour faire avancer le ruban, appuyez sur et sur .

2. Appuyez sur A ou sur ¥ pour sélectionner 'une des options suivantes :

Option Description

Avance&Coup  Sélectionnez cette option pour alimenter et couper le ruban automatiquement.

Avance Seule Sélectionnez cette option pour faire avancer le ruban, mais sans le couper.

Recommandé lors de I'utilisation de rubans pour tissu thermocollants, qui doivent étre
coupés a l'aide de ciseaux.

3. Appuyez sur OK.

u Renseignements connexes

» Configurer votre étiqueteuse
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# Accueil > Configurer votre étiqueteuse > Régler la luminosité de 'affichage

| Régler la luminosité de I'affichage

1. Appuyez sur .

Appuyez sur 4 ou » pour afficher [Réglages], puis appuyez sur OK.
Appuyez sur A ou Y pour afficher [Réglage], puis appuyez sur OK.
Appuyez sur A ou Y pour afficher [Luminosité affichage], puis appuyez sur OK.

ok~ DN

Appuyez sur A ou Y pour sélectionner votre préférence, [-2 - +2], puis appuyez sur OK.

u Renseignements connexes

» Configurer votre étiqueteuse
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# Accueil > Configurer votre étiqueteuse > Définir le mode d’entrée
| Définir le mode d’entrée

Mode Vue de I’étiquette

m -

ABC Company
Sales Dept.

Mode Apercgu avant impression

ABC Companyd
Sales Dept.

1. Appuyez sur .

Appuyez sur €4 ou » pour afficher [Réglages], puis appuyez sur OK.
Appuyez sur A ou Y pour afficher [Mode de saisie], puis appuyez sur OK.

Eal

Appuyez sur A ou sur Y pour sélectionner 'une des options suivantes :

Option Description

Vue de 1'étiquette Affiche les attributs de caracteres et les cadres que vous avez définis lors de la
création d’une étiquette.

Appuyez sur pour modifier le grossissement de I'écran ACL.

Apercu avant Sélectionnez cette option si vous ne souhaitez pas afficher les attributs sur
impression I’écran ACL.

5. Appuyez sur OK.

i .
'uu Renseignements connexes

» Configurer votre étiqueteuse

Sujets connexes :
» Prévisualiser des étiquettes
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# Accueil > Installation de logiciels

| Installation de logiciels
* Installation de pilotes d'imprimante et de logiciels sur un ordinateur (Windows)

* Connecter I'étiqueteuse a un ordinateur

[ H-10159
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# Accueil > Installation de logiciels > Installation de pilotes d’imprimante et de logiciels sur un ordinateur
(Windows)
Installation de pilotes d’imprimante et de logiciels sur un ordinateur
(Windows)
Pour imprimer a partir de votre ordinateur Windows, installez le pilote d’imprimante et le logiciel Brother P-touch

Editor sur votre ordinateur.
1. Ouvrez votre navigateur Web préféré et saisissez install.brother dans la barre d’adresse.

http://install.brother

LT e | -\ v NN
£ ] [ s [ —
e Y s s Y | i [ | i\ i { i\ i\ i

L

2. Cliquez sur le bouton Télécharger pour télécharger le programme d’installation du logiciel/documentation.

3. Parcourez le dossier Téléchargements de votre ordinateur, double-cliquez sur le fichier du programme
d’installation téléchargé et suivez les instructions a I'écran.

REMARQUE

« Lorsque vous connectez I'étiqueteuse a votre ordinateur a I'aide de Bluetooth, assurez-vous de régler
le parametre de transfert de données Bluetooth de votre systéme d’exploitation sur bidirectionnel.

* Appuyez sur le bouton requis sur I'étiqueteuse pour I'appariement lorsque vous confirmez le code
d’'acces.

7 .
v Renseignements connexes

* Installation de logiciels

» Applications disponibles

[ H-10159
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# Accueil > Installation de logiciels > Installation de pilotes d’imprimante et de logiciels sur un ordinateur
(Windows) > Applications disponibles

| Applications disponibles

Windows
Application Fonctionnalités
P-touch Editor Vous permet de concevoir et d'imprimer des étiquettes personnalisées a I'aide d’outils de

dessin intégrés pour créer divers styles de police et de texte, importer des images et insérer
des codes-barres.

P-touch Transfer Vous permet de transférer des modeles et d’autres données vers I'étiqueteuse et d’enregistrer
Manager 2 les sauvegardes de vos données sur 'ordinateur.

Cette application est installée avec P-touch Editor.

P-touch Library Geére et imprime des modéles P-touch Editor.
Vous pouvez utiliser P-touch Library pour imprimer des modéles.
Cette application est installée avec P-touch Editor.

P-touch Transfer Permet de transférer des documents sur 'étiqueteuse.
Express 2

P-touch Update Met a jour le logiciel et le micrologiciel vers la derniére version.
Software 2

1 La fonction de transfert de modéle n’est actuellement disponible qu’avec P-touch Editor 5.4. Le P-touch Editor 6.0 prendra en charge
cette fonction a partir d’'une prochaine mise a jour.

2 Disponible uniguement avec la connexion USB.

Mac
Application Fonctionnalités
P-touch Editor Vous permet de concevoir et d'imprimer des étiquettes personnalisées a 'aide d’outils de
dessin intégrés pour créer divers styles de police et de texte, importer des images et insérer
des codes-barres.
Transfer Express 1 Met a jour le micrologiciel vers la derniére version.

1 Disponible uniqguement avec la connexion USB.

M Renseignements connexes

* Installation de pilotes d’imprimante et de logiciels sur un ordinateur (Windows)
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# Accueil > Installation de logiciels > Connecter I'étiqueteuse a un ordinateur

| Connecter I'étiqueteuse a un ordinateur

* Connecter I'étiqueteuse a un ordinateur a I'aide d’'un cable USB

[ H-10159
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# Accueil > Installation de logiciels > Connecter I'étiqueteuse a un ordinateur > Connecter I'étiqueteuse a un
ordinateur a I'aide d’un cable USB

| Connecter I'étiqueteuse a un ordinateur a I’aide d’un cable USB

1. Assurez-vous que |'étiqueteuse est éteinte avant de brancher le cable USB.
2. Connectez le cable USB au port USB de I'étiqueteuse, puis a votre ordinateur.

=2 \

3. Mettez I'étiqueteuse sous tension.

u Renseignements connexes

» Connecter I'étiqueteuse a un ordinateur
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# Accueil > Editer une étiquette

| Editer une étiquette

Ajouter du texte a votre étiquette

Ajouter une nouvelle ligne de texte a votre étiquette
Ajouter un nouveau bloc de texte a votre étiquette
Supprimer du texte

Insérer un onglet

Utiliser le rappel de texte pour compléter automatiquement les mots courants
Entrer les symboles

Saisir des caractéres accentués

Définir les attributs des caractéres

Définir la longueur d’étiquette

Utiliser les mises en page en format automatique
Utiliser des mises en page de blocs de texte

Créer des tableaux

Création d’'une étiquette de code a barres

Utiliser la fonction Heure et Date
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& Accueil > Editer une étiquette > Ajouter du texte a votre étiquette
| Ajouter du texte a votre étiquette

1. Appuyez sur .

2. Appuyez sur €4 ou P pour afficher [Créer étiquette], puis appuyez sur OK.

3. Saisissez le texte ou les symboles que vous souhaitez (jusqu’a 280 caractéres alphanumériques, espaces et
signes de ponctuation compris).

u Renseignements connexes

+ Editer une étiquette
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& Accueil > Editer une étiquette > Ajouter une nouvelle ligne de texte a votre étiquette

| Ajouter une nouvelle ligne de texte a votre étiquette

Vous pouvez ajouter jusqu’a sept lignes a vos étiquettes, selon le ruban que vous utilisez. Pour plus

d'information »» Sujets connexes

1. Déplacez le curseur a la fin de la ligne actuelle.

2. Appuyez sur .

Ligne 1

1 ABG

Ligne 2

0| ABCJ
3 DEF

Résultat de I'étiquette imprimée

ABC
DEF

.ﬁ Le nombre maximum de lignes que vous pouvez ajouter dépend de la largeur du ruban.

Lignes maximales Largeur du ruban
7 lignes 24 mm (0,94 po)
5 lignes 18 mm (0,70 po)
3 lignes 12 mm (0,47 po)
2 lignes 9 mm (0,35 po)

6 mm (0,23 po)
1 ligne 3,5 mm (0,13 po)

u Renseignements connexes

« Editer une étiquette

Sujets connexes :
» Spécifications
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& Accueil > Editer une étiquette > Ajouter un nouveau bloc de texte a votre étiquette
| Ajouter un nouveau bloc de texte a votre étiquette

Pour imprimer des étiquettes comportant plusieurs sections séparées de texte, vous pouvez insérer jusqu’a cing
blocs de texte différents dans la méme étiquette.

ABC DEF: GHI A JKL M

Pour ajouter un nouveau bloc de texte ou des lignes vierges a droite de votre texte actuel, maintenez enfoncée

, puis appuyez simultanément sur .

Le curseur se déplace au début du nouveau bloc.

ABC

.ﬁ - Pour modifier les attributs de caractéres d’un bloc de texte, suivez les étapes de modification des
attributs de caractéres d’une ligne de texte.

- ll'y a un maximum de cinq blocs par étiquette.

... Renseignements connexes

« Editer une étiquette
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& Accueil > Editer une étiquette > Supprimer du texte

| Supprimer du texte
>> Pour supprimer un caractére a la fois :
>> Pour supprimer le texte, mais pas les paramétres de format :
>> Pour supprimer tous les caractéres d’une ligne spécifique :

>> Pour supprimer tous les caractéres et tous les paramétres de format :

Pour supprimer un caracteére a la fois :

Appuyez sur .

Pour supprimer le texte, mais pas les parameétres de format :

1. Appuyez sur .

2. Appuyez sur A ou ¥ pour afficher [Txt seulement], puis appuyez sur OK.

Pour supprimer tous les caractéeres d’une ligne spécifique :
1. Appuyez sur A ou sur Y pour vous déplacer sur la ligne que vous souhaitez supprimer.

2. Appuyez sur et

Pour supprimer tous les caractéeres et tous les parameétres de format :

1. Appuyez sur .

2. Appuyez sur A ou ¥ pour afficher [Txt & Format], puis appuyez sur OK.

simultanément.

i 2 .
'uu Renseignements connexes

« Editer une étiquette
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& Accueil > Editer une étiquette > Insérer un onglet

| Insérer un onglet

Pour insérer un onglet, placez le curseur a gauche du texte, et appuyez sur(( AN ]) et([ ))simultanément.

Le symbole de I'onglet () apparait sur I'écran ACL.

.ﬁ Pour supprimer un onglet d’'une étiquette :

Positionnez le curseur a droite du symbole de I'onglet sur I'écran de saisie de texte, puis appuyez sur .

m Renseignements connexes

+ Editer une étiquette

* Modifier la longueur de I'onglet

(ULINE JERES
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& Accueil > Editer une étiquette > Insérer un onglet > Modifier la longueur de I'onglet
| Modifier la longueur de I'onglet

1. Saisissez le texte que vous voulez.

. Appuyez sur .

2
3. Appuyez sur A ou ¥ pour afficher [Long. Onglet], puis appuyez sur OK.
4. Effectuez 'une des opérations suivantes :

* Appuyez sur A ou sur Y pour afficher 0 a 100 mm (0,0 po a 4,0 po), puis appuyez sur OK.

+ Saisissez la longueur de I'onglet souhaitée a l'aide des touches numériques. Lorsque vous avez terminé,
appuyez sur OK.

. Appuyez sur pour revenir a I'écran de saisie de texte.

M Renseignements connexes

[$)

* Insérer un onglet

[ H-10159
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& Accueil > Editer une étiquette > Utiliser le rappel de texte pour compléter automatiquement les mots
courants

Utiliser le rappel de texte pour compléter automatiquement les mots
courants

Vous pouvez enregistrer des textes ou des phrases fréquemment utilisés dans votre étiqueteuse pour les
retrouver rapidement et les utiliser dans vos étiquettes. Par défaut, la fonction Rappel de texte est réglée sur
[Activeé].

ﬁot hier

Saisissez un caractére (par exemple : « B »).
2. Appuyez sur OK.
L’étiqueteuse affiche une liste de mots imprimés commencant par la lettre « B », comme « Brother ».
3. Appuyez sur A ou Y pour sélectionner le mot souhaité.
4. Appuyez sur » pour afficher le mot entier si nécessaire.
Appuyez sur € pour revenir a la liste des mots.
5. Appuyez sur OK.

Pour fermer la liste de mots et revenir a I'écran de saisie de texte, appuyez sur .

7 .
v Renseignements connexes

« Editer une étiquette
+ Mémoire de rappel en texte clair
» Activer ou désactiver le rappel de texte

[ H-10159
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& Accueil > Editer une étiquette > Utiliser le rappel de texte pour compléter automatiquement les mots
courants > Mémoire de rappel en texte clair

| Mémoire de rappel en texte clair

1. Appuyez sur .

Appuyez sur 4 ou » pour afficher [Réglages], puis appuyez sur OK.
Appuyez sur A ou Y pour afficher [Rappel texte], puis appuyez sur OK.

P on

Appuyez sur A ou Y pour afficher [Effacer la mémoire], puis appuyez sur OK.
Le message [Effacer toute la mémoire du rappel texte ?] apparait.
5. Appuyez sur OK.

u Renseignements connexes

 Utiliser le rappel de texte pour compléter automatiquement les mots courants

(ULINE JERES
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& Accueil > Editer une étiquette > Utiliser le rappel de texte pour compléter automatiquement les mots
courants > Activer ou désactiver le rappel de texte

| Activer ou désactiver le rappel de texte

. Appuyez sur .

Appuyez sur 4 ou » pour afficher [Réglages], puis appuyez sur OK.

—_

Appuyez sur A ou Y pour afficher [Rappel texte], puis appuyez sur OK.
Appuyez sur A ou sur Y pour sélectionner [Activé/Désactivé], puis appuyez sur OK.

o > 0D

Appuyez sur A ou sur Y pour sélectionner [Activé] ou [Désactivé], puis appuyez sur OK.

m Renseignements connexes

» Utiliser le rappel de texte pour compléter automatiquement les mots courants

[ H-10159
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& Accueil > Editer une étiquette > Entrer les symboles

| Entrer les symboles
» Saisir des symboles a I'aide de la fonction de symbole
» Définir I'historique des symboles

* Options de symboles

[ H-10159
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& Accueil > Editer une étiquette > Entrer les symboles > Saisir des symboles & I'aide de la fonction de
symbole

| Saisir des symboles a I’aide de la fonction de symbole

1. Appuyez sur .

2. Appuyez sur A ou sur Y pour sélectionner une catégorie, puis appuyez sur OK.
3. Appuyez sur A, ¥, 4 ou » pour sélectionner un symbole, puis appuyez sur OK.

m Renseignements connexes

* Entrer les symboles

[ H-10159
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& Accueil > Editer une étiquette > Entrer les symboles > Définir I'historique des symboles
| Définir I’historique des symboles

L’historique des symboles peut stocker jusqu’a 30 symboles récemment utilisés. Par défaut, la fonction
Historique des symboles est réglée sur [Activé].

1. Appuyez sur .

Appuyez sur 4 ou » pour afficher [Réglages], puis appuyez sur OK.
Appuyez sur A ou Y pour afficher [Mise & jour symboles], puis appuyez sur OK.

ral

Appuyez sur A ou sur Y pour sélectionner [Activé] ou [Désactivé], puis appuyez sur OK.

u Renseignements connexes

* Entrer les symboles

[ H-10159
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& Accueil > Editer une étiquette > Entrer les symboles > Options de symboles

| Options de symboles

Catégorie Symboles
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Catégorie

Symboles

Electricité

~=4+L =000 1 200 (A
L

Outils

REBDTBI DX AN TASE
iy

Jardin

TR L AORT FETHREYLOD
R e I W B
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Catégorie Symboles

ol PEERAARAOMNONPEOO® O
RO nBwIra g B

Srepniaue QOHNIAAVYIVALBMOYY ¢O
b TOEDRT GRS
A T

Aetrologie TEXISAMA M A I3 5 H

i 2 .
'uu Renseignements connexes

* Entrer les symboles
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& Accueil > Editer une étiquette > Saisir des caractéres accentués
| Saisir des caractéres accentués

1. Saisissez le caractére que vous voulez.

2. Appuyez sur .

3. Appuyez sur A ou sur ¥ pour sélectionner un caractére accentué, puis appuyez sur OK.

u Renseignements connexes

« Editer une étiquette

» Options de caractéres accentués
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& Accueil > Editer une étiquette > Saisir des caractéres accentués > Options de caractéres accentués

| Options de caractéres accentués

Les caractéres accentués affichés sur I'écran ACL dépendent de votre langue.

Caractére Caractéres accentués
a dadadxagaaa
A AAAAAZAAAAA
© cCC

° éeééecee
) EEEEEEEE
9 offe

¢ GG

! [REREER

! FTTT1Ti

X K

« K

! LT

: FLLL

n NANN

O-
Oa
O
Q
O:
O
0
i1l
O

S SSSS B [ Hios9
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Caractere Caractéres accentués

u

vy
vy
z 2217
: zzz

u Renseignements connexes

e Saisir des caractéres accentués
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& Accueil > Editer une étiquette > Définir les attributs des caractéres
| Définir les attributs des caractéres

Vous pouvez définir les attributs des caractéres par étiquette ou par ligne.
» Appliquer des attributs de caractéres a un caractére
* Appliquer des attributs de caractéres a une ligne de texte
» Options de paramétrage des attributs

» Définir le style auto

[ H-10159
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& Accueil > Editer une étiquette > Définir les attributs des caractéres > Appliquer des attributs de caractéres a
un caractére

| Appliquer des attributs de caractéres a un caractére

Lorsque vous mettez en forme votre texte, vous pouvez prévisualiser vos sélections d’attributs de caractéres sur
I'écran ACL.

1. Saisissez le texte que vous voulez.

Appuyez sur .

Appuyez sur A ou sur Y pour sélectionner un attribut, puis appuyez sur OK.
Appuyez sur A ou sur Y pour définir une valeur pour cet attribut, puis appuyez sur OK.

Appuyez sur pour revenir a I'écran de saisie de texte.

M Renseignements connexes

o >N

« Définir les attributs des caractéres

Sujets connexes :
» Options de paramétrage des attributs
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& Accueil > Editer une étiquette > Définir les attributs des caractéres > Appliquer des attributs de caractéres a
une ligne de texte

| Appliquer des attributs de caractéres a une ligne de texte

Si vous ajoutez plusieurs lignes dans votre étiquette, vous pouvez formater chaque ligne de texte pour qu’elle ait
un aspect différent.

1. Saisissez les lignes de caractéres ou le texte que vous voulez sur votre étiquette.

2. Appuyez sur A ou sur Y pour déplacer le curseur sur la ligne dont vous souhaitez modifier les attributs de
caractéres.

3. Appuyez sur| 4 ) etsur({ZP) pour afficher les attributs de mise en forme disponibles.

Trois lignes noires (1) sur le c6té gauche de I'attribut de caractére indiquent que vous appliquez maintenant
I'attribut a cette ligne spécifique uniquement.

1

A<a [ﬁpulice AA

B ABC Compal '@l LA
a Sa|eS Dep Largeur 'ﬁ'

4. Appuyez sur A ou sur Y pour sélectionner un attribut, puis appuyez sur OK.
5. Appuyez sur A ou sur Y pour définir une valeur pour cet attribut, puis appuyez sur OK.

6. Appuyez sur pour revenir a I'écran de saisie de texte.

.ﬁ Lorsque différentes valeurs d’attributs sont définies pour chaque ligne, les valeurs de chaque ligne
apparaissent sous la forme de trois lignes noires (1), également appelées « menu hamburger », lorsque

vous appuyez sur .

Police E,_

ABC Company ™ [=1
Sales Dept| Largeur,E|—

i 2 .
'uu Renseignements connexes

¢ Définir les attributs des caractéres

Sujets connexes :
» Options de paramétrage des attributs
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& Accueil > Editer une étiquette > Définir les attributs des caractéres > Options de paramétrage des attributs

| Options de paramétrage des attributs

Police

Valeur Message a 'écran ACL Résultat
Helsinki HEL A1
Dortmund DTN A1
Brussels BRU Al
Cooperstown cop AT
Atianta ATL AT
us Us Al
Los Angeles LA A1
San Diego SGO Al
Florida FLO Al
Calgary CAL a1
Belgium BEL A
Adams ADM A1
Brunei BRN a1
Sofia SOF Al
Germany GER Al
Letter Gothic LGO AT
Istanbul IST Al

Taille de la police

Tailles disponibles :

Auto, 6 pt, 9 pt, 12 pt, 18 pt, 24 pt, 36 pt, 42 pt, 48 pt

.ﬁ Lorsque le mode Auto est sélectionné, le texte est automatiquement ajusté pour s’imprimer dans la plus
grande taille disponible dans les paramétres de police pour chaque largeur de ruban.

Largeur

Valeur Résultat
x 1 A

x 3/2 A
x2 A
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Valeur

Résultat

x1/2

A

x 2/3

A

Style de police

Valeur Message a I’écran ACL Résultat
Normal Normal A
Gras Gras A
Souligné Soulig A
Souligné en gras Soulig+Gras A
Barré Barré #
Contour Contour A
Ombre Ombre A
Solide Solide A
Italique Italique A
Italique Gras I+Gras A
Souligné + ltalique Soulig+I A
Souligné + Gras + Italique Soulig+Gras+I ;
Italique Contour I+Contour _AX
Italique Ombre I+Ombre A
Italique Solide I+Solide A
Vertical Vertical

<C
Vertical Gras Vrticl+Gras <

Alignement

Valeur

Résultat

Gauche

ABC

Centre

ABC

Droite

ABC

Justif

A B

C

u Renseignements connexes

« Définir les attributs des caractéres
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& Accueil > Editer une étiquette > Définir les attributs des caractéres > Définir le style auto
| Définir le style auto

Vous pouvez réduire la taille du texte pour 'adapter a la longueur de votre étiquette.

1. Appuyez sur .

Appuyez sur 4 ou » pour afficher [Réglages], puis appuyez sur OK.
Appuyez sur A ou Y pour afficher [Style auto], puis appuyez sur OK.

R

Appuyez sur A ou sur Y pour sélectionner 'une des options suivantes :

Option Description

Taille du texte La taille totale du texte est réduite pour s’adapter a I'étiquette.

Largeur du La largeur du texte est réduite a la taille du paramétre x 1/2 ou x 2/3 pour tenir
texte dans I'étiquette. Pour le résultat attendu »» Sujets connexes

5. Appuyez sur OK.

m Renseignements connexes

« Définir les attributs des caractéres

Sujets connexes :
» Options de paramétrage des attributs

[ H-10159
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& Accueil > Editer une étiquette > Définir la longueur d’étiquette
| Définir la longueur d’étiquette

Les étiquettes peuvent avoir une longueur comprise entre 1,2 po (30 mm) et 12,0 po (300 mm). Lorsque vous
sélectionnez [Auto], la longueur de I'étiquette est automatiquement ajustée en fonction de la quantité de texte

saisie.

1. Appuyez sur .

2. Appuyez sur A ou ¥ pour afficher [Long. ], puis appuyez sur OK.
3. Effectuez 'une des opérations suivantes :
* Appuyez sur A ou sur Y pour définir la valeur, puis appuyez sur OK.

« Définissez la longueur de I'étiquette en entrant la longueur souhaitée a I'aide des touches numériques.
Lorsque vous avez terminé, appuyez sur OK.

4. Appuyez sur pour revenir a I'écran de saisie de texte.

7 .
v Renseignements connexes

« Editer une étiquette
+ Définir les cadres

Sujets connexes :
» Modifier la longueur de 'onglet
» Sélectionner une option de coupe

[ H-10159
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& Accueil > Editer une étiquette > Définir la longueur d’étiquette > Définir les cadres

| Définir les cadres

1. Appuyez sur .

Appuyez sur A ou Y pour afficher [Cadre], puis appuyez sur OK.
Appuyez sur A ou sur Y pour sélectionner une catégorie, puis appuyez sur OK.

pwn

Appuyez sur A, ¥, 4 ou » pour sélectionner un cadre, puis appuyez sur OK.

ﬁ Vous pouvez également sélectionner un cadre en saisissant son numéro. Pour plus d'information »>»
Renseignements connexes

u Renseignements connexes

+ Définir la longueur d’étiquette

» Options du cadre

[ H-10159
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& Accueil > Editer une étiquette > Définir la longueur d’étiquette > Définir les cadres > Options du cadre

| Options du cadre

Catégorie Cadres
Simple 1 | | | I | | ’ ] [ ]
( ) ( ]|
( ? wr A3 2 ]
F | L 4§ | @ | L |
: ¢ g i i : L il 1
£ 3 R SR N I
Simple 2 s [ s I A s Y —
— T i | T ] [T
| i H g 3 ¢ 7 ¥ f
Décoration %: :i % % ot ot % % % %

%

a0

b £

-

[T ERAEROLN

LT PN

29

(D &¢

B @

ol Y
@y 8

i

Entreprise 1
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Catégorie

Entreprise 2

Cadres

W W ® » ¢ = EER O
@ E Wum ol T
A an Sk e SF ¥
| " & &0 +Q &
= I=] i(s] =] | B |
& | | = | &3 =] |

B .
... Renseignements connexes

¢ Définir les cadres
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# Accueil > Editer une étiquette > Utiliser les mises en page en format automatique

| Utiliser les mises en page en format automatique
» Utiliser des modéles

* Options du modéle

[ H-10159
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& Accueil > Editer une étiquette > Utiliser les mises en page en format automatique > Utiliser des modéles
| Utiliser des modéles

Sélectionnez une mise en page parmi les modéles préchargés inclus dans votre étiqueteuse, saisissez votre
texte, puis appliquez la mise en forme souhaitée. Pour les modeles préchargés »>» Sujets connexes:Options du
modeéle.

.ﬁ Si la largeur de la cassette de ruban actuelle ne correspond pas a la largeur définie pour le modéle
sélectionné, un message d’erreur s’affiche dés que vous essayez d'imprimer I'étiquette. Appuyez sur

ou sur toute autre touche pour effacer le message d’erreur, puis insérez la bonne cassette de ruban ou
choisissez un autre modéle.

Exemple - Pour personnaliser et imprimer le modéle préchargé appelé Etiquette de suivi 1 :
XXX COMPANY

XXX department
| O T O YO O OO )
*0001492%

—_

Appuyez sur .

Appuyez sur 4 ou » pour afficher [Format auto], puis appuyez sur OK.

Appuyez sur A ou Y pour afficher [Modéles], puis appuyez sur OK.

Appuyez sur A ou Y pour afficher [Gestion actifs], puis appuyez sur OK.

Appuyez sur A ou Y pour afficher [Etiquette de suivi 1], puis appuyez sur OK.

Saisissez le texte que vous voulez, puis appuyez sur OK.

Saisissez le texte du champ suivant, puis appuyez sur OK.

Appuyez sur A, ¥, €, ou sur P pour sélectionner un attribut de code a barres, puis appuyez sur OK.

© © N o ok~ 0N

Saisissez les données du code a barres, puis appuyez sur OK. Pour plus d'information »» Sujets connexes:
Création d’une étiquette de code a barres.

10. Effectuez 'une des opérations suivantes :
+ Sélectionnez [Imprimer], puis cliquez sur OK.
* Appuyez sur A ou sur ¥ pour sélectionner I'une des options suivantes :

Imprimer o

Modifier _f
L

Enreqg. j

Option Description
Modifier Changez le texte.
Enreg. Enregistrez I'étiquette.

Pour plus d'information »>» Sujets connexes: Utiliser la mémoire de fichiers.

Menu Modifiez les paramétres de la police ou du style.
%ﬁ—mﬁ- 9
Prévisual. Prévisualis avant de I'imprimer.
PAGE 373 OF 464 -800-295-5510 _ . 1023 IH-10159VND
| pour modifier le grossissement de I'écran ACL.

Options d'impression Sélectionnez les options d’'impression.

Appuyez sur




Option Description
Pour plus d'information »>» Sujets connexes: Impression d’étiquettes.

11. Appuyez sur A ou Y pour sélectionner le nombre d’étiquettes que vous souhaitez imprimer, puis appuyez

sur sur OK.

u Renseignements connexes

« Utiliser les mises en page en format automatique
Sujets connexes :

» Création d’une étiquette de code a barres

+ Utiliser la mémoire de fichiers

* Impression d’étiquettes

* Options du modéle

[ H-10159
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& Accueil > Editer une étiquette > Utiliser les mises en page en format automatique > Options du modéle

| Options du modéle

Catégorie

Valeur

Détails

Gestion actifs

Etiquette de suivi 1

(24 mm x 70 mm [0,94 po x 2,8 po])

Etiquette de suivi 2

(18 mm x 70 mm [0,70 po x 2,8 po])

Etiquette de suivi 3

ABC Company, Inc.
YU A0 U
*00001%

(24 mm x 70 mm [0,94 po x 2,8 po])

Etiquette de suivi 4

ABC Company, Inc.
(O YT U 0
*00001%

(18 mm x 70 mm [0,70 po x 2,8 po])

Etiquette de suivi 5

Property of:
ABC Company, Inc.

00001

(24 mm x 70 mm [0,94 po x 2,8 po])

Etiquette de suivi 6

Property of:
ABC Company, Inc.
00001

(18 mm x 70 mm [0,70 po x 2,8 po])

Etiquette de suivi 7

ABC Company, Inc. ‘

|0 RN Y OO0
(12 mm x 70 mm [0,47 po x 2,8 po])

Corbeille

‘ L
(24 mm x 76 mm [0,94 po x 3,0 po])

Etiquette
d’équipement

ABC Company, Inc.

Control Sales
Eguipment NoJ123456789

(24 mm x 58 mm [0,94 po x 2,3 po])

Armoire Etiqu. armoire 1 i i
Office Supplies
Sales Dept.
(24 mm x 126 mm [0,94 po x 5,0 po])
Etiqu. armoire 2 ‘ §  Ofice Supples
(18 mm x 111 mm [0,70 po x 4,4 po])
Etiqu. armoire 3 ‘ @ Office Supplies
Sales Dept.
(24 mm x 126 mm [0,94 po x 5,0 po])
Etiqu. armoire 4 ‘ @ Office Supplies @
(24 mm x 160 mm [0,94 po x 6,3 po])
Dossier Classeur 1 m H-]O‘ DLW <OOODZH—W0
PAGE 375 OF 464 1-800-295-55F MM x 219 mm [0,94 po x 8,6 po]) 1023 IH-10159
Classeur 2

‘w<4mm <OOO0DZFW
(18 mm x 219 mm [0,70 po x 8,6 po])

VND




PAGE

| S Design Data

Catégorie Valeur Détails
Classeur 3
-~ .
O De sign Data Jan-Mar 2022
(24 mm x 219 mm [0,94 po x 8,6 po])
Classeur 4

Jan-Mar 2022

(12 mm x 219 mm [0,47 po x 8,6 po])

Onglet de dossier

PAYABLES |

(12 mm x 82 mm [0,47 po x 3,2 po])

Onglet de séparation

AUGUST

(12 mm x 42 mm [0,47 po x 1,6 po])

Indexation de
document

2202
H439W303a
DECEMBER

2022

(24 mm x 36 mm [0,94 po x 1,4 po])

Adresse/ID Etiquette d’adresse 1
(24 mm x 72 mm [0,94 po x 2,8 po])
Etiquette d’adresse 2
Robert Becker
ABC CORPORATION
1234 Main street
Telephone(XXX) XXX-XXXX
(24 mm x 72 mm [0,94 po x 2,8 po])
Badge Nom 1 Rostsgsnmangv(er
(24 mm x 72 mm [0,94 po x 2,8 po])
Badge Nom 2
_5_ Robert Becker
Sales Manager
(24 mm x 72 mm [0,94 po x 2,8 po])
Badge Nom 3 Fig?gn Bec‘ker
(18 mm x 72 mm [0,70 po x 2,8 po])
Badge Nom 4
Robert Becker
ABC Company, Inc.
(24 mm x 72 mm [0,94 po x 2,8 po])
Médias Etiqu. carte SD s
(12 mm x 25 mm [0,47 po x 1,0 po])
Clé USB e
(9 mm x 25 mm [0,35 po x 1,0 po])
Tranche boite DVD SERVICE MANUAL (PDF)
(9 mm x 178 mm [0,35 po x 7,0 po])
Tranche boite CD \
(6 mm x 113 mm [0,23 po x 4,4 po])
Etiqu. cable Drapeau 1 J H-10159
76 OF 464 1-800-295-55 {1 mm x 90 mm [0,47 po x 3,5 po]) 1023 IH-10159
Drapeau 2 mc |

(12 mm x 90 mm [0,47 po x 3,5 po])

VND




Catégorie

Valeur

Détails

Nappe 1

Nappe 2

(18 mm x 39 mm [0,70 po x 1,5 po])

Dalle (VRT)

(12 mm x 70 mm [0,47 po x 2,8 po])

Signalisation

Signalisation 1

HOT!

(24 mm x 66 mm [0,94 po x 2,6 po])

Signalisation 2

<
o

(24 mm x 50 mm [0,94 po x 2,0 po])

CAUTION
THIS IS SIDE
UpP

u Renseignements connexes

« Utiliser les mises en page en format automatique
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& Accueil > Editer une étiquette > Utiliser des mises en page de blocs de texte
| Utiliser des mises en page de blocs de texte

Vous pouvez choisir différentes mises en page de blocs de texte, en fonction de la taille du ruban, pour disposer
les lignes de texte sur votre étiquette. Sélectionnez 'une des options de mise en page de blocs de texte,
saisissez votre texte, puis appliquez la mise en forme du texte si nécessaire. Pour voir quelles options sont
disponibles pour le ruban que vous utilisez »>» Renseignements connexes: Options de mise en page de blocs de
texte.

Appuyez sur .

Appuyez sur 4 ou » pour afficher [Format auto], puis appuyez sur OK.

—_

Appuyez sur A ou ¥ pour afficher [M. en page blocs], puis appuyez sur OK.

Appuyez sur A ou sur Y pour sélectionner la largeur de ruban souhaitée, puis appuyez sur OK.

Appuyez sur A ou sur Y pour sélectionner la mise en page de blocs de texte souhaitée, puis appuyez sur OK.
Saisissez le texte que vous voulez, puis appuyez sur OK.

Répétez ces étapes pour chaque champ de texte, puis appuyez sur OK.

Appuyez sur OK pour afficher le menu d’'impression.

© ® N ok 0D

Effectuez I'une des opérations suivantes :
» Sélectionnez [Imprimer], puis cliquez sur OK.

* Appuyez sur A ou sur Y pour sélectionner 'une des options suivantes :

Imprimer ==

Modifier 4
: .

Enreg. | |

Option Description
Modifier Changez le texte.
Enreg. Enregistrez I'étiquette.

Pour plus d'information »» Sujets connexes: Utiliser la mémoire de fichiers.

Menu Modifiez les paramétres de police, d’alignement ou de cadre.

Prévisual. Prévisualisez I'étiquette avant de I'imprimer.

Appuyez sur pour modifier le grossissement de I'écran ACL.

Options d'impression Sélectionnez les options d'impression.
Pour plus d'information »» Sujets connexes: Impression d’étiquettes.

10. Appuyez sur A ou ¥ pour sélectionner le nombre d’étiquettes que vous souhaitez imprimer, puis appuyez

sur sur OK.

.ﬁ Si la largeur de la cassette de ruban actuelle ne correspond pas a la largeur définie pour la mise en page
sélectionnée, un message d’erreur s’affiche dés que vous essayez d’imprimer I'étiquette. Appuyez sur

Esc || ou sur toute autre touche pour effacer le message d’erreur, puis insérez la bonne cassette de ruban.

[ H-10159
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Renseignements connexes

« Editer une étiquette
» Options de mise en page de blocs de texte

Sujets connexes :
¢ Utiliser la mémoire de fichiers

* Impression d’étiquettes

(ULINE JER[E
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# Accueil > Editer une étiquette > Utiliser des mises en page de blocs de texte > Options de mise en page de
blocs de texte

Options de mise en page de blocs de texte

Ruban de 24 mm/0,94 po

Valeur Détails

1Ligne(inversion)

2LigneA

2LigneB

3LigneA

3LigneB

3LigneC

1+1LigneA

Eq'l:lt e - g2 |:|'|:

Sbpt-. - 18pt

1+1LigneB |

1+1LigneC

a8 pt-| & 2qpt

1+2LigneA

20 pt

dapt-- ."'Eq-l:l't

[ H-10159
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Valeur Détails
1+2LigneB
d2pt.| &
1+2LigneC
43 pt--
1+3LigneA
43 pt--
1+3LigneB
45 pt--
1+3LigneC
45 pt--
1+4LigneA
24pt..
1+4LigneB
43 pt--
1+5Ligne
24pt..
Ruban de 18 mm/0,70 po
Valeur Détails
2LigneA
2LigneB
3LigneA
3LigneB

[ H-10159
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Valeur Détails

1+1LigneB

SEpt--
1+1LigneC

42 pt-.
1+2LigneA

d2pt--
1+2LigneB

32 pt--
1+2LigneC

42 pt--
1+2LigneD

42 pt-.
1+3Ligne

42 pt-.
1+4Ligne

24 pt..
1+5Ligne

24 pke
Ruban de 12 mm/0,47 po
Valeur Détails
2LigneA
2LigneB
3LigneA
3LigneB
1+1LigneA
1+1LigneB
1+1LigneC
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Valeur Détails
1+2Ligne
24 pt.- il =
Ruban de 9 mm/0,35 po
Valeur Détails
2LigneA e R Ept
“12pt
2LigneB 12 pt
...... El Dt
1+2Ligne
18pt - -
Ruban de 6 mm/0,23 po
Valeur Détails
1+2Ligne 1E|:It---

7 .
v Renseignements connexes

» Utiliser des mises en page de blocs de texte
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& Accueil > Editer une étiquette > Créer des tableaux
| Créer des tableaux

Créez un tableau en définissant le nombre de lignes et de colonnes que vous souhaitez. Vous pouvez
enregistrer le fichier comme modele pour le réutiliser dans d’autres étiquettes.

Eﬁé} Il existe un nombre maximal de lignes, qui dépend de la largeur du ruban.

Lignes maximales Largeur du ruban
7 lignes 24 mm (0,94 po)
5 lignes 18 mm (0,70 po)
3 lignes 12 mm (0,47 po)
2 lignes 9 mm (0,35 po)
6 mm (0,23 po)

1. Appuyez sur .

2. Appuyez sur 4 ou » pour afficher [Format auto], puis appuyez sur OK.

w

Appuyez sur A ou V¥ pour afficher [Format tableaul, puis appuyez sur OK.

Utilisez les touches A, Y, < et » pour créer votre tableau.

Appuyez sur A ou sur ¥ pour sélectionner la largeur de ruban souhaitée, puis appuyez sur OK.
Appuyez sur A ou sur ¥ pour sélectionner [Lignes].

Appuyez sur € ou » pour définir le nombre de lignes souhaité.

Appuyez sur A ou sur ¥ pour sélectionner [Colonnes].

Appuyez sur € ou » pour définir le nombre de colonnes souhaité, puis appuyez sur OK.
Saisissez le texte que vous voulez, puis appuyez sur OK.

a2 0 ® No oM

0. Répétez ces étapes pour chaque champ de texte, puis appuyez sur OK.
1. Effectuez 'une des opérations suivantes :
» Sélectionnez [Imprimer], puis cliquez sur OK.

» Appuyez sur A ou sur Y pour sélectionner I'une des options suivantes :

Imprimer ==

Modifier _f

4

Enreg. |

Option Description
Modifier Changez le texte.
Enreg. Enregistrez I'étiquette.

Pour plus d'information »» Sujets connexes: Utiliser la mémoire de fichiers.

Menu Modifiez les paramétres de la police ou du style.

Prévisual. Prévisualisez I'étiquette avant de I'imprimer.

Appuyez sur pour modifier le grossissement de I'écran ACL.

[ H-10159
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Option Description

Options d'impression Sélectionnez les options d’'impression.
Pour plus d'information »>» Sujets connexes: Impression d’étiquettes.

12. Appuyez sur A ou Y pour sélectionner le nombre d’étiquettes que vous souhaitez imprimer, puis appuyez

sur sur OK.

.ﬁ * Leruban de 3,5 mm (0,13 po) ne peut pas étre utilisé pour créer des tableaux.

+ Silalargeur de la cassette de ruban actuelle ne correspond pas a la largeur définie pour la mise en
page sélectionnée, un message d’erreur s’affiche dés que vous essayez d’imprimer I'étiquette. Appuyez

sur ou sur toute autre touche pour effacer le message d’erreur, puis insérez la bonne cassette de

ruban.

m Renseignements connexes

« Editer une étiquette

Sujets connexes :

« Utiliser la mémoire de fichiers

* Impression d’étiquettes

» Options de mise en page de blocs de texte

[ H-10159
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& Accueil > Editer une étiquette > Création d’une étiquette de code a barres

| Création d’une étiquette de code a barres
» Créer et imprimer des codes a barres

* Modifier ou supprimer un code a barres et des données de code a barres

[ H-10159
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& Accueil > Editer une étiquette > Création d’une étiquette de code a barres > Créer et imprimer des codes a
barres

| Créer et imprimer des codes a barres

L’étiqueteuse n’est pas congue exclusivement pour la création d’étiquettes de codes a barres. Vérifiez toujours
que les étiquettes de codes a barres peuvent étre lues par le lecteur de codes a barres.

Pour obtenir de meilleurs résultats, imprimez les étiquettes de codes a barres a I'encre noire sur un ruban blanc.
Certains lecteurs de codes a barres peuvent ne pas étre en mesure de lire les étiquettes de codes a barres
créées a I'aide d’'un ruban ou de I'encre coloré(e).

Jusqu’a cing codes a barres peuvent étre imprimés sur une étiquette.

REMARQUE

» Utilisez le paramétre [Grand] pour [Largeur] chaque fois que cela est possible. Certains lecteurs de
codes a barres peuvent ne pas étre en mesure de lire les étiquettes de codes a barres créées a l'aide du
parametre [Petit].

* Limpression continue d’'un grand nombre d’étiquettes avec des codes a barres peut faire surchauffer la
téte d’'impression, ce qui peut affecter la qualité d’'impression.

* Les symboles sont disponibles uniquement pour les protocoles CODE39, CODE128, CODABAR ou
GS1-128.

» Lattribut « Chif.Cont » (chiffre de contrdle) est uniquement disponible pour les protocoles CODE39, -2/5,
et CODABAR.

1. Appuyez sur .

Appuyez sur A ou Y pour afficher [Code barre], puis appuyez sur OK.

Appuyez sur A, ¥, €, ou » pour sélectionner un attribut, puis appuyez sur OK.

B wDN

Saisissez les données du code a barres. Pour plus d'information »» Sujets connexes

Appuyez sur| #% |0u @

6. Appuyez sur A ou sur Y pour sélectionner un caractére, puis appuyez sur OK.

o

7. Appuyez sur OK.

i .
'uu Renseignements connexes

» Création d’une étiquette de code a barres

» Options de code a barres

[ H-10159
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& Accueil > Editer une étiquette > Création d’une étiquette de code & barres > Créer et imprimer des codes a

barres > Options de code a barres

| Options de code a barres

Attribut Valeur
Protocole CODE39, CODE128, EAN-8, EAN-13, GS1-128 (UCC/
EAN-128), UPC-A, UPC-E, 1-2/5 (ITF), CODABAR

Largeur Petit

Grand

Sous# Activé

(Caractéres imprimés sous le code a barres)
Désactivé
Chif.Cont Désactivé
(Chiffre de controle)
Activé

(Disponible uniquement pour les protocoles CODE39,

I-2/5, et CODABAR)

Options de caractéres spéciaux

CODE39
Caractére spécial
(ESPACE)

$

/

+

7
CODABAR

Caracteére spécial

[ H-10159
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Caractere spécial

+

CODE128, GS1-128 (UCC / EAN-128)

Caractere spécial
(ESPACE) | ] #
$ 7 '
( ) +
r — = j
. ’ < =
> ? al C
\ ] A -
NUL SOH STX
ETX EOT ENQ ACK
BEL BS HT LF
VT FF CR SO
Sl DLE DC1 DC2
DC3 DC4 NAK SYN
ETB CAN EM SuUB
ESC { FS
GS } RS o
us DEL FNC3 FNC2
FNC4 FNC1

Eﬁ Renseignements connexes

» Créer et imprimer des codes a barres
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& Accueil > Editer une étiquette > Création d’une étiquette de code a barres > Modifier ou supprimer un code
a barres et des données de code a barres

I Modifier ou supprimer un code a barres et des données de code a
barres

>> Supprimer un code a barres d’une étiquette
>> Modifier les données du code a barres

Supprimer un code a barres d’une étiquette

1. Positionnez le curseur a droite du code a barres sur I'écran de saisie des données.
2. Appuyez sur .

Modifier les données du code a barres

PT-D610BT

1. Pour modifier les attributs et les données du code a barres, positionnez le curseur a gauche du code a barres
sur I'écran de saisie des données.

2. Appuyez sur pour ouvrir I'écran de configuration du code a barres.

3. Appuyez sur A ou ¥ pour afficher [Code barre], puis appuyez sur OK.

i 2 .
'uu Renseignements connexes

» Création d’'une étiquette de code a barres

[ H-10159
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& Accueil > Editer une étiquette > Utiliser la fonction Heure et Date
| Utiliser la fonction Heure et Date

Vous pouvez ajouter I'heure et la date a votre étiquette.
* Reégler I'heure et la date
» Définir le format de I'heure et de la date
» Définir 'horodatage et ajouter I'heure et la date a une étiquette

* Modifier ou supprimer les paramétres de I'heure et de la date

[ H-10159
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& Accueil > Editer une étiquette > Utiliser la fonction Heure et Date > Régler I'heure et la date
| Régler I’heure et la date

Réglez I'heure et la date dans le paramétre Horloge. Aprés avoir réglé I'heure et la date, vous pouvez ajouter
ces informations a votre étiquette a I'aide de la fonction Heure et date.

1. Appuyez sur .

2. Appuyez sur 4 ou » pour afficher [Réglages], puis appuyez sur OK.
3. Appuyez sur A ou Y pour afficher [Réglages de 1'horloge], puis appuyez sur OK.
4. Appuyez sur A ou sur Y pour définir 'année.
5. Appuyez sur €4 ou sur P pour passer au champ suivant.
6. Appuyez sur A ou sur Y pour mettre a jour le champ.
7. Appuyez sur OK.
REMARQUE

* Vous pouvez également utiliser les touches numériques de I'appareil pour saisir I'heure et la date.
* Lheure et la date sont actives dés que vous appuyez sur OK.

» Pour sauvegarder les paramétres de I'heure et de la date méme lorsque votre appareil n’est pas branché
sur une source d’alimentation, installez deux piles alcalines AA (LR6).

m Renseignements connexes

 Utiliser la fonction Heure et Date

[ H-10159
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& Accueil > Editer une étiquette > Utiliser la fonction Heure et Date > Définir le format de I'heure et de la date
| Définir le format de I’heure et de la date

Cette étiqueteuse propose différents formats d’heure et de date a ajouter a votre étiquette. Choisissez le style
analogique ou numérique.

1. Appuyez sur .

Appuyez sur 4 ou » pour afficher [Réglages], puis appuyez sur OK.

Appuyez sur A ou Y pour afficher [Format date et heure], puis appuyez sur OK.
Appuyez sur A ou sur Y pour afficher [Date] ou [Heure].

Appuyez sur € ou sur » pour définir le format.

o0~ 0w Db

Appuyez sur OK.

m Renseignements connexes

« Utiliser la fonction Heure et Date

» Options de format d’heure et de date

[ H-10159
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& Accueil > Editer une étiquette > Utiliser la fonction Heure et Date > Définir le format de I'heure et de la
date > Options de format d’heure et de date

| Options de format d’heure et de date

Les options de format d’heure et de date disponibles sont répertoriées dans le tableau. Vous pouvez régler
I'heure et la date a partir du menu [Réglages] > [Format date et heure] de l'appareil.

Attribut Options de format Attribut Options de format
Date 12/31/2099 Date 31/12/2099
12.31.2099 31/12/2099
12-31-2099 31.12.2099
31 décembre, 2099 31-12-2099
Déc. 31, 2099 31. Décembre 2099
2099/12/31 31. déc. 2099
Temps 11:59 PM Temps 23:59

Les paramétres par défaut sont indiqués en gras.

REMARQUE

Les valeurs de la date et de I'heure sont utilisées pour afficher un exemple de réglage. Lorsqu’un format est
sélectionné, I'heure et la date que vous avez définies dans le réglage de I'horloge apparaissent dans I'option
de format sélectionnée.

u Renseignements connexes

« Définir le format de I'heure et de la date
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# Accueil > Editer une étiquette > Utiliser la fonction Heure et Date > Définir 'horodatage et ajouter I'heure et
la date a une étiquette

| Définir ’horodatage et ajouter I’heure et la date a une étiquette

1. Appuyez sur .

2. Appuyez sur 4 ou P pour afficher [Réglages], puis appuyez sur OK.

3. Appuyez sur A ou ¥ pour afficher [Réglage indic temps], puis appuyez sur OK.
4. Appuyez sur A ou sur ¥ pour sélectionner I'une des options suivantes :

* [Heure]
Utilisez le [Indic. Temps] pour ajouter la date et I'heure a n’importe quelle étiquette.
a. Appuyez sur A ou sur ¥ pour afficher [Heure].
b. Appuyez sur € ou sur » pour afficher [Auto] ou [Fixé], puis appuyez sur OK.

Option Description

Auto « Positionnez le curseur a I'endroit ou vous voulez que I'heure et la

date apparaissent. Appuyez sur , sur A ou Y pour

sélectionner Indic. Temps, puis appuyez sur OK. La date et
I’heure actuelles (ou une date et une heure futures ou passées, si
vous les avez précédemment définies a I'aide de I'option
Transférer) et une icobne d’horloge apparaissent sur I'écran
ACL.

« Lorsque vous appuyez sur uniquement, la date et I'heure

les plus récentes sont imprimées sur I'étiquette. L’icone de
I’horloge ne s’imprime pas.

Fixé » Positionnez le curseur a I'endroit ou vous voulez que I'heure et la

date apparaissent. Appuyez sur , sur A ou Y pour

sélectionner Indic. Temps, puis appuyez sur OK. La date et
I'heure actuelles apparaissent sur I'écran ACL.

* Lorsque vous appuyez sur , la date et I'heure s’impriment
sur votre étiquette.

ﬁ Vérifiez et confirmez les parameétres de I'heure et de la date en placant le curseur a gauche de l'icone de

I'horloge, en appuyant sur , en appuyant sur A ou Y pour sélectionner [Indic. Temps], puis en
appuyant sur OK.

¢ [Format]
Sélectionnez le format d’heure et de date que vous souhaitez utiliser.
a. Appuyez sur A ou sur Y pour sélectionner [Format].
b. Appuyez sur € ou sur » pour sélectionner I'option de format souhaitée.

Option Description

Date Imprime uniquement la date sur I'étiquette.
Date&Heu Imprime la date et I'heure sur I'étiquette.
Heure Imprime uniquement I'heure sur 'étiquette.
Heug&Date Imprime I'heure et la date sur I'étiquette.

c. Appuyez sur OK.
* [Transférer]
Définissez une date et une heure futures ou passées.
a. Appuyez sur A ou sur ¥ pour sélectionner [Transférer].

[ H-10159
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b. Appuyez sur €4 ou sur P pour sélectionner [On] et spécifier les valeurs de date et d’heure que vous
souhaitez utiliser, puis appuyez sur OK.

Option Description

Oon Permet d’augmenter ou de diminuer les valeurs de I'heure et de la
date.

Off Imprime I'heure et la date actuelles.

c. Appuyez sur 4 ou sur P pour sélectionner 'année, le mois, la semaine, la date, 'heure ou la minute.
Appuyez sur A ou sur Y pour modifier la date et ’heure actuelles selon vos besoins.

ﬁ Vous pouvez également régler la date et I'heure en saisissant les chiffres a I'aide du clavier.

e. Appuyez sur OK.

m Renseignements connexes

« Utiliser la fonction Heure et Date
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# Accueil > Editer une étiquette > Utiliser la fonction Heure et Date > Modifier ou supprimer les paramétres de
I'heure et de la date

| Modifier ou supprimer les parameétres de I’heure et de la date

>> Modifier les paramétres de I'heure et de la date
>> Supprimer I'heure et la date d’une étiquette

Modifier les paramétres de I’heure et de la date

1. Positionnez le curseur a gauche de l'icone de I'horloge sur I'écran de saisie de texte.

2. Appuyez sur pour ouvrir I'écran de réglage de I'horodateur.

3. Mettez a jour les parametres que vous souhaitez et appuyez sur OK lorsque vous avez terminé.

Supprimer I’heure et la date d’une étiquette

1. Positionnez le curseur a droite de I'icbne de I'horloge sur I'écran de saisie de texte.

2. Appuyez sur .

| .
v Renseignements connexes

« Utiliser la fonction Heure et Date
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# Accueil > Imprimer les étiquettes

| Imprimer les étiquettes
* Prévisualiser des étiquettes

* Impression d’étiquettes

Sélectionner une option de coupe

Régler la longueur de I'étiquette

* Imprimer les modéles transférés
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# Accueil > Imprimer les étiquettes > Prévisualiser des étiquettes
| Prévisualiser des étiquettes

Vous pouvez prévisualiser les étiquettes avant de les imprimer pour vous assurer qu’elles sont correctes.

1. Appuyez sur .

2. Effectuez I'une des opérations suivantes :

* Appuyez sur 4, P, A, ou ¥ pour faire défiler 'apergu vers la gauche, la droite, le haut ou le bas.

* Appuyez sur et 4, », A, ou ¥ pour faire défiler directement la bordure gauche, droite, supérieure
ou inférieure.

*  Appuyez sur pour modifier le grossissement de I'apercgu.

u Renseignements connexes

* Imprimer les étiquettes
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# Accueil > Imprimer les étiquettes > Impression d’étiquettes

| Impression d’étiquettes

REMARQUE
* Ne tirez pas sur I'étiquette lorsque I'étiqueteuse I'éjecte de la fente de sortie du ruban. Dans ce cas, le
ruban encreur sera déchargé avec le ruban, ce qui rendra le ruban inutilisable.

* Ne bloquez pas la fente de sortie du ruban pendant I'impression. Cela provoquerait en effet un bourrage
du ruban.

1. Aprés avoir créé votre étiquette, appuyez sur .

2. Appuyez sur A ou Y pour modifier le nombre de copies, puis appuyez sur ou OK.

.ﬁ » Vous pouvez également spécifier le nombre de copies a 'aide des touches numériques.

+ Sivous n’avez besoin que d’'une seule copie de I'étiquette, appuyez sur sans sélectionner le

nombre de copies.

u Renseignements connexes

* Imprimer les étiquettes
* Impression séquentielle
* Impression miroir
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# Accueil > Imprimer les étiquettes > Impression d’étiquettes > Impression séquentielle
| Impression séquentielle

Utilisez cette fonction pour créer des étiquettes avec des chiffres ou des lettres disposés de maniére
séquentielle, a partir d’'un format d’étiquette unique.

AA [ AB [ AC
0123 0124[ 0125

1. Appuyezsur([ 74N j)et((E[j).

Appuyez sur A ou Y pour afficher [Numéro], puis appuyez sur OK.

Appuyez sur 4 ou sur P pour sélectionner un point de départ, puis appuyez sur OK.
Appuyez sur € ou sur P pour sélectionner un point de fin, puis appuyez sur OK.

o~ N

Appuyez sur A ou Y pour sélectionner le nombre d’étiquettes que vous souhaitez imprimer, puis appuyez

sur sur OK.

| .
v Renseignements connexes

» Impression d’étiquettes
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# Accueil > Imprimer les étiquettes > Impression d’étiquettes > Impression miroir
! Impression miroir

Avec [Miroir], utilisez du ruban transparent afin que les étiquettes puissent étre correctement lues depuis le
cbté opposé lorsqu’elles sont collées sur du verre, des fenétres ou d’autres surfaces transparentes.

= T2NILH

1. Appuyezsur( AN ])et([El)).

2. Appuyez sur A ou sur ¥ pour sélectionner [Miroir], puis appuyez sur OK.

3. Appuyez sur ou OK.

Ed .
... Renseignements connexes

* Impression d’étiquettes

(ULINE JERES
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# Accueil > Imprimer les étiquettes > Sélectionner une option de coupe
| Sélectionner une option de coupe

Choisissez parmi plusieurs options intégrées pour déterminer comment I'étiqueteuse découpe vos étiquettes.

1. Appuyez sur .

2. Appuyez sur A ou ¥ pour afficher [Option Coupe], puis appuyez sur OK.

3. Appuyez sur A ou sur ¥ pour sélectionner [Pte marge], [Gde marge], [Chaine], [Non coupé] oOu
[Ruban spec.], puis appuyez sur OK.

m Renseignements connexes

* Imprimer les étiquettes

» Options de coupe du ruban
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# Accueil > Imprimer les étiquettes > Sélectionner une option de coupe > Options de coupe du ruban

| Options de coupe du ruban

Dans le tableau des options, ces motifs visuels représentent des parties de votre étiquette, comme illustré dans

la colonne Exemple.

ABC

Zone d’impression

Marge

Marge de stratification

Parameétre

Description

Exemple

Pte marge

Découpe automatiquement un morceau de
ruban vierge avant d’'imprimer la premiéere
étiquette, puis découpe le ruban aprés chaque
impression d’étiquette en laissant une marge de
2 mm (0,08 po) a chaque extrémité.

» Lorsque la longueur de I'étiquette est d’environ
23 mm (0,9 po) ou plus

2 2 2
L1 1
_ || Asc]|| nBC
R

1. Environ 23 mm (0,9 po)
2. 2 mm (0,08 po)

+ Lorsque la longueur de I'étiquette est d’environ
23 mm (0,9 po) ou moins

AllA

1. Environ 23 mm (0,9 po)
2. 2 mm (0,08 po)

Gde marge

Coupe automatiquement le ruban apres
'impression de chaque étiquette, en laissant une
marge de 25 mm (0,98 po) a chaque extrémité.

2 2 2 2
L L L L
ABC ABC
T T T T
1 1 1 1

1. Environ 23 mm (0,9 po)
2. 2 mm (0,08 po)

Chaine

* Découpe automatiquement un morceau de
ruban vierge avant d’'imprimer la premiére
étiquette, puis découpe le ruban apres
chaque impression d’étiquette en laissant
une marge de 2 mm (0,08 po) a chaque
extrémité.

» Aprés I'impression de la derniére étiquette, le
ruban n’est ni avancé ni coupé. Appuyez

simultanément sur et et pour

faire avancer et couper le ruban.

2 2
o — 3
_ || ABC/|| ABC
T T

1 2

RN

Environ 23 mm (0,9 po)
2. 2 mm (0,08 po)
3. Position de coupe
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Parameétre

Description

Exemple

Non coupé

» Sélectionnez ce parameétre lorsque vous
imprimez plusieurs copies d’'une étiquette ou
lorsque vous utilisez des rubans pour tissu
thermocollants ou d’autres rubans spéciaux
qui ne peuvent pas étre coupés par le coupe-
ruban de I'étiqueteuse.

» Apres I'impression de la derniére étiquette, le
ruban n’est pas avancé ni découpé.

- Appuyez simultanément sur et

\j et pour faire avancer et couper le

ruban.

- Lorsque vous utilisez des rubans
spéciaux qui ne peuvent pas étre coupés
par le coupe-ruban de I'étiqueteuse,
retirez la cassette de ruban de
I’'étiqueteuse et utilisez des ciseaux pour
couper le ruban.

2 2
-k e

ABC ABC

T T

1

1. 23 mm (0,9 po)
2. 2mm (0,08 po)

2

Ruban
spec.

Sélectionnez ce paramétre lorsque vous utilisez
un ruban spécial.

2
L

2 2
L L

7

ABC ABC

=
1

1. Environ 23 mm
2. 2mm (0,08 po)

T
2

(0,9 po)

m Renseignements connexes

» Sélectionner une option de coupe
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# Accueil > Imprimer les étiquettes > Régler la longueur de I'étiquette
| Régler la longueur de I'étiquette

Lorsque la cassette de ruban est presque vide, la longueur de I'étiquette imprimée peut étre moins précise. Dans
ce cas, réglez manuellement la longueur de I'étiquette.

.ﬁ Environ 1 % de la longueur totale de I'étiquette est ajustée d’un niveau.

1. Appuyez sur .

Appuyez sur 4 ou » pour afficher [Réglages], puis appuyez sur OK.

Appuyez sur A ou Y pour afficher [Réglage], puis appuyez sur OK.
Appuyez sur A ou Y pour afficher [Long. étiquet.], puis appuyez sur OK.

ok~ 0D

Appuyez sur 4 ou » pour afficher [-3 - +3], puis appuyez sur OK.

13 .
L;;g Renseignements connexes

* Imprimer les étiquettes
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# Accueil > Imprimer les étiquettes > Imprimer les modéles transférés
| Imprimer les modéles transférés

Vous pouvez transférer les modéles créés dans P-touch Editor vers votre étiqueteuse, personnaliser votre texte,
puis imprimer les étiquettes mises a jour.

1. Appuyez sur .

Appuyez sur 4 ou » pour afficher [Modéles transférés], puis appuyez sur OK.
Appuyez sur A ou Y pour sélectionner le modéle que vous souhaitez imprimer, puis appuyez sur OK.
Appuyez sur A ou Y pour afficher [Imprimer], puis appuyez sur OK.

o DN

.ﬁ Si vous n’avez pas encore transféré de modeéles depuis P-touch Editor, [Modéles transférés]
n’apparaitra pas dans la liste des options.

Pour plus d'information »» Sujets connexes

M Renseignements connexes

* Imprimer les étiquettes
» Modifier et imprimer les modéles transférés
* Imprimer les modeles transférés de la base de données
* Supprimer un modéle transféré
Sujets connexes :
 Transfert de modeéles sur I'imprimante (P-touch Transfer Manager) (Windows)
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# Accueil > Imprimer les étiquettes > Imprimer les modéles transférés > Modifier et imprimer les modeéles
transférés

| Modifier et imprimer les modéles transférés

1. Appuyez sur .

Appuyez sur 4 ou » pour afficher [Modéles transférés], puis appuyez sur OK.
Appuyez sur A ou Y pour sélectionner le modéle que vous souhaitez modifier, puis appuyez sur OK.
Appuyez sur A ou Y pour afficher [Modif étiqu (non enreg) ], puis appuyez sur OK.

A o R

Modifiez le modéle.

.ﬁ Vous ne pouvez pas ajouter ou supprimer un saut de ligne lorsque vous modifiez un modéle transféré.

6. Appuyez sur A ou sur Y pour sélectionner un modéle modifié, puis appuyez sur OK.
7. Appuyez sur A ou Y pour afficher [Imprimer], puis appuyez sur OK.

.ﬁ Vous ne pouvez pas enregistrer vos modifications dans un modeéle transféré.

A .
m Renseignements connexes

* Imprimer les modéles transférés
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# Accueil > Imprimer les étiquettes > Imprimer les modéles transférés > Imprimer les modéles transférés de
la base de données

| Imprimer les modéles transférés de la base de données

1. Appuyez sur .

Appuyez sur 4 ou » pour afficher [Modéles transférés], puis appuyez sur OK.
Appuyez sur A ou Y pour sélectionner le modéle que vous souhaitez imprimer, puis appuyez sur OK.
Appuyez sur A ou Y pour afficher [Imprimer depuis BdD], puis appuyez sur OK.

o M D

Appuyez sur 4, », A, ou ¥ pour sélectionner le premier enregistrement de la plage que vous souhaitez
imprimer.

6. Appuyez sur 4, P, A, ou ¥ pour sélectionner le dernier enregistrement de la plage que vous souhaitez
imprimer.

Les enregistrements de la plage sélectionnée sont mis en évidence sur I'écran ACL.
7. Appuyez sur A ou Y pour afficher [Imprimer], puis appuyez sur OK.

ﬁ Le nombre maximum de caractéres pouvant étre imprimés pour un modéle transféré est de
1500 caractéres. Les sauts de ligne et les blocs de texte réduisent le nombre maximal.

7 -
v Renseignements connexes

* Imprimer les modeéles transférés

* Recherchez un modele dans la base de données
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# Accueil > Imprimer les étiquettes > Imprimer les modéles transférés > Imprimer les modéles transférés de
la base de données > Recherchez un modéle dans la base de données

| Recherchez un modéle dans la base de données

1. Appuyez sur .
2

Appuyez sur 4 ou » pour afficher [Modéles transférés], puis appuyez sur OK.
Appuyez sur A ou Y pour sélectionner le modéle que vous souhaitez imprimer, puis appuyez sur OK.
Le premier enregistrement de la base de données sélectionnée s’affiche.

4. Saisissez les données ou le nom que vous recherchez.

Par exemple, saisissez « B » pour trouver toutes les chaines de caractéres contenant « B ». Saisissez
« BR » pour trouver toutes les chaines de caractéres contenant « BR ».

Saisissez autant de lettres ou de chiffres que nécessaire.

.ﬁ + Siune chaine contient le caractére que vous avez saisi, le curseur sur I'écran ACL se déplace vers ce
contenu et le met en surbrillance. Si le contenu n’existe pas, le curseur reste a sa position actuelle.

» Sile caractére que vous avez recherché est contenu dans plusieurs champs de la base de données,
appuyez simultanément sur les touches ([ 74N ]) et([ ) ]) pour passer au champ suivant contenant
le caractéere. Le caractére est mis en évidence dans le champ.

* Appuyez sur pour supprimer le dernier caractére de vos données de recherche. Le curseur se
déplace vers le champ suivant contenant les caractéres de recherche restants.

are _
... Renseignements connexes

» Imprimer les modéles transférés de la base de données
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# Accueil > Imprimer les étiquettes > Imprimer les modéles transférés > Supprimer un modeéle transféré
| Supprimer un modéle transféré

Lorsque vous supprimez un modeéle transféré, il est supprimé uniquement de votre étiqueteuse.

1. Appuyez sur .

Appuyez sur 4 ou » pour afficher [Modéles transférés], puis appuyez sur OK.
Appuyez sur A ou Y pour sélectionner le modéle que vous souhaitez supprimer, puis appuyez sur OK.
Appuyez sur A ou Y pour afficher [Supprimer], puis appuyez sur OK.

o DN

Le message [Supprimer 2] apparait.
5. Appuyez sur OK.

u Renseignements connexes

e Imprimer les modéles transférés
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# Accueil > Utiliser la mémoire de fichiers

| Utiliser la mémoire de fichiers
* Enregistrer les fichiers d’étiquettes

* Imprimer, ouvrir, supprimer ou marquer une étiquette sauvegardée
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# Accueil > Utiliser la mémoire de fichiers > Enregistrer les fichiers d’étiquettes
| Enregistrer les fichiers d’étiquettes

Vous pouvez enregistrer jusqu’a 99 étiquettes et les recharger ultérieurement a des fins d'impression. Vous
pouvez enregistrer au maximum 280 caracteres par fichier. Vous pouvez également modifier et remplacer les
étiquettes enregistrées.

1. Saisissez le texte et mettez en forme votre étiquette.

. Appuyez sur .

2
3. Appuyez sur A ou ¥ pour afficher [Enreg. ], puis appuyez sur OK.
4. Appuyez sur A ou Y pour sélectionner un fichier, puis appuyez sur OK.

M Renseignements connexes

« Utiliser la mémoire de fichiers
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# Accueil > Utiliser la mémoire de fichiers > Imprimer, ouvrir, supprimer ou marquer une étiquette
sauvegardée

| Imprimer, ouvrir, supprimer ou marquer une étiquette sauvegardée

1.

wnN

Appuyez sur .

Appuyez sur 4 ou » pour afficher [Fichier], puis appuyez sur OK.
Appuyez sur A ou Y pour sélectionner un fichier, puis appuyez sur OK.
Effectuez I'une des opérations suivantes :

Option Description
Imprimer a. Appuyez sur A ou ¥ pour afficher Imprimer, puis appuyez sur OK.

b. Appuyez sur A ou Y pour modifier le nombre de copies, puis appuyez sur ou OK.

Ouvrir Appuyez sur A ou Y pour afficher Ouvrir, puis appuyez sur OK.

Supprimer a. Appuyez sur A ou Y pour afficher Suppr., puis appuyez sur OK.
b. Appuyez sur OK.
Le message Supprimer ? apparait.
c. Appuyez sur OK.

Pour supprimer une étiquette enregistrée dans I'écran de sélection des fichiers, sélectionnez
I'étiquette a I'aide de A ou V¥, puis appuyez sur .

Marquage Les fichiers sauvegardés peuvent étre organisés en huit catégories différentes avec un code
couleur. Les choix de couleurs apparaissent a gauche du nom du fichier dans I'écran de
sélection des fichiers.

a. Appuyez sur A ou ¥ pour afficher Marqu., puis appuyez sur OK.
b. Appuyez sur A ou sur ¥ pour sélectionner une couleur, puis appuyez sur OK.

p— _
... Renseignements connexes

« Utiliser la mémoire de fichiers
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# Accueil > Créer et imprimer des étiquettes a I'aide de votre ordinateur

| Créer et imprimer des étiquettes a I’aide de votre ordinateur
» Créer des étiquettes a I'aide de P-touch Editor (Windows)
» Créer des étiquettes et les imprimer avec P-touch Editor (Mac)

» Impression d’étiquettes a I'aide du pilote d'imprimante (Windows)

[ H-10159
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# Accueil > Créer et imprimer des étiquettes a I'aide de votre ordinateur > Créer des étiquettes a I'aide de P-
touch Editor (Windows)

| Créer des étiquettes a I'aide de P-touch Editor (Windows)

La fonction de transfert ne peut étre utilisée qu’avec P-touch Editor 5.4.

Pour utiliser votre étiqueteuse avec votre ordinateur Windows, installez P-touch Editor et le pilote d’'imprimante
sur votre ordinateur.

Pour obtenir les derniers pilotes et logiciels, accédez a la page Téléchargements de votre modéle sur le site
Web de soutien Brother a I'adresse support.brother.com.

1. Démarrez P-touch Editor @.

*  Windows 11 :

Cliquez sur Démarrer > Brother P-touch > P-touch Editor, ou double-cliquez sur 'icbne P-touch
Editor sur le bureau.

* En fonction du systéme d’exploitation de votre ordinateur, le dossier Brother P-touch peut étre créé ou
non.

*  Windows 10 :

Cliquez sur Démarrer > Brother P-touch > P-touch Editor, ou double-cliquez sur 'icbne P-touch
Editor sur le bureau.

*  Windows 8,1 :

Cliquez sur l'icéne P-touch Editor de I'écran Applications ou double-cliquez sur I'icone P-touch Editor
sur le bureau.

2. Effectuez 'une des opérations suivantes :
* P-touch Editor 5.4

Pour ouvrir une mise en page existante, cliquez sur Ouvrir (1).

Pour connecter une mise en page prédéfinie a une base de données, cochez la case en regard de
Connexion base de données (2).

Pour créer une nouvelle mise en page, double-cliquez sur le volet Nouvelle mise en page (3) ou
cliquez sur le volet Nouvelle mise en page (3), puis cliquez sur —.

Pour créer une nouvelle mise en page a I'aide d’'une mise en page prédéfinie, double-cliquez sur un
bouton de catégorie (4) ou sélectionnez un bouton de catégorie (4), puis cliquez sur —.

/z ‘)‘ il “‘ - liem %ﬁa
g s
O A

e P-touch Editor 6.0
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Pour ouvrir une mise en page exi " ez sur Ouvrir (4).

Pour créer une nouvelle mise en pag]é,scqa'lggzr’éﬁﬂgnglet Nouvelle étiquette et le bouton!RSUNdAPIVND
étiquette (1).



- Pour créer une nouvelle mise en page a l'aide d’'une mise en page prédéfinie, cliquez sur 'onglet
Nouvelle étiquette et sur le bouton d’une catégorie (2), sélectionnez un modéle, puis cliquez sur

Créer (3).
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» Créer et imprimer des étiquettes a I'aide de votre ordinateur
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#& Accueil > Créer et imprimer des étiquettes a I'aide de votre ordinateur > Créer des étiquettes et les
imprimer avec P-touch Editor (Mac)

| Créer des étiquettes et les imprimer avec P-touch Editor (Mac)

Téléchargez et installez P-touch Editor depuis I'App Store sur votre Mac.

Pour utiliser votre étiqueteuse avec votre ordinateur Mac, installez P-touch Editor.

1. Double-cliquez sur Macintosh HD > Applications, puis double-cliquez sur I'icéne Brother P-touch Editor.

2. Lorsque P-touch Editor démarre, cliquez sur Nouveau pour sélectionner un modele, créez une nouvelle mise
en page ou ouvrez une mise en page existante.

[ JON ) Sélectionnez un modéle ] @

Nouveau Evénements

o)

SERvVICE

Identité Magasin Paneaux

N v
® | ® |
1 s = B
—_ ] H— L]
g ' Cey - o, ' tey
Professionnel Réseau Covid-19_24mm Covid-19_36mm

3. Permet de sélectionner les paramétres d’'impression.
4. Cliquez sur l'icone Imprimer.

v Renseignements connexes

» Créer et imprimer des étiquettes a l'aide de votre ordinateur

» Fenétre principale de P-touch Editor (Mac)

(ULINE JER[E
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# Accueil > Créer et imprimer des étiquettes a I'aide de votre ordinateur > Créer des étiquettes et les
imprimer avec P-touch Editor (Mac) > Fenétre principale de P-touch Editor (Mac)

| Fenétre principale de P-touch Editor (Mac)

°
e

&

i

f (0]
-

Imprimante ( N

Support d'impression
12mm []

Vérifier le support
2 —1 Aucun objet sélectionné
Longueur

Définir la longueur

Marges 2mm

Sens
O Texte horizontal

Texte vertical

Acheter des étiquettes [ Glisser-déposer le fichier de base de données ici ]

Barre d’outils

Inspecteur d’objets

Zone de connexion de base de données
Inspecteur d’'étiquettes

A

Fenétre de mise en page

m Renseignements connexes

» Créer des étiquettes et les imprimer avec P-touch Editor (Mac)
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# Accueil > Créer et imprimer des étiquettes a I'aide de votre ordinateur > Impression d’étiquettes a I'aide du
pilote d’imprimante (Windows)

| Impression d’étiquettes a I’'aide du pilote d’imprimante (Windows)

Vérifiez que vous avez installé le pilote d'imprimante.

Pour obtenir les derniers pilotes et logiciels, accédez a la page Téléchargements de votre modéle sur le site
Web de soutien Brother a I'adresse support.brother.com.

Branchez I'étiqueteuse a un ordinateur.
Ouvrez le document que vous voulez imprimer.
Sélectionnez la commande d’impression dans votre application.

N =

Sélectionnez votre étiqueteuse, puis cliquez sur les propriétés de I'imprimante ou le bouton des préférences.
La fenétre du pilote d’'imprimante s’affiche.
Modifiez les paramétres du pilote d’imprimante, si nécessaire.

o o

Cliquez sur OK.
7. Terminez votre opération d’'impression.

M Renseignements connexes

» Créer et imprimer des étiquettes a I'aide de votre ordinateur

Sujets connexes :

» Connecter I'étiqueteuse a un ordinateur a 'aide d’'un cable USB

» Activer ou désactiver le Bluetooth

* Installation de pilotes d’imprimante et de logiciels sur un ordinateur (Windows)

[ H-10159
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# Accueil > Imprimer des étiquettes a I'aide d’appareils mobiles

| Imprimer des étiquettes a I'aide d’appareils mobiles
 Installer I'application Brother iPrint&Label

» Création d’étiquettes et impression a 'aide d’appareils mobiles

[ H-10159
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# Accueil > Imprimer des étiquettes a I'aide d’appareils mobiles > Installer I'application Brother iPrint&Label
| Installer I’application Brother iPrint&Label

Utilisez I'application iPrint&Label de Brother pour imprimer directement depuis votre iPhone, iPad, iPod touch et
appareils mobiles Android™.

Application Fonctionnalités

Brother iPrint&Label Créez des étiquettes pour un usage professionnel, notamment des codes-barres,
des étiquettes d’équipement et des étiquettes pour des onglets de dossier.

Pour plus d’informations sur les applications mobiles disponibles pour votre imprimante, visitez https://
support.brother.com/g/d/f5f9

u Renseignements connexes

* Imprimer des étiquettes a I'aide d’appareils mobiles

[ H-10159
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# Accueil > Imprimer des étiquettes a I'aide d’appareils mobiles > Création d’étiquettes et impression a 'aide
d’appareils mobiles

| Création d’étiquettes et impression a I’aide d’appareils mobiles

1. Lancez l'application d'impression d’étiquettes sur votre appareil mobile.
2. Sélectionnez un modeéle ou une conception d’étiquette.

ﬁ Vous pouvez également sélectionner une étiquette ou une image précédemment congue et I'imprimer.

3. Sélectionnez le menu d’'impression dans 'application d'impression d’étiquettes.

M Renseignements connexes

* Imprimer des étiquettes a I'aide d’appareils mobiles
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# Accueil > Transfert de modeles sur I'imprimante (P-touch Transfer Manager) (Windows)

Transfert de modéles sur I'imprimante (P-touch Transfer Manager)
(Windows)

» Transfert de modéles sur I'imprimante a 'aide de P-touch Transfer Manager (Windows)

» Distribution de modéles a transférer aux utilisateurs sans utiliser P-touch Transfer
Manager (Windows)

[ H-10159
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# Accueil > Transfert de modeles sur 'imprimante (P-touch Transfer Manager) (Windows) > Transfert de
modéles sur 'imprimante a I'aide de P-touch Transfer Manager (Windows)

Transfert de modeéles sur I'imprimante a I'aide de P-touch Transfer
Manager (Windows)

* Remarques concernant l'utilisation de P-touch Transfer Manager (Windows)

« A propos du transfert de modéles de I'ordinateur vers I'imprimante (Windows)

» Sauvegarde de modeéles ou d’autres données mémorisés dans I'imprimante (Windows)
» Suppression des données de I'imprimante (Windows)

» Création de fichiers de transfert et de fichiers de package de transfert (Windows)

(ULINE JERES
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# Accueil > Transfert de modeles sur 'imprimante (P-touch Transfer Manager) (Windows) > Transfert de
modeles sur 'imprimante a l'aide de P-touch Transfer Manager (Windows) > Remarques concernant
I'utilisation de P-touch Transfer Manager (Windows)

Remarques concernant l'utilisation de P-touch Transfer Manager
(Windows)

Certaines fonctions de P-touch Editor n’étant pas disponibles avec I'imprimante, gardez les points suivants a
I'esprit lors de I'utilisation de P-touch Editor pour créer des modeéles.

Vous pouvez prévisualiser les modeles créés avant qu’ils ne soient transférés vers I'imprimante.

Création de modéles

* Une partie du texte dans les modeles transférés sur 'imprimante peut étre imprimée a I'aide de polices et
tailles de caracteres similaires chargées dans I'imprimante. Par conséquent, I'étiquette imprimée peut différer
de 'image du modele créé dans P-touch Editor.

» Selon la configuration de I'objet de texte, la taille de caractére peut étre automatiquement réduite ou une
partie du texte ne sera peut-étre pas imprimée. Si cela se produit, modifiez la configuration de I'objet de
texte.

+ Bien que les styles de caractéres puissent étre appliqués a des caractéres individuels avec P-touch Editor,
les styles peuvent étre appliqués a un bloc de texte uniquement avec I'imprimante. En outre, certains styles
de caractére ne sont pas disponibles sur I'imprimante.

» Les arriére-plans spécifiés dans P-touch Editor ne sont pas compatibles avec I'imprimante.

» Une mise en page P-touch Editor utilisant la fonction d’impression divisée (agrandissement de I'étiquette et
impression de cette derniére sur au moins deux étiquettes) ne peut pas étre transférée.

+ Seule la partie de I'étiquette au sein de la zone imprimable est imprimée.

Transfert de modéles

« Létiquette imprimée peut différer de I'image apparaissant dans la zone de prévisualisation de P-touch
Transfer Manager.

» Siun code a barres bidimensionnel autre qu'un code QR non chargé sur I'imprimante est transféré sur
'imprimante, le code a barres est converti en image. L'image du code a barres converti ne peut pas étre
editée.

» Tous les objets transférés ne pouvant pas étre édités par 'imprimante sont convertis en images.

+ Les objets regroupés sont convertis en bitmap unique.

+ Siles objets se chevauchent, seul 'objet du bas est imprimé.

Transfert de données autres que des modéles

Si le nombre ou I'ordre des champs dans une base de données est modifié et que seule la base de données
(fichier CSV) est transférée pour la mettre a jour, la base de données ne sera peut-étre pas liée correctement au
modéle. En outre, la premiére ligne de données dans le fichier transféré doit étre reconnue par I'imprimante sous
la forme de « noms de champs ».

... Renseignements connexes

» Transfert de modéles sur 'imprimante a I'aide de P-touch Transfer Manager (Windows)

[ H-10159
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# Accueil > Transfert de modéles sur 'imprimante (P-touch Transfer Manager) (Windows) > Transfert de

modéles sur imprimante & l'aide de P-touch Transfer Manager (Windows) > A propos du transfert de
modeles de I'ordinateur vers I'imprimante (Windows)

A propos du transfert de modéles de 'ordinateur vers I'imprimante
(Windows)

Vous pouvez transférer des modéles et d’autres données sur 'imprimante et enregistrer les sauvegardes de vos
données sur 'ordinateur.

Pour pouvoir utiliser P-touch Transfer Manager, vous devez d’abord transférer sur P-touch Transfer Manager les
modéles créés dans P-touch Editor.

u Renseignements connexes

» Transfert de modéles sur 'imprimante a I'aide de P-touch Transfer Manager (Windows)
» Transfert d'un modéle sur P-touch Transfer Manager (Windows)
* Fenétre principale de P-touch Transfer Manager (Windows)

» Transfert de modéles ou d’autres données de I'ordinateur sur I'imprimante (Windows)

[ H-10159
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& Accueil > Transfert de modeles sur I'imprimante (P-touch Transfer Manager) (Windows) > Transfert de
modeles sur 'imprimante a 'aide de P-touch Transfer Manager (Windows) > A propos du transfert de
modeles de I'ordinateur vers I'imprimante (Windows) > Transfert d'un modéle sur P-touch Transfer Manager

(Windows)
| Transfert d’'un modeéle sur P-touch Transfer Manager (Windows)

1. Démarrez P-touch Editor @.

*  Windows 11 :
Cliquez sur Démarrer > Brother P-touch > P-touch Editor, ou double-cliquez sur 'icbne P-touch
Editor sur le bureau.
* En fonction du systéme d’exploitation de votre ordinateur, le dossier Brother P-touch peut étre créé ou
non.
*  Windows 10 :
Cliquez sur Démarrer > Brother P-touch > P-touch Editor, ou double-cliquez sur 'icbne P-touch
Editor sur le bureau.
*  Windows 8,1 :
Cliquez sur l'icéne P-touch Editor de I'écran Applications ou double-cliquez sur I'icone P-touch Editor
sur le bureau.
2. Ouvrez le modéle souhaité ou créez une mise en page.
3. Cliquez sur Fichier > Transférer Modéle > Transférer.
La fenétre P-touch Transfer Manager apparait. Le modéle est transféré vers le dossier Configurations.

&8 PC (Brother XX-XXXX  )\Configurations - P-touch Transfer Manager — O x
Fichier Edition Affichage QOutils Aide
] P o ™ =] Imprimante :
— = B oY e
X ; Toutes les imprimantes
Rechercher  Style d'affichage
:] P-touch Library Mom de transfert Taille Type Date Code d'affectation  Nom
% 'II:'.cl;:utIecontenu @:name 1KB  Mise en page 28/12/2018 06:31:36 - name.lbx
iltre
Corbeille
‘@, Résultats de la recherche
_,i Transfer Manager
: PC (Brother XX-X00CK 1
Configurations
&) Sauvegardes
PC (Brother X )
PC (Brother XX-XXXX }
Brother JOG000(
< >
Aucun contenu sélectionné A
v
Pour I'aide, appuyez sur F1 NUM
u Renseignements connexes
+ A propos du transfert de modéles de I'ordinateur vers I'imprimante (Windows)
1-800-295-5510 1023 IH-10159VND
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# Accueil > Transfert de modeles sur 'imprimante (P-touch Transfer Manager) (Windows) > Transfert de
modéles sur limprimante & l'aide de P-touch Transfer Manager (Windows) > A propos du transfert de
modeles de l'ordinateur vers I'imprimante (Windows) > Fenétre principale de P-touch Transfer Manager
(Windows)

| Fenétre principale de P-touch Transfer Manager (Windows)

& Tout le contenu - P-touch Transfer Manager — E X

N

'] —\E\ch\er Edition  Affichage Outils Agde)

— 5 = 1 = Imprimante :

=z = &= Q e -

- - A Toutes les imprimantes 2
1 ] Rechercher  Style d'afficha

7] P-touch Library Y| Nom Taille Date Emplacement
MiEc] Tout le contenu ( A
& Filtre
& Corbeille
- @ Résultats de la recherche
D Transfer Manager B 3
=] PC (Brother XX300X )
5% Configurations
[Z3 Nouveau dossier

6 —|

N

& Seuvegardes

5 — [ 9] PC (Brother XX-XXX% )]
(- M PC (Brother XX-00X )

.20 Brother XCX-X00CK >~ 1

- - - \

Aucun contenu sélectionné S

— 4
v
Nour I'aide, appuyez sur F1 _J NUM A

1. Barre de menus

Permet d’accéder a diverses commandes regroupées sous chaque titre de menu (les menus Fichier,
Edition, Affichage, Outils et Aide) selon leurs fonctions.

2. Sélecteur d’imprimante

Vous permet de sélectionner une imprimante sur laquelle transférer les données. Lorsque vous sélectionnez
une imprimante, seules les données qui peuvent étre envoyées a I'imprimante sélectionnée apparaissent
dans la liste des données.

3. Liste des modéles

Affiche la liste des modéles du dossier sélectionné.
4. Apercu

Affiche un apercu des modéles de la liste des modéles.
5. Liste des dossiers

Affiche la liste des dossiers et des imprimantes. Lorsque vous sélectionnez un dossier, les modéles qu’il
contient apparaissent dans la liste des modeéles. Si vous sélectionnez une imprimante, ce sont les modéles et
les autres données mémorisés dans I'imprimante qui apparaissent.

6. Barre d’outils

Donne accés aux commandes frequemment utilisées.

Icones de la barre d’outils

Icone Nom du bouton Fonction

Transférer Cliquez pour transférer des modéles et d’autres données de
I'ordinateur sur I'imprimante.

%

-

Sauvegarder le fichier de Cliquez pour modifier le type de fichier des données a
transfert transférer vers d’autres applications.
(Sans connexion a une Les interfaces disponibles peuvent varier en fonction du
imprimante) modéle.
+al | Sauvegarder Cliquez pour récupérer les modeles et les autres données
mémorisées dans I'imprimante et les enregistrer sur
I'ordinateur.

[ H-10159
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Fonction

Icone Nom du bouton
lr_e; Ouvrir Cliquez pour ouvrir le modéle sélectionné.
) Rechercher Cliquez pour rechercher des modeéles ou d’autres données
» enregistrés dans P-touch Library.
Style d'affichage Cliquez pour modifier le style d’affichage du fichier.

u Renseignements connexes

« A propos du transfert de modéles de I'ordinateur vers I'imprimante (Windows)
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# Accueil > Transfert de modeles sur 'imprimante (P-touch Transfer Manager) (Windows) > Transfert de
modéles sur 'imprimante a l'aide de P-touch Transfer Manager (Windows) > A propos du transfert de
modeles de I'ordinateur vers I'imprimante (Windows) > Transfert de modeéles ou d’autres données de
I'ordinateur sur I'imprimante (Windows)

Transfert de modeéeles ou d’autres données de I’ordinateur sur

Fimprimante (Windows)

ﬁ Pour transférer des modeéles d’'un appareil mobile vers I'imprimante, »» Renseignements connexes

1. Branchez I'imprimante et I'ordinateur en utilisant un cable USB, puis allumez I'imprimante.

Le nom de modéle de 'imprimante s’affiche a cété d’'une icbne d’imprimante dans I'apergu du dossier.

Si vous sélectionnez 'imprimante dans I'apergu du dossier, ce sont les modéles et les autres données
mémorisés dans I'imprimante qui s’affichent.

ﬁ Si une imprimante est débranchée ou hors ligne, elle n’apparait pas dans I'apergu du dossier.

2. Sélectionnez I'imprimante sur laquelle vous souhaitez transférer le modéle ou les données.

& PC (Brother XX000(  )\Configurations - P-touch Transfer Manager - O X
Fichier Edition Affichage Outils  Aide
i 1 }’ Imprimante :
----- by Toutes les imprimantes
Rechercher  Style d'affichage e
Toutes les imprimantes
:] P-touch Library MNom de transfert Taille Ty| A Code d'affectation  Nom
rother X%
= E'? ;_‘l’t“t'“””te”” @ name KB | M grother 1003000 18.06:31:56 name.lbx
i cl 'E 5 @D 1KB Mise en page ZE1272018 06:33:24 CD.lbx
croeilie
dd 1KB  Mi 28/12/2018 06:34:32 ddress.|b:
1 Résultats de la recherche @) address meenpags A2 address.lox
;_i Transfer Manager
=& PC (Brother XX-X00( ]
%) Configurations
[| Sauvegardes
+|- 8] PC (Brother )OO0 ]
+__-,J PC (Brother XX-XXXX b
ifal) Brother XX-XXXX
< >
Aucun contenu sélectionné A
v
Pour |'aide, appuyez sur F1 UM

PAGE 431 OF 464

[ H-10159

1-800-295-5510

1023 IH-10159VND



Faites un clic droit sur le dossier Configurations, sélectionnez Nouveau, puis créez un nouveau dossier.

Crée un nouveau dossier

@ PC (Brother X04-300¢x NConfigurations - P-touch Transfer Manager - O *
Fichier Edition Affichage Outils Aide
= ;'\_ L = Imprimante :
b Toutes les imprimantes
Rechercher  Style d'affichage
[Z] P-touch Library Mem de transfert Taille Type Date Code d'affectation  Nem
T_OUt I contenis @ name 1KB  Mise en page 28/12/2018 06:31:56 - name.lbx
E””E 2 @ D KB Mise en page 28/12/2018 06:3%:24 - CD.Ibx
orbeille 5 z
e — @| address 1KB  Mise en page 28/12/2018 06:34:32 - address.|bx
;_.i Transfer Manager
PC (Brother Xx-000x 3
Configuration:
[| Sauvegardes Nouveau
PC (Brother Xx-x Mouveau message...
PC (Brother XX-X» 5 o
\.£2) Brother X000 roprietes..
I < >
ucun contenu sélectionné 2
v
MUM

Effectuez I'une des opérations suivantes :
Faites glisser le modele ou d’autres données a transférer et placez-les dans le nouveau dossier.

Pour transférer plusieurs modéles ou d’autres données, faites glisser les fichiers a transférer, puis placez-
les dans le nouveau dossier. Chaque fichier regoit un numéro de clé (emplacement de mémoire dans
'imprimante) lorsqu'il est placé dans le nouveau dossier.

& PC (Brother XX XXX

Fichier Edition Afficha

N\Configurations\Nouveau dossier - P-touch Transfer Manager

Imprimante :

Toutes les imprimantes

=] P-touch Library
Tout le contenu
17 Filtre

Corbeille

Transfer Manager

= *gj Configurations

Sauvegardes

F2l Brother Y0000

Pour I'aide, appuyez sur F1

2. Résultats de la recherche
@[] PC (Brother 3000 b]

MNouveau dossier

PC (Brother XXX 5
PC (Brother XX-XXxX )

ge  Outils  Ajde
n, ~
= I =g LWl
| o b
Rechercher  Style d'affichage
Mom de transfert Taille
@ name 1KB
@ D 1KB
@ address 1KB

<

Type Date Code d'affectation
Mise en page 28/12/2018 06:31:56 1
Mise en page 28/12/2018 06:33:24 2
Mise en page 28/12/201806:3432 3

MNom
name.lbx
CD.lbx
address.lbx

Aucun contenu sélectionné

O >
>
~
v
NUM

Type de données

Nombre maximum
d’éléments transférables

Informations sur les restrictions

Modele

20

* Chaque modéle peut contenir au maximum

20 d’'objets.

» Chaque objet peut contenir au maximum sept lignes.

Base de données

20

» Seuls les fichiers CSV peuvent étre transférés.
» Chaque fichier CSV peut contenir au maximum

255 champs et 65 000 enregistrements.
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ﬁ * Vous pouvez vérifier I'espace disponible dans la mémoire des fichiers de transfert en imprimant un
rapport de configuration.

* Vous pouvez afficher les modéles et les autres données en sélectionnant :
- Le sous-dossier du dossier Configurations
- Tout le contenu

- L’une des catégories sous Filtre, telles que Mises en page

5. Pour changer le numéro de clé attribué a un élément, faites un clic droit sur cet élément, sélectionnez le
menu Code d'affectation, puis sélectionnez le numéro de clé souhaité.

&
Imprimante :
i ) Toutes les imprimantes
Rechercher  Style d'affichage
FZ] P-touch Library MNom de transfert Taille Type Date Code d'affectation  Mom
:_T“““””te”“ @ name KB Mise en page 28/12/201806:31:56 1 name.lbx
2 cl t": > @l D KB Mise en page 28/12/20180633:24 2 CD.lbx
orbeille n
L Resultats de 1 echierchie @) address 1KB Mise en page Code d'affectation e address.|bx
_} Transfer Manager
=[] PC (Brother X300 ) z i
- =% Configurations ~
P 2 Nouveau dossier i ler
g Sauvegardes 5
18] PC (Brother Xx-X¥XX ) &
+- [ PC (Brother XX-2000C J ;
i) Brother JXO(X00C( < 9 >
10
11 2
12
13
14
15
16
17
18
19
20
21 2
Pour |'aide, appuyez sur F1 22 UM

;ﬁ + Alexception des données enregistrées dans les bases de données, toutes les données transférées sur
I'imprimante regoivent un numéro de touche.

+ Sile modéle ou d’autres données transférées sur I'imprimante possédent le méme numéro de clé qu'un
autre modele déja mémorisé dans I'imprimante, le nouveau modéle remplace I'ancien. Vous pouvez
confirmer les numéros de modéle affectés enregistrés dans I'imprimante en sauvegardant les modeéles
ou d’autres données.

» Sila mémoire de l'imprimante est pleine, supprimez un ou plusieurs modéles de la mémoire de
limprimante.

6. Pour modifier les noms de modéles ou d’autres données a transférer, cliquez sur I'élément souhaité, puis
saisissez le nouveau nom.

En fonction du modéle de I'imprimante, le nombre de caractéres des noms de modéle peut étre limité.

[ H-10159
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Transférer.

Sélectionnez le dossier contenant les modeles ou les autres données a transférer, puis cliquez sur

& PC (Brother XX-XXXX

Fichier Editicn

¥

Transférer

Affichage

NConfigurations\Mouveau dossier - P-touch Transfer Manager

Outils  Aide

=

Quvrir

Rechercher

- Imprimante:

: Toutes les imprimantes
Style d'affichage

[FZ] P-touch Library
Tout le contenu
f? Filtre

7). Résultats de la recherche
@ Transfer Manager

5.E]] PC (Brother Xx-X000
%51 Configurations

o [
%y Sauvegardes
PC (Brother J3(-0000
; PC (Brother XX-XX0XK
.20 Brother X000

Pour |'aide, appuyez sur F1

MNom de transfert
@ name
[@co

13‘ address

Taille
1KB
1KB
1KB

Date

28/12/2018 06:31:56
28/12/2018 06:33:24
28/12/2018 06:34:32

Type

Mise en page
Mise en page
Mise en page

Code d'affectation
1
2
3

Mem
name.lbx
CD.lbx
address.lbx

MUM

Un message de confirmation s’affiche.

ﬁ * Vous pouvez également transférer sur 'imprimante des éléments individuels sans les ajouter a un
dossier. Sélectionnez le modéle ou les autres données a transférer, puis cliquez sur Transférer.

Vous pouvez sélectionner plusieurs éléments et dossiers, et les transférer en une seule opération.

8. Cliquez sur OK.

Les éléments sélectionnés sont transférés sur 'imprimante.

u Renseignements connexes

+ A propos du transfert de modéles de I'ordinateur vers 'imprimante (Windows)
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# Accueil > Transfert de modeles sur 'imprimante (P-touch Transfer Manager) (Windows) > Transfert de
modeles sur 'imprimante a l'aide de P-touch Transfer Manager (Windows) > Sauvegarde de modéles ou

d’autres données mémorisés dans I'imprimante (Windows)

Sauvegarde de modéles ou d’autres données mémorisés dans

'imprimante (Windows)

&

1.

Les modéles ou autres données sauvegardés ne peuvent pas étre modifiés sur I'ordinateur.

« En fonction du modéle d’'imprimante, les modéles ou données sauvegardés risquent de ne pas pouvoir
étre transférés entre différents modéles.

Vérifiez que votre ordinateur et I'étiqueteuse sont connectés et que I'étiqueteuse est allumée.

Le nom de modéle de 'imprimante s’affiche a cété d’'une icbne d’imprimante dans I'apercu du dossier. Si
vous sélectionnez 'imprimante dans I'apergu du dossier, ce sont les modéles et les autres données

mémorisés dans l'imprimante qui s’affichent.
2. Sélectionnez I'imprimante dont les données doivent étre sauvegardées, puis cliquez sur Sauvegarder.

"\, Résultats de la recherche
;_,i Transfer Manager

S.E] PC (Brother XX-000K )
*5) Configurations

(27 Meuveau dossier

[] Sauvegardes

PC (Brother XX-000K ]
PC (Brother XX-XX0CK )
Brother XX

€

...... =]

& Brother XX-XXXX - P-touch Transfer Manager - O *
Fichier Edition Affichage Qutils Aide
= _‘m] e Imprimante :
: = Vol ~% T
: : Toutes les imprimantes
Sauvegarder Rechercher  Style d'affichage
:] P-touch Library Mom de transfert Taille Type Date Code d'affectation  Mom de la base de donné
QE ;’”t'emte”” B name KB Modéle 12/28/18 07:04 1
cl t’; 5 Blco KB Modéle 12/28/18 07:04 2
. & address KB Modéle 12/28/18 07:04 3

Pour |'aide, appuyez sur F1

Plusieurs fichiers sont sélectionnés.

MUM

Un message de confirmation s’affiche.

Cliquez sur OK.

Un nouveau dossier est créé sous I'imprimante dans I'apercu du dossier. Le nom du dossier correspond a la
date et a I'heure de la sauvegarde. Tous les modéles et autres données de I'imprimante sont transférés dans

le nouveau dossier et enregistrés sur I'ordinateur.

7 -
v Renseignements connexes

» Transfert de modéles sur 'imprimante a I'aide de P-touch Transfer Manager (Windows)
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# Accueil > Transfert de modeles sur 'imprimante (P-touch Transfer Manager) (Windows) > Transfert de
modeles sur 'imprimante a I'aide de P-touch Transfer Manager (Windows) > Suppression des données de
limprimante (Windows)

| Suppression des données de 'imprimante (Windows)

Pour supprimer tous les modéles et autres données enregistrés sur I'imprimante, procédez comme suit :

1.

3.

Vérifiez que l'ordinateur et I'étiqueteuse sont connectés et que I'étiqueteuse est allumeée.

Le nom de modéle de I'imprimante s’affiche a cété d’une icone d’'imprimante dans I'apercu du dossier.

Faites un clic droit sur 'imprimante, puis sélectionnez le menu Effacer tout.

&5 Brother 3-3000( - P-touch Transfer Manager - O x
Fichier Edition Affichage Outils Aide
== ";-_;t == ™ = Imprimante :
: Toutes les imprimantes
Sauvegarder Rechercher  Style d'affichage
:] P-touch Library Mom de transfert Taille Type Date Code d'affectation ~ Mom de la base de donne:
: ;‘l’“t Ieicanteny S KB Modele 12/28/18 07:04 1
cl t'; * co KB Modéle 12/28/18 07:04 2
S 5 address KB Modéle 12/28/18 07:04 3

"\, Résultats de la recherche
i_’; Transfer Manager

S E]] PC (Brother XX-00GK )
%21 Configurations

[ Nouveau dossier

)] Sauvegardes

PC (Brother XX-XXXX )
PC (Brother XH-K )

Effacer tout

sont sélectionnés.

Parameétres de I'imprimante...

Propriétés...

MNUM

Un message de confirmation s’affiche.

P-touch Transfer Manager >

| Toutes les données vont étre effacées de I'imprimante.
OK pour continuer 7

Annuler

Cliquez sur OK.

Tous les modéles et les autres données enregistrés dans I'imprimante sont supprimés.

m Renseignements connexes

» Transfert de modéles sur I'imprimante a I'aide de P-touch Transfer Manager (Windows)
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#& Accueil > Transfert de modéles sur I'imprimante (P-touch Transfer Manager) (Windows) > Transfert de
modeles sur 'imprimante a I'aide de P-touch Transfer Manager (Windows) > Création de fichiers de transfert
et de fichiers de package de transfert (Windows)

Création de fichiers de transfert et de fichiers de package de transfert

(Windows)

Ordinateur 1

P-touch Editor

Créer un modéle

Transférer le modéle

P-touch Transfer Manager

Créer un fichier de package de
modele

xxx.blf

Xxx.pdz

Stockage de
masse (BLF)

Imprimante

<

P-touch Transfer
Express

: XxX.pdz

A4
Ordinateur 2

Piéce jointe a I’ e-mail
P-touch Transfer
Express (PDZ)

P-touch Transfer

Express

P-touch Transfer
Express (PDZ)

Méthode de transfert de modéle

Format de fichier

A partir d’'un ordinateur

P-touch Transfer Express

PDzZ

1. Créez le modéle avec P-touch Editor, puis transférez-le sur P-touch Transfer Manager.

.ﬁ * Pour plus d'information »>» Renseignements connexes
» Lors du transfert d’'un nouveau modele, assurez-vous que vous spécifiez le numéro d’affectation de clé
(dans P-touch Transfer Manager) qui n’est pas actuellement utilisé. Si le numéro d’affectation de clé
spécifié est déja utilisé, le modeéle existant sera remplacé par le nouveau.

2. Sans brancher I'étiqueteuse a I'ordinateur, sélectionnez le dossier Configurations dans la fenétre P-touch
Transfer Manager, puis sélectionnez le modéle a enregistrer.

.ﬁ Vous pouvez sélectionner plusieurs modéles a la fois.

3. Cliquez sur Fichier > Sauvegarder le fichier de transfert.

REMARQUE

Le bouton Sauvegarder le fichier de transfert ne s’affiche que si I'étiqueteuse est débranchée de

I'ordinateur ou hors ligne.
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ﬁ » Sivous cliquez sur le boutonSauvegarder le fichier de transfert aprés avoir sélectionné
Configurations, tous les modéles du dossier sont enregistrés en tant que fichier de transfert (BLF) ou

fichier de package de transfert (PDZ).
* Vous pouvez regrouper plusieurs modeles dans un méme fichier de transfert (BLF) ou fichier de
package de transfert (PDZ).

4. Dans le champ Type, sélectionnez le format de modeéle souhaité, puis saisissez le nom et enregistrez le
modéle.

u Renseignements connexes

» Transfert de modéles sur 'imprimante a I'aide de P-touch Transfer Manager (Windows)

[ H-10159

PAGE 438 OF 464 1-800-295-5510 1023 IH-10159VND



# Accueil > Transfert de modéles sur I'imprimante (P-touch Transfer Manager) (Windows) > Distribution de
modeles a transférer aux utilisateurs sans utiliser P-touch Transfer Manager (Windows)
Distribution de modéles a transférer aux utilisateurs sans utiliser P-
touch Transfer Manager (Windows)

Transférez les modéles vers I'imprimante a I'aide de P-touch Transfer Express.

Pour télécharger la derniére version de P-touch Transfer Express, accédez a la page Téléchargements de votre
modele sur le site Web de soutien de Brother a I'adresse support.brother.com.

ﬁg} * Lors du transfert d’'un nouveau modele, assurez-vous que vous spécifiez le numéro d’affectation de clé
(dans P-touch Transfer Manager) qui n’est pas actuellement utilisé. Si le numéro d’affectation de clé
spécifié est déja utilisé, le modeéle existant sera remplacé par le nouveau.

» Cette fonction nécessite une connexion USB.

Administrateur Utilisateurs

1 Site Web de soutien Brother = Transfer Express
* support.brother.com
4
P-touch P-touch P-touch
Editor Transfer Manager Transfer Express
1 & B
D D |::> D pifilodl  FtTrExpexe  PtTvExpini
xxx.lbx xxx.Ibx  xxx.pdz m%d” ng” XQ,Z
l Il | l
I 2. LI 3. 1 I

>> Taches de 'administrateur
>> Taches de l'utilisateur

Taches de I’administrateur

>> Préparation de P-touch Transfer Express

>> Transfert d’'un modéle sur P-touch Transfer Manager

>> Enregistrement du modéle en tant que fichier de package de transfert (PDZ)

>> Distribution du fichier de package de transfert (PDZ) et de P-touch Transfer Express a d’autres utilisateurs

Préparation de P-touch Transfer Express

Le pilote d’'imprimante doit étre installé avant d'utiliser P-touch Transfer Express.

ﬁ P-touch Transfer Express n’est disponible qu’en anglais.

1. Téléchargez P-touch Transfer Express sur n'importe quel emplacement de I'ordinateur.

2. Décompressez le fichier téléchargé (ZIP).

Transfert d’'un modéle sur P-touch Transfer Manager

.ﬁ Pour utiliser la fonction de transfert de modéle, utilisez P-touch Editor 5.4. P-touch Editor 6.0 sera mis a
jour dans le futur.

1. Démarrez P-touch Editor @.

*  Windows 11 :
Cliquez sur Démarrer > Brother P-touch > P-touch Editor, ou double-cliquez sur I'icone P-touch

Editor sur le bureau.
[ H-10159
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* En fonction du systéme d’exploitation de votre ordinateur, le dossier Brother P-touch peut étre créé ou
non.

«  Windows 10 :

Cliquez sur Démarrer > Brother P-touch > P-touch Editor, ou double-cliquez sur l'icbne P-touch
Editor sur le bureau.

*  Windows 8,1 :

Cliquez sur l'icéne P-touch Editor de I'écran Applications ou double-cliquez sur I'icobne P-touch Editor
sur le bureau.

Ouvrez le modéle souhaité.
3. Cliquez sur Fichier > Transférer Modéle > Transférer.

@ P-touch Editor - [Mise en page?] s x
@ Fichier | Edition Affichage Insérer Format Outils Miseenpage Fenétre Aide
Ctrl+N -
1 = I |
Ctrl-0 | [ =
Not Ctdsw  [Sienets | Mise en page Imprimer Enregistrer
Enregistrer cues B k| | =]

S, [0 ) 5o 60 o 60 ) 100 frio 120 150 40 150 160 i 180 190 200 210 220 30 240, 250 50 270
Enregistrer sous.. e T Ot L7 L i L SO et A A

Enregistrer sur le Web... ‘

Transférer Modéle > Apercu

Base de données Transférer...

Mise e

n page et configuration de l'imprimante

Apercu avant impression
Imprimer. Ctrl+P ‘
Propriétés de mise en page. culsL |
Fichiers utilisés récemment > ‘
Quitter ‘
Urernaton

—  ® Horizontale
T O Verticale

Finalité

Format normal

R O R

Al &l Bl @l 8o

(T

I

Feuille 1

] \ “rofessiona Brother v - 100%

Le modele est transféré sur P-touch Transfer Manager. P-touch Transfer Manager démarre.

Enregistrement du modéle en tant que fichier de package de transfert (PDZ)

Pour créer un fichier dans un format pouvant étre utilisé par P-touch Transfer Express, enregistrez le modéle en
tant que fichier de package de transfert (PDZ).

1. Sélectionnez le dossier Configurations dans la fenétre P-touch Transfer Manager.
2. Sélectionnez les modeles que vous souhaitez distribuer.
3. Cliquez sur Fichier > Sauvegarder le fichier de transfert.

;ﬁ + L'option Sauvegarder le fichier de transfert ne s’affiche que si I'imprimante est débranchée de
I'ordinateur ou hors ligne.

» Sivous cliquez sur I'option Sauvegarder le fichier de transfert aprés avoir sélectionné le dossier
Configurations ou un dossier créé, tous les modeles du dossier sont enregistrés en tant que fichier de
package de transfert (PDZ).

* Vous pouvez regrouper plusieurs modeles dans un méme fichier de package de transfert (PDZ).

[ H-10159
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4. Saisissez le nom, puis cliquez sur Enregistrer.
45 Enregistrer sous *
%] » CePC » Bureau » echercher dans : Docume
Organiser = Mouveau dossier hd o
%| Documents =
= Images
¢@& OneDrive
Bl CePC
g Réseau
W
Mom du fichier: | Layout? %
Type: | Fichier de package de transfert (*.pdz) ~
» Masquer les dossiers Annuler

Le modeéle est enregistré en tant que fichier de package de transfert (PDZ).

Distribution du fichier de package de transfert (PDZ) et de P-touch Transfer
Express a d’autres utilisateurs

ﬁ Si vous avez déja téléchargé P-touch Transfer Express sur I'ordinateur, il n’est pas nécessaire que
I'administrateur envoie le dossier Transfer Express. Dans ce cas, I'utilisateur peut simplement déplacer le

fichier de package de transfert distribué dans le dossier téléchargé, puis double-cliquer sur le fichier

PtTrExp.exe.

1. Déplacez le fichier de package de transfert (PDZ) vers le dossier de téléchargements.

| [4 | = | Transfer Bxpress
Accusil  Parage  Affichage (2]
~ @ | Rechercherdans: Transfer Ex..

[ s Transfer Bxpress

&

ptilot.di PHTrExp.exe

ReadMeEng.ot RezdMelpn.txt TRDRV.dll unzip32.dil Layoutl pdz

7 élément(s)

Layoutl.pdz

2. Distribuez a l'utilisateur tous les fichiers du dossier des téléchargements.
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Taches de I'utilisateur

Transfert du fichier de package de transfert (PDZ) sur votre imprimante

ﬁ N’éteignez pas I'imprimante pendant le transfert de modéles.

Mettez I'étiqueteuse sous tension.
Branchez 'imprimante a l'ordinateur a I'aide d’'un cable USB.
Double-cliquez sur le fichier PtTrExp.exe recu de 'administrateur.

Pon-~

Effectuez I'une des opérations suivantes :

+ Pour transférer un seul fichier de package de transfert (PDZ) dans le dossier contenant le fichier
PtTrExp.exe, cliquez sur Transfer.

» Pour transférer plusieurs fichiers de package de transfert (PDZ) dans le dossier contenant le fichier
PtTrExp.exe, procédez comme suit :

a. Cliquez sur Browse.

@ P-touch Transfer Express it

= Select the Transfer Package file to be transferred to the printer.
@ Then, click the Transfer button to begin transferring.

Transfer Package File:

|| Browse...

_Eowse. |
%21 Transfer Exit

b. Sélectionnez le fichier de package de transfert que vous souhaitez transférer, puis cliquez sur Ouvrir.

c. Cliquez sur Transfer.
d. Cliquez sur Yes.
5. Une fois I'opération terminée, cliquez sur OK.

L‘g Renseignements connexes

» Transfert de modéles sur I'imprimante (P-touch Transfer Manager) (Windows)
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# Accueil > Stockage et gestion de modeles (P-touch Library)

| Stockage et gestion de modeles (P-touch Library)
» Modification de modéles a I'aide de P-touch Library (Windows)
» Impression de modéles a 'aide de P-touch Library (Windows)

* Recherche de modéles a l'aide de P-touch Library (Windows)

[ H-10159
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& Accueil > Stockage et gestion de modéles (P-touch Library) > Modification de modeles a I'aide de P-touch

Library (Windows)

| Modification de modéles a I’'aide de P-touch Library (Windows)

1. Lancez P-touch Li
¢«  Windows 11 :

brary.

Cliquez sur Démarrer > Brother P-touch > P-touch Library.

* En fonction du systéme d’exploitation de votre ordinateur, le dossier Brother P-touch peut étre créé ou

non.
«  Windows 10 :

Cliquez sur Démarrer > Brother P-touch > P-touch Library.

*  Windows 8,1

Cliquez sur 'icone P-touch Library de I'écran Applications.

La fenétre principale apparait.

Pour |'aide, appuyez sur F1

& Tout le contenu - P-touch Library - [m] *
Fichier Edition Affichage Outils Aide
Cuvrir Imprimer Rechercher  Style d'affichage
:] P-touch Library Mom Taille Date Emplacement
@3 ﬂ ABC.Ibx 1KB  28/12/201807:22:48  ChUsers\WM138_WIN10\Documents\Mes étiquettes\ ABC.Ibx
R‘," : : e @) Brother.lbx KB 28/12/201307:2208  C:\Users\VM138_WIN'10\Documents\Mes étiquettes\Brotherllx
P AR @) P-touch.lbx KB 28/12/201207:2342  C:\Users\VM138_ WIN10\Documents\Mes étiquettes\P-touch.bx

NUM

Présentation des icones de la barre d’outils

Icone Nom du bouton Fonction
[_jj' Ouvrir Cliquez pour ouvrir le modéle sélectionné.
L'_;j Imprimer Cliquez pour imprimer le modéle sélectionné.
) Rechercher Cliquez pour rechercher des modéles enregistrés dans
» P-touch Library.
j Style d'affichage Cliquez pour modifier le style d’affichage du fichier.

2. Sélectionnez le modeéle que vous souhaitez modifier, puis cliquez sur Ouvrir.

Vous pouvez maintenant modifier le modéle.

u Renseighements connexes

» Stockage et gestion de modeles (P-touch Library)
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# Accueil > Stockage et gestion de modéles (P-touch Library) > Impression de modéles a 'aide de P-touch

Library (Windows)

| Impression de modéles a I'aide de P-touch Library (Windows)

1. Lancez P-touch Library.
*  Windows 11 :

Cliqguez sur Démarrer > Brother P-touch > P-touch Library.

* En fonction du systéme d’exploitation de votre ordinateur, le dossier Brother P-touch peut étre créé ou

non.
*  Windows 10 :

Cliqguez sur Démarrer > Brother P-touch > P-touch Library.

*  Windows 8,1 :
Cliquez sur 'icone P-touch Library de I'écran Applications.
La fenétre principale apparatt.

&5 Tout le contenu - P-touch Library
Fichier Edition Affichage Qutils Aide

& P Q

Quvrir Imprimer Rechercher  Style d'affichage
FE] P-touch Library MNom Taille Date Emplacement
ﬂ ABC.Ibx 1KB  28/12/2018 07:22:48  C:\Users\VM138_WIN10\Decuments\Mes Etiquettes\ABC.Ibx
s Rf" l‘:' ted Eog @ Brother.lbx 1KB 28/12/201807:23:09  C:\Users\VM138_ WINT0\Documents\Mes étiquettes\Brother.lbx
T R e @) P-touch.lbx KB 28/12/201807:22:42  C:\Users\VM132_WIN10\Documents\Mes étiquettes\P-touch.lbx

Pour |'aide, appuyez sur F1

MNUM

2. Sélectionnez le modele a imprimer, puis cliquez sur Imprimer.
L'étiqueteuse connectée imprime le modéle.

u Renseignements connexes

» Stockage et gestion de modéles (P-touch Library)
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# Accueil > Stockage et gestion de modéles (P-touch Library) > Recherche de modéles a I'aide de P-touch

Library (Windows)

| Recherche de modeéles a I’'aide de P-touch Library (Windows)

1. Lancez P-touch Library.
*  Windows 11 :

Cliquez sur Démarrer > Brother P-touch > P-touch Library.

* En fonction du systéme d’exploitation de votre ordinateur, le dossier Brother P-touch peut étre créé ou

non.
«  Windows 10 :

Cliquez sur Démarrer > Brother P-touch > P-touch Library.

*  Windows 8,1 :
Cliquez sur l'icone P-touch Library de I'écran Applications.
La fenétre principale apparait.

&5 Tout le contenu - P-touch Library

Fichier Edition Affichage OQutils Aide

e —— o

Quvrir Imprimer Rechercher  Style d'affichage
:] P-touch Library Mom Taille Date Emplacement
@ ABC.Ibx KB 28/12/2018 07:22:48  C:\Users\WM138_WIN10\Decuments\Mes étiquettes\ABC.Ibx
R'," I‘:' te SE B @ Brother.lbx KB 28/12/2018 07:23:09  C:\Users\WM138_WIN10\Documents\Mes étiquettes\Brother.lbx
S R O G @) P-touch.lbx KB 28/12/2018 07:23:42  C:\Users\WM132_WIN10\Documents\Mes étiquettes\P-touch.Ibx

Pour |'aide, appuyez sur F1

NUM

2. Cliquez sur Rechercher.
La boite de dialogue Rechercher s’affiche.
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|Fi-_'hie:' Edition Affichage

&

Cutils  Aide

Quvrir Imprimer Rechercher  Style d'affichage
FE] P-touch Library MNom Taille Date Emplacement
& l"”;'_e”“”te”“ @] ABC.Ibx KB 28/12/201807:22:48  C:\Users\VM138_WIN10\Documents\Mes étiquettes\ABC.Ibx
g @) Brother.lbx KB 28/12/201807:23:00  C:\Users\VM138_ WIN10\Documents\Mes étiquettes\Brother.lbx
jResultatsde lairecherche @| P-touch Ik AKD 28/13/3018 07.2247 £ learc\ UAA128 WINAM Naciwmantc bac Stingettes)P-touch.lbx
Rechercher >
Paramétres multiples ®ET Ciou
[Inom | | | conmenu v
I Crype Mise en page (lbx;lbl;lbp;mbl) ~ | | CONTENU ~
< [ Taille De [.0 = >
s [ He .
[Jpate De E.I"EJ"ZU 13 ﬁ =i
A 81202018 [~
Fermer
v

Pour I'aide, appuyez surF1

3. Spécifiez les critéeres de recherche.

Ll

Les critéres de recherche disponibles sont présentés ci-dessous :

Parameétres

Détails

Parameétres multiples

Détermine le mode de recherche utilisé par le
programme quand plusieurs critéres sont spécifiés. Si
vous sélectionnez ET, le programme recherche les
fichiers répondant a 'ensemble des critéres spécifiés.
Si vous sélectionnez OU, le programme recherche les
fichiers répondant a I'un des critéres spécifiés, quel qu'il
soit.

Nom Recherchez un modele en spécifiant le nom du fichier.
Type Recherchez un modele en spécifiant le type de fichier.
Taille Recherchez un modéle en spécifiant la taille du fichier.
Date Recherchez un modéle en spécifiant la date du fichier.

4. Cliquez sur Lancer la recherche.

La recherche commence et les résultats de la recherche sont affichés.

5. Fermez la boite de dialogue Rechercher.

Pour vérifier les résultats de la recherche, cliquez sur Résultats de la recherche dans la vue du dossier.

.ﬁ Vous pouvez enregistrer des modéles dans P-touch Library en les faisant glisser dans le dossier Tout le

contenu ou dans la liste de dossiers.

u Renseignements connexes

» Stockage et gestion de modéles (P-touch Library)
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#& Accueil > Maintenance de routine

| Maintenance de routine

* Entretien

[ H-10159
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#& Accueil > Maintenance de routine > Entretien

| Entretien

Retirez toujours les piles et débranchez I'adaptateur secteur avant de nettoyer I'étiqueteuse.

>> Nettoyez I'unité
>> Nettoyage de la téte d’'impression
>> Nettoyage du coupe-ruban

Nettoyez I'unité

1. Essuyez toute poussiére ou marque sur I'étiqueteuse avec un chiffon doux et sec.
2. Utilisez un tissu légérement humidifié avec de I'eau pour retirer les marques tenaces.

ﬁ N’utilisez aucun diluant, benzéne, alcool ou autre solvant organique. Ceux-ci peuvent déformer ou
endommager le boftier de votre étiqueteuse.

Nettoyage de la téte d’impression

Des stries ou une mauvaise qualité d'impression des caractéres sur I'étiquette indiquent généralement que la
téte d’'impression est sale.

Nettoyez la téte d’'impression a l'aide d’'un coton-tige ou de la cassette de nettoyage de la téte d’impression en
option (TZe-CL4).

N

ﬁ - Ne touchez pas la téte d’impression directement a mains nues.
- Lisez et suivez les instructions fournies avec la cassette de nettoyage de la téte d’impression.

Nettoyage du coupe-ruban

De I'adhésif de ruban peut s’accumuler sur la lame du coupe-ruban aprés une utilisation répétée et émousser
ainsi la lame, ce qui peut entrainer un bourrage du ruban au niveau du coupe-ruban.
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Environ une fois par an, nettoyez la lame du coupe-ruban en utilisant un coton-tige Iégérement humidifié avec de
I'alcool isopropylique (alcool a friction).

ﬁ - Ne touchez pas la lame du coupe-ruban a mains nues.
- Utilisez I'alcool isopropylique conformément aux consignes du fabricant.

u Renseignements connexes

» Maintenance de routine
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# Accueil > Dépistage des pannes

| Dépistage des pannes
» Sivous avez des difficultés avec votre étiqueteuse

* Messages d’erreur et d’entretien

Vérifier les informations sur la version

Réinitialiser I'étiqueteuse
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# Accueil > Dépistage des pannes > Si vous avez des difficultés avec votre étiqueteuse
| Sivous avez des difficultés avec votre étiqueteuse

Ce chapitre explique comment résoudre les problémes courants qui pourraient survenir lors de I'utilisation de
I'étiqueteuse.

Si ces problemes persistent »>» Renseignements connexes Si, aprés la lecture des rubriques, vous n’étes pas
en mesure de résoudre le probléme, visitez le site Web de soutien Brother a I'adresse support.brother.com.

Probléme Solution
L’étiqueteuse n’imprime » Assurez-vous que la cassette de ruban est correctement insérée.
pas. » Sila cassette de ruban est vide, remplacez-la. Pour commander des fournitures et

des accessoires, consultez www.brother.ca.

» Vérifiez que le couvercle du compartiment de la cassette de ruban est bien fermé.

« Vérifiez que I'étiqueteuse est allumée.

» Vérifiez que le parameétre Bluetooth de I'ordinateur ou de I'appareil mobile est
activé.

» Vérifiez que I'étiqueteuse est connectée a I'ordinateur ou a I'appareil mobile par
Bluetooth.

» Vérifiez que I'étiqueteuse est sélectionnée dans I'application Brother iPrint&Label.

+ Vérifiez que I'étiqueteuse n’est pas couplée a un autre appareil.

» Assurez-vous que l'étiqueteuse et votre appareil mobile ou ordinateur sont
suffisamment proches pour communiquer.

+ Vérifiez que le parametre de reconnexion Bluetooth automatique d’'un autre
ordinateur ou appareil mobile n’est pas activé.

+ Assurez-vous qu’aucun appareil émettant des ondes radio (par exemple, un four a
micro-ondes) ne se trouve a proximité.

+ Vérifiez que le bon pilote d'imprimante est installé pour I'impression a partir d'un
ordinateur.

» Connectez I'étiqueteuse a votre ordinateur a I'aide du cable USB (inclus) lorsque
vous imprimez depuis un ordinateur.

+ Silatéte d'impression est sale, nettoyez-la avec un coton-tige ou la cassette de
nettoyage de la téte d’'impression en option (TZe-CL4).

* Leruban n’avance pas |+ Sile ruban est plié, coupez la section pliée.

correctement. + Sile ruban est coincg, retirez la cassette de ruban, retirez le ruban coincé, puis
* Le ruban se coince a coupez le ruban endommageé.

I‘|’nt.er|eur de + Vérifiez que I'extrémité de ruban sort par le guide-ruban.

I'étiqueteuse.

» Assurez-vous que le ruban est pointé vers la fente de sortie du ruban.
* Retirez la cassette de ruban et insérez-la de nouveau.

Une erreur s’est produite Allez dans le menu des parameétres de votre application mobile et sélectionnez
pendant I'utilisation d’une Support (Soutien) > FAQ et Diagnostic.
application mobile.

L’écran s’est verrouillé. * Réinitialisez la mémoire interne aux parametres d’usine. Pour plus d'information »>»
Sujets connexes

» Débranchez I'adaptateur secteur et retirez les piles pendant au moins 10 minutes.

L’écran ACL reste blanc Vérifiez que les piles sont correctement installées ou que I'adaptateur secteur fourni
apres la mise sous tension. |avec I'étiqueteuse est correctement connecté.

Les messages de I'écran Définissez la langue de I'écran ACL que vous souhaitez. Pour plus d'information »»
ACL s’affichent dans une Sujets connexes
langue étrangere.

L’étiqueteuse s’arréte * Remplacez la cassette de ruban si un ruban rayé est visible, car cela indique que

pendant I'impression d’'une vous avez atteint la fin du ruban.

etiquette. + Remplacez toutes les piles ou connectez I'adaptateur secteur directement &
I'étiqueteuse.
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Probléme

Solution

Les fichiers d’étiquettes
précédemment enregistrés
ne sont pas disponibles.

Tous les fichiers enregistrés dans la mémoire interne sont supprimés si les piles sont
faibles ou si I'adaptateur secteur est débranché.

* Je ne peux pas installer
le pilote d'imprimante
méme si je suis la
procédure correctement.
(Windows)

+ Je ne peux pas voir mon
imprimante listée dans
le P-touch Editor méme
si j'ai installé le pilote
d’'imprimante. (Windows)

Si vous ne pouvez pas utiliser votre étiqueteuse alors que vous avez installé le pilote
d’'imprimante :

1. Téléchargez le programme Désinstaller les logiciels et pilotes d’imprimante depuis
la page de votre modéle sur support.brother.com.

2. Utilisez le programme Désinstaller les logiciels et pilotes d'imprimante pour
supprimer les informations relatives a I'imprimante.

3. Exécutez a nouveau le programme d’installation du pilote d'imprimante et suivez les
instructions a I'écran pour procéder a I'installation.

Le ruban encreur est
séparé du rouleau encreur.

Si le ruban encreur est endommagé, remplacez la cassette de ruban. Sinon, ne coupez
pas le ruban et retirez soigneusement la cassette de ruban, puis enroulez le ruban
encreur desserré sur la bobine.

Les codes a barres ou les
codes QR imprimés sont
illisibles.

* Changez le ruban. (Recommandé : ruban noir sur blanc)

» Agrandissez les codes a barres ou les codes QR a I'aide de votre application de
codes a barres, si possible.

Je ne connais pas le
numéro de version du
micrologiciel de
I'étiqueteuse.

Vous pouvez confirmer le numéro de version du micrologiciel et d’autres informations
sur I'écran ACL. Pour plus d'information »>» Sujets connexes

Lorsque I'étiquette est
imprimée, il y a trop de
marge (espace) des deux
cétés du texte.

Sélectionnez les options Pte marge, Chaine, ou Non coupé pour réduire les
marges.

Pour plus d'information »» Sujets connexes

» Apres l'impression de la derniére étiquette, appuyez simultanément sur et

pour faire avancer le ruban, puis éjectez et coupez la derniére étiquette. Notez

que l'étiqueteuse fera avancer le ruban d’environ 23 mm (0,9 po) avant la nouvelle
étiquette suivante lorsque vous utilisez cette méthode.

La taille de la police ne peut
pas étre augmentée.

La police a déja la taille maximale correspondant a la largeur de I'étiquette, ou la
longueur de I'étiquette a été définie, de sorte que la taille de la police est limitée pour
éviter de dépasser la longueur définie.

Lorsque plusieurs étiquettes
sont imprimées, la derniére
étiquette est coupée de
maniére incorrecte.

Lorsque Chaine est activée, faites avancer le ruban pour éjecter la derniere étiquette
imprimée.

Je ne peux pas mettre a
jour le micrologiciel de
limprimante a l'aide P-
touch Update Software, de
Transfer Express ou de
Mac Update Tool.

Redémarrez I'imprimante, puis essayez a nouveau de mettre a jour le micrologiciel.
N’appuyez sur aucun bouton pendant la mise a jour du micrologiciel jusqu’a ce que
I'écran d’accueil s’affiche automatiquement.

L'étiqueteuse ne fonctionne
pas normalement.

* Réinitialisez la mémoire interne aux parameétres d’usine. Pour plus d'information »>»
Sujets connexes

» Débranchez I'adaptateur secteur et retirez les piles pendant au moins 10 minutes.

& .
... Renseignements connexes

» Dépistage des pannes
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Sujets connexes :

+ Réinitialiser I'étiqueteuse

+ Définir la langue

 Vérifier les informations sur la version

» Options de coupe du ruban
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# Accueil > Dépistage des pannes > Messages d’erreur et d’entretien

| Messages d’erreur et d’entretien

Message Cause/Solution

Enreg :XXXXX Il'y a eu une tentative d’'impression d’étiquettes a code a barres a partir d’'une base de
Enreg :XXXXX donnges.

Champ :XXXXX L'étiqueteuse affiche ce message lorsque la plage sélectionnée de la base de données

comprend des caractéres invalides ou des numéros non pris en charge par le protocole
de code a barres.

Erreur systéme XX Contactez le service a la clientéle Brother.

Etiqu. trop longue La longueur de I'étiquette imprimée avec le texte saisi est supérieure a 999 mm
(39,37 po). Modifiez le texte de fagon a ce que la longueur de I'étiquette soit inférieure a
999 mm (39,37 po).

Probléme découpe ! Si le ruban est coincé dans le coupe-ruban, retirez le ruban. Eteignez, puis rallumez
I'étiqueteuse avant de continuer.

Texte trop long ! La longueur de I'étiquette imprimée a partir du texte saisi est supérieure a la longueur
définie. Modifiez le texte afin de s’adapter a la longueur définie ou modifiez le
parameétre de longueur.

Vérifier le nombre Le nombre de chiffres saisis dans les données du code a barres ne correspond pas au
de chiffres saisis nombre de chiffres définis dans les paramétres du code a barres. Saisissez le nombre
correct de chiffres.

u Renseignements connexes

» Dépistage des pannes
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# Accueil > Dépistage des pannes > Vérifier les informations sur la version
| Vérifier les informations sur la version

Vous pouvez confirmer le numéro de version du micrologiciel et d’autres informations sur I'écran ACL. Vous
pourriez avoir besoin de ces informations si vous appelez Brother pour une question ou une garantie.

1. Appuyez sur .

2. Appuyez sur €4 ou P pour afficher [Réglages], puis appuyez sur OK.
3. Appuyez sur A ou ¥ pour afficher [Informations de version], puis appuyez sur OK.

m Renseignements connexes

» Dépistage des pannes
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# Accueil > Dépistage des pannes > Réinitialiser I'étiqueteuse
| Réinitialiser I'étiqueteuse

Réinitialisez la mémoire interne de votre étiqueteuse pour effacer tous les fichiers d’étiquettes enregistrés ou si
I'étiqueteuse ne fonctionne pas correctement.

* Reéinitialiser a I'aide de I'écran ACL
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# Accueil > Dépistage des pannes > Reinitialiser I'étiqueteuse > Réinitialiser a I'aide de I'écran ACL
| Réinitialiser a I'aide de I’écran ACL

1. Appuyez sur .

Appuyez sur €4 ou » pour afficher [Réglages], puis appuyez sur OK.
Appuyez sur A ou ¥ pour afficher [Réinitialiser], puis appuyez sur OK.

Ll A

Appuyez sur A ou sur Y pour afficher la méthode de réinitialisation, puis appuyez sur OK.
Un message s’affiche vous demandant de confirmer votre option de réinitialisation.
5. Appuyez sur OK.

ﬁﬁ? Si vous utilisez les options de réinitialisation [Réinitialiser paramétres] OU [Paramétres par
défaut], vous devrez redéfinir votre langue par défaut préférée aprés la réinitialisation.

Options de réinitialisation Détails

Réinitialiser parameétres |La mémoire du fichier n'est PAS effacée.

Les données de paramétrage sont effacées et tous les paramétres sont
réinitialisés aux parameétres d’usine.

Effacer tout contenu La mémoire du fichier est effacée.

Les données de paramétrage ne sont PAS effacées et les paramétres restent tels
qu’ils sont actuellement configurés.

Paramétres par défaut La mémoire des fichiers, les étiquettes et les paramétres personnalisés sont
réinitialisés aux parameétres d’usine.

=3 .
. Renseignements connexes

* Réinitialiser I'étiqueteuse
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& Accueil > Annexe

| Annexe
» Spécifications

* Aide et support client Brother
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#& Accueil > Annexe > Spécifications
| Spécifications

>> |mpression

>> Taille

>> |nterface

>> Environnement

>> Bloc d’alimentation

>> Médias

>> Mémoire

>> Systémes d’exploitation compatibles

Impression

Vitesse d’impression Maximum 30 mm/s (1,18 po/s)
(Selon le support utilisé)

Hauteur d’impression maximale 18,0 mm (0,71 po) (en cas d'utilisation d’un ruban de 24 mm / 0,94 po) '

1 La taille réelle du caractére peut étre inférieure a la hauteur d'impression maximale.

Taille

Poids Environ 990 g (environ 2,2 Ib) (sans les piles et la cassette de ruban)
Dimensions |Environ 202 mm (L) x 87 mm (H) x 199 mm (P) (Environ 7,95 po [L] x 3,42 po [H] x 7,83 po [P])
Ecran LCD |320 x 120 ppp

Interface
usB USB Ver. 2.0 (pleine vitesse) (Micro B)
Bluetooth Bluetooth Ver. 5.0
SPP : iAP2
Environnement

Température de fonctionnement Entre 10 et 35 °C (entre 50 et 95 °F)

Humidité de fonctionnement Entre 20 et 80 %

Température isobarique maximale du thermometre mouillé : 27 °C (80,6 °F)

Bloc d’alimentation

Pile Six piles alcalines AA (LR6)
Adaptateur secteur (AD-E001A)

Médias

Largeur du ruban | Cassette de ruban standard TZe :

3,5 mm (0,13 po), 6 mm (0,23 po), 9 mm (0,35 po), 12 mm (0,47 po), 18 mm (0,70 po), 24 mm
(0,94 po)

Nombre de lignes | Ruban de 24 mm (0,94 po) : 1 a 7 lignes
Ruban de 18 mm (0,70 po) : 1 a 5 lignes
Ruban de 12 mm (0,47 po) : 1 a 3 lignes
Ruban de 9 mm (0,35 po) : 1 a 2 lignes
Ruban de 6 mm (0,23 po) : 1 a 2 lignes
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Ruban de 3,5 mm (0,13 po) : 1 ligne

Mémoire

Tampon de texte

280 caractéres maximum

Stockage des fichiers 99 fichiers maximum

Systémes d’exploitation compatibles

Pour voir la derniére liste des logiciels compatibles, rendez-vous sur support.brother.com.

u Renseignements connexes
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#é Accueil > Annexe > Aide et support client Brother

| Aide et support client Brother

Pour obtenir une aide technique, il est impératif d’appeler le numéro du pays ou vous avez acheté I'appareil.
Tous les appels doivent étre effectués depuis ce pays.

>> FAQ (Foire aux questions)
>> Pour le service a la clientéle
>> Commande d'accessoires et de consommables

FAQ (Foire aux questions)

Pour plus d’information sur votre appareil Brother, rendez-vous sur le site Web de soutien Brother a I'adresse
support.brother.com. Pour une aide et des conseils supplémentaires, accédez a la page FAQ et Diagnostic de
votre modele; pour les derniers pilotes et logiciels, accédez a la page Téléchargements de votre modéle.

Pour le service a la clientéle

Aux Etats-Unis :
www.brother-usa.com/support (Libre-service/Courriel/Clavardage)
1-877-BROTHER (1-877-276-8437)

Au Canada:
www.brother.ca/support

(Vidéos libre-service, Courriel, Clavardage, aide via Facebook et Twitter)

Localisateur de centre de service (Etats-Unis uniquement)

Pour connaitre 'emplacement d’un centre de service autorisé de Brother, composez le 1-877-BROTHER
(1-877-276-8437) ou visitez le site www.brother-usa.com/support.

Adresses des centres de service (Canada uniquement)

Pour connaitre 'emplacement d’'un centre de service autorisé Brother, visitez le site www.brother.ca/support.

Commande d'accessoires et de consommables

Pour obtenir des résultats de la meilleure qualité, utilisez uniguement des consommables de marque Brother
authentiques, disponibles chez la plupart des détaillants Brother. Si vous ne trouvez pas les consommables
recherchés, commandez-les directement de Brother si vous possédez un compte PayPal ou une carte de crédit
Visa, MasterCard, Discover ou American Express. Vous pouvez visiter notre site Web pour consulter la gamme
compléte des accessoires et des fournitures de marque Brother en vente.

REMARQUE

Au Canada, seules les cartes Visa et MasterCard sont acceptées.

Aux Etats-Unis :
1-877-BROTHER (1-877-276-8437)

www.brother-usa.com/support
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Au Canada:

www.brother.ca

v Renseignements connexes
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